
NSP
Network Services Platform

Network Functions Manager - Packet (NFM-P)
Release 17.3

Optical User Guide

3HE-12002-AAAA-TQZZA

Issue 2

April 2017



Legal notice

Nokia is a registered trademark of Nokia Corporation. Other products and company names mentioned herein may be trademarks or
tradenames of their respective owners.

The information presented is subject to change without notice. No responsibility is assumed for inaccuracies contained herein.

© 2017 Nokia.

NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

2 Issue 2



Contents

About this document..........................................................................................................................................18

Part I: Introduction .............................................................................................................................................21

1 What’s new? .................................................................................................................................................23

1.1 Overview .............................................................................................................................................23

1.2 What’s new in NFM-P Release 17.3 for 1830 PSS .............................................................................23

2 1830 PSS overview.......................................................................................................................................25

2.1 Overview .............................................................................................................................................25

2.2 1830 PSS OCS system overview........................................................................................................25

2.3 1830 PSS WDM system overview.......................................................................................................26

2.4 IP-optical management workflow ........................................................................................................29

Part II: 1830 PSS system management.............................................................................................................33

3 1830 PSS user security................................................................................................................................35

3.1 Overview .............................................................................................................................................35

3.2 User security overview ........................................................................................................................35

4 1830 PSS map management .......................................................................................................................37

4.1 Overview .............................................................................................................................................37

4.2 Topology maps ....................................................................................................................................37

4.3 To view a service topology map ..........................................................................................................40

4.4 To view optical interconnections only ..................................................................................................40

4.5 To view IP interconnections only .........................................................................................................42

5 1830 PSS equipment navigation tree .........................................................................................................45

5.1 Overview .............................................................................................................................................45

5.2 Equipment navigation tree ..................................................................................................................45

5.3 To start the 1830 PSS external EMS browser in normal mode ...........................................................46

5.4 To start the 1830 PSS external EMS browser in secure mode ...........................................................46

6 1830 PSS CLI sessions................................................................................................................................49

6.1 Overview .............................................................................................................................................49

6.2 CLI access...........................................................................................................................................49

6.3 To create, run and schedule an 1830 PSS CLI script..........................................................................49

NFM-P

Release 17.3
April 2017
Issue 2 33HE-12002-AAAA-TQZZA



Part III: 1830 PSS device management .............................................................................................................53

7 1830 PSS discovery .....................................................................................................................................55

7.1 Overview .............................................................................................................................................55

7.2 WDM and OCS device discovery ........................................................................................................55

7.3 Workflow to discover 1830 PSS devices.............................................................................................59

7.4 Switching modes between SONET and SDH......................................................................................61

7.5 To configure SNMPv3 on an 1830 PSS devices from the WebUI .......................................................61

7.6 To configure a user account on an 1830 PSS device..........................................................................63

7.7 To distribute a user account to 1830 PSS devices ..............................................................................64

7.8 To delete an 1830 PSS user configuration ..........................................................................................66

7.9 To identify differences between a global and local 1830 PSS user or two local 1830 PSS users.......67

7.10 To configure NE mediation ..................................................................................................................68

7.11 To configure a discovery rule...............................................................................................................70

8 1830 PSS backup and upgrade...................................................................................................................73

8.1 Overview .............................................................................................................................................73

Back up and restore files on the 1830 PSS NEs .......................................................................................75

8.2 Overview .............................................................................................................................................75

8.3 Workflow to backup and restore an 1830 PSS device ........................................................................76

8.4 To configure an 1830 PSS WDM backup/restore policy and assign the policy to NEs .......................77

8.5 To configure an 1830 PSS OCS backup/restore policy and assign the policy to NEs ........................79

8.6 To assign a backup policy to 1830 PSS devices .................................................................................81

8.7 To perform an on-demand 1830 PSS backup .....................................................................................82

8.8 To import an 1830 PSS device backup from a file system to NFM-P database ..................................82

8.9 To export device backup files from NFM-P to file system....................................................................83

8.10 To restore a WDM device configuration backup other than the most recent.......................................84

8.11 To restore an OCS device configuration backup other than the most recent ......................................85

8.12 To force restore a device configuration ...............................................................................................86

Managing 1830 PSS software upgrades ....................................................................................................89

8.13 1830 PSS software upgrade ...............................................................................................................89

8.14 Workflow to configure an 1830 PSS software upgrade.......................................................................91

8.15 To import 1830 PSS WDM device software image files to NFM-P database ......................................92

8.16 To import 1830 PSS OCS device software image files to NFM-P database .......................................94

8.17 To download 1830 PSS-4 card images ...............................................................................................95

8.18 To create a software upgrade policy....................................................................................................96

8.19 To perform software upgrade through USB port on an EC card..........................................................97

NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

4 Issue 2



8.20 To assign a software upgrade policy to an 1830 PSS.........................................................................99

8.21 To perform an immediate software upgrade......................................................................................100

8.22 To schedule an automatic software upgrade.....................................................................................102

8.23 To view the status of a software upgrade ..........................................................................................104

9 1830 PSS equipment management...........................................................................................................105

9.1 Overview ...........................................................................................................................................105

Introduction ................................................................................................................................................108

9.2 Overview ..........................................................................................................................................108

9.3 Workflow to manage the 1830 PSS equipment ................................................................................108

Managing objects .......................................................................................................................................110

9.4 Working with objects..........................................................................................................................110

9.5 11DPM12 card and port objects ........................................................................................................110

Managing shelves ......................................................................................................................................113

9.6 1830 PSS WDM shelves ...................................................................................................................113

9.7 To configure a WDM shelf .................................................................................................................117

9.8 1830 PSS OCS shelves ....................................................................................................................118

9.9 To configure an OCS shelf.................................................................................................................119

9.10 To remove a shelf ..............................................................................................................................120

9.11 VWM-CW and VWM-DW shelves .....................................................................................................120

9.12 To associate an 1830 PSS-8 EC with a clip-on shelf ........................................................................121

Managing cards..........................................................................................................................................123

9.13 1830 PSS cards ................................................................................................................................123

9.14 Equipment protection group ..............................................................................................................123

9.15 32EC2E and 8EC2E cards................................................................................................................124

9.16 Raman 3 external amplifier ..............................................................................................................124

9.17 Amplifier and associated cards .........................................................................................................125

9.18 Client line cards for WDM devices ....................................................................................................128

9.19 OCS cards.........................................................................................................................................129

9.20 Optical transponder cards .................................................................................................................131

9.21 TDM cards.........................................................................................................................................136

9.22 Wavelength router cards ...................................................................................................................136

9.23 To configure an OPSA card ...............................................................................................................137

9.24 To configure an OPSB card...............................................................................................................138

9.25 To configure a card on a WDM shelf .................................................................................................138

9.26 To configure a card on an OCS shelf ................................................................................................140

NFM-P

Release 17.3
April 2017
Issue 2 53HE-12002-AAAA-TQZZA



9.27 To configure uplink cards on the upper row of the 1830 PSS-64 ......................................................141

9.28 To switch between active and standby matrix and FLC cards on an OCS device ............................142

9.29 To remove a card...............................................................................................................................143

9.30 To configure card firmware ................................................................................................................144

9.31 To configure the card mode for the 260SCX2 card ...........................................................................145

Managing ports .........................................................................................................................................147

9.32 Overview ...........................................................................................................................................147

9.33 OCS ports..........................................................................................................................................147

9.34 To configure a port on a WDM device ...............................................................................................150

9.35 To configure a port on an OCS device ..............................................................................................151

9.36 To enable interworking between different generations of coherent 100G OTU4 cards.....................152

9.37 To auto-disable a CIT port on an EC card .........................................................................................153

Managing LAGs..........................................................................................................................................154

9.38 LAGs .................................................................................................................................................154

9.39 To configure LAG on 11OPE8, 11QCE12X, and 11QPE24 cards .....................................................154

9.40 To create a LAG on an 11DPE12A card ............................................................................................157

Managing optical links...............................................................................................................................160

9.41 WDM optical links..............................................................................................................................160

9.42 OCS optical links ...............................................................................................................................160

9.43 1830 PSS and generic NE optical links.............................................................................................162

9.44 To configure an optical link between ports ........................................................................................163

9.45 To delete an optical link .....................................................................................................................164

9.46 To view an invalid or stale optical link................................................................................................165

9.47 To configure an OCS topological link ................................................................................................165

9.48 To create a physical link between an 1830 PSS device and a GNE .................................................166

Managing dry contact ................................................................................................................................168

9.49 Dry contact ........................................................................................................................................168

9.50 To configure 1830 PSS dry contact sensors .....................................................................................168

Managing inventory ...................................................................................................................................169

9.51 Workflow to manage inventory ..........................................................................................................169

Managing connections ..............................................................................................................................170

9.52 ROADM OADM and mesh connections (degree 2+).........................................................................170

9.53 One-device Anydirection and Two-device Anydirection configuration connections...........................173

NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

6 Issue 2



1830 PSS synchronization ........................................................................................................................177

9.54 WDM and OCS synchronization........................................................................................................177

9.55 To configure synchronization on an 1830 PSS WDM device ............................................................177

9.56 NTP server ........................................................................................................................................179

9.57 To configure an NTP server...............................................................................................................179

9.58 To delete an NTP server....................................................................................................................180

9.59 Precision time protocol ......................................................................................................................180

9.60 To configure TOD on the PTPCTL cards...........................................................................................181

9.61 To configure an IEEE 1588 PTP clock ..............................................................................................181

9.62 BITS ..................................................................................................................................................183

9.63 To configure BITS attributes on an 1830 PSS WDM device .............................................................183

9.64 To configure BITS attributes on an 1830 PSS OCS device...............................................................184

10 NFM-P application — Equipment view .....................................................................................................187

10.1 Overview ...........................................................................................................................................187

10.2 Equipment view .................................................................................................................................187

10.3 To start the equipment view application on a specific web browser ..................................................187

Part IV: 1830 PSS SDH trails and services .....................................................................................................189

11 SDH trails and services .............................................................................................................................191

11.1 Overview ...........................................................................................................................................191

SDH networks.............................................................................................................................................192

11.2 Workflow to configure a VC4 service ................................................................................................192

11.3 VC4 sub-structures............................................................................................................................193

11.4 To bind and collapse VC4 sub-structures..........................................................................................194

11.5 VCn cross-connects ..........................................................................................................................194

11.6 To configure a VCn XC and protect/unprotect the VCn XC...............................................................195

11.7 To configure an unprotected STM trail ..............................................................................................197

11.8 To configure a VC4 service ...............................................................................................................198

1+1 MSP group ...........................................................................................................................................201

11.9 Overview ...........................................................................................................................................201

11.10 To configure a 1+1 MSP group..........................................................................................................202

SDH line timing synchronization ..............................................................................................................203

11.11 Overview ...........................................................................................................................................203

11.12 To configure an SDH line timing synchronization ..............................................................................203

NFM-P

Release 17.3
April 2017
Issue 2 73HE-12002-AAAA-TQZZA



Part V: 1830 PSS OTN layer management ......................................................................................................207

12 1830 PSS optical trail management..........................................................................................................209

12.1 Overview ...........................................................................................................................................209

OTN — Introduction ...................................................................................................................................210

12.2 Overview ...........................................................................................................................................210

OTN trail management ..............................................................................................................................212

12.3 Workflow to manage OTN trails from NFM-P....................................................................................212

12.4 Manage OTN trails from NFM-P........................................................................................................213

Optical trail configuration procedures.....................................................................................................219

12.5 To configure an ODU trail ..................................................................................................................219

12.6 To discover services associated with ODU trails...............................................................................221

12.7 To configure path constraints for ODU trails......................................................................................221

12.8 To modify the protection and route of an ODU trail ...........................................................................223

12.9 To configure an ODUCTP..................................................................................................................225

12.10 To configure an OTU trail ..................................................................................................................226

12.11 To auto-discover an OTU trail............................................................................................................228

12.12 To discover client trails from an OTU trail..........................................................................................229

12.13 To configure an OCH trail ..................................................................................................................230

12.14 To auto-configure an OMS trail..........................................................................................................232

12.15 To view an OTS trail ..........................................................................................................................233

12.16 To discover optical trails ....................................................................................................................233

12.17 To view the optical channel usage.....................................................................................................234

13 1830 PSS OTH facility management.........................................................................................................235

13.1 Overview ...........................................................................................................................................235

OTH facility .................................................................................................................................................236

13.2 Overview ...........................................................................................................................................236

13.3 ODU facility types..............................................................................................................................238

ODUk cross-connections ..........................................................................................................................244

13.4 ODUk cross-connection ....................................................................................................................244

13.5 To configure ODUk cross-connects...................................................................................................244

13.6 To sub-structure ODUk timeslots.......................................................................................................245

Virtual OCH cross-connection ..................................................................................................................247

13.7 Virtual OCH cross-connections .........................................................................................................247

NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

8 Issue 2



ODUk protection groups ...........................................................................................................................248

13.8 Overview ...........................................................................................................................................248

13.9 To configure ingress path overhead monitoring ................................................................................249

13.10 To configure ODUk protection groups ...............................................................................................249

13.11 To configure 1:N ODUk protection groups.........................................................................................252

13.12 To configure protection switching ......................................................................................................254

Part VI: 1830 PSS service management .........................................................................................................257

14 1830 PSS VPLS management ...................................................................................................................259

14.1 Overview ...........................................................................................................................................259

VPLS management.....................................................................................................................................260

14.2 VPLS .................................................................................................................................................260

14.3 To configure a VPLS..........................................................................................................................261

14.4 VLAN ranges .....................................................................................................................................264

14.5 To configure an 1830 PSS connection profile ...................................................................................265

14.6 To configure VPLS VLAN range SAPs ..............................................................................................266

14.7 Split horizon group ............................................................................................................................267

14.8 To configure an SHG.........................................................................................................................267

14.9 To add ports to an SHG.....................................................................................................................268

14.10 E-Tree services .................................................................................................................................268

14.11 IGMP snooping..................................................................................................................................270

14.12 MAC move.........................................................................................................................................270

15 1830 PSS optical transport service management ...................................................................................273

15.1 Overview ...........................................................................................................................................273

Overview .....................................................................................................................................................276

15.2 General information...........................................................................................................................276

Optical protection ......................................................................................................................................278

15.3 Protection types and protection levels...............................................................................................278

15.4 Diverse route .....................................................................................................................................279

15.5 ESNCP..............................................................................................................................................279

15.6 OPS protection ..................................................................................................................................280

15.7 Y-cable protection..............................................................................................................................284

15.8 Client protection ................................................................................................................................287

NFM-P

Release 17.3
April 2017
Issue 2 93HE-12002-AAAA-TQZZA



Types of optical transport services ..........................................................................................................288

15.9 Dual-stage multiplexing .....................................................................................................................288

15.10 Regeneration services.......................................................................................................................288

15.11 CDC-F ROADM service ....................................................................................................................291

15.12 Symmetric and asymmetric interworking services ............................................................................292

15.13 Client/line ADM services....................................................................................................................293

15.14 ADM ring and linear configurations ...................................................................................................294

15.15 Multipoint services.............................................................................................................................296

Operations on optical transport services ................................................................................................298

15.16 Path search for optical transport services and trails..........................................................................298

15.17 Viewing optical services on NFM-P GUI............................................................................................299

15.18 Deleting optical transport services and trails.....................................................................................301

15.19 Administrative state transitions for service and trail ..........................................................................303

15.20 Administrative and operational states determined by NFM-P ...........................................................305

15.21 AINS parameters for ports and facility objects ..................................................................................309

Procedures to configure optical transport services ...............................................................................311

15.22 To configure an optical transport service ...........................................................................................311

15.23 To configure a multipoint transport service........................................................................................314

15.24 To discover optical transport services ...............................................................................................317

15.25 To unmanage an optical transport service.........................................................................................319

15.26 To remanage an unmanaged optical transport service .....................................................................319

15.27 To configure path constraints for a service........................................................................................320

15.28 To convert an unprotected service to an ESNCP service on a 4DPA4 FlexMux card .......................322

15.29 To convert an ESNCP service to an unprotected service on a 4DPA4 FlexMux card .......................323

15.30 To display services riding on external or internal optical links ...........................................................324

15.31 To view the service hops ...................................................................................................................325

Procedures to configure protected services...........................................................................................326

15.32 To configure an ESNCP protected service ........................................................................................326

15.33 To configure a Y-cable protected service...........................................................................................328

15.34 To configure a client-side OPS protected service..............................................................................330

15.35 To configure an OMSP protected service..........................................................................................331

15.36 To configure an OCHP protected service ..........................................................................................331

15.37 To configure an optical transport service with underlying cascaded OCHP and OMSP protected

trails...................................................................................................................................................332

15.38 To configure an OLP protected service .............................................................................................334

NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

10 Issue 2



15.39 To configure a client protected service on OCS devices ...................................................................334

15.40 To configure a client protected service with double add-drop ...........................................................336

15.41 To configure a diverse route protected service..................................................................................336

Procedures to configure service using 11DPM12, 11DPM8, and 11DPM4M cards ..............................339

15.42 To configure an unprotected service routing through an SNCN protected ODU trail on 11DPM12,

11DPM8, and 11DPM4M cards .........................................................................................................339

15.43 To extend a drop site on an unprotected multipoint service ..............................................................339

15.44 To configure an ODU timeslot assignment for 11DPM12 cards ........................................................340

15.45 To associate a line-side LO-ODUk on the 11DPM12 card ................................................................342

15.46 To configure OPTSG .........................................................................................................................343

15.47 To delete an ODUk XC on the 11DPM12 card ..................................................................................343

OTN layer management and service configuration using 112SDX11 card ...........................................345

15.48 112SDX11 card..................................................................................................................................345

15.49 To configure an OMSP protection service using 112SDX11..............................................................347

15.50 To view the OCH cross-connect group from the NE..........................................................................349

15.51 To view the OCH cross-connect group from the primary OCH trail ...................................................349

15.52 To bind and collapse HO-ODUk timeslots .........................................................................................350

Procedures to configure dual-stage muxing services ...........................................................................352

15.53 To configure dual-stage multiplexing services on an 1830 PSS for keyed and unkeyed services ....352

15.54 To configure CWDM and DWDM single fiber bidirectional service....................................................354

Procedures to configure APS groups ......................................................................................................356

15.55 To configure an APS group................................................................................................................356

15.56 To modify the protection switch for an APS group.............................................................................357

Procedures to configure services using LAGs .......................................................................................359

15.57 To configure 11DPE12A service using LAGs ....................................................................................359

Procedures to configure timeslots...........................................................................................................362

15.58 To configure a port-timeslot assignment on channelized cards.........................................................362

Procedures to configure VTS maps and XCs..........................................................................................363

15.59 To configure VTS maps on 11DPE12/E/A cards ...............................................................................363

15.60 To configure VTS XCs on 11DPE12/E/A cards .................................................................................364

16 1830 PSS mirror service management.....................................................................................................367

16.1 Overview ...........................................................................................................................................367

16.2 Mirror service management...............................................................................................................367

NFM-P

Release 17.3
April 2017
Issue 2 113HE-12002-AAAA-TQZZA



Part VII: 1830 PSS performance management ...............................................................................................369

17 1830 PSS performance management .......................................................................................................371

17.1 Overview ...........................................................................................................................................371

Performance monitoring ...........................................................................................................................373

17.2 Overview ...........................................................................................................................................373

17.3 Performance statistics .......................................................................................................................374

17.4 Workflow for performance statistics collection ..................................................................................376

1830 PSS statistics procedures................................................................................................................380

17.5 To configure an 1830 PSS WDM performance management policy .................................................380

17.6 To configure an 1830 PSS OCS performance management policy ..................................................381

17.7 To enable PMON configuration on an 1830 PSS OCS device ..........................................................382

17.8 To configure retention time for file-based statistics ...........................................................................382

17.9 To collect and display the statistics values ........................................................................................384

17.10 To clear the 1830 PSS bins on an EC card .......................................................................................385

17.11 To clear the 1830 PSS bins on a port................................................................................................386

Managing TCA profiles ..............................................................................................................................388

17.12 Overview ...........................................................................................................................................388

17.13 Workflow to manage TCA profiles .....................................................................................................388

Procedures to configure TCA profile .......................................................................................................390

17.14 To configure an card TCA profile .......................................................................................................390

17.15 To assign an Ethernet TCA profile to an Ethernet card port ..............................................................391

17.16 To assign an Ethernet TCA profile to an Ethernet card SAP .............................................................392

17.17 To assign TCA profiles to an EC card and other card ports ..............................................................392

17.18 To configure thresholds for NE and Card TCA profiles......................................................................393

17.19 To configure an OCS TCA profile ......................................................................................................394

17.20 To assign an OCS TCA profile...........................................................................................................395

17.21 To configure thresholds for an OCS TCA profile ...............................................................................397

PM data .......................................................................................................................................................398

17.22 Overview ...........................................................................................................................................398

17.23 To enable PM TCA alerts...................................................................................................................398

17.24 To clear PM counters of a TCA profile bin associated with a port or SAP on L2 card .......................399

Cards and ports that support PM data .....................................................................................................401

17.25 Overview ...........................................................................................................................................401

NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

12 Issue 2



Part VIII: 1830 PSS power management .........................................................................................................407

18 1830 PSS power management ..................................................................................................................409

18.1 Overview ...........................................................................................................................................409

Power management ...................................................................................................................................411

18.2 Power management settings .............................................................................................................411

Power chart.................................................................................................................................................415

18.3 Overview ...........................................................................................................................................415

18.4 To view optical power on ports ..........................................................................................................419

18.5 To display optical power levels along a service path.........................................................................421

Power adjustment - equipment.................................................................................................................424

18.6 Power adjustment..............................................................................................................................424

18.7 To configure power management type ..............................................................................................424

18.8 Automatic power adjustment-Equipment level ..................................................................................425

18.9 To perform an automatic power adjustment on an 1830 PSS...........................................................426

Power adjustment - service and trails......................................................................................................428

18.10 Service, OCH trail, and OTU trail - automatic power adjust ..............................................................428

18.11 To configure automatic power adjustment for a service, an OCH trail, or an OTU trail .....................429

18.12 Automatic power adjustment rules ....................................................................................................431

18.13 To configure automatic power adjustment rules for a service, an OCH trail, or an OTU trail ............431

Wavelength tracker and wave key ............................................................................................................433

18.14 Wavelength tracker and wave key.....................................................................................................433

18.15 Wave keys for the L-band, C-band, and S-band channels................................................................434

18.16 Rekey and reuse wave keys .............................................................................................................440

18.17 To rekey wave key values of a service, OCH trail, or OTU trail.........................................................442

18.18 To configure a rekey with duplicates allowed on an existing service or trail......................................443

Spectral grids for WDM devices ...............................................................................................................445

18.19 Introduction........................................................................................................................................445

18.20 Fixed and flexible grid .......................................................................................................................445

Target power offset ....................................................................................................................................447

18.21 Target power offset............................................................................................................................447

18.22 To configure target power offset per direction ...................................................................................447

18.23 To view and configure target power offset per channel .....................................................................448

OSNR...........................................................................................................................................................450

18.24 OSNR measurement .........................................................................................................................450

18.25 To configure an on-demand OSNR scan...........................................................................................450

NFM-P

Release 17.3
April 2017
Issue 2 133HE-12002-AAAA-TQZZA



OTDR ...........................................................................................................................................................452

18.26 OTDR ................................................................................................................................................452

18.27 To configure an OTDR scan ..............................................................................................................452

Technology types .......................................................................................................................................456

18.28 Overview ...........................................................................................................................................456

18.29 To create an unreserved technology type .........................................................................................456

18.30 To set the technology type on OCH cross-connects on the 1830 PSS .............................................457

Baseline ......................................................................................................................................................459

18.31 To configure baseline types OPT and OPR on ports.........................................................................459

Part IX: 1830 PSS fault management ..............................................................................................................461

19 1830 PSS fault management .....................................................................................................................463

19.1 Overview ...........................................................................................................................................463

Fault management .....................................................................................................................................464

19.2 Overview ...........................................................................................................................................464

RCA audit ....................................................................................................................................................465

19.3 Overview ...........................................................................................................................................465

19.4 To configure an RCA audit policy ......................................................................................................465

19.5 To perform an RCA audit of an optical link ........................................................................................466

Alarm management....................................................................................................................................468

19.6 Overview ...........................................................................................................................................468

19.7 To configure environmental alarms ...................................................................................................469

Alarm profile and severity — WDM devices ............................................................................................471

19.8 Alarm severity....................................................................................................................................471

19.9 To override an alarm severity at the NE level....................................................................................472

19.10 To override an alarm severity at the equipment level ........................................................................474

19.11 To override an alarm severity at the object level ...............................................................................476

Alarm profile and severity — OCS devices .............................................................................................479

19.12 Alarm severity assignment profiles....................................................................................................479

19.13 To configure an OCS alarm profile ....................................................................................................480

19.14 To assign an OCS alarm profile to objects ........................................................................................481

Alarm correlation .......................................................................................................................................483

19.15 Alarm correlation in 1830 PSS ..........................................................................................................483

NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

14 Issue 2



Part X: 1830 PSS policy management ............................................................................................................485

20 1830 PSS QoS policy .................................................................................................................................487

20.1 Overview ...........................................................................................................................................487

QoS policy management on the 1830 PSS ..............................................................................................488

20.2 Configuring QoS policies...................................................................................................................488

Procedures to configure 1830 PSS QoS local policies ..........................................................................490

20.3 To configure an 1830 PSS access ingress local policy .....................................................................490

20.4 To configure an 1830 PSS network local policy ................................................................................492

20.5 To configure an 1830 PSS port access egress local policy...............................................................493

20.6 To configure an 1830 PSS port scheduler local policy ......................................................................495

20.7 To configure an 1830 PSS network queue local policy .....................................................................495

20.8 To configure an 1830 PSS WRED slope local policy ........................................................................497

20.9 To associate a slope policy with a port ..............................................................................................498

21 1830 PSS ACL IP filter................................................................................................................................499

21.1 Overview ...........................................................................................................................................499

21.2 1830 PSS ACL IP filter .....................................................................................................................499

21.3 Workflow to configure 1830 PSS WDM ACL IP filtering ....................................................................500

21.4 To enable ACL configuration on an 1830 PSS ..................................................................................501

21.5 To create an 1830 PSS ACL IP pattern .............................................................................................501

21.6 To create an 1830 PSS ACL IP filter..................................................................................................502

21.7 To assign an ACL IP filter to a port ....................................................................................................503

21.8 To configure an 1830 PSS OCS ACL IP filter ....................................................................................504

Part XI: 1830 PSS network management ........................................................................................................507

22 1830 PSS Ethernet OAM ...........................................................................................................................509

22.1 Overview ...........................................................................................................................................509

Ethernet OAM .............................................................................................................................................511

22.2 Overview............................................................................................................................................511

Ethernet CFM tests ....................................................................................................................................512

22.3 Overview ...........................................................................................................................................512

22.4 Components of Ethernet CFM...........................................................................................................513

Ethernet CFM procedures .........................................................................................................................515

22.5 To configure Ethernet CFM ...............................................................................................................515

OAM diagnostic tests ................................................................................................................................519

22.6 Overview ...........................................................................................................................................519

NFM-P

Release 17.3
April 2017
Issue 2 153HE-12002-AAAA-TQZZA



OAM diagnostic test procedures..............................................................................................................521

22.7 To configure Ethernet OAM fault management mode .......................................................................521

22.8 To create and run an on-demand CFM loopback test .......................................................................522

22.9 To create and run an on-demand CFM link trace test .......................................................................523

22.10 To create and run an on-demand CFM one-way delay test ..............................................................524

22.11 To create and run an on-demand and proactive CFM two-way delay test ........................................525

22.12 To create and run an on-demand and proactive CFM two-way SLM test .........................................527

22.13 To create and run an on-demand CFM LM test.................................................................................528

Smart SFP-RMD..........................................................................................................................................530

22.14 Overview ...........................................................................................................................................530

Procedures to configure RMD ..................................................................................................................531

22.15 To manually configure an RMD on a card .........................................................................................531

22.16 To automatically configure an RMD on a card...................................................................................533

22.17 To reset the RMD ..............................................................................................................................534

22.18 To configure the RMD ports...............................................................................................................535

22.19 To configure Ethernet CFM for an RMD............................................................................................536

22.20 To configure TSoP device types........................................................................................................538

MAC swap ...................................................................................................................................................540

22.21 Port loopback ....................................................................................................................................540

22.22 To configure port loopback with MAC swap ......................................................................................540

23 1830 PSS IP routing ..................................................................................................................................543

23.1 Overview ...........................................................................................................................................543

Network interfaces and IP routing ............................................................................................................545

23.2 L3 network interfaces ........................................................................................................................545

23.3 To configure a network interface on an 1830 PSS WDM device.......................................................547

23.4 To configure a network interface on an 1830 PSS OCS device ........................................................549

23.5 Types of IP routing ............................................................................................................................551

OSPFv2 on WDM and OCS devices..........................................................................................................552

23.6 OSPF routing.....................................................................................................................................552

23.7 Workflow to configure an OSPFv2 routing ........................................................................................552

23.8 To configure a multi-area OSPFv2 for WDM devices........................................................................553

23.9 To configure a multi-area OSPFv2 for OCS devices .........................................................................554

23.10 To modify a multi-area OSPFv2 for WDM devices ............................................................................555

23.11 To modify a multi-area OSPFv2 for OCS devices .............................................................................556

23.12 To delete a multi-area OSPFv2 for WDM devices.............................................................................556

NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

16 Issue 2



23.13 To delete a multi-area OSPFv2 for OCS devices ..............................................................................557

23.14 To configure a OSPF interface for WDM devices..............................................................................557

23.15 To modify a OSPF interface for OCS devices ...................................................................................558

23.16 To configure an OSPFv2 area range for WDM devices ....................................................................558

23.17 To configure an OSPFv2 area range for OCS devices......................................................................559

IP static routing ..........................................................................................................................................560

23.18 Overview ...........................................................................................................................................560

23.19 To configure a static route .................................................................................................................560

24 1830 PSS service tunnels..........................................................................................................................563

24.1 Overview ...........................................................................................................................................563

Service tunnels...........................................................................................................................................564

24.2 Overview ...........................................................................................................................................564

24.3 Ethernet (G.8032) ring protection......................................................................................................564

Procedures for Ethernet ring configuration management .....................................................................567

24.4 To configure an Ethernet ring ............................................................................................................567

24.5 To configure interconnect for Ethernet sub-rings...............................................................................572

24.6 To configure an Ethernet ring element ..............................................................................................574

24.7 To configure an Ethernet ring element path ......................................................................................575

25 1830 PSS MC LAG group...........................................................................................................................577

25.1 Overview ...........................................................................................................................................577

25.2 MC LAG ............................................................................................................................................577

25.3 To configure an MC LAG...................................................................................................................578

25.4 To configure an MC LAG source on a card .......................................................................................580

25.5 To configure an MC LAG peer on the card........................................................................................581

A MIB entry name and TL1 command mapping..........................................................................................583

A.1 MIB entry name and TL1 command mapping ...................................................................................583

NFM-P

Release 17.3
April 2017
Issue 2 173HE-12002-AAAA-TQZZA



About this document

Purpose

This guide provides information about how to access NFM-P to configure and manage
the 1830 PSS network. NFM-P guides describe the GUI operations associated with each
function, and indicate whether the function is available, using the OSSI. See the NSP
NFM-P XML API Developer Guide for information about using the OSSI to perform
NFM-P function.

The guide is intended for optical network planners, administrators, and operators and is
to be used in conjunction with other guides in NFM-P documentation suite where
management of optical devices does not differ from other network elements. Procedures
that are unique to managing the 1830 PSS devices are included in this document and
make reference to configurable parameters described in the NSP NFM-P Optical
Parameter Reference.

The document describes the features, and configurations, for the 1830 PSS-32, 1830
PSS-16 and 1830 PSS-4, and the hardware components, devices, and networks. For
more information about the 1830 PSS devices, see the documents listed in the “1830
PSS reference documentation” (p. 19).

Overview

The guide contains the following parts:

1. Introduction—contains general 1830 PSS information such as features supported
and system overview

2. System management—contains information about user security, map management,
navigation tree, and CLI sessions

3. Device management—contains information about the 1830 PSS device discovery,
software upgrade and backup, equipment management tasks that can be performed
using NFM-P

4. SDH trails and services—contains information about SDH trails and services

5. OTN layer management—contains information about various OTN layers that can
be managed using NFM-P

6. Service management—contains information about the 1830 PSS devices managing
the optical transport services, VPLS and mirror services using NFM-P

7. Performance management—contains information about the 1830 PSS
performance monitoring tasks performed using NFM-P

8. Power management—contains power management information

9. Fault management—contains alarm and troubleshooting information

10. Policy management—contains information about configuring and applying NFM-P
policies that define rules for 1830 PSS management, or NFM-P operation
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11. Network management—contains information about the 1830 PSS network
functions

1830 PSS reference documentation

See the following documents for more information about the 1830 PSS devices:

• Nokia 1830 Photonic Service Switch 1 (PSS-1) GBEH Edge Device User Guide

• Nokia 1830 Photonic Service Switch 1 (PSS-1) MD4H Edge Device User Guide

• Nokia 1830 Photonic Service Switch (PSS-1) AHP Amplifier User Guide

• Nokia 1830 Photonic Service Switch 4 (PSS-4) User Guide

• Nokia 1830 Photonic Service Switch User Provisioning Guide

• Nokia 1830 Photonic Service Switch Product Information and Planning Guide

• Nokia 1830 Photonic Service Switch Maintenance and Trouble-Clearing Guide

• Nokia 1830 Photonic Service Switch 32/16 (PSS-32/PSS-16) Installation and System
Turn-Up Guide

• Nokia 1830 Photonic Service Switch (PSS) Safety Guide

• Nokia 1830 Photonic Service Switch (PSS) Command Line Interface Guide

• Nokia 1830 Photonic Service Switch (PSS) TL1 Commands and Messages Guide

• Nokia 1830 Photonic Service Switch (PSS) Engineering and Planning Tool User Guide

• Nokia 1830 Photonic Service Switch (PSS) Commissioning and Power Balancing Tool
User Guide

Document support

Customer documentation and product support URLs:

• Customer documentation welcome page

• Technical support

How to comment

Documentation feedback
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Part I: Introduction

Overview

Purpose

This part lists the new features and describes the WDM and OCS function of the 1830
Photonic Service Switch (PSS).

Contents

Chapter 1, What’s new? 23

Chapter 2, 1830 PSS overview 25
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1 What’s new?

1.1 Overview

1.1.1 Purpose

This chapter highlights new optical features for NFM-P Release 17.3 and provides
references to the specific feature content. Feature lists and high-level feature
descriptions are also available in the NSP NFM-P Release Description.

1.1.2 Contents

1.1 Overview 23

1.2 What’s new in NFM-P Release 17.3 for 1830 PSS 23

1.2 What’s new in NFM-P Release 17.3 for 1830 PSS

1.2.1 What’s new in NFM-P Release 17.3 for 1830 PSS

Table 1, “NFM-P Release 17.3 1830 PSS features” (p. 24), lists the features and
functions added in NFM-P Release 17.3 for 1830 PSS support. See the NSP NFM-P
User Guide for more information about non-1830 PSS features and functions.
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Table 1 NFM-P Release 17.3 1830 PSS features

Feature Description and Reference

SAM-88144 - Support for 1830
PSS Release 9.1 enhancements
for D5X500 card

Supports the following:
• configuration of the four functional variants of the D5X500 card
• read-only flexgrid parameters on the amplifier and IROADM cards
• configuration of CUSTLAN port, OTDRRX, and OTDRTX ports on the amplifier

cards
• configuration of 75 GHz spectral width during trail and service creation
• configuration of flexgrid channels during trail and service creation

9.20.4 “D5X500 card functional variants” (p. 133)

9.17.2 “Flexgrid parameters in amplifier cards” (p. 125)

9.17.3 “CUSTLAN Port” (p. 125)

9.17.4 “OTDRRX and OTDRTX Ports” (p. 126)

18.20.2 “Flexible grid” (p. 445)

18.20.3 “Flex grid channels” (p. 446)

15.22 “To configure an optical transport service” (p. 311)

15.23 “To configure a multipoint transport service” (p. 314)

12.5 “To configure an ODU trail” (p. 219)

12.10 “To configure an OTU trail” (p. 226)

12.13 “To configure an OCH trail” (p. 230)

SAM-97855 - QS-ANSSI -
32EC2E and 8EC2E

Supports the configuration of the 32EC2E and 8EC2E cards.

9.15 “32EC2E and 8EC2E cards” (p. 124)

SAM-102976 - S13X100 card
support

Supports the configuration of the S13X100 card.

9.20.5 “S13X100E card” (p. 134)
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2 1830 PSS overview

2.1 Overview

2.1.1 Purpose

This chapter provides an overview of the 1830 PSS OCS and WDM systems and a high-
level description of the IP-Optical management workflow.

2.1.2 Contents

2.1 Overview 25

2.2 1830 PSS OCS system overview 25

2.3 1830 PSS WDM system overview 26

2.4 IP-optical management workflow 29

2.2 1830 PSS OCS system overview

2.2.1 General information

The OCS component of the 1830 Photonic Service Switch provides OTH switching and
control functions using matrix cards.

NFM-P supports the 1830 PSS OCS product family of devices which includes:

• 1830 PSS-64

• 1830 PSS-36

See the current NSP NFM-P and 5620 SAM Network Element Compatibility Guide for
information about the 1830 PSS support in NFM-P release.

2.2.2 1830 PSS-64 and 1830 PSS-36 devices

The OCS component uses 1830 PSS-64 and 1830 PSS-36 devices. The 1830 PSS-36
is used for lower bandwidth requirements. The 1830 PSS-64 is used for higher
bandwidth requirements and switching. The devices handle interfaces of OTH, SDH,
SONET, and Ethernet. These devices support agnostic matrix cards which enable
switching of WDM and OCS traffic.

For more information about the hardware and capabilities that are supported by the
shelves, see the Nokia 1830 Photonic Service Switch Product Information and Planning
Guide.
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2.3 1830 PSS WDM system overview

2.3.1 General information

The 1830 Photonic Service Switch product family provides CWDM, DWDM, and OTN
capabilities. Photonic networking increases flexibility and operational automation.

NFM-P supports the 1830 PSS WDM product family of devices, which includes:

• 1830 PSS-32—central office device

• 1830 PSS-16—end office device

• 1830 PSS-16II—metro aggregation device

• 1830 PSS-8—metro aggregation device

• 1830 PSS-4—edge device platform

• 1830 PSS-1—edge aggregation devices that collect lower rate signals for input to the
1830 PSS network, which include:

— 1830 PSS-1 GBE edge device

— 1830 PSS-1 MD4H edge device

— 1830 PSS-1 AHP

See the current NSP NFM-P and 5620 SAM Network Element Compatibility Guide for
information about the 1830 PSS support in NFM-P release.

2.3.2 1830 PSS-32 central office device/1830 PSS-16 end office device

The 1830 PSS-32 and 1830 PSS-16 provide multi-service and multi-reach solutions. The
shelves are referred to collectively as the 1830 PSS-32/1830 PSS-16. They are scalable
optical transport platforms for regional and metropolitan network transport and services
delivery.
• The 1830 PSS-32 central office device provides a 32-slot platform for core, central

office applications.

• The 1830 PSS-16 end office device provides a 16-slot platform that can be used for
end office or smaller core office applications.

For information about the hardware and capabilities supported by the shelves, see the
Nokia 1830 Photonic Service Switch 32/16 Product Information and Planning Guide.

The 1830 PSS-32 network consists of standalone NE, or two or more interconnected
NEs that provide SDH/SONET/GigE aggregation and transport, 10G, FC (R1.1), or
transponderless wavelength services in a metropolitan or regional networking
environment.

The 1830 PSS-32 and 1830 PSS-16 support bidirectional transmission over a single
fiber. The devices can be configured to support applications using CWDM filters. Each
bidirectional transmission requires different CWDM wavelengths in each direction.
Bidirectional transmissions over a single fiber is supported with the following filters and
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OTs:

• SFC-2
• SFC-4
• SFC-8
• 4DPA4

• 11STAR1
• 11STAR1A
• 11STMM10
• 11DPE12(E)

See the Nokia 1830 Photonic Service Switch 36/32/16 Product Information and Planning
Guide and the Nokia 1830 Photonic Service Switch 36/32/16 (PSS-36/PSS-32/PSS-16)
User Provisioning Guide for more information.

2.3.3 1830 PSS-8 and 1830 PSS-16II metro aggregation devices

The 1830 PSS-8 and 1830 PSS-16II are metro aggregation WDM-OTN devices that
provide scalability and flexibility in the WDM and the OTN metropolitan networks.

The 1830 PSS-8 is a scalable, aggregation, access shelf for photonic and metro
transport applications. The 1830 PSS-8 is 3 RU high and has eight universal slots for
OT, OA, SFC, and SFD.The 1830 PSS-8 also includes the mandatory cards; the
redundant AC and DC Power Filter cards, Fan Unit with dust filter, redundant EC, Shelf
panel, and User panel. The User panel is not a mandatory card and can only be placed
in the protection EC slot of the master shelf.

The 1830 PSS-16II is an evolution of the 1830 PSS-16 device for photonic and multi-
service metro transport applications. The 1830 PSS-16II provides 1.6 T capacity in the 8
RU shelf for packet, OTN, and photonic switching for central office and data center. The
1830 PSS-16II has 22 slots and supports up to 8 full-height or 16 half-height universal
I/O cards.

The 1830 PSS-8 and 1830 PSS-16II shelves support the common set of cards and the
1830 PSS-16II device similar to a 2X 1830 PSS-8 device.

See the Nokia 1830 Photonic Service Switch 36/32/16/8 Product Information and
Planning Guide and the Nokia 1830 Photonic Service Switch 36/32/16 (PSS-36/PSS-32
/PSS-16/8) User Provisioning Guide for more information.

2.3.4 1830 PSS-4 edge device platform

The 1830 PSS-4 edge device platform is designed for installation near the edge of the
metropolitan networks. The edge device platform provides a flexible, power saving,
OTN-based solution for metropolitan and access applications. The target application
provides OTN-based multiple service aggregation for CWDM and DWDM networks. The
application can also be configured to provide an FOADM terminal, and in-line amplifier
solution for the 1830 PSS-32 networks. The platform supports non-switched and
electrical switched configurations, and ensures full interworking and compatibility with
other 1830 PSS product platforms.
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The 1830 PSS-4 supports bidirectional transmission over a single fiber. See the Nokia
1830 Photonic Service Switch 36/32/16 Product Information and Planning Guide and the
Nokia 1830 Photonic Service Switch 36/32/16 (PSS-36/PSS-32/PSS-16) User
Provisioning Guide for more information.

See the Nokia 1830 Photonic Service Switch 4 (PSS-4) User Guide for more information.

2.3.5 1830 PSS-1 GBE edge device

The 1830 PSS-1 GBE edge device is a 1-RU device for installation in 19-in., ANSI, or
ETSI racks. The device is based on a 12xGBE optical transponder that supports optional
CWDM filters.

The device provides an optimized WDM access platform that includes the following
features:

• 1-RU height

• dc power (ac power adapter available)

• standard or temperature-hardened versions

— standard 1830 PSS-1 GBE

— hardened 1830 PSS-1 GBEH

• Black & White (B&W), CWDM, or DWDM optics

• in-band management using GCC

• stackable as a single NE

• alignment with the 1830 PSS service cards and operations

• support for single-fiber bidirectional transmission

See the 1830 Photonic Service Switch 1 (PSS-1) GBEH Edge Device User Guide for
more information.

2.3.6 1830 PSS-1 MD4H edge device

The 1830 PSS-1 MD4H edge device is a 1-RU device for installation in 19-in., ANSI, or
ETSI racks. The MD4H designation represents the device as a multiservice dual module
unit with 4 client ports per module, which is temperature hardened. The device is based
on two 1830 PSS-32 4DPA4 optical transponders, which are remapped into an external
device that also supports optional CWDM filters.

The device provides an optimized WDM access platform that includes the following
features:

• 1-RU height

• dc power (ac power adapter available)

• standard or temperature-hardened versions

• Black & White (B&W), CWDM, or DWDM optics

• in-band management using GCC

1830 PSS WDM system overview NFM-P
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• alignment with the 1830 PSS service cards and operations

• support for single-fiber bidirectional transmission

See the Nokia 1830 Photonic Service Switch 1 (PSS-1) MD4H Edge Device User Guide
for more information.

2.3.7 1830 PSS-1 AHP

The 1830 PSS-1 AHP is a 1-RU edge device that supports an adapted amplifier. Two
devices can be used to provide a low-cost ILA for the 1830 PSS.

The 1830 PSS-1 AHP software provides the following enhanced capabilities:

• multi-shelf NE management

• IP routing (OSPF) over OSC links

• wave key assignment distribution over OSPF LSAs

• automatic/manual power management between devices

• keyed-unkeyed DWDM OCH XC provisioning and OCH trail management

• DCM shelf/card/port management

See the Nokia 1830 Photonic Service Switch 1 (PSS-1) AHP Amplifier User Guide for
more information.

Before you can use NFM-P to manage one or more 1830 PSS devices, the required
1830 PSS modules and quantities must be included in NFM-P software license. See “
Software and license configuration procedures” in the NSP NFM-P System Administrator
Guide for information about viewing and updating the license information.

2.4 IP-optical management workflow

2.4.1 Workflow

The following workflow describes the sequence of high-level tasks that are required to
deploy the 1830 PSS and use NFM-P for 1830 PSS management.

NFM-P works in parallel to the planning and commissioning functions which are
performed by the EPT and CPB tools. There is no interaction between NFM-P and the
EPT and CPB tools.
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2.4.2 Stages

EPT

1

Plan the 1830 PSS deployment using the Engineering Planning Tool by considering,
for example:

• network parameters

• sites

• fiber connectivity

• traffic patterns

• run automatic design synthesis

• create reports

• divide the network into downloadable systems for automatic commissioning

• create the commissioning files

See the Nokia 1830 PSS Engineering and Planning Tool User Guide for more
information.

Commissioning

2

Commission the 1830 PSS devices using the Commissioning and Power Balancing
Tool by considering, for example:

• Provision the system

• Commission the Greenfield system

• Power-balance the system

• Create system and network element loss report

See the Nokia 1830 PSS Commissioning and Power Balancing Tool User Guide for
more information.

NFM-P network management

3

Configure and manage the 1830 PSS device using NFM-P.

1. Use NFM-P to discover the commissioned 1830 PSS devices; see Chapter 7,
“1830 PSS discovery” .
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2. Configure SSH2 security for CLI sessions, if required; see Chapter 6, “1830 PSS
CLI sessions” .

3.View, manage, and configure the discovered 1830 PSS device network objects:

• device objects; see Chapter 8, “1830 PSS backup and upgrade”

• shelf, card, port, and LAG objects; see Chapter 9, “1830 PSS equipment
management”

• equipment view on a specified browser; see Chapter 10, “NFM-P application
— Equipment view”

• power levels; see Chapter 18, “1830 PSS power management”

4.Configure NFM-P policies that specify the conditions for NFM-P management
functions including:

• QoS policy; see Chapter 20, “1830 PSS QoS policy”

• ACL IP filter; see Chapter 21, “1830 PSS ACL IP filter”

5. View, manage, and configure the OTN layers on 1830 PSS. See Chapter 12,
“1830 PSS optical trail management”

6.View, manage, and configure the network functions, as required:

• routing and forwarding; see Chapter 23, “1830 PSS IP routing ”

• service tunnels; see Chapter 24, “1830 PSS service tunnels”

7.View, manage, and configure the SDH trails and services, as required:

• SDH trails and services; see Chapter 11, “SDH trails and services”

8.View, manage, and configure the services and related functions:

• optical transport services; see Chapter 15, “1830 PSS optical transport service
management”

• VPLS services; see Chapter 14, “1830 PSS VPLS management”

• mirror services; see Chapter 16, “1830 PSS mirror service management”

9. Collect NFM-P and 1830 PSS statistics see Chapter 17, “1830 PSS performance
management” and the NSP NFM-P Statistics Management Guide.
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Part II: 1830 PSS system management

Overview

Purpose

This part provides information about:

• user security

• map management

• equipment navigation tree

• CLI sessions

Contents

Chapter 3, 1830 PSS user security 35

Chapter 4, 1830 PSS map management 37

Chapter 5, 1830 PSS equipment navigation tree 45

Chapter 6, 1830 PSS CLI sessions 49
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3 1830 PSS user security

3.1 Overview

3.1.1 Purpose

This chapter describes NFM-P management of the security functions.

3.1.2 Contents

3.1 Overview 35

3.2 User security overview 35

3.2 User security overview

3.2.1 Introduction

NFM-P provides security functions for user groups, devices, and paths.

Note: The administrator can restrict the access of some operators to equipment and
services in their domain, for example, transport or data.

3.2.2 NFM-P user and user group security

You can use NFM-P to configure user accounts, user groups, and spans of control,
which define NFM-P objects the users can view and manage. For more information
about user security, see “ NFM-P user security” in the NSP NFM-P System Administrator
Guide.

3.2.3 Span of control

The span of control allows you to assign access permissions to a functional group of
NFM-P server objects; for example, a group of NEs or services.

You can use NFM-P to create a span of control, or to copy an existing span of control
and modify the list of associated objects to create a span of control. The objects that are
in a span of control, or that can be added to a span of control, are called span objects.
NFM-P has several pre-defined spans of control. Each new NFM-P object, for example,
a discovered NE, is added to the corresponding pre-defined span of control. Optical
objects, such as the wavelength service on the 1830 PSS, are added to the Default
Transport Span.
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For more information about the span of control, see “ User account and group
management” in the NSP NFM-P System Administrator Guide.

You can filter the objects the map or the list displays, based on the user span of control.
By default, the GUI displays only the objects that are in the View Access and Edit Access
spans of control of the user.

Table 2 User security references

Topics Chapter Document

User account and group management NFM-P user security tasks NSP NFM-P System Administrator Guide

User activity logging NFM-P user security tasks NSP NFM-P System Administrator Guide

Sample span rule configuration NFM-P user security tasks NSP NFM-P System Administrator Guide

Sample NFM-P user authentication
configuration

NFM-P user security tasks NSP NFM-P System Administrator Guide

Remote authentication and authorization NFM-P user security tasks NSP NFM-P System Administrator Guide

NFM-P user security procedures NFM-P user security tasks NSP NFM-P System Administrator Guide
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4 1830 PSS map management

4.1 Overview

4.1.1 Purpose

This chapter describes the network topology and grouping in NFM-P that apply to the
1830 PSS.

4.1.2 Contents

4.1 Overview 37

4.2 Topology maps 37

4.3 To view a service topology map 40

4.4 To view optical interconnections only 40

4.5 To view IP interconnections only 42

4.2 Topology maps

4.2.1 Network topology maps

NFM-P uses map windows to represent network objects and paths. For the 1830 PSS,
NFM-P supports physical network topology maps. Each map displays network objects
and information, and provides contextual menus to open forms that display additional
information. See “ Topology maps” in the NSP NFM-P User Guide for more information
about network topology.

4.2.2 Service topology map

A service topology map can be viewed from the service properties form. See 4.3 “To
view a service topology map” (p. 40) . If you move an NE in the service topology map
view, the associated ports are also moved with the NE. To view the optical link properties
from the topology map, double-click on the optical link. The Optical Link form opens.

Note: The optical link properties are displayed on the topology map only for external
optical links.

The active path (working path or protected path) of a service or trail is highlighted in
green and the standby path in blue in the Topology view, when the service or trail is
operationally up. For a protected service, when the working and protection ports of an
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APS group are switched, using the Protection Switch parameter, the colors of the active
path and standby path also changes. If the service or trail is operationally down, then
both active and standby paths are highlighted in red in the topology view.

4.2.3 Physical topology map

When NFM-P client GUI starts, the physical topology map is open in the working panel
by default. The default view displays the interconnections between IP and optical
devices. NFM-P allows you to filter the view to display only optical interconnections or IP
interconnections. See 4.4 “To view optical interconnections only” (p. 40) and 4.5 “To
view IP interconnections only” (p. 42) .

Table 3 NFM-P topology map management references

Topics Chapter Document

NFM-P topology map management
overview

NFM-P topology map management NSP NFM-P User Guide

NFM-P topology map types NFM-P topology map management NSP NFM-P User Guide

Basic NFM-P topology map procedures NFM-P topology map management NSP NFM-P User Guide

NFM-P topology map management
procedures

NFM-P topology map management NSP NFM-P User Guide

Contextual menus on the physical topology map

When you right-click on an 1830 PSS device, compound node, optical link, or optical link
group, the contextual menu for the specified object opens.

Table 4 1830 PSS specific contextual menus on physical topology map

Contextual menu option Objects Description

Show Internal Optical Links
1830 PSS device

Opens the Internal Optical Links form for the
specific device.
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Table 4 1830 PSS specific contextual menus on physical topology map (continued)

Contextual menu option Objects Description

Show Services 1830 PSS device Opens the Transport Services — NE form with
a list of optical transport services or multipoint
transport services configured on the specific
device.

Compound node Opens the Transport Services — NE form with
a list of optical transport services or multipoint
transport services configured on any of the
WDM or the OCS devices within the
compound node.

Optical link or Optical link group
containing a single optical link

Opens the Optical Link (Edit) form with the
Optical Transport Services tab displaying the
list of optical transport services that are
configured on the optical link.

Optical link group Opens the Transport Services — Optical Link
Group form with a list of optical transport
services configured on any of the optical links
in the group.

• For more information about viewing optical transport services or multipoint
transport services, see 15.17 “Viewing optical services on NFM-P GUI” (p. 299).

• When you select multiple optical links and choose Show Service→Optical
Transport Services or Show Trails, the services or trails that run on any of the
links are displayed in the Transport Services form.

Show Trails 1830 PSS device

Optical link

Optical link group

Opens the Manage OTN Trails form with a list
of ODU, Unterm ODU, OTU, OCH, OMS,
OTS, or STM trails, depending on the option
selected.

Discover Transport Services 1830 PSS device

Compound node

Opens the Manage Services form.

Create Transport Service 1830 PSS device Opens the Optical Transport Service (Create)
form.

Create ODU Trail 1830 PSS device Opens the ODU Trail (Create) form.

Expand All Optical Links 1830 PSS device

Compound node

Optical link group

Expands all the optical links on the map.

Show Alarms 1830 PSS device Opens NFM-P — Fault Management
application with the alarm list of the
corresponding 1830 PSS device.

Collapse All Optical Links Optical link Binds all the expanded optical links on the
map.
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Table 4 1830 PSS specific contextual menus on physical topology map (continued)

Contextual menu option Objects Description

Show Alarms 1830 PSS device Opens NFM-P — Fault Management
application with the alarm list of the
corresponding 1830 PSS device.

Note: The contextual menus for the 1830 PSS device and the optical links are also
available on the Manage Equipment form when you select Network Element and Optical
Link from the object drop-down menu.

4.3 To view a service topology map

4.3.1 Steps

1

Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form opens.

2

Choose Optical Transport Service from the object drop-down menu. The list of
optical transport services appears.

3

Choose an entry and click Properties. The Optical Transport Service (Edit) form
opens.

4

Click Topology View. The service topology map appears.

END OF STEPS

4.4 To view optical interconnections only

4.4.1 Steps

1

Open a physical topology map.

2

Click on the Filter icon. The Topology Filter - Physical Topology form opens.
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3

Choose Optical Link from the Object Filters to Add drop-down menu.

4

Click on the Add object filter icon. The Optical Link Filter panel appears.

5

Choose Endpoint A Type from the Attribute drop-down menu.

6

Choose EQUALS from the Function drop-down menu.

7

Choose Port from the Value drop-down menu.

8

Click on the Add to Filter icon.

9

Choose AND from the Operators drop-down menu. Repeat Step 5 to Step 8 to add
Endpoint B Type.

10

Click Save. The Save Filter dialog box appears.

11

Enter a Filter Name and Description and click Save.

12

Choose Network Element from the Object Filters to Add drop-down menu.

13

Click on the Add object filter icon. The Network Element Filter panel appears.

14

Choose Chassis Type from the Attribute drop-down menu.

15

Choose EQUALS from the Function drop-down menu.
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16

Choose the required 1830 PSS chassis from the Value drop-down menu.

17

Click on the Add to Filter icon. The Chassis Type appears on the Filter panel.

18

Choose AND from the Operators drop-down menu. Repeat Step 12 to Step 17 to
add the different 1830 PSS chassis types.

19

Click Save, the Save Filter dialog box appears.

20

Enter a Filter Name and Description and click Save. The filter is saved.

21

Click Apply to apply the Optical Link filter. The Topology Filter - Physical Topology
form closes and the map view is refreshed to display only devices with optical
interconnections.

END OF STEPS

4.5 To view IP interconnections only

4.5.1 Steps

1

Open a physical topology map.

2

Click on the Filter icon. The Topology Filter - Physical Topology form opens.

3

Choose Physical Link from the Object Filters to Add drop-down menu.

4

Click on the Add object filter icon. The Physical Link Filter panel appears.

5

Choose Chassis Type from the Attribute drop-down menu.
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6

Choose NOT EQUAL from the Function drop-down menu.

7

Choose the required 1830 PSS chassis from the Value drop-down menu.

8

Click on the Add to Filter icon. The 1830 PSS chassis appears on the Filter panel.

9

Choose OR from the Operators drop-down menu to add other 1830 PSS chassis
types. Repeat Step 5 to Step 7 . The 1830 PSS chassis appears on the Filter
panel.

10

Click Save, the Save Filter dialog box appears.

11

Enter a Filter Name and Description and click Save. The filter is saved.

12

Click Apply to apply the Physical Link filter. The Topology Filter - Physical Topology
form closes and the map view is refreshed to display only devices with IP
interconnections.

END OF STEPS
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5 1830 PSS equipment navigation tree

5.1 Overview

5.1.1 Purpose

This chapter describes the equipment navigation tree functions.

5.1.2 Contents

5.1 Overview 45

5.2 Equipment navigation tree 45

5.3 To start the 1830 PSS external EMS browser in normal mode 46

5.4 To start the 1830 PSS external EMS browser in secure mode 46

5.2 Equipment navigation tree

5.2.1 Overview

The view selector in NFM-P navigation tree is a drop-down menu that lists the physical
and logical network views. You can use the contextual menu for an object in the
navigation tree to create, configure, and manage specific parameters for the object and
child objects.

5.2.2 Using the 1830 PSS external element manager

You can start the 1830 PSS external element manager, ZIC interface, from NFM-P GUI.
The ZIC interface provides WebUI to access the 1830 PSS. The WebUI supports
provisioning, administration, performance monitoring, and displaying alarms and
conditions from the NE. For more information about using the WebUI with the 1830 PSS,
see the Nokia 1830 Photonic Service Switch 36/32/16 (PSS-36/PSS-32/PSS-16) User
Provisioning Guide. 5.3 “To start the 1830 PSS external EMS browser in normal mode”
(p. 46) describes how to start the 1830 PSS external element manager from NFM-P GUI
in the normal mode. 5.4 “To start the 1830 PSS external EMS browser in secure mode”
(p. 46) describes how to start the 1830 PSS external element manager from NFM-P GUI
in the secure mode.
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5.3 To start the 1830 PSS external EMS browser in normal
mode

5.3.1 Steps

Note: The 1830 PSS external EMS browser is supported on the latest release of Firefox,
IE, Chrome, and Safari.

1

Choose Equipment from the navigation tree view selector. The navigation tree
displays the Equipment view.

2

Right-click on an 1830 PSS device object and choose Launch External EMS
Browser. The WebUI main view screen appears in the normal mode (http).

END OF STEPS

5.4 To start the 1830 PSS external EMS browser in secure
mode

5.4.1 Steps

Note: This procedure requires actions to be performed both in the WebUI and NFM-P
GUI.

From the WebUI

1

Start the 1830 PSS external EMS bowser in the normal mode. See 5.3 “To start the
1830 PSS external EMS browser in normal mode” (p. 46) . The WebUI main view
screen appears.

2

Connect to the 1830 PSS device using admin credentials. The WebUI opens with
the System Properties form displayed.

3

Choose Administration→Security→Encryption→SSH Key. The SSH KEY form
opens.
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4

Click Generate and click OK. The SSH key is generated.

5

Click Close. The SSH KEY form closes and the System Properties form reappears.

6

Configure the UI Mode parameter as Encrypted and click Submit.

7

Click OK. The 1830 PSS device reboots.

8

Connect to the 1830 PSS device using admin credentials. The WebUI opens with
the System Properties form displayed and the UI Mode parameter set to Encrypted.

9

Choose Administration→Security→SNMP v3 Users. The SNMP v3 Users form
opens.

10

Click Create. The Create SNMP v3 Users form opens.

11

Configure the required parameters and click Apply.

From NFM-P

12

Create an SNMPv3 user account. See 7.6 “To configure a user account on an 1830
PSS device” (p. 63) .

Note: Provide the same user name and password that was provided during the
SNMPv3 user creation using the WebUI.

13

Create a new SNMP mediation security policy using the SNMPv3 user created in
Step 12 . See Procedure “To configure NE mediation” in the NSP NFM-P User
Guide for more information about configuring a SNMP mediation security policy.
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14

Create a discovery rule using the new SNMP mediation security policy created in
Step 13 . See Procedure “To configure a discovery rule” in the NSP NFM-P User
Guide for more information about configuring a discovery rule.

15

Right-click on the discovered 1830 PSS device in the Equipment view and choose
Launch External EMS Browser. The WebUI main view screen appears in the secure
mode (https).

Note: The 1830 PSS external EMS browser is supported on the latest release
of Firefox, IE, Chrome, and Safari.

END OF STEPS
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6 1830 PSS CLI sessions

6.1 Overview

6.1.1 Purpose

This chapter provides a description of NFM-P CLI access to the managed 1830 PSS
devices.

6.1.2 Contents

6.1 Overview 49

6.2 CLI access 49

6.3 To create, run and schedule an 1830 PSS CLI script 49

6.2 CLI access

6.2.1 Introduction

You can perform most NE management functions using NFM-P client GUI. The functions
that require CLI access to a managed NE include:

• validating GUI configuration actions

• configuring items that cannot be configured using the GUI; for example, creating a
community on the NE

• troubleshooting using device debug files

NFM-P client GUI provides CLI access to the managed NEs from the main menu, and
from NE contextual menus in topology maps and navigation trees. See the chapter
Device CLI sessions of the NSP NFM-P User Guide and the 1830 Photonic Service
Switch (PSS-1) Command Line Interface Guide for more information.

6.3 To create, run and schedule an 1830 PSS CLI script

6.3.1 Before you begin

Before you perform the following procedure, you must change the CLI user name and
password in the mediation policy. See the “To configure device mediation” procedure in
the NSP NFM-P User Guide for information about configuring a mediation policy.
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Attention: Scripts that are not correctly created or applied can cause serious damage to
the network. Nokia recommends that the system administrators clearly define user
responsibilities for CLI script usage, and ensure that the scripts are verified and validated
before they are run on devices in a live network.

Table 5 Device CLI session references

Topics Chapter Document

Device CLI sessions overview Device CLI sessions NSP NFM-P User Guide

To configure NFM-P CLI console
preferences

Device CLI sessions NSP NFM-P User Guide

To open and close NFM-P device CLI
session

Device CLI sessions NSP NFM-P User Guide

All topics All chapters 1830 Photonic Service Switch
(PSS-1) Command Line Interface
Guide

6.3.2 Steps

1

Choose Tools→Scripts from NFM-P main menu. The Scripts form opens.

2

Choose CLI Script (Scripting) from the object drop-down menu and click Create. The
CLI Script (Create) form opens.

3

Configure the required parameters.

Enable the Use Latest Version parameter to associate all of the targets of the script
with the latest version of the CLI script.

You can set the Content Type parameter to one of the following:

• CLI

• Velocity

Note: If you choose Velocity, you can import a script by clicking on the Import
button in the right panel of the Script Manager form.

4

Click the Add icon to add the NE types and click Apply.

To create, run and schedule an 1830 PSS CLI script NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

50 Issue 2



5

Click on the Versions tab and click Create to create a script. The Script Editor script_
name form opens

6

Create a version for a set of commands that must be run on the 1830 PSS. The
following commands can be created:

• show version—displays the device software release information

• show xc brief —lists the cross-connects on the NE

• whoami—lists the user logged in to the NE

7

Click on the Targets tab and click Create. The Target Configuration form opens.

8

Click on the Add icon to add the target on which the created script must be run. The
Select Network Elements form opens.

9

Choose the target and click OK. The specific target appears on the Target
Configuration form.

10

Click OK. The target is created and the CLI Script (Edit) form opens.

11

Perform one of the following in the right panel to run the script:

a. Click Execute to execute the script. Go to Step 13 .

b. Click Schedule. The Script Scheduled Task (Create) form opens.

12

Schedule a script:

1. Configure the required parameters.

2. From the Schedule panel, click Select. The Select Schedule - Script Scheduled
Task form opens.

3. Click Create. The NFM-P Schedule (Create) form opens.

4. Configure the required parameters in the Information, Time Settings, Schedule
Settings, and Frequency Settings panel.

5. Click OK. The Select Schedule - Script Scheduled Task form opens.
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6. Choose the schedule task and click Properties. The Script Scheduled Task
(Create) form opens.

7. Click Apply. The schedule is created and runs at the scheduled time.

8. After the schedule is created, the Schedule tab appears on the CLI Script (Edit)
form, which displays the schedule information.

13

Click Show Results to view the results of the executed script or the scheduled script.

Note: The Schedule column displays the executed script as N/A. The
scheduled script displays information about the Schedule manager and the
script.

14

Close the forms.

END OF STEPS
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Part III: 1830 PSS device management

Overview

Purpose

This part provides information about the 1830 PSS discovery, backup, upgrade,
equipment management and optical applications.

Contents

Chapter 7, 1830 PSS discovery 55

Chapter 8, 1830 PSS backup and upgrade 73

Chapter 9, 1830 PSS equipment management 105

Chapter 10, NFM-P application — Equipment view 187
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7 1830 PSS discovery

7.1 Overview

7.1.1 Purpose

This chapter provides information about the 1830 PSS discovery from NFM-P.

7.1.2 Contents

7.1 Overview 55

7.2 WDM and OCS device discovery 55

7.3 Workflow to discover 1830 PSS devices 59

7.4 Switching modes between SONET and SDH 61

7.5 To configure SNMPv3 on an 1830 PSS devices from the WebUI 61

7.6 To configure a user account on an 1830 PSS device 63

7.7 To distribute a user account to 1830 PSS devices 64

7.8 To delete an 1830 PSS user configuration 66

7.9 To identify differences between a global and local 1830 PSS user or two
local 1830 PSS users

67

7.10 To configure NE mediation 68

7.11 To configure a discovery rule 70

7.2 WDM and OCS device discovery

7.2.1 Overview

NFM-P discovers the 1830 PSS devices and reconciles the properties with the contents
of NFM-P database.

7.2.2 In-band and out-of-band management of 1830 PSS devices

The 1830 PSS devices are configured as either gateway NEs (GNEs) or remote NEs
(RNEs) in an 1830 PSS management network. The GNE provides access to all of the
RNEs in the network through DCN. The GNEs are connected to the out-of-band DCN
using the OAMP LAN port. Only the GNEs are directly connected to NFM-P through
DCN. See the 1830 PSS Installation and System Turn-Up Guide for more information
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about configuring an 1830 PSS device as a GNE and configuring the IP route
information to allow connection to RNEs.

The WDM RNEs have in-band OSC connectivity to one or more GNEs. The OCS RNEs
have in-band GCC connectivity to one or more GNEs. See the 1830 PSS DCN Planning
and Engineering Guide for more information about DCN, GNE, and RNE configuration.

Figure 1 In-band and out-of-band management
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GNE management using NFM-P

A GNE has two IP addresses — OAMP (management) IP address and the loopback
(system) IP address. The GNE communicates with NFM-P using the OAMP IP address
and with the RNEs using the loopback IP address. First, configure the SNMP source
parameter of the GNE as Any IP interface in the WebUI. Then, discover the GNE from
NFM-P using the OAMP (management) IP address in the discovery rule. After the device
discovery, the Network Element (Edit) form→Polling→Management tab displays the
Management IP address in the Out Of Band panel and the System IP address in the In
Band panel. Next, set the Management IP Selection parameter in the Management
Preference panel of the Network Element (Edit) form→Polling→Management tab to Out
of Band Preferred.

When the OAMP (management) IP address is not reachable due to a failure, NFM-P
automatically switches to the loopback (system) IP address and restores the
connectivity. The automatic switching from out-of-band to in-band and from in-band to
out-of-band occurs when two or more GNEs are configured in the network.

Note: NFM-P does not support automatic switching from out-of-band to in-band and
from in-band to out-of-band for OCS devices.

If you need to access a GNE using the loopback IP address, configure the SNMP source
parameter of the GNE as Loopback IP only in the WebUI. Next, discover the GNE from
NFM-P using the loopback IP address in the discovery rule. NFM-P does not support
automatic switching from in-band to out-of-band and from out-of-band to in-band in this
case.

RNE management using NFM-P

An RNE has two IP addresses — OAMP (management) IP address and the loopback
(system) IP address. RNEs communicate with NFM-P through GNE connected to DCN
using the loopback IP address. First, configure the SNMP source parameter of the RNE
as Loopback IP only in the WebUI. Then, discover the RNE from NFM-P using the
loopback IP address in the discovery rule. After the device discovery, the Network
Element (Edit) form→Polling→Management tab displays the Management IP Address
and System IP Address in the Out Of Band and In Band panels respectively with same
values.

7.2.3 WDM device discovery

The 1830 PSS WDM device must be commissioned and preconfigured before NFM-P
can manage the device. When the preconfiguration is complete, NFM-P can discover the
device. NFM-P discovers the WDM devices using SNMP and FTP.
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Discovery using SNMP

The WDM devices support the following SNMP functions:
• provisioning interface for equipment and parameters using SNMP v2c and v3

• alarm and trap reporting

• trap destination definition

To configure SNMP users using the WebUI, see 7.5 “To configure SNMPv3 on an 1830
PSS devices from the WebUI” (p. 61). For information about the 1830 PSS SNMP
support, see the 1830 Photonic Service Switch 36/32/16 Product Information and
Planning Guide and the 1830 Photonic Service Switch 36/32/16 User Provisioning
Guide.

File-based FTP discovery

For a large NE system with a high volume of configuration data, the file-based FTP
discovery of the 1830 PSS devices is preferred to discovery using SNMP. NFM-P
triggers the bulk data transfer and the 1830 PSS devices collect the configuration and
status data from the database and other software components. The data files are then
transferred using FTP. See 7.10 “To configure NE mediation” (p. 68) for more
information about configuring the FTP parameters during the NE mediation
configuration.

Note: NFM-P supports the file-based FTP only on the 1830 PSS-8, 1830 PSS-16, and
1830 PSS-32 devices.

Attention: The file-based synchronization is triggered at full node resync and node
discovery, only if the FTP Resync Admin State parameter in the General tab of the
Mediation (Edit) form is set to Up and the parameters are configured in the FTP panel of
the Mediation Policy (Create) form. See 7.10 “To configure NE mediation” (p. 68) for
more information about configuring the FTP parameters during the NE mediation
configuration.

7.2.4 OCS device discovery

NFM-P discovers the OCS devices using TL1. The 1830 PSS OCS device must be pre-
provisioned before it can be managed by NFM-P. When the pre-provisioning is complete,
NFM-P can discover the device. See the Nokia 1830 PSS-64 Installation and System
Turn-up Guide for more information about pre-provisioning the device.

Note: Ensure that you configure the User Label parameter on the Properties→General
form of the WebUI, when you perform the initial system parameter setting during pre-
provisioning. NFM-P does not discover the OCS devices if the User Label parameter
has an empty string.
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7.2.5 Manage and unmanage devices

You can manage or unmanage an NE. Unmanaged NEs are displayed on the topology
map of NFM-P GUI as an unmanaged NE icon.

Note: If you unmanage an NE, all associated optical transport services are unmanaged.
If the service is rediscovered, the name of the service reverts to the default name.

7.3 Workflow to discover 1830 PSS devices

7.3.1 Workflow

The following workflow describes the sequence of high-level tasks required to discover
1830 PSS devices with NFM-P.

Figure 2 1830 PSS device discovery workflow
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Before you discover the 1830 PSS devices, ensure that the 1830 PSS OCS device is
pre-provisioned. See the Nokia1830 PSS-64 Installation and System Turn-up Guide for
more information about pre-provisioning the device.

Note: Ensure that you configure the User Label parameter on the Properties→General
form of the WebUI, when you perform the initial system parameter setting during pre-
provisioning. NFM-P does not discover the OCS devices if the User Label parameter
has an empty string.

7.3.2 Stages

From the WebUI

1

If required, configure SNMPv3 on the 1830 PSS WDM device from the WebUI. See
7.5 “To configure SNMPv3 on an 1830 PSS devices from the WebUI” (p. 61) .

From NFM-P

2

Configure a user account as SNMPv2 (console) or SNMPv3 for 1830 PSS WDM or
TL1 for an OCS device. See 7.6 “To configure a user account on an 1830 PSS
device” (p. 63) .

3

Distribute the user to specific 1830 PSS devices. See 7.7 “To distribute a user
account to 1830 PSS devices” (p. 64) .

1. If required, delete the user configuration. See 7.8 “To delete an 1830 PSS user
configuration” (p. 66) .

2. If required, identify the differences between local and global users. See 7.9 “To
identify differences between a global and local 1830 PSS user or two local 1830
PSS users” (p. 67) .

4

Configure the NE mediation policy. See 7.10 “To configure NE mediation” (p. 68) .

5

Configure the discovery rule. See 7.11 “To configure a discovery rule” (p. 70) .
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7.4 Switching modes between SONET and SDH

7.4.1 Mode changes

The 1830 PSS can be set to SONET or SDH mode using the CLI command. You cannot
change the SONET or SDH mode using NFM-P GUI. If you switch modes between
SONET and SDH, and the mode value is changed, you would need to perform a full
manual resynchronization of the NE using NFM-P GUI.

When the mode is changed using a tnSysSonetSdhMode CLI command, NFM-P
recognizes the NE mode change and generates an alarm. The alarm must be cleared by
the user. See “ Alarm management” in the NSP NFM-P User Guide for more information
about clearing alarms.

Attention: If the NE mode is changed to SONET or SDH, the configurations on the
shelf, card, and port NE are lost. After the NE is restarted, the new mode must be
reconfigured.

7.5 To configure SNMPv3 on an 1830 PSS devices from the
WebUI

7.5.1 Steps

From the WebUI

1

Connect to the 1830 PSS device using admin credentials. The WebUI opens with
the System Properties form displayed.

2

Choose Administration→Security→Encryption→SSH Key. The SSH KEY form
opens.

3

Click Generate and click OK. The SSH key is generated.

4

Click Close. The SSH KEY form closes and the System Properties form reappears.
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5

Note: Configure the UI Mode parameter as Normal, Encrypted or Fips values
based on the following criteria and click Submit.

If... then...

the authentication
protocol is MD5 and
the privacy protocol is
AES128

configure the UI mode parameter as Normal or
Encrypted.

the authentication
protocol is SHA and the
privacy protocol is
AES256

configure the UI mode parameter as Fips

Note: Configuration of the UI mode parameter as Fips is only allowed if the
existing mode is Normal. You cannot switch directly from Encrypted to Fips, or
from Fips to Encrypted.

6

Click OK.

Note: The 1830 PSS devices support the creation of a default SNMP user at
initial startup with a known password. This known password permits NFM-P to
perform auto-discovery of 1830 PSS devices. The default SNMP user cannot
be deleted. It can only be disabled.

Result: The 1830 PSS device reboots.

7

Connect to the 1830 PSS device using admin credentials. The WebUI opens with
the System Properties form displayed.

8

Choose Administration→Security→SNMP v3 Users. The SNMP v3 Users form
opens.

9

Click Create. The Create SNMP v3 Users form opens.
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10

Configure the required parameters, save your changes and close the forms.

END OF STEPS

7.6 To configure a user account on an 1830 PSS device

7.6.1 Steps

1

Choose Administration→Security→NE User Configuration from NFM-P main menu.
The NE User Configuration form opens.

2

Click Create. The NE User Global Policy (Create) form opens.

3

Configure the parameters.

4

Perform one of the following:

a. Configure the SNMPv2 (Console) user.

1. Select Console in the Access panel.

2. Configure the parameters for SNMPv2 (Console) user in the following panels:

• Set New Password (Console and/or FTP)

• File System Permissions

• Console Login Permissions

• PSS Specific Attributes

b. Configure the SNMPv3 user.

1. Select SNMP in the Access panel.

2. Click on the SNMPv3 tab.

3. Configure the required parameters.

Note:

When the Authentication Protocol parameter is set to MD5, set the Privacy
Protocol parameter to AES-128.

When the Authentication Protocol parameter is set to SHA, set the Privacy
Protocol parameter to AES-256.
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Provide the same user name and password that was provided during the
SNMPv3 user creation in the 7.5 “To configure SNMPv3 on an 1830 PSS
devices from the WebUI” (p. 61) .

4. Configure the parameters in the Set New Authentication Password panel.

5. Configure the parameters in the Set New Privacy Password panel.

6. Configure the parameters in the PSS Specific Attributes panel.

Note:

Configure the Access Privilege parameter to NMS or Admin to obtain complete
privileges.

Configuring the Access Privilege parameter to Provisioner, Observer, or Crypto
will restrict access to certain functions.

c. Configure the TL1 user.

1. Select TL1 in the Access panel.

2. Click on the TL1 tab.

3. Configure the required parameters.

5

Save your changes and close the forms.

6

If required, distribute the global users to specific devices. See 7.7 “To distribute a
user account to 1830 PSS devices” (p. 64) .

7

If required, perform an audit to identify the differences between two local users or a
global and a local user. See 7.9 “To identify differences between a global and local
1830 PSS user or two local 1830 PSS users” (p. 67) .

END OF STEPS

7.7 To distribute a user account to 1830 PSS devices

7.7.1 Steps

1

Create the user as described in 7.6 “To configure a user account on an 1830 PSS
device” (p. 63) .
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2

Choose Administration→Security→NE User Configuration. The NE User
Configuration form opens.

3

Choose a user and click Properties. The NE User - Global Policy (Edit) form opens.

4

When the Configuration Mode parameter is Draft, the Distribute button or the
Distribute option under the More Actions button, is disabled and the policy cannot be
distributed to the 1830 PSS devices. You must first release the policy for distribution.
If the Configuration Mode parameter is Released, go to Step 5 .

1. Click Switch Mode and a dialog box appears.

2. Click Yes and the configuration mode of the policy is changed to Released. The
Release - SR Local User form opens with a list of available nodes.

3. Go to Step 6 .

5

Click Distribute. The Distribute - SR Local User form opens.

6

Choose the 1830 PSS devices from the Available Nodes list and click on the right
arrow icon. The devices move to the Selected Nodes list on the right side of the
form.

7

Click Distribute. The policy is distributed to the devices.

8

Close the Distribute - SR Local User form. The NE User - Global Policy (Edit) form
reappears.

9

Configure the distribution mode of the local definitions.

1. Click Distribution Mode. The Distribution Mode - SR Local User form opens.

2. Configure the Distribution Mode parameter. The local definitions that are
configured with the specified distribution mode are listed.

3. Choose one ore more rows from the Available Nodes list.

4. Click on the right arrow icon. The devices move to the Selected Nodes list on the
right side of the form.
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5. Click Sync With Global or Local Edit, depending on the distribution mode of the
specified devices.

6. Close the Distribution Mode - SR Local User form. The NE User - Global (Edit)
form reappears.

10

Close the forms.

Note: The SNMPv3 users cannot be distributed on 1830 PSS devices
discovered using SNMPv2.

END OF STEPS

7.8 To delete an 1830 PSS user configuration

7.8.1 Steps

1

Choose Administration→Security→NE User Configuration. The NE User
Configuration form opens with a list of NE Users displayed.

2

Perform one of the following:

a. Choose the user that needs to be deleted and click Delete.

Note: If you delete a global policy, all of the local instances are deleted.

b. Delete a local user.

1. Choose the global user containing the local user that needs to be deleted and
click Properties. The NE User Global Policy (Edit) form opens.

2. Click on the Local Definitions tab. The 1830 PSS devices are listed.

3. Choose an entry and click Delete.

END OF STEPS
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7.9 To identify differences between a global and local 1830
PSS user or two local 1830 PSS users

7.9.1 Steps

1

Choose Administration→Security→NE User Configuration. The NE User
Configuration form opens.

2

Choose the NE user local or global policy that you need to compare with another
policy.

3

Click Properties. The NE User (Edit) form opens.

4

Click Local Audit On. The Local Audit form opens.

Note: You can cancel the local audit at any time by clicking on Local Audit Off
on the NE User (Edit) form.

5

Perform one of the following from the Policy scope drop-down menu:

a. Choose Global and click OK. The local user is compared with the global user.

b. Choose Local and perform the following:

1. Click Select to choose an NE. The Select a Network Element form opens.

2. Select the required NE from the list and click OK. The local users are
compared.

6

View the differences between the policies by clicking on the tabs that are highlighted
with an arrow icon, which indicates that differences exist between the forms. A purple
arrow indicates that an attribute is set differently between the two audited forms.

END OF STEPS
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7.10 To configure NE mediation

7.10.1 Steps

1

Choose Administration→Mediation from NFM-P main menu. The Mediation (Edit)
form opens with the General tab displayed.

2

Note: NFM-P supports the file-based FTP only on the 1830 PSS-8, 1830 PSS-
16, and 1830 PSS-32 devices.

If... then...

the 1830 PSS discovery is file-based
FTP

set the FTP Resync Admin State
parameter to Up.

otherwise Go to Step 3.

3

Configure a MIB Entry policy that specifies the MIB polling intervals for different
managed devices, if required.

1. Click on the MIB Entry Policies tab and click Search. A list of MIBs appears,
organized by the product name of the device that supports the MIB.

2. Choose one or more MIBs from the list and click Properties. The MIB Entry Policy
(Edit) form opens.

See the Appendix A, “MIB entry name and TL1 command mapping” for more
information about the mapping of the MIB entry names and the TL1 commands.

See the 1830 PSS TL1 Commands and Messages Guide (Switching
Applications) for more information about TL1 commands.

3. Configure the required parameters in the Configuration panel.

Note: Changing the Number of Varbind per PDU parameter value may affect the
time required for subsequent NE resynchronizations and degrade NFM-P server
performance. Do not configure the parameter without contacting Nokia technical
support.

4. Save your changes and close the form.

4

Click on the Mediation Security tab.
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5

Click Create to create a new mediation security policy, or choose an existing policy
and click Properties. The Mediation Policy form opens.

6

Configure the general policy and SNMP mediation parameters.

The recommended values for Timeout (milliseconds) and Retry parameters specifying
the SNMP timeout value for polling or deployment requests between NFM-P and the
1830 PSS device are listed in the following table.

Table 6 Recommended values for Timeout and Retry

Timeout (milliseconds) Retry

60000 1

50000 2

7

Perform one of the following to configure the Security Model parameter depending
on the type of user.

a. Configure an SNMP v1 or SNMP v2c user.

1. Configure the Security Model parameter as SNMP v1 or SNMP v2c.

2. Configure the Community String parameter in the SNMPv1/v2c panel.

b. Configure an SNMP v3 user.

1. Configure the Security Model parameter as SNMP v3 (USM).

2. Select the v3DefaultUser or the specific SNMPv3 user configured as per
7.6 “To configure a user account on an 1830 PSS device” (p. 63) .

8

Configure the required parameters in the TL1 panel for OCS devices.

9

Configure the required parameters in the FTP Server panel for file-based FTP
discovery of 1830 PSS devices.

Note: NFM-P supports the file-based FTP only on the 1830 PSS-8, 1830 PSS-
16, and 1830 PSS-32 devices.

10

Retain the default values for all other parameters in the Mediation Policy (Edit) form.
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11

Save your changes and close the form.

END OF STEPS

7.11 To configure a discovery rule

7.11.1 Steps

1

Choose Administration→Discovery Manager from NFM-P main menu. The Discovery
Manager form opens.

2

Click Create. The Specify General Attributes step form opens.

3

Configure the required parameters.

4

Select a equipment group.

Note: If the selected equipment group reaches the maximum element limit, any
additional discovered NEs are automatically added to the Discovered NEs
group.

5

Configure the Discovery Protocol parameter as SNMP for WDM devices and as TL1
for OCS devices.

6

Click Next. The Add Rule Elements form opens.

7

Click Create to add a new rule element. The Topology Discovery Rule Element
(Create) form opens.

8

Configure the required parameters and click OK.
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9

Repeat Step 7 to Step 8 to create an additional rule element, if required.

10

Click Next. The Add Auto Discovery Rule Elements ACL form opens.

11

Retain the default values and click Next. The Configure Mediation Security form
opens.

12

Perform one of the following:

a. Select the specific mediation security policy in the following panels and click Next.

• Read Access Mediation Policy

• Write Access Mediation Policy

• Trap Access Mediation Policy

• Security Access Mediation Policy

Note: The OCS NE mediation requires only the Read Access Mediation
Policy for connection establishment. The other policies can retain the
default values.

b. Overwrite the default policy or create a copy of the mediation policy.

1. Click Properties in the Read Access Mediation Policy panel. The Mediation
Policy (Edit) form opens.

2. Configure the parameters depending on the Security Model parameter value.

3. For SNMPv1 or SNMPv2c, configure the Community String parameter.

4. For SNMPv3, select the v3Default user or a specific user.

Note:

It is recommended that SNMPv3 user with NMS or Admin access privilege
should be used in discovery rule to discover the 1830 PSS device in NFM-P.

5. Click Next.

13

Retain the default values for all other parameters in the remaining step forms.

14

Click Finish.
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15

Save your changes and close the forms.

END OF STEPS
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8 1830 PSS backup and upgrade

8.1 Overview

8.1.1 Purpose

This chapter describes the 1830 PSS software upgrade, backup, and restore procedures
using NFM-P.

8.1.2 Contents
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8.16 To import 1830 PSS OCS device software image files to NFM-P
database
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8.17 To download 1830 PSS-4 card images 95
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Back up and restore files on the 1830 PSS NEs

8.2 Overview

8.2.1 General information

The WDM devices support SFTP and TFTP data transfer. The OCS devices support
SFTP data transfer.

8.2.2 Encrypted file transfer

During the SFTP data transfer, the NE communicates with an external SSH server that
runs on the database backup and software repository machine. NFM-P runs on the
same machine.

Previous configurations supported in the CLI are valid for software configuration or
database configuration. The option is available in the transfer protocol field, and must be
used to initiate an SFTP-based transfer.

For software and database downloads, the applications that run on the NE are SSH or
SFTP clients which connect to an external SSH server. Authentication is password-
based only. Public key-based authentication is not supported. As a result, you can initiate
SFTP-based database and software download operations even when an encryption key
is not generated.
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8.3 Workflow to backup and restore an 1830 PSS device

8.3.1 Workflow

8.3.2 Stages

1

Configure a backup/restore policy. See 8.4 “To configure an 1830 PSS WDM
backup/restore policy and assign the policy to NEs” (p. 77) and 8.5 “To configure an

Figure 3 Backup and restore workflow
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1830 PSS OCS backup/restore policy and assign the policy to NEs” (p. 85) for more
information about how to configure backup/restore policies for WDM and OCS
devices.

2

Assign a backup/restore policy to the 1830 PSS devices. See 8.7 “To perform an
on-demand 1830 PSS backup” (p. 82) .

3

Perform an on-demand 1830 PSS device backup. See 8.7 “To perform an on-
demand 1830 PSS backup” (p. 82) for more information about how to configure on-
demand 1830 PSS device backup for WDM and OCS devices.

4

If required, import specific 1830 PSS device backup files from a file system to
NFM-P. See 8.8 “To import an 1830 PSS device backup from a file system to
NFM-P database” (p. 82) .

5

If required, export specific 1830 PSS device backup files from NFM-P to a client file
system. See 8.9 “To export device backup files from NFM-P to file system” (p. 83) .

6

If required, restore a backed up 1830 PSS device configuration. See 8.10 “To
restore a WDM device configuration backup other than the most recent” (p. 84) and
8.11 “To restore an OCS device configuration backup other than the most recent”
(p. 85) for WDM and OCS devices respectively.

7

If required, force restore an 1830 PSS device configuration. See 8.12 “To force
restore a device configuration” (p. 86) .

8.4 To configure an 1830 PSS WDM backup/restore policy and
assign the policy to NEs

8.4.1 Steps

Note: The default backup policy is automatically assigned to NFM-P-managed NEs that
do not have an assigned backup policy.
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1

Choose Administration→NE Maintenance→Backup/Restore from NFM-P main
menu. The Backup/Restore form opens.

2

Click on the Backup/Restore Policy tab and click Create. The Backup Policy (Create)
form opens.

3

Perform one of the following to specify whether backup functionality is enabled:

a. Select the Enable Backup check box.

b. Deselect the Enable Backup check box. Go to Step 9 .

4

Set the Policy Type parameter to 1830 PSS Node.

5

Configure the required parameters in the Backup Triggering and Backup Purging
panels.

6

Configure the required parameters in the PSS Backup/Restore Settings panel.

Note: If the Transfer Protocol parameter is set to SFTP, the SFTP User ID,
SFTP Password, and the Server IP parameter values must be authenticated.

7

Perform one of the following to configure the server to save the backup files:

a. Select the Use Active Server check box.

b. Deselect the Use Active Server check box and configure the Server IP parameter.

8

Save your changes and close the form.

9

Assign the policy to the 1830 PSS devices, as required.

1. Choose Administration→NE Maintenance→Backup/Restore, choose the new
policy in the list and click Properties. The Backup Policy (Edit) form opens.
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2. Click on the Backup/Restore Policy Assignment tab. The Backup Policy (Edit)
Filter form opens.

3. Configure the policy filter criteria, as required and click OK. The Backup Policy
(Edit) Filter form closes.

4. Choose one or more 1830 PSS devices in the Unassigned Sites list and click on
the right arrow key to move 1830 PSS devices to the Assigned Sites list.

5. Save your changes and close the form.

END OF STEPS

8.5 To configure an 1830 PSS OCS backup/restore policy and
assign the policy to NEs

8.5.1 Steps

Note: The default backup policy is automatically assigned to NFM-P-managed NEs that
do not have an assigned backup policy.

1

Choose Administration→NE Maintenance→Backup/Restore from NFM-P main
menu. The Backup/Restore form opens.

2

Configure the general backup policy parameters.

3

Click on the Backup/Restore Policy tab.

4

Click Create. The Backup Policy (Create) form opens.

5

Enable or disable the backup functionality:

a. Select the Enable Backup check box.

b. Deselect the Enable Backup check box. Go to Step 8 .

6

Configure the general backup policy parameters.

Note: Configure the Policy Type parameter as 1830 PSS OCS Node.
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7

Configure the required parameters in the Backup Triggering and Backup Purging
panels.

8

Configure the SFTP parameters in the PSS Backup/Restore Settings panel.

9

Configure the backup server:

a. Select the Use Active Server parameter.

• NFM-P automatically creates the samNodeBackup/1830OCS/ folders that are
empty.

•

The backup files are available in the following folders:

— PSS:

/opt/nsp/nfmp/nebackup/PSS/<IP address>

— OCS:

/opt/nsp/nfmp/nebackup/OCS/<IP address>

b. Deselect the Use Active Server parameter and configure the Server IP and File
Transfer Server Directory parameters.

Note:

• NFM-P appends the site name to the file transfer server directory configured
in the PSS Backup/Restore Settings panel. Before performing the backup,
you must ensure that the directory exists on the remote server.

• For example, if the File Transfer Server Directory parameter is configured as
/user/ocs_backup, and you are performing a backup of the site with Site
Name as SITE_123, then you must ensure that /usr/ocs_backup/SITE_123
directory exists in the remote server.

• If the File Transfer Server Directory parameter is not configured in the PSS
Backup/Restore Settings panel, the default directory for the backup of the
site with Site Name as SITE_123 is /opt/nsp/nfmp/server/nms/
samNodeBackup/1830OCS/SITE_123.

• In case of remote server backup, NFM-P does not compress the backup file.

• If a backup exists for an OCS device, then you must move the existing
backup to another location, before performing the next backup for a
particular OCS device.

10

Save your changes and close the form.
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11

Assign the policy to the 1830 PSS OCS devices.

1. Choose the new policy from the list in the Backup/Restore form and click
Properties. The Backup Policy (Edit) form opens.

2. Click on the Backup/Restore Policy Assignment tab. The Backup Policy (Edit)
Filter opens.

3. Apply the filter criteria as required.

4. Choose one or more OCS devices from the Unassigned Sites list and click on the
right arrow button to move OCS devices to the Assigned Sites list.

5. Save your changes and close the forms.

END OF STEPS

8.6 To assign a backup policy to 1830 PSS devices

8.6.1 Steps

Note: The default backup policy is automatically assigned to NFM-P-managed NEs that
do not have an assigned backup policy.

1

Choose Administration→NE Maintenance→Backup/Restore, choose the new policy
in the list and click Properties. The Backup Policy (Edit) form opens.

2

Click on the Backup/Restore Policy Assignment tab. The Backup Policy (Edit) Filter
form opens.

3

Configure the policy filter criteria, as required and click OK. The Backup Policy (Edit)
Filter form closes.

4

Choose one or more 1830 PSS devices in the Unassigned Sites list and click on the
right arrow key to move 1830 PSS devices to the Assigned Sites list.

5

Save your changes and close the form.

END OF STEPS
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8.7 To perform an on-demand 1830 PSS backup

8.7.1 Steps

1

Choose Administration→NE Maintenance→Backup/Restore from NFM-P main
menu. The Backup/Restore form opens.

2

Perform one of the following.

a. For OCS devices:

1. Click on the Backup/Restore Policy tab.

2. Choose the OCS backup policy and click Properties. The Backup Policy (Edit)
form opens.

3. Configure the required parameters in the PSS Backup/Restore Settings panel.

4. Click OK to confirm. The Backup/Restore form reappears.

b. Go to Step 3 for WDM devices.

3

Click on the Backup/Restore Status tab, choose an OCS or a WDM device, and click
Backup.

4

Confirm the changes to start the backup and close the form after successful backup.

Note: The status of the backup is displayed in the Last Operation Details
column of the Backup/Restore form.

END OF STEPS

8.8 To import an 1830 PSS device backup from a file system to
NFM-P database

8.8.1 Steps

1

Choose Administration→NE Maintenance→Backup/Restore from NFM-P menu. The
Backup/Restore form opens.
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2

Click on the Backup/Restore Status tab. The managed devices are listed.

3

Double-click on a device from the list. The NE Backup/Restore Status form for the
selected device opens.

4

Click Import. If the Import button is not visible, click on the More Actions button and
choose Import. A file navigator form opens.

5

Use the form to specify the directory that contains the device backup and click OK.

If the directory contains a backup for this NE, NFM-P imports the backup files into
NFM-P database and the import is successful. Otherwise, a dialog box appears, and
the import fails. Click OK to close the dialog box.

6

Save your changes and close the forms.

END OF STEPS

8.9 To export device backup files from NFM-P to file system

8.9.1 Steps

1

Choose Administration→NE Maintenance→Backup/Restore from NFM-P menu. The
Backup/Restore form opens.

2

Click on the Backup/Restore Status tab. The managed devices are listed.

3

Double-click on a device from the list. The NE Backup/Restore Status form for the
selected device opens.

4

Click on the Backups tab. A list of backups for the selected device appears, ordered
from the oldest to the most recent.
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5

Choose a specific backup in the list and click Export. A file navigator form opens.

6

Use the form to specify the directory that is to contain the exported device backup
and click OK. The NE configuration backup is saved to the specified directory.

7

Save your changes and close the forms.

END OF STEPS

8.10 To restore a WDM device configuration backup other than
the most recent

8.10.1 Before you begin

Attention:

• You can choose to restore an older version of the device configuration to meet special
network requirements.

• Older backups do not have the most recent network information. Restoring an older
device configuration may be service-affecting.

Ensure that you back up the current device configuration using 8.7 “To perform an on-
demand 1830 PSS backup” (p. 82) before you proceed.

8.10.2 Steps

1

Choose Administration→NE Maintenance→Backup/Restore from NFM-P menu. The
Backup/Restore form opens.

2

Click on the Backup/Restore Status tab. The managed devices are listed.

3

Double-click on a device from the list. The NE Backup/Restore Status form for the
selected device opens.

4

Click on the Backups tab. A list of configuration backups for the selected device
appears, ordered from the oldest to the most recent.
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5

Choose a backup in the list and click Restore. A dialog box appears.

6

Click Yes.

7

Right-click on the device on the navigation tree and choose Resync and ensure that
the latest network information is available.

Note: The status of the restore is displayed in the Last Operation Details
column of the Backup/Restore form.

8

Save your changes and close the forms.

END OF STEPS

8.11 To restore an OCS device configuration backup other than
the most recent

8.11.1 Before you begin

Attention: You can choose to restore an older version of the device configuration to
meet special network requirements.

Older backups do not have the most recent network information. Restoring an older
device configuration may be service-affecting.

Ensure that you back up the current device configuration using 8.7 “To perform an on-
demand 1830 PSS backup” (p. 82) before you proceed.

8.11.2 Steps

1

Choose Administration→NE Maintenance→Backup/Restore from NFM-P menu. The
Backup/Restore form opens.

2

Click on the Backup/Restore Policy tab.
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3

Choose the OCS backup policy and click Properties. The Backup Policy (Edit) form
opens.

4

Configure the required parameters in the PSS Backup/Restore Settings panel.

5

Click on the Backup/Restore Status tab. The managed devices are listed.

6

Double-click on a device from the list. The NE Backup/Restore Status form for the
selected device opens.

7

Click on the Backups tab to list the configuration backups for the selected device,
sorted from the oldest to the most recent.

8

Choose the specific backup in the list and click Restore.

9

Save your changes and close the forms.

10

Right-click on the device on the equipment tree and choose Resync and ensure that
the latest network information is available.

Note: The status of the restore is displayed in the Last Operation Details
column of the Backup/Restore form.

END OF STEPS

8.12 To force restore a device configuration

8.12.1 When to use

You can choose to restore a device configuration using the configuration of another 1830
PSS OCS or WDM (1830 PSS-32) device to meet special network requirements by
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importing that device configuration and performing a forced restore. The default restore
rejects the OCS device configuration if the loopback IP address and region parameter
values do not match.

You can perform a force restore where NFM-P requests the NE to override the following
validations and restores the device configuration despite the existence of failure
conditions:

• Software release identifier mismatch

• SID mismatch

• Time stamp mismatch

• Region mismatch

8.12.2 Before you begin

Attention: Older backups do not have the most recent network information. Restoring
an older device configuration may be service-affecting.

Ensure that you back up the current device configuration using 8.7 “To perform an on-
demand 1830 PSS backup” (p. 82) before you proceed.

8.12.3 Steps

1

Import the device configuration from a specific node. See 8.8 “To import an 1830
PSS device backup from a file system to NFM-P database” (p. 82) .

2

Choose Administration→NE Maintenance→Backup/Restore from NFM-P menu. The
Backup/Restore form opens.

3

Click on the Backup/Restore Status tab. The managed devices are listed.

4

Double-click on a device from the list. The NE Backup/Restore Status form for the
selected device opens.

5

Click on the Backups tab. A list of configuration backups for the selected device
appears, ordered from the oldest to the most recent.

6

Choose the specific backup in the list and click Force Restore.
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7

Save your changes and close the forms.

8

Right-click on the device on the navigation tree and choose Resync and ensure that
the latest network information is available.

Note: The status of the restore is displayed in the Last Operation Details
column of the Backup/Restore form.

END OF STEPS
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Managing 1830 PSS software upgrades

8.13 1830 PSS software upgrade

8.13.1 Overview

When an 1830 PSS device needs a software upgrade to another software version, you
can use NFM-P to perform an on-demand or scheduled NE software upgrade using a
software upgrade policy. You can create and configure multiple software upgrade
policies and assign them to multiple NEs. You cannot delete a software upgrade policy
that is assigned to an NE.

The information in a software upgrade policy includes the following:

• whether to activate the software after the software is transferred to the NE

• whether to re-initialize the NE after the upgrade

During a software upgrade, NFM-P performs checks to ensure that the new software is
compatible with the device type and that the required files are present. NFM-P initiates a
device software upgrade only when the required conditions exist. You can use NFM-P to
roll back a software upgrade to the previous version if an upgrade fails.

NFM-P provides an option to choose concurrent upgrade, while performing an 1830 PSS
OCS device software upgrade, version 8.1 or later, in the following upgrade options:

• activate

• auto-upgrade

• schedule

The concurrent upgrade option allows you to upgrade the software on every card at the
same time on the 1830 PSS OCS device. If you do not choose the concurrent upgrade
option, the software is upgraded one card at a time. See 8.21 “To perform an immediate
software upgrade” (p. 100) and 8.22 “To schedule an automatic software upgrade”
(p. 102) .

For more information about the error descriptions, see the following guides:

• Nokia 1830 Photonic Service Switch 36 Installation and System Turn-up Guide

• Nokia 1830 Photonic Service Switch 64 Installation and System Turn-up Guide

• Nokia 1830 Photonic Service Switch 36/32/16 (PSS-36/PSS-32/PSS-16) User
Provisioning Guide

8.13.2 1830 PSS-4 card image download

The EC card in the 1830 PSS-4 device is limited to 2GB. The card images for all the
newly introduced cards from 1830 PSS-4 version 7.0 and later, along with the existing
card images, are too large to be stored in the EC card flash memory for performing an
upgrade. For the 1830 PSS-4, version 7.0 and later, the card images can be dynamically
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downloaded and deleted based on the provisioning requirement. You can configure the
download for available card images, as required, using the dynamic download for an
1830 PSS-4 device. See 8.17 “To download 1830 PSS-4 card images” (p. 95) for more
information.

8.13.3 Software upgrade through USB

Besides performing a software upgrade through a remote server, you can also perform a
software upgrade to 1830 PSS, version 8.2 and later, through the USB ports of 32EC2
and 8EC2 cards on an 1830 PSS-32, 1830 PSS-16II, and 1830 PSS-8. The size of the
USB flash drive is 2GB. Before performing a software upgrade through USB, ensure that
the USB flash drive is formatted, installed, and the NE software is copied to the drive.
The drive must be inserted in the USB port of the required EC card. See 8.19 “To
perform software upgrade through USB port on an EC card” (p. 97) for more information.
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8.14 Workflow to configure an 1830 PSS software upgrade

8.14.1 Workflow

8.14.2 Stages

1

Import 1830 PSS device software image files to NFM-P database.

See 8.15 “To import 1830 PSS WDM device software image files to NFM-P
database” (p. 92) and 8.16 “To import 1830 PSS OCS device software image files to
NFM-P database” (p. 94) for more information about how to import WDM and OCS
software images respectively.

Figure 4 Software upgrade workflow
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2

Configure a software upgrade policy. See 8.18 “To create a software upgrade policy”
(p. 96) .

3

Assign a software upgrade policy to an 1830 PSS device. See 8.20 “To assign a
software upgrade policy to an 1830 PSS” (p. 99) .

4

Perform an immediate software upgrade. See 8.21 “To perform an immediate
software upgrade” (p. 100) .

5

If required, schedule an automatic software upgrade. See 8.22 “To schedule an
automatic software upgrade” (p. 102) .

6

If required, view the status of the software upgrade. See 8.23 “To view the status of
a software upgrade” (p. 104) .

8.15 To import 1830 PSS WDM device software image files to
NFM-P database

8.15.1 Steps

1

Copy or move the device software to a directory that is accessible to NFM-P. The
directory can be on the local server or an accessible remote server.

Note: The directory must contain a valid and complete set of device software
files. See the 1830 PSS Release Notes for a complete list of files.

2

Choose Administration→NE Maintenance→Software Upgrade from NFM-P main
menu. The Software Upgrade form opens.

3

Click on the Software Images tab and then on the PSS Software Images tab.

4

Perform one of the following:
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a. Import image files from NFM-P directory on the local server:

1. Click Import. The Select import PSS Software window appears.

2. Navigate to the directory that contains the software image file and select the
image directory.

Note:

Ensure that the image directory name is in the following format:

<1830PSSxx-software version/>

where xx can be: 4, 16, or 32, depending on the device variant that you are
upgrading. For example: 1830PSS4-6.0-37/. In this example, the device is a
1830 PSS-4 and the software version is 6.0-37.

3. Click Open. The Import Image dialog box appears.

4. Click Yes. When the import is complete, an entry for the image file appears in
the list.

b. Import 1830 PSS software from a remote location with FTP support:

Note: The remote system address is the server IP address that is
configured in the policy of the associated NE. See 8.18 “To create a
software upgrade policy” (p. 96) for more information about creating a
software upgrade policy.
When using FTP, the default user login directory is typically “/var/ftp”.

1. Click Remote Path. A Remote Path notification box appears.

2. Click Yes. The Software Directory Path form opens.

3. Enter the Remote Software Path. The software upgrade files must have the
last directory specified in the path described in the following table.

Device Default
login
directory

Format Example

1830 PSS-4 /var/ftp </EC/1830PSS4-software version> /EC/1830PSS4-8.0-62

where the device is 1830 PSS-4 and the software
version is 8.0-62

1830 PSS-8 /var/ftp </EC/1830PSS8-software version> /EC/1830PSS8-8.0-12

where the device is 1830 PSS-8 and the software
version is 8.0-12

1830 PSS-16 /var/ftp </EC/1830PSS16-software version> /EC/1830PSS16-7.0-57

where the device is 1830 PSS-16 and the
software version is 7.0-57

1830 PSS-32 /var/ftp </EC/1830PSS32-software version> /EC/1830PSS32-6.0-43

where the device is 1830 PSS-32 and the
software version is 6.0-43
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Result: When the remote path import is complete, an entry for the image file
appears in the list.

5

Save your changes and close the forms.

END OF STEPS

8.16 To import 1830 PSS OCS device software image files to
NFM-P database

8.16.1 Steps

1

Copy or move the device software to a directory that is accessible to NFM-P. The
directory can be on the local server or an accessible remote server.

Note: The directory must contain a valid and complete set of device software
files. See the 1830 PSS 36/64 Release Notes for a complete file listing.

2

Choose Administration→NE Maintenance→Software Upgrade from NFM-P main
menu. The Software Upgrade form opens.

3

Click on the Software Images tab and then on the OCS Software Images tab.

4

Perform one of the following:

a. To import image files from NFM-P directory on the local server:

1. Click Import. The Select Import PSS Software window appears.

2. Navigate to the directory that contains the software image file and select the
image directory.

Note:

Ensure that the image directory name is in the following format:

<software version/>

3. Click Open. The Import Image dialog box appears.

4. Click Yes. When the import is complete, an entry for the image file appears in
the list.

b. To provide a remote path for the 1830 PSS OCS software:
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Note: Ensure that the server IP address is configured in the software
upgrade policy of the associated NE. See 8.18 “To create a software
upgrade policy” (p. 96) for information about creating a software upgrade
policy.

1. Click Remote Path. A Remote Path notification box appears.

2. Click Yes to continue. The Software Directory Path dialog box appears.

3. Enter the Remote Software Path. The software upgrade files must have the
last directory specified in the path, as follows:

</root/FLC/software version/>

For example: /root/FLC/08.08.12

Note:

Ensure that the format of the software version is “xx.xx.xx”.

See the current NSP NFM-P and 5620 SAM Network Element Compatibility
Guide for more information about the load that you need to upgrade or
downgrade.

5

Close the Software Upgrade form.

END OF STEPS

8.17 To download 1830 PSS-4 card images

8.17.1 When to use

The EC capacity for the 1830 PSS-4 device is too low to accommodate all of the card
images. This procedure allows you to set the card image to be downloaded when
required.

8.17.2 Steps

1

Choose Administration→NE Maintenance→PSS4 Card Image. The Card Image
Status form opens.

2

Choose an 1830 PSS-4 device and click Properties. The Network Element (Edit)
form opens.

3

Click on the Card Image tab. A list of the available card images appears.
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4

Select a card image from the list and click Set. The Ready for Download field is
selected for the corresponding card image.

5

Click Download to start downloading the card image.

Result: The status of the card image download is displayed in the Card Image
Download Status panel.

END OF STEPS

8.18 To create a software upgrade policy

8.18.1 When to use

NFM-P uses an 1830 PSS-specific software upgrade policy to download 1830 PSS
software. A default 1830 PSS software upgrade policy is created when NFM-P initializes.

Use the following procedure to create a policy that you can use to perform an on-
demand or scheduled device software image upgrade. Contact your Nokia technical
support representative for information about downgrades.

8.18.2 Before you begin

Ensure that:

• you validate the default user directory at login to determine the appropriate path for
WDM devices. When using FTP, you can run pwd to display the default login directory.
A typical return example would be “/var/ftp”

• appropriate FTP accounts are configured and available on the devices to which you
intend to apply the policy for WDM devices

• device configuration files are backed up for OCS and WDM devices

8.18.3 Steps

1

Perform 8.15 “To import 1830 PSS WDM device software image files to NFM-P
database” (p. 92) to import the 1830 PSS WDM device software image file or
8.16 “To import 1830 PSS OCS device software image files to NFM-P database”
(p. 94) for 1830 PSS OCS device.

2

Choose Administration→NE Maintenance→Software Upgrade from NFM-P main
menu. The Software Upgrade form opens.
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3

Click Create. The Software Upgrade Policy (Create) form opens.

4

Configure the 1830 PSS Node for the Policy Type parameter, if your are configuring
a WDM device, and 1830 PSS OCS Node for an OCS device.

5

Configure the required parameters in the PSS Based Setting panel.

6

If you deselect the Use Active Server parameter in Step 5, configure the Server IP
parameter.

7

Configure the required parameters in the PSS Audit Setting panel, for a WDM
device.

Note: If you want to use the Revert function, ensure that you select the Node
Backup check box in the PSS Audit Setting panel.

8

Save your changes and close the forms.

END OF STEPS

8.19 To perform software upgrade through USB port on an EC
card

8.19.1 When to use

You can perform a software upgrade through a USB flash drive inserted in the USB port
of a 32EC2 card on an 1830 PSS-16II or 1830 PSS-32 device, and an 8EC2 card on an
1830 PSS-8 device.

8.19.2 Before you begin

Ensure that the USB flash drive is inserted into the required EC card and has the
required software image copied on it.
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8.19.3 Steps

1

Choose Administration→NE Maintenance→Software Upgrade from NFM-P main
menu. The Software Upgrade form opens.

2

Click on the Software Images tab, then on the PSS Software Images tab.

3

Click Remote Path, and select the following check boxes in the Warning window,
and click Yes.

• Import using USB Port

• I understand the implications of this item

The Software Directory Path window opens. By default, the USB Software Path
parameter is configured as /usbkey.

4

Click OK or configure the USB Software Path parameter, as required and click OK.
The software image is listed.

Modify software upgrade policy for software upgrade using USB

5

Click on the Software Upgrade Policy tab.

6

Choose the required 1830 PSS WDM software upgrade policy and click Properties.
The Software Upgrade Policy (Edit) form opens.

7

Configure the Transfer Protocol parameter on the PSS Based Setting panel as FTP.

Note: You must set the Transfer Protocol parameter as FTP for software
upgrade through USB.

8

Deselect the Use Active Server check box and select the Use USB Port check box.
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Note: Although the Use USB Port check box appears in the Software Upgrade
Policy (Edit) form, it is applicable only for software upgrade to 1830 PSS,
version 8.2 and later.

9

Perform one of the following to configure the FTP user ID and password:

a. To perform a software upgrade from version 8.1 to 8.2, set the SFTP/FTP User ID
parameter as root and the SFTP/FTP Password parameter to the password
provided to your administrator by Nokia technical support.

b. To perform a software upgrade to versions later than 8.2, set the SFTP/FTP User
ID parameter as ftplocal and the SFTP/FTP Password parameter to the
password provided to your administrator by Nokia technical support.

10

Select the Node Backup check box in the PSS Audit Setting panel to perform backup
during upgrade. By default, the Node Backup Directory parameter is set as
/usbkey.

Note: For performing a software upgrade from version 8.1 to 8.2, the FTP user
ID parameter is ftplocal. However, ftplocal user ID has only read
permission and no write permission, so a node backup fails, if selected. As a
work-around for upgrading version 8.1 to 8.2, you must take backup using
root user ID, then perform the upgrade using ftplocal user ID and deselect
the Node Backup check box.

Immediate or scheduled software upgrade

11

a. For an immediate software upgrade, perform Step 4 to Step 6 of the procedure
8.21 “To perform an immediate software upgrade” (p. 100) .

b. For a scheduled software upgrade, perform Step 3 to Step 8 of the procedure
8.22 “To schedule an automatic software upgrade” (p. 102) .

END OF STEPS

8.20 To assign a software upgrade policy to an 1830 PSS

8.20.1 Steps

1

Choose Administration→NE Maintenance→Software Upgrade from NFM-P main
menu. The Software Upgrade form opens.
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2

Choose a software upgrade policy from the list and click Properties. The Software
Upgrade Policy (Edit) form opens.

3

Click on the Software Upgrade Policy Assignment tab, configure the filter
parameters, as required and click OK.

4

Choose one or more NEs in the Unassigned Sites list and click on the right arrow to
move the NEs to the Assigned Sites list.

5

Save your changes and close the forms.

END OF STEPS

8.21 To perform an immediate software upgrade

8.21.1 Before you begin

Before you perform the procedure, ensure that:

• the required software image files are imported to NFM-P database. See 8.15 “To
import 1830 PSS WDM device software image files to NFM-P database” (p. 92) to
import the 1830 PSS WDM device software image file or 8.16 “To import 1830 PSS
OCS device software image files to NFM-P database” (p. 94) for the 1830 PSS OCS
device.

• the node is assigned to the appropriate software upgrade policy. See 8.20 “To assign
a software upgrade policy to an 1830 PSS” (p. 99) .

8.21.2 Steps

1

Choose Administration→NE Maintenance→Software Upgrade from NFM-P main
menu. The Software Upgrade form opens.

2

Perform one of the following:

a. If you are configuring an OCS device:

1. Choose the OCS upgrade policy and click Properties. The Software Upgrade
Policy (Edit) form opens.

2. Configure the required parameters in the PSS Based Setting panel.
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3. Click OK to confirm the changes and the Software Upgrade form reappears.

4. Click on the Software Images tab, then on the OCS Software Images tab.

b. If you are configuring a WDM device, click on the Software Images tab, then on
the PSS Software Images tab.

3

Perform one of the following node level upgrades:

a. separate audit, load, and activate tasks. Go to Step 4 .

b. single task. Go to Step 5 .

c. scheduled task. See 8.22 “To schedule an automatic software upgrade” (p. 102) .

4

Perform the audit, load, and activate as separate tasks. See the 1830 PSS User
Provisioning Guide for more information about the audit, load, and activate tasks.

Audit the 1830 PSS software image file to verify the software load on NFM-P local
server or remote server.

1. Choose the appropriate 1830 PSS software image file from the list, click Audit,
configure the Audit Settings parameter, and select the 1830 PSS device.

Note:

If you choose the Default Audit Settings option, the policy level settings are used.

Click on the Software Upgrade Status tab to view the progress of the audit.

Verify that the software is successfully audited before you go to 2 .

2. Click Load and select the 1830 PSS device.

Note:

The load operation may take considerable time to complete.

Click on the Software Upgrade Status tab to view the progress of the audit.

Verify that the audited software is successfully loaded before you go to 3 .

3. Click Activate, and select the 1830 PSS device.

Note:

The activate operation may take considerable time to complete.

4. To upgrade the software on all the cards concurrently, select the Concurrent
Upgrade option in the warning message while performing the Activate operation
on the 1830 PSS OCS device, version 8.1 or later.

5. Go to Step 6 .

5

Choose the appropriate 1830 PSS software image file from the list, click Auto
Upgrade, and select an 1830 PSS device.
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To upgrade the firmware on all cards concurrently, select the Concurrent Upgrade
option in the warning message while performing the Auto Upgrade operation on the
1830 PSS OCS device, version 8.1 or later.

Note: If you choose the Default Audit Settings option, the policy level settings
are used.
Click on the Software Upgrade Status tab to view the progress.

6

Perform one of the following:

a. Click Commit and select an 1830 PSS device.

Note: You can commit the active release at any time after the software
release has been activated.

b. Click Revert and select an 1830 PSS device.

Note: You can revert to a previously committed software release at any time
during the software upgrade process.

7

Save your changes and close the forms.

END OF STEPS

8.22 To schedule an automatic software upgrade

8.22.1 Before you begin
• See “ NFM-P-based schedule procedures” in the NSP NFM-P User Guide for

information about creating schedules.

• Ensure that the required software image files are imported to NFM-P database.

— see 8.15 “To import 1830 PSS WDM device software image files to NFM-P
database” (p. 92) to import the 1830 PSS WDM device software image file

— see 8.16 “To import 1830 PSS OCS device software image files to NFM-P
database” (p. 94) for the 1830 PSS OCS device

• Ensure that the node is assigned to the appropriate software upgrade policy (see
8.20 “To assign a software upgrade policy to an 1830 PSS” (p. 99) ).

8.22.2 Steps

1

Choose Administration→NE Maintenance→Software Upgrade from NFM-P main
menu. The Software Upgrade form opens.
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2

Choose the appropriate software upgrade policy and click on the Software Images
tab.

Note: NFM-P performs the upgrade according to the configuration in the
software upgrade policy that is assigned to the NE.

3

Choose a software image in the list and click Schedule. The Confirm Audit Settings
dialog box appears.

4

Choose an option from the Audit Settings and click OK. The AutoUpgrade - Select
Sites form opens.

Note: If you choose the Default Audit Settings option, the policy level settings
are used.

5

Select the node that you need to upgrade and click OK. The Select Schedule -
Select Schedule form opens.

6

Choose a schedule in the list and click OK. The Schedule Upgrades dialog box
appears. See the NSP NFM-P User Guide for information about creating schedules.

To upgrade the firmware on all cards concurrently, select the Concurrent Upgrade
option in the warning message while performing Schedule operation on the 1830
PSS OCS device, version 8.1 or later.

7

Click Yes. NFM-P schedules the upgrade.

8

Perform one of the following:

a. Commit the activated software release to the node.

1. Click Commit. The Commit - Select Sites form opens with a list of nodes that
have activated software displayed.

2. Select the node where you need to commit the activated software release and
click OK. The Commit dialog box appears.

3. Click Yes.
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b. Revert the node to the previously committed software release.

1. Click Revert. The Revert - Select Sites form opens with a list of nodes that
have activated software displayed.

2. Select the node where you need to revert the software release and click OK.
The Revert dialog box appears.

3. Click Yes.

9

Save your changes and close the forms.

END OF STEPS

8.23 To view the status of a software upgrade

8.23.1 Steps

1

Choose Administration→NE Maintenance→Software Upgrade from NFM-P main
menu. The Software Upgrade form opens.

2

Click on the Software Upgrade Status tab.

3

Choose the node from the list and click Properties. The Software Upgrade Status
(View) form opens.

4

Click on the Software Upgrade tab. The values of the Last Operation Status and Last
Operation Percentage Completed parameters represent the status of the software
upgrade.

5

Close the forms.

END OF STEPS
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9 1830 PSS equipment management

9.1 Overview

9.1.1 Purpose

This chapter provides information about the 1830 PSS equipment management using
NFM-P.
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Introduction

9.2 Overview

9.2.1 Equipment management

NFM-P equipment management interface consists of:

• a main menu

• contextual menus

• a navigation tree

• managed objects

• property forms to configure object parameters

NFM-P is used to create, configure, and manage a device with the child objects that
must be part of a network. Equipment, for example, the routers, which are at the top of
the hierarchy, have properties that are configured using the CLI and are discovered
when NFM-P discovery process is run.

After the device is discovered, you use properties forms to configure specific parameters
for the child objects of the discovered device. See the NSP NFM-P User Guide for more
information about equipment management.

9.3 Workflow to manage the 1830 PSS equipment

9.3.1 Workflow

The workflow is used to manage the 1830 PSS. See the NSP NFM-P User Guide for
more information about managing devices.

9.3.2 Stages

1

Manage the 1830 PSS equipment using the navigation tree:

1. Use NFM-P to discover the 1830 PSS.

2. Right-click on the Discovered NEs equipment group in the Equipment view of the
navigation tree and choose List. You can also double-click on the Discovered
NEs icon on the topology map to open the Discovered NEs form.

3. Drag the 1830 PSS to the network icon in the Equipment view of the navigation
tree or to the topology map.
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4. Right-click on the 1830 PSS device in the navigation tree and choose an option.
See the NSP NFM-P User Guide for a list of contextual menu options.

5.Use the Properties option in the Equipment view to perform any of the following, as
required:

• Modify the device parameters

• Create card objects in the shelf. See “Managing cards” (p. 123) for more
information.

• View the parameters of the port objects that were created automatically with
the card object. See “Managing ports ” (p. 147) for more information.

• Modify the parameters of the created objects.

2

Verify that the 1830 PSS devices are configured before they are discovered by
NFM-P.

3

Access the 1830 PSS device and start the configuration and management.

From NFM-P, choose Manage→Equipment→Equipment. The Manage Equipment
form opens.

The network administrators and operators can:

• filter views and information for the managed devices

• view and use a graphical representation of the shelf to configure equipment

• view objects and get statistical information about the NEs in their administrative
domain

• view the services that traverse or terminate on equipment

• provision and pre-provision equipment to prepare the equipment for the creation of
subscriber services

• view, configure, monitor the state of, and manage the following physical elements
of the hardware:

— a managed device

— each device that has at least one physical shelf

— internal and external storage devices (flash memory)

— physical links

— current OLC state

• configure network and access policies for network objects; for example, ingress
buffer policies for a port

• view and manage APS groups

• manage hardware fault conditions
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Managing objects

9.4 Working with objects

9.4.1 Overview

Objects in NFM-P have parent/child relationships that are contained within a hierarchy.
For example, a card in a card slot is the parent object of a daughter card. The
parameters for each object are configured for a specific function. The parameters can be
managed to meet the needs of the service. Objects are created and managed using the
properties forms of the Equipment view.

The network is the top object in the navigation tree. The device object is the discovered
device at the top of the hierarchy in the navigation tree, directly below the network icon.
The child objects are created automatically in the navigation tree after the device is
discovered.

9.4.2 Resynchronization of objects

The Resync option of the contextual menu specifies that SNMP MIB and CLI information
bases are reread to synchronize them with NFM-P, which also synchronizes the network
management settings with the device. The changes in the values for some of the read-
only parameters from the 1830 PSS are not updated automatically. The parameters are
identified by the resync icon that is beside each parameter. Click on the resync icon to
display the updated parameter values.

Note: The port operational state is updated automatically.

9.5 11DPM12 card and port objects

9.5.1 Introduction

The 11DPM12 card and port objects of 1830 PSS devices Release 5.5 and later appear
differently than the other 1830 PSS cards on the navigation tree of NFM-P.

When you expand the 11DPM12 card object, the following objects appear on the
navigation tree:

• eight ODU1PTFs

• two line ports

• 12 client ports

• two VA ports

Working with objects NFM-P
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9.5.2 ODU1PTF objects

NFM-P displays the ODU1PTF objects on the navigation tree after the 11DPM12 card is
configured. The eight ODU1PTF objects are mapped to 12 client ports. An 11DPM12
card is divided into four client port groups with three client ports per group. Each port
group can use two ODU1PTFs to map to the OPTSG client ports. Table 7, “ODU1PTF
mapping” (p. 110) lists the client ports and the assigned ODU1PTFs.

Table 7 ODU1PTF mapping

Port groups Client ports ODU1PTF

1 C1, C2, and C3 ODU1PTF1 and ODU1PTF2

2 C4, C5, and C6 ODU1PTF3 and ODU1PTF4

3 C7, C8, and C9 ODU1PTF5 and ODU1PTF6

4 C10, C11, and C12 ODU1PTF7 and ODU1PTF8

The OPTSG objects are either configured manually or created automatically by NFM-P.

To manually configure the OPTSG objects, configure the timeslots for ODU1 container
type as described in 15.44 “To configure an ODU timeslot assignment for 11DPM12
cards” (p. 340) . Associate the line-side LO-ODUk facility as described in 15.45 “To
associate a line-side LO-ODUk on the 11DPM12 card” (p. 342) . Right-click on the
ODU1PTF object and choose the Configure ODU1PTF Timeslots option to configure
ODU1PTF timeslots which appear as OPTSG objects under the ODU1PTF object.

During optical transport service creation, NFM-P automatically creates ODU1 container
on the line-side, configures the appropriate ODU1PTF objects, associates with the line-
side, creates OPTSG objects, and creates the cross connect between the client port and
the OPTSG object. The cascading cross connects between ODU1PTF objects across
port groups are also created as required. The OPTSG objects are created when you
choose OC3 or OC12 for the Rate parameter on the General tab of the Optical Transport
Service (Create) form. The Assigned Rate parameter option of the client port must be set
to OC3 or OC12 on the General tab under the Port Specifics tab of the Physical Port
(Edit) form which automatically configures the container type as OPTSG.

The timeslots are numbered from 1 to 16. The OC3 requires one timeslot and OC12
requires four timeslots. The number of OPTSG objects created depends on the Rate
parameter value.

9.5.3 Line port objects

NFM-P supports the creation of two 11DPM12 line ports with OTU2 as the Assigned
Rate parameter option on the General tab under the Port Specifics tab of the Physical
Port (Edit) form. Each OTU2 line port contains an ODU2 object below the OTU2 line port
on the navigation tree. The ODU2 object allows you to configure multiple low-order ODU

NFM-P 11DPM12 card and port objects

Release 17.3
April 2017
Issue 2 1113HE-12002-AAAA-TQZZA



objects below the ODU2 objects by clicking on the Configure Timeslots button on the
General tab under the Port Specifics tab of the Physical Port (Edit) form. The timeslots
are numbered from 1 to 8. The number of low-order ODU objects that can be created
depends on the container type.

9.5.4 Client port objects

The twelve client ports support the following signal rates:

• 1GbE • HDSDI

• 3GSDI • OC3

• FC100 • OC12

• FC200 • OC48

• FC400 • OTU1

• FE • SDSDI

The ODU0, ODU1, ODUflex, and OPTSG containers are mapped to the signal rate as
follows:

• ODU0—1GbE, FE, FC100, SDSDI, OC3 or OC12

• ODU1—FC200, HDSDI, OC48, or OTU1

• ODUflex—3GSDI, or FC400

• OPTSG—OC3, or OC12

Depending on the Assigned Rate parameter option that is specified on the General tab
under the Port Specifics tab of the Physical Port (Edit) form, the corresponding client port
objects appear on the navigation tree with the container type displayed.

9.5.5 VA port objects

The 11DPM12 cards contain two eVOA ports that are used for wavelength tracking and
power adjustment. The eVOA ports appear as VA objects on the navigation tree.
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Managing shelves

9.6 1830 PSS WDM shelves

9.6.1 Introduction

The 1830 PSS-32 and 1830 PSS-16 shelves provide the framework for the configuration
of the 1830 PSS-32 / 1830 PSS-16 NEs. A universal shelf provides card slots, fiber
management trays, backplane, power distribution, and cooling for the NE. The NEs can
be deployed in a shelf or expanded to multiple interconnected universal shelves.

The first universal shelf of an NE becomes the master shelf, which provides the
management and control connections to the operations systems for the cluster of
shelves in a multi-shelf NE. Expansion shelves connect to the master shelf using a
protected internal LAN communication link. The shelves provide extended slot capacity
managed by the database that resides in the master shelf.

The universal shelf is the basic building block for the 1830 PSS-32 NE. The shelf
provides a framework for the active modules in a system, for example, the controller and
interface cards.

Each universal shelf has a shelf ID that can be configured using a physical mechanism
(for example, a rotary dial) on the backplane. Up to eight bits of information can be set.
The shelf ID determines the identity of each universal shelf in the cluster. The most
significant bit of the rotary dial determines whether the shelf is the main shelf or an
extension shelf.

Each shelf is equipped with mandatory modules. Some of the shelves are equipped with
optional modules.

The mandatory equipment must be automatically provisioned regardless of whether the
equipment is present.

Each shelf includes the following mandatory equipment:

• one shelf controller (EC) in slot 1 or 18

• two power modules (PF)

• a fan module (FAN)

The user interface panel (USRPNL) is mandatory and can only reside on the main shelf.
Mandatory equipment is provisioned without an AINS state. The AINS allows newly
provisioned entities to be inserted later without generating alarms. Therefore, if a
mandatory equipment (without AINS) is inserted later, alarms are generated.

A DCM enclosure can hold up to 16 DCMs. The system manages each DCM as a
separate shelf.
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See the Nokia 1830 Photonic Service Switch Product Information and Planning Guide
and the Nokia 1830 Photonic Service Switch User Provisioning Guide for more
information. See the NSP NFM-P Optical Parameter Reference for more information
about parameters.

9.6.2 1830 PSS-32 shelves

The 1830 PSS-32 system supports the following types of shelves: Universal, DCM, ITLB,
and ITLU. The 1830 PSS-32 universal shelf contains 32 replaceable slots.

The SFD44 (44-channel DWDM static filter) is modelled as an OMD shelf with an SFD44
card. Other shelves that can be configured from NFM-P are: SFD40, SFD40B, SFD44B,
and ITLB.

The DCM and OMD shelves are passive module shelves that can contain DCMs and
SFD44 modules. The modules provide dispersion compensation and the optical mux
/demux function that is associated with core optics modules that is, line drivers and
CWR8, respectively that are installed in the universal shelf. Each 1830 PSS-32 includes
up to 8 universal shelves, and up to 24 DCM and OMD shelves.

Each 1830 PSS-32 universal shelf contains 32 slots for function cards. Two additional
slots are reserved for controller cards that are configured for redundant control. Two
more slots are reserved for the power filter cards. The top of the shelf contains a fan tray
for cooling, a customer interface panel, and two timing interface cards that provide a
redundant connection to synchronization references. See the Nokia 1830 Photonic
Service Switch Product Information and Planning Guide and the Nokia 1830 Photonic
Service Switch User Provisioning Guide for more information.

9.6.3 1830 PSS-16 shelves

In addition to the slots for the two power filters and two controller cards, the 1830
PSS-16 shelf contains 16 function card slots. The 1830 PSS-16 supports the following
types of shelves: PSS 16, DCM, ITLB, and ITLU. The slots at the top of the shelf can
hold two function cards or the user interface panel on units that are used as main
shelves. A fan tray for cooling is located at the bottom of the shelf. NFM-P supports up to
eight extension shelves. See the Nokia1830 Photonic Service Switch Product
Information and Planning Guide and the Nokia1830 Photonic Service Switch User
Provisioning Guide for more information.

9.6.4 1830 PSS-16II shelves

The 1830 PSS-16II is an 8 RU shelf with 22 slots that supports up to eight full-height or
up to 16 half-height universal I/O cards, using 16 half-slots for universal I/O cards. Two
half-slots can be combined into a single full-height slot by removing the detachable
divider that separates the left slot from the right slot.
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The common cards that are supported include: equipment controller cards, PF DC cards,
one user panel, and one fan unit. All the OTs and optical cards supported on the 1830
PSS-16 and the 1830 PSS-32 shelves are supported on the 1830 PSS-16II shelf.

The shelves that are supported include: the 1830 PSS-16II as master or subtending
shelf, SFD44, SFD44B, ITLB, ITLU, DCM, and the clip-on shelf. The 1830 VWM clip-on
shelf is connected using a USB connection from the EC card. The SFD2 and SFD4
cards are connected from the VWM-DW shelf and the SFC4 and SFC8 cards are
connected from the VWM-CW shelf.

9.6.5 1830 PSS-8 shelves

The 1830 PSS-8 shelf has an overall depth of 325 mm. The shelf is 33 mm high and 439
mm wide. The 1830 PSS-8 shelf has slots 1 and 7 dedicated to power filter modules,
and slots 6 and 12 dedicated to integrated shelf controllers. Slot 12 can also be used for
user panel card when the protection EC is not installed in the master shelf. The electrical
shelf-ID for user panel is 40. There are eight half-slots (2 to 5, 8 to 11) capable of
supporting universal I/O cards. Two half-slots (left and right) can be combined into a
single full-height slot by removing the divider that separates the left slot from the right
slot. Slot 13 is for the user panel and slot 14 is for the fan unit

See 9.7 “To configure a WDM shelf” (p. 117) for more information about configuring the
1830 PSS shelves.

Fan unit

The Fan units used in the 1830 PSS-8 shelf are controlled by the active EC through
backplane links. The EC determines the speed of the fan motors on the fan unit. A local
microcontroller control and monitor each associated fan motor.

Power filter cards

The 1830 PSS-8 shelf supports AC and DC power filter cards. The PF-AC card, 8AC7,
accepts AC input and provides power supply to other parts of the shelf. The PF-DC card,
F8DC30, accepts DC input and provides power supply to other parts of the shelf.

NFM-P supports the configuration of the AC and DC power filter cards in slot 1 by setting
the PFA Expected parameter value to AC7 or DC30 on the Shelf (Edit) form. The card
object in slot 1 changes to PFAC or PFDC on the equipment tree, depending on the PFA
Expected parameter setting.

NFM-P supports the configuration of the AC and DC power filter cards in slot 7 by setting
the PFB Expected parameter value to AC7 or DC30 on the Shelf (Edit) form. The card
object in slot 7 changes to PFAC or PFDC on the equipment tree, depending on the PFB
Expected parameter setting.

NFM-P 1830 PSS WDM shelves

Release 17.3
April 2017
Issue 2 1153HE-12002-AAAA-TQZZA



See 9.25 “To configure a card on a WDM shelf” (p. 138) for more information about
configuring a card.

Equipment controller

Each 1830 PSS-8 shelf contains at least one active EC. A standby EC can be configured
and equipped to provide controller redundancy. An1830 PSS-8 can operate normally,
without alarms, with a single EC in each 1830 PSS-8 shelf. EC protection provides both
automatic and user-initiated switch capability.

User panel

The User panel is an optional card that is installed in the protection EC slot in 1830
PSS-8 master shelf.

9.6.6 1830 PSS-4 shelves

The 1830 PSS-4 provides a modular platform with four universal slots that can be used
for cards that support ILAs, and various FOADM and terminal configurations. The 1830
PSS-4 supports DCM shelves. The 1830 PSS-4 shelf is two RU high and can be
mounted in EIA, ETSI, or WECO racks. See the Nokia 1830 Photonic Service Switch 4
(PSS-4) User Guide for more information.

9.6.7 1830 PSS-1 AHP shelves

The 1830 PSS-1 AHP system supports the following types of shelves: Universal and
DCM.

9.6.8 MSH8-FSM shelf

The Mesh 8 degrees Fiber Shuffle Module is a rack mounted, 3 RU, passive shelf. All of
the front plate optical connectors are Multi-Push On fiber connectors with 12 fibers. The
MSH8-FSM card is used to provide fiber shuffle between degrees, to and from the
multicast switch add-drop blocks, and to the expansion layer of the CDC-F configuration.
NFM-P supports the configuration of the MSH8-FSM shelf on the 1830 PSS-32 devices.

The MSH8-FSM card, the MPO ports, and the LC ports are automatically configured
during the shelf configuration.

NFM-P supports modifying and viewing the following MPO port attributes on the MSH8-
FSM card:

• WSS(1-8)ADD1OUT

• WSS(1-8)DROP1IN

• WSS(1-8)ADD2OUT

• WSS(1-8)DROP2IN

• WSS1TO4AD(1-12)
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• WSS5TO8AD(1-12)

The eight LC ports are dimmed and not available for configuration.

9.6.9 Shelf objects

Shelf objects represent the hardware that is configured on a shelf. When you choose the
shelf object in the navigation tree and click on Properties in the contextual menu, you
can view the following information about the shelf:

• general information • statistics

• fan tray state and speed • dry contacts

• power supply tray statuses • faults

• LED statuses • port segregation

• card slots • software control module

• hardware environment • software bank

• timing • cross-connects

9.7 To configure a WDM shelf

9.7.1 Steps

1

On the equipment tree, expand Network→1830 PSS.

2

Right-click on the 1830 PSS device object and choose Configure Shelf. The Shelf,
Configure Shelf, (Create) form opens.

3

Configure the required parameters in the Shelf Details panel.

Note: During the creation of an ITLB shelf, one ITLB card slot is automatically
provisioned.

4

Save your changes and close the form.

END OF STEPS
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9.8 1830 PSS OCS shelves

9.8.1 Introduction

The 1830 PSS-36 and 1830 PSS-64 shelves provide the framework for the configuration
of the 1830 PSS-36 and 1830 PSS-64 devices. The main shelf provides card slots, fiber
management trays, backplane, power distribution, and cooling for the devices.

The 1830 PSS-36 and 1830 PSS-64 are composed of a main shelf and expansion
shelves. Expansion shelves connect to the main shelf using a protected internal LAN
communication link. The main shelf provides a framework for the active modules in a
system, for example, the controller and interface cards. Switching can be performed until
the matrix card capacity is reached.

See the Nokia1830 Photonic Service Switch Product Information and Planning Guide
and the Nokia1830 Photonic Service Switch User Provisioning Guide for more
information.

9.8.2 1830 PSS-36 shelves

The 1830 PSS-36 has one high-speed backplane with 16 I/O card slots.

The dedicated card slots on the 1830 PSS-36 support the following cards:

• MT1T9C—matrix cards

• FLC36EA—first-level controller cards

• BT36—bus termination cards

• PSFC—power supply, filter, and clock interface cards

• FAN3T8—fan unit

See the Nokia1830 Photonic Service Switch Product Information and Planning Guide
and the Nokia1830 Photonic Service Switch User Provisioning Guide for more
information.

9.8.3 1830 PSS-64 shelves

The 1830 PSS-64 has one high-speed and two low-speed backplanes with 32 I/O card
slots.

The dedicated card slots on the 1830 PSS-64 support the following cards:

• MT1T9—matrix cards

• FLC64—first-level controller cards

• BT3T8/BTC3T8—bus termination cards

• PSF3T8—power supply, filter, and clock interface cards

• FAN3T8—fan units

1830 PSS OCS shelves NFM-P
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See the Nokia1830 Photonic Service Switch Product Information and Planning Guide
and the Nokia1830 Photonic Service Switch User Provisioning Guide for more
information.

9.9 To configure an OCS shelf

9.9.1 Steps

1

On the equipment tree, expand Network→1830 PSS.

2

Right-click on an 1830 PSS device object and choose Configure Shelf. The Shelf,
Configure Shelf (Create) form opens.

3

Configure the required parameters in the Shelf Details panel.

4

If the Shelf Type parameter is configured as 1830 PSS 36 Shelf in Step 3 , configure
the Air Flow parameter, then go to Step 6 .

5

If the Shelf Type parameter is configured as 1830 PSS 64 Shelf in Step 3 , configure
the required parameters:

• TRU Type

• TRU Shelf ID

Note:

The TRU Shelf ID parameter can be configured as a value between 128 to 255, if
the TRU Type parameter is not None.

When an 1830 PSS-64 device is configured with TRU shelf, the HPCFAP card is
configured automatically under the 1830 PSS TRU Shelf on the navigation tree.
See the Nokia 1830 Photonic Service Switch Product Information and Planning
Guide for more information about the HPCFAP card.

6

Select an Alarm Profile.

7

Configure the Matrix Size (Gbps) parameter in the Switching Capacity panel.
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8

Save your changes and close the form.

END OF STEPS

9.10 To remove a shelf

9.10.1 Steps

1

On the equipment tree, expand Network→1830 PSS.

2

Right-click on the shelf and choose Remove Shelf. A dialog box appears.

3

Click on View Dependencies. An Information form displays the dependencies that
affect the removal of the shelf.

4

Select “I understand the implications of this action” check box and click Yes. The
shelf is removed from the network object.

END OF STEPS

9.11 VWM-CW and VWM-DW shelves

9.11.1 Introduction

The 1830 PSS-8 and the 1830 PSS-16 shelves support CWDM and DWDM clip-on
shelves. NFM-P supports the configuration of the VWM-CW (the CWDM clip-on shelf)
and the VWM-DW (the DWDM clip-on shelf). See 9.7 “To configure a WDM shelf”
(p. 117) for more information about configuring the 1830 PSS shelves. Both CWDM and
DWDM clip-on shelves are managed and powered by a USB interface on the 1830
PSS-8 or 1830 PSS-16 EC faceplate.

A single 1830 PSS-8 or 1830 PSS-16 EC can subtend up to three VWM-CW clip-on
shelves through USB interfaces.

NFM-P supports the configuration of the following EC and SFC cards in the VWM-CW
shelves:

• EC-CW—slot 1

• SFC4A—slot 2 and 3
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• SFC4B—slot 2 and 3

• SFC8—slot 2 and 3

A partially protected 1830 PSS-8 EC can subtend up to two VWM-DW clip-on shelves
through a USB interface. An unprotected 1830 PSS-8 EC can subtend up to three
VWM-DW clip-on shelves through a USB interface. NFM-P supports the configuration of
the following EC and SFD cards in the VWM-DW shelves:

• EC-DW
• SFD2A
• SFD2B
• SFD2C
• SFD2D
• SFD2E
• SFD2F
• SFD2G
• SFD2H
• SFD2I
• SFD2L
• SFD2M
• SFD2N
• SFD2O
• SFD2P

• SFD2Q
• SFD2R
• SFD4A
• SFD4B
• SFD4C
• SFD4D
• SFD4E
• SFD4F
• SFD4G
• SFD4H
• SFD8A
• SFD8B
• SFD8C
• SFD8D

See 9.12 “To associate an 1830 PSS-8 EC with a clip-on shelf” (p. 121) for more
information about the association of the 1830 PSS-8 EC with the clip-on shelves.

9.11.2 SFC and SFD cards on clip-on shelves

The SFC and SFD cards on the clip-on shelves can be used as replacement or
extensions of the SFC and SFD cards on the 1830 PSS-8 or 1830 PSS-16II shelves.
NFM-P supports the configuration of the SFC and SFD cards. See 9.25 “To configure a
card on a WDM shelf” (p. 138) for more information about configuring a card.

9.12 To associate an 1830 PSS-8 EC with a clip-on shelf

9.12.1 Steps

1

On the equipment tree, expand Network→1830 PSS-8 object→VWM-CW or
VWM-DW Shelf→EC-CW or EC-DW card object.

2

Right-click on the EC-CW or EC-DW card and choose Properties. The Card Slot
(Edit) form opens.
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3

Click on the Card Specifics tab and select an EC card to associate with the clip-on
shelf on the Card Details panel.

4

Configure the Clip-On Shelf ID parameter.

5

Save the changes and close the forms.

END OF STEPS
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Managing cards

9.13 1830 PSS cards

9.13.1 Overview

NFM-P GUI supports view, modify, create, and delete card level functions, and the pre-
provisioning of a card in an empty slot. See Table 39, “Cards and ports supporting PM
data” (p. 401) for transmission cards supported on the universal shelf. See Table 40,
“Dedicated cards and ports” (p. 405) for dedicated cards required to boot the 1830 PSS.
See the NSP NFM-P Optical Parameter Reference for more information about
parameters.

Note: You must use filler blanks in slots that are not used for the required airflow and
cooling.

To provision two-slot height cards and two-slot width cards, the adjacent slots must be
empty.

9.14 Equipment protection group

9.14.1 Overview

An 1830 PSS OCS device has the following 1+1 protection group for matrix and FLC
cards:

• On an 1830 PSS-64:

— Active matrix card in card slot 71 and standby matrix card in card slot 72, or the
converse

— Active FLC card in card slot 75 and standby FLC card in card slot 73, or the
converse

• On an 1830 PSS-36:

— Active matrix card in card slot 11 and standby matrix card in card slot 15, or the
converse

— Active FLC card in card slot 23 and standby FLC card in card slot 40, or the
converse

See the Nokia 1830 PSS User Provisioning Guide for more information about equipment
protection group and switching.

An 1830 PSS OCS device switches between the active and standby matrix or FLC cards
in two ways— automatic switching and external switching. See the Nokia 1830 PSS
Product Information and Planning guide for more information about automatic switching.

NFM-P allows you to configure external switching on the matrix and FLC cards of an
1830 PSS OCS device. See 9.28 “To switch between active and standby matrix and
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FLC cards on an OCS device” (p. 59) for more information about configuring an
equipment protection switch.

9.15 32EC2E and 8EC2E cards

9.15.1 Introduction

NFM-P supports the configuration of the following EC cards:

• 32EC2E card is supported on

— 1830 PSS-16II in the 2 and 18 card slots

— 1830 PSS-32 in the 1 and 18 card slots

• 8EC2E card is supported on 1830 PSS-8 in the 6 and 12 card slots.

The 32EC2E and 8EC2E are encrypted controllers that are configured in ANSSI QS
devices. An ANSSI QS device is either an 1830 PSS-32 or an 1830 PSS-8 shelf or a
combination of both. The devices are managed using SNMPv3 that requires an
authentication and encryption method such as SSH assigned to each user for validation
by the device.

See 7.3 “Workflow to discover 1830 PSS devices” (p. 59) for more information about
managing the devices using SNMPv3.

9.16 Raman 3 external amplifier

9.16.1 Hardware

The RA3P external amplifier is used for long span masking in the 1830 PSS terrestrial
applications. An RA3P amplifier contains Field Programmable Gate Array (FPGA) and
microprocessor-controlled Raman pump module for C-Band (1528.4 nm to 1564.7 nm)
distributed Raman amplification. The pump module includes three-pump laser diodes at
different wavelengths and polarizations.

The RA3P is an external pizza-box. It is not part of the 1830 PSS shelf, but is installed in
an Optinex ETSI rack, EIA cabinet, and 19–in or 23–in bay frames.

The output port of each RA3P is connected to the ingress LD of the co-located 1830
PSS-32 device (TOADM, ROADM, FOADM, or a line-repeater site).

9.16.2 Supported LD cards

The following LD cards can be connected to RA3P:

• A2325A

• AHPHG

• AHPLG
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• ALPHG

The External Amp IP Address In and External Amp IP Address Out parameters on the
Connection panel in the Physical Port→Port Specifics→General form of the LD card Line
port displays the connectivity to Raman 3 external amplifier.

9.17 Amplifier and associated cards

9.17.1 ASWG and A4WSG cards

NFM-P supports viewing and modifying the ASWG and A4PWSG ports that function as
unidirectional LD ports with the following additional functions:

• The EDFA module monitors both low and medium power gain ranges.

• The OTDRRX and OTDRTX ports provide connections to an OTDR card. OTDR
monitoring is used for characterization of the fiber plant, and for locating fiber cuts.

The following ports are automatically configured during the card configuration:

• LINEIN
• OTDRRX
• OTDRTX

• LINEOUT
• OSCSFP
• OSC

The received optical power of the OSC is displayed for the OSCSFP port. If the
OSCSFP port on the ASWG or A4PWSG card is assigned, the LINEIN port can only be
connected as an external connection. The A4PWSG is a Raman amplifier with four
Raman pumps unlike the AWSG card, which is not a Raman amplifier.

9.17.2 Flexgrid parameters in amplifier cards

NFM-P supports viewing flexgrid parameters for ports on the following LDs and
IROADMs when the Opposite Direction Port parameter is set or for the line ports when
the “Internal Port is Valid XC Endpoint” is true:

• A2325A, AA2DONW, AHPHG, AHPLG, ALPHG, and OSCT: LINE ports

• A2P2125, A4PSWG, AM2032A, AM2125A, AM2125B, AM2318A, AM2625A, ASWG,
AWBILA, IROADMF, IROADMV: LINEIN, LINEOUT ports

• AWBEGR: LINEOUT

• AWBING: LINEIN

• RA2P, RA5P: LINEIN ports

9.17.3 CUSTLAN Port

NFM-P supports the configuration of the CUSTLAN port parameters in the amplifier
cards. The port is automatically created and deleted with the card. Both the Provisioned
Link Speed parameter and the Provisioned Duplex Mode parameter need to be set to
Auto, or not to Auto.
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9.17.4 OTDRRX and OTDRTX Ports

NFM-P supports the configuration of OTDRRX and OTDRTX ports in the following
amplifier cards:

• A4PSWG

• ASWG

• AWBILA

• AWBING

• MON-OTDR

9.17.5 OTDR cards

NFM-P supports configuration of the Connected LD OTDR Port parameter on OTDR P
(1 to 8) ports. The P (1 to 8) ports are automatically created and deleted with the card.
The OTDR card is used with the LD cards that has OTDR ports.

9.17.6 MON-OTDR cards

The MON-OTDR card provides functions to the legacy amplifier cards that the OTDR
cards provide to the ASWG and A4WSG cards. The SIGIN port of the MON-OTDR card
must be associated with the LINEOUT, LINE, SIG port of the amplifier card, as required.
The SIGOUT port of the MON-OTDR card must be associated with the LINEIN, LINE,
SIG port of the amplifier card, as required. The OTDRRX and OTDRTX must be
associated with one of P1 through P8 ports of the OTDR card.

The amplifier cards that can be associated with the MON-OTDR cards include the
following:

• A2325A
• AHPHG
• AHPLG
• AM2032A

• AM2125A
• AM2318A
• AM2625A
• RA2P

You can perform an OTDR scan on the LINEIN, LINEOUT, LINE, or SIG port of the
amplifier that is associated with the SIGIN or SIGOUT port of a MON-OTDR card. See
“OTDR” (p. 452) for more information.

9.17.7 AAR-8A card

The AAR-8A card is connected between the MSH8-FSM and the MCS8-16 to provide
add-drop direction amplification in the CDC-F ROADM configuration. The AAR-8A card
provides four drop paths and four add paths. On each path, a nominal fixed-gain EDFA
optical amplifier amplifies the signal.

NFM-P supports modifying and viewing the following ports:

• AAR-8A AMPIN(1-8) ports
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• AAR-8A AMPOUT(1-8) ports

• AAR-8A FSM port

• AAR-8A MCS port

The 1-4 AMPIN and AMPOUT ports are used for drop amplification, and the 5-8 ports
are used for add amplification. The ASE Mode parameter on the Port Specifics tab of the
AMPOUT Physical Port (Edit) form can be configured to Yes to provide constant power.
If you set the ASE Mode to Yes, the Operating Mode parameter is automatically set to
Power. If you set the ASE Mode parameter to No, the Operating Mode parameter is
automatically set to Gain. The Power Setting parameter can be configured only when the
ASE Mode is set to Yes.

The FSM port connects to the AD ports on the MSH8-FSM. The MCS port connects to
the MCS8-16 at the AAR1 or AAR2 port in its MCS add-drop block.

9.17.8 MON-OCM cards

NFM-P supports MON-OCM card configuration. The MON-OCM card is used to provide
signals to the WTOCMx cards and to the associated external optical monitoring device
(for example, to an optical spectrum analyzer). The MON-OCM card splits the monitored
DWDM optical signal from the MON port of an LD into two paths: one to the WTOCMx
card for optical channel monitoring and the other to the customer monitoring equipment.
The MON-OCM is configured between the WTOCMx and the amplifier cards. Supported
amplifier cards include:

• AM2125A
• AM2125B
• AM2318A
• A2P2125

• AM2032A
• AM2625A
• ASWG
• A4PSWG

9.17.9 Integrated ROADM cards

The IROADM card is a single-slot full-height card that provides compact integration of
the following functionality into a single card:

• ingress and egress amplifiers

• ROADM capable of 4 degrees

• wavelength selective switch for the add or express-add paths

• optical splitter for the drop or express-drop paths

The two variants of the IROADM card are:

• IROADM-Fixed—for low-loss spans

• IROADM-Variable—for higher loss spans
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The IROADM-Fixed card has a fixed-gain built-in amplifier, which supports shorter span
reach. The IROADM-Variable card has a variable-gain built-in amplifier, which has a
wider gain range that can support longer span reach.

NFM-P supports the configuration of the IROADM-Fixed and IROADM-Variable cards on
the 1830 PSS-8, 1830 PSS-16, 1830 PSS-16II, and 1830 PSS-32 devices.

9.18 Client line cards for WDM devices

9.18.1 Introduction

NFM-P supports the configuration of client line cards. The client line configurations
consist of a combination of interconnected 20P200 and 1UD200 cards in the 1830
PSS-8 or 1830 PSS-16II shelves. The interconnection is through multiple backplane
connections to the adjacent slot or one slot over. See 9.25 “To configure a card on a
WDM shelf” (p. 138) for more information about configuring the client line cards. Set the
Assigned Card Type parameter to Optical Client/Line Cards.

9.18.2 1UD200 card

The 1UD200 is a single-slot uplink card with second-generation 100GigE coherent optics
and a backplane interface configured on the 1830 PSS-8 or the 1830 PSS-16II shelves.
For long reach applications, the 1UD200 card supports a 100GigE mode, which provides
Polarization Division Multiplexing - Quaternary Phase Shift Keying (PDM-QPSK) on the
DWDM line interface. For high capacity applications with less demanding reach
requirements, the 1UD200 card supports a 200GigE mode, which provides Polarization
Division Multiplexing - 16 Quadrature Amplitude Modulation (PDM -16 QAM) on the
DWDM line interface.

When the Assigned Rate parameter of the L1 port is set to OTU4, the card supports the
100GigE mode and when the Assigned Rate parameter is set to OTU4X2, the card
supports the 200GigE mode.

9.18.3 20P200 card

The 20P200 is a very-high-density 10 GigE any-rate card with 20 SFP+ ports. It is a
single-slot, full-height card that is used to support the 1UD200 card for 200G uplink
applications. It can also act as a standalone 10G transponder card to support 20x10G
add/drop links with ODU switching and grooming capabilities.

20P200 Backplane Ports

The 20P200 card has two backplane (electrical) ports, BP 1 and BP 2 that support the
following assigned rates:

• Interlaken
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Interlaken is configured for interconnection with another 20P200 card. Two cards can
communicate using the Interlaken interface, only when the same port types are
configured as Interlaken. For example, BP1 ports on both the cards participating in
the interconnection should be configured as Interlaken. Similarly, BP 2 on both the
cards should be Interlaken. It is not possible to communicate when the ports
participating in the interconnection are BP1 on one card configured as Interlaken and
BP2 on another card configured as Interlaken.

• OTL4.10

OTL4.10 is configured for interconnection with 1UD200 cards.

The BP1 port is connected from Flex framer 1 (FF 1) to the upper half-slot crossbar
switch. The BP2 port is connected from Flex framer 2 (FF 2) to the lower half-slot
crossbar switch. The Interlaken interconnection between FF 1 and FF 2 has 200 G
capacity. You can view the inter-FF capacity for the 20P200 card with the maximum
bandwidth of 120 G. The Max Inter-FF Capacity (G) and Consumed Inter-FF Capacity
are read-only parameters in the Card Details panel on the Card Specifics tab of the
20P200 Card Slot (Edit) form.

9.19 OCS cards

9.19.1 Introduction

This section describes the procedures for card slot provisioning. NFM-P GUI supports
viewing, modifying, creating, and deleting card slot level functions, and configuring a
card in an empty slot.

The following dedicated cards can be viewed on NFM-P GUI for the OCS shelves:

• agnostic matrix

• first-level controller

• power supply filter

• fan unit

• bus termination card

9.19.2 Agnostic matrix cards

The matrix cards on the 1830 PSS-36 and 1830 PSS-64 OCS shelves can operate as a
1+1 redundant pair. One of the matrix cards is active and the other is standby.

The following parameters are selected by default in the Secondary State information
under the States panel of the Card Specifics tab of the card properties form:

• Working—for the active matrix card

• Standby Hot—for the standby matrix card

In the navigation tree of NFM-P, two MT1T9C cards are configured by default in card
slots 11 and 15 on the 1830 PSS-36 device and two MT1T9 cards in card slots 71 and
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72 on the 1830 PSS-64 device.

9.19.3 First-level controller cards

In the navigation tree of NFM-P, two FLC36EA cards are configured by default in card
slots 23 and 40 on the 1830 PSS-36 device and two FLC64 cards in card slots 73 and
75 on the 1830 PSS-64 device.

9.19.4 Bus termination cards

In the navigation tree of NFM-P, two BT36 cards are configured by default in card slots
42 and 43 on the 1830 PSS-36 device, four BT3T8 cards in card slots 81, 82, 85, and 86
on the 1830 PSS-64 device, and two BTC3T8 cards in card slots 83 and 84 on the 1830
PSS-64 device.

9.19.5 Power supply filter cards

In the navigation tree of NFM-P, two PSFC cards are configured by default in card slots
44 and 45 on the 1830 PSS-36 device and two PSF3T8 cards in card slots 91 and 94 on
the 1830 PSS-64 device.

9.19.6 Fan units

In the navigation tree of NFM-P, one FAN3T8 card is configured by default in card slot 41
on the 1830 PSS-36 device and two FAN3T8 cards in card slots 92 and 93 on the 1830
PSS-64 device.

9.19.7 I/O cards

The I/O cards signal and transport varying data formats and rates across the network.
The I/O cards that can be configured using NFM-P on the 1830 PSS-36 and 1830
PSS-64 devices include:

• 1AN100G
• 2AN40G
• 2ANQ40G
• 4AN10G

• 8ET1GB
• 10AN10G
• 10AN10GC

• 10ET10G
• 10ET10GC
• 10OTH10G

• 24ANM
• 24ET1GB
• 24ET1G

The 1AN100G card can be configured on the 1830 PSS-36 or 1830 PSS-64, Release
7.0.1 or later. The 10AN10GC and 10ET10GC cards can be configured on the 1830
PSS-36 or 1830 PSS-64, Release 8.0 or later

The 2ANQ40G card supports optical multilane pluggable modules: SR42W41GEUC for
the 40GbE assigned rate and LR42W43GAUC for the 40GbE and OTU-3 assigned
rates.
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9.19.8 Uplink cards

The uplink cards are used for connecting and interworking with the WDM systems. On
the 1830 PSS-64, the uplink cards are configured on the lower row by default, that is,
from card slot 33 to card slot 64. You can also configure the uplink cards on the upper
row, that is, from card slot 1 to 16, by configuring the Environmental Conditions
Restricted parameter. See 9.27 “To configure uplink cards on the upper row of the 1830
PSS-64” (p. 141) for more information about configuring uplink cards on the upper row of
the 1830 PSS-64 device.

The following uplink cards are supported on the 1830 PSS-36 and 1830 PSS-64
devices:

• 11QCUP
• 11QCUPC
• 43SCUP

• 130SCUP
• 130SCUPB
• 130SCUPC

The 130SCUPC card is similar to the 130SCUP and 130SCUPB cards, but has a faster
payload restructuring. The 130SCUPC can interwork with the following OTs and uplink
cards:

• 112SCA1(AFEC only with asymmetric flag
set)

• 112SCX10 (AFEC only with asymmetric flag
set)

• 112SNA1 (AFEC only with asymmetric flag
set)

• 112SNX10 (AFEC only with asymmetric flag
set)

• 260SCX2 in 130G mode (SDFEC only)

• 130SCUP,130SCUPB (SDFEC only)
• 130SCUPC (SDFEC only)
• 130SCX10 (SDFEC only)
• 130SNX10 (SDFEC only)

9.19.9 Filter card

The SFC8 filter card can be configured in any I/O card slot on the 1830 PSS-36 and
1830 PSS-64.

For more information about the cards supported on the 1830 PSS-36 and 1830 PSS-64
devices, see the Nokia 1830 Photonic Service Switch Product Information and Planning
Guide.

9.20 Optical transponder cards

9.20.1 OPS cards

The OPS cards provide photonic protection switching in DWDM configurations for any
supported channel in the C-band, allowing users to provide 1+1 dedicated OCh
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protection for any optical signal carried in the Nokia 1830 PSS DWDM domain. The
optical protection switch (OPS) packs (OPSA and OPSB) are implemented as half-height
modules that can be configured in any universal slots in the universal shelves. See
9.23 “To configure an OPSA card” (p. 137) for more information about OPSA card
configuration.

9.20.2 230SCX card

The 260SCX2 card operates in the following modes:

• 100GbE

• OTU4

When the card is configured in 100 GbE mode, the card capacity can be set to either
100 GbE or 200 GbE, based on the line rate. If the line rate is configured as the OTU4
rate, only the C1 client port that is set to the 100 GbE rate is available. If the line rate is
configured as the OTU4x2 rate, both the C1 and the C2 client ports that are set to
100GbE rates are available.

When the card is configured in OTU4 mode, the card capacity is 100GbE and the line
rate is OTU4. Only the C1 client port set to the OTU4 rate is available.

Note:

The following configurations are not supported on the 260SCX2 card:

• 260 GbE mode with two OTU4 clients at the same time

• 260 GbE mode with one OTU4 client and one 100 GbE client at the same time

• 260 GbE mode with one OTU4 client

See 9.31 “To configure the card mode for the 260SCX2 card” (p. 145) for more
information about how to configure the card mode for the 260SCX2 card.

9.20.3 D5X500 card

The D5X500 card works both as an uplink card and a muxponder on the 1830 PSS-16II
and 1830 PSS-32 devices.

The D5X500 card supports the configuration of an OTU4 and OTU4x2 rate on the L1
port. After you assign the OTU4x2 rate on the L1 port, five OTU4 facilities are created on
the equipment navigation tree and the L2 port gets auto-assigned to the OTU4x2 rate.

The five client ports (C1 to C5) support a rate of 100GbE LAN and OTU4. The OTU4-1
and OTU4-3 are the functional facilities out of the five OTU (OTU-1 to OTU-5) facilities.
After the first client port is provisioned, you can only provision that assigned rate for
subsequent ports. Assigning the first client port causes an FPGA download and cold
reboot of the card.
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The D5X500 card supports 16QAM (1830 PSS, version 8.2.2 and later) a-nd 8QAM
encoding types on the OTU4x2 port. You can configure the encoding type only on the L1
port. The L2 port is configured automatically with the same value. To change the
encoding value of the line port from 8QAM to 16QAM and conversely, configure the
Encoding parameter in the OTU panel of the Port Specifics→General sub-tab to
Unassigned, then to 16QAM or 8QAM, as required in the Physical Port (Edit) form for L1
port.

The D5X500 card supports QPSK and SP-QPSK encoding types on the OTU4 line port.
You can configure the encoding type only on the L1 port. The L2 port is configured
automatically with the same value. To change the Encoding type, provision the L1 line
port as OTU4 and change the encoding type to QPSK/SP-QPSK in the Port
Specifics→General sub-tab of the Physical Port (Edit) form.

NFM-P supports the configuration of the dispersion compensation parameter on the
OTU4 port. Configure the CD Pre-Compensation (ps/m) parameter in the OTU panel of
the Port Specifics→General sub-tab in the Physical Port (Edit) form.

9.20.4 D5X500 card functional variants

NFM-P supports the configuration of the following functional variants of the D5X500
card:

• D5X500-100GBE_BJFEC

• D5X500-100GBE_BKP400

• D5X500-100GBE_Prop

• D5X500-OTU4_Prop

The following signal rates are supported on the line ports:

• OTU4

• OTU4x2

• OTU4Half

• OTU4Halfx5

The following signal rates are supported on the client ports:

• D5X500-100GBE_BJFEC - 100GbE LAN

• D5X500-100GBE_BKP400 - 100GbE LAN

• D5X500-100GBE_Prop - 100GbE LAN

• D5X500-OTU4_Prop - OTU4

You can configure the flexgrid transmit frequency for line ports in the OT panel on the
Port Specifics→General tab of the Physical Port (Edit) form. The configuration of trails
and services is not supported. The configuration of cross-connection is supported.
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The modulation formats supported are as follows:

Table 8 Modulation formats supported

Modulation format L1 port L2 port

8QAM OTU4x2 OTU4x2

16QAM (16QAM_ 200G) OTU4x2 OTU4x2

QPSK (DP-QPSK) OTU4 OTU4

SP-QPSK OTU4 OTU4

16QAM (16QAM_ 250G) OTU4Halfx5 OTU4Halfx5

BPSK OTU4Half OTU4Half

You can configure the Card Mode parameter on the Card Specifics→General tab of the
Card Slot (Edit) form.

If... then...

the Card Mode parameter is configured as:
• 100GbE_BJFEC
• 100GbE_BKP400
• 100GbE_Prop

only 100GbE LAN client rate is supported

the Card Mode parameter is configured as
OTU4_Prop

only OTU4 client rate is supported

9.20.5 S13X100E card

NFM-P supports the configuration of the single-slot wide, full-height S13X100E card in
the 1830 PSS-32, 1830 PSS-16II, and 1830 PSS-8 devices. You can configure the
S13X100E card in any card slot of the supported shelf types except slot 10 in the 1830
PSS-32 shelf.

NFM-P supports the following signal rates for client ports:

• C{1-10}: 10GbE LAN, OC192, OTU2, OTU2e, STM64, 10GbE LAN(ODU2), and
10GbE LAN(ODU2E)

• C21: 100GbE LAN, and OTU4

• C31: 40GbE LAN

• C32: 40GbE LAN, 100GbE LAN, and OTU4

The following rules apply when you configure the client ports:

• If the first client port configured is of type 100GbE LAN or OTU4, no other client ports
can be configured.

Optical transponder cards NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

134 Issue 2



• If the first client port configured is of type 40GbE LAN (C31 or C32), only another
40GbE LAN port (C32 or C31) can be configured. No other client ports can be
configured.

• If the first client port configured is one of C{1-10}, then C21, C31 and C32 cannot be
configured.

9.20.6 MVAC cards

NFM-P supports configuring the VOA Mode parameter to either Power or Attenuation on
the Port Specifics→General tab of the Physical Port (Edit) form for the G1 to G8 ports on
the MVAC card. When the VOA Mode parameter is configured to Power, the Attenuation
(dB) parameter cannot be configured. When the VOA Mode parameter is configured to
Attenuation, you can configure the Attenuation (dB) parameter from 0 to 10 dB, allowing
you to increase the optical power at the receiving end of the fiber link. The default value
is 0 dB.

You can also connect the supported ingress LD ports to the MVAC G ports by selecting
the ports on the Connected to Port panel of the Port Specifics→General tab of the
Physical Port (Edit) form.

You can configure the VOA Mode parameter when:

• there are no internal optical links to or from the port

• the port Administrative State parameter value is Down or Maintenance

You can configure the Attenuation (dB) parameter when:

• VOA Mode parameter is set to Attenuation

• port Administrative State parameter value is Up or Maintenance

Note:

When the port Administrative State parameter value changes from Up to Down or
Maintenance, the configured attenuation value is retained.

When the VOA Mode parameter is set to Attenuation:

• ensure that the Pluggable Module Type parameter is configured to sVOA on the
Physical Port (Edit) form

• receive power and transmit power are not applicable

• connection information attributes are not applicable

• opposite direction port is not applicable

• wave key encoder attributes are not applicable

• performance monitoring is not supported
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9.21 TDM cards

9.21.1 Introduction

NFM-P supports the configuration of the following TDM cards on an 1830 PSS-36 or
1830 PSS-64 device:

• 10SD10G

• 24SDM

These cards help in providing a gateway from and to SDH to OTN using VC timeslots at
a device level. See Chapter 11, “SDH trails and services” for more information.

9.22 Wavelength router cards

9.22.1 MCS8-16 card

The MCS8-16 card is a multicast switch card used with the AAR-8A card to provide MCS
add-drop blocks for the colorless, directionless, and contentionless flexible grid ROADM
configuration.

NFM-P supports modifying and viewing the following ports:

• MCS8-16 AD (1-16) ports

• MCS8-16 SIG (1-8) ports

• MCS8-16 AAR1 port

• MCS8-16 AAR2 port

The AD ports direct the signals to SIG ports in the add direction and receive signals from
SIG ports in the drop direction. The Force Routing Add/Drop parameter on the Port
Specifics→General tab of the Physical Port (Edit) form is configured to route the signal
to a specific SIG port.

The SIG ports combine signals from the AD ports and direct the signals to AAR-8A
cards. The SIG ports also receive signals from an AAR-8A packs and split the signals to
the AD ports for selection.

The MPO ports AAR1 and AAR2 amplify signals to and from the MCS add/drop blocks.

TDM cards NFM-P
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9.22.2 WR20-TFM card

The WR20-TFM card is a twin 1x20 WSS flex capable card with MPO connectors.

NFM-P supports modifying and viewing the following ports of the WR20-TFM card:

• SIG port

• two 1x20 wavelength selective switches in a single optical module, called twin WSS.
Eight ports are used for add, drop, or through paths and the remaining 12 ports are
used for add-drop paths.

— ADT(1-8) ports

— AD(9-20) portsThe 20 ports are connected to the four MPO ports.

• MPO ports

The MPO port is known as a multi-port and supports 12 positions where the
underlying ports connect. Some of the positions are not used on a specific multi-port.

— DROP1OUT

— DROP2OUT

— ADD1IN

— ADD2IN

9.23 To configure an OPSA card

9.23.1 Steps

1

On the equipment tree, expand Network→NE→Shelf→Card Slot (OPSA: Enhanced
Optical Protection Switch Card).

2

Right-click on the card slot and choose Properties. The Card Slot OPSA: Enhanced
Optical Protection Switch Card (Edit) form opens.

3

Click on the Card Specifics tab and choose OMSP or OLP from the Protection Mode
drop-down menu, as applicable.

Note: The default value for the Protection Mode parameter is OCHP.

4

Click Apply to save the changes and close the form.

END OF STEPS
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9.24 To configure an OPSB card

9.24.1 Steps

1

Configure the OPSB card. See 9.25 “To configure a card on a WDM shelf” (p. 138)
for information about configuring a card.

Note: The A, B, and SIG ports are automatically created when the OPSB card
is configured.

2

Configure an optical link from either the OPSB A port or OPSB B port to the OT. See
9.44 “To configure an optical link between ports” (p. 163) for information about
creating an optical link.

The following configuration rules apply for the client ports when creating an optical
link.

• Set the Assigned Rate, Transmit Frequency, Pluggable Module Type, and OPR
mode to be same at the client ports of the working and protection OTs.

• Set the LOS Propagation to LASER OFF.

• Encapsulation Mode can be the same or different at the client ports of the working
and protection OTs.

• Set the Transmit Frequency to either 1310 or 1550.

3

Create an APS group. See 15.55 “To configure an APS group” (p. 356) for
information about creating an APS group.

END OF STEPS

9.25 To configure a card on a WDM shelf

9.25.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf.

2

Right-click on an empty Card Slot object and choose Configure Card. The Card Slot
(Create) form opens.

3
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Configure the required parameters on the General tab.

4

Click Apply to save the changes. The form name changes to Card Slot (Edit) form.

5

Click on the Card Specifics tab.

6

Configure the required parameters in the Card Details panel.

7

Configure the Card Rate Mode parameter for the 11DPE12 card.

8

Configure the required parameters in the Ethernet Loopback panel for the
11DPE12A cards.

9

Configure the Optical Intrusion Detection parameters for the AM2318A and
AM2125B cards. An external topological link must be configured on a line port.

10

Configure the required parameters on the Temperature panel.

11

Configure the Card Mode parameter for the 4DPA4, 112SCA1, 112SNA1, and
1DPP24M cards. The 1DPP24M card is configured only on the 1830 PSS-4 device.

The 1DPP24M card supports the card modes, Master and Slave. The Master mode
provides 21 E1 access points and one line port (STM-1). The Master mode can
support 42 E1 access points (21 E1 from Master mode and 21 E1 from Slave mode
1DPP24M). The Slave mode provides 21 E1 access points. The Line port of the
Slave mode is always set to the unassigned state and is connected to the Master
mode through the backplane.

12

Save your changes and close the form.

END OF STEPS
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9.26 To configure a card on an OCS shelf

9.26.1 When to use

Full-slot I/O cards can be configured in the following card slots:

• 2 to 9, 12, 13, and 16 to 21 on the 1830 PSS-36 device

• 1 to 16 and 33 to 48 on the 1830 PSS-64 device

The uplink cards can be configured in card slots 33 to 48 on the 1830 PSS-64. See
9.27 “To configure uplink cards on the upper row of the 1830 PSS-64” (p. 141) to
configure the uplink cards in card slots 1 to 16 of the 1830 PSS-64.

The dedicated cards, such as the matrix cards, power supply filter cards, bus termination
cards, fan units, and first-level controller cards are configured in the default card slots
automatically when a shelf is configured.

9.26.2 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf.

2

Right-click on an empty Card Slot object and choose Configure Card. The Card Slot
(Create) form opens.

3

Configure the required parameters on the General tab.

4

Click Apply to save the changes.

5

Click on the Card Specifics tab.

6

Configure the required parameters on the Card Details panel.

7

Click on the IO Card tab and configure the Administrative State parameter, if
required.
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8

To view more information about the configured card:

• Click on the Port Group tab to view the port groups. For more information about
port groups, see “Managing ports ” (p. 147) .

• Click on the Ports tab to view the ports on the card.

• Click on the Statistics tab to view the statistics policies associated with the card.

• Click on the Faults tab to view the alarms on the card.

9

Save your changes and close the form.

Note: See the ENT-EQPT State Mismatches subsection in the Nokia 1830
Photonic Service Switch TL1 Commands and Messages Guide (Switching
Applications) Guide for more information about the card slot restrictions.

END OF STEPS

9.27 To configure uplink cards on the upper row of the 1830
PSS-64

9.27.1 Steps

Note: By default, you cannot configure uplink cards on the upper row, that is, in card
slots 1 to 16 of the 1830 PSS-64 device.

1

On the equipment tree, expand Network→1830 PSS-64.

2

Right-click on the 1830 PSS-64 device and choose Properties. The Network Element
(Edit) form opens.

3

Click on the NE Specifics tab.

4

Select the Environmental Conditions Restricted check box.

5

Click OK to confirm and close the form.
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6

On the equipment tree, expand Network→1830 PSS-64→Shelf→Card Slot. Right-
click on the empty upper row card slot and choose Properties. The Card Slot
(Create) form opens.

7

Perform Step 3 to Step 9 of 9.26 “To configure a card on an OCS shelf” (p. 140) to
configure the required uplink card.

Note: See the ENT-EQPT State Mismatches subsection in the Nokia 1830
Photonic Service Switch TL1 Commands and Messages Guide (Switching
Applications) Guide for more information about the card slot restrictions.

END OF STEPS

9.28 To switch between active and standby matrix and FLC
cards on an OCS device

9.28.1 Steps

1

On the equipment tree, expand Network→1830 PSS-36 or 1830 PSS-64→Shelf.

2

Right-click on the shelf and choose Properties. The Shelf (Edit) form opens.

3

Click on the Equipment Protection Group tab.

The first equipment protection group listed is for the matrix cards. The second
equipment protection group is for the FLC cards.

4

Choose a protection group, as required, and click Properties. The Equipment
Protection Group form opens.

5

Configure the protection switch in the Protection Switch panel.

Note: To switch a matrix card, configure the Protection Switch parameter to
Forced Protection Switch or Normal Protection Switch.
To switch an FLC card, configure the Protection Switch parameter to Normal
Protection Switch.
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6

Click Apply. The Group State parameter in the Protection Group Status panel
displays the status of the switch operation.

Note: The switch operation is completed successfully when the active and
standby equipment are swapped in the Protection Group panel.
The protection group can be switched again, only after the Group State
parameter has the value of No Request.

7

If the Forced Protection Switch option is used to switch between active and standby
matrix cards, the Group State displays the status as Forced after the switching is
complete. Configure the Protection Switch parameter as Allow Protection Switch
after the forced switch is complete.

8

Save your changes and close the forms.

END OF STEPS

9.29 To remove a card

9.29.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card.

2

Right-click on the card object and choose Remove Card. A dialog box appears.

3

Select the “I understand the implications of this action” check box and click Yes. The
card is removed from the navigation tree.

END OF STEPS
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9.30 To configure card firmware

9.30.1 Steps

1

Choose Manage→Equipment→Equipment from NFM-P main menu. The Manage
Equipment form opens.

2

Choose Card Firmware (Physical Equipment) from the Object drop-down menu and
click Search. A list of cards managed appears.

3

Choose an entry and click Properties. The Card firmware form opens.

4

Select the provisioned release for the equipped card.

5

Click Properties beside the Slot parameter. The Card Slot (Edit) form opens.

6

Click on the IO Card tab and set the Administrative State parameter to Down.

7

Click Apply to save the changes and close the Card Slot (Edit) form. The Card
firmware Slot form reappears.

8

Click Apply to save the changes and close the Card firmware Slot form. The list of
card reappears.

9

Choose the required card from the list of cards in the Manage Equipment form and

a. click Reboot

b. click Hitless Upgrade

Note:

• After the card is rebooted successfully, the Provisioned Release parameter is
updated with the firmware profile.
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• To perform a card firmware upgrade without interrupting a service
transmission, choose Hitless Upgrade.

• Hitless upgrade is supported for the following cards on an 1830 PSS WDM
device, version 7.0 or later:

• 112SCA1
• 112SCX10
• 112SNA1
• 112SNX10
• 130SCX10
• 130SNQ10
• 130SNX10

• 1UD200
• 20P200
• 260SCX2
• A2325A
• AHPHG
• AHPLG
• AM2032A

• AM2125A
• AM2125B
• AM2318A
• AM2625A

END OF STEPS

9.31 To configure the card mode for the 260SCX2 card

9.31.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf.

2

Configure the 260SCX2-100GEth or 260SCX2-OTU4 card on the required card slot.
See 9.25 “To configure a card on a WDM shelf” (p. 138) .

3

Expand the card slot object to view the ports of the card.

4

Right-click on the line port and choose Properties. The Physical Port (Edit) form
opens.

5

Click on the Port Specifics tab.

6

Configure the Assigned Rate parameter to one of the following, depending on the
card that is configured:

• OTU4

• OTU4x2
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7

Click Apply.

8

Expand the L1 line port object on the navigation tree to view the port objects.

• If the value for the Assigned Rate parameter is configured as OTU4 in Step 6 ,
the CH1-OTU4 object appears below the line port.

• If the value for the Assigned Rate parameter is configured as OTU4x2 in Step 6 ,
the CH1-OTU4 and CH2-OTU4 objects appear below the line port.

9

Change the mode of the 260SCX2 card:

1. On the equipment tree, expand Network→1830 PSS→Shelf→260SCX2-100GEth
or 260SCX2-OTU4 card.

2. Right-click on the card object and choose Properties. The Card Slot (Edit) form
opens.

3. Click on the Card Specifics tab and configure the Card Mode parameter.

10

Save your changes and close the form.

END OF STEPS
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Managing ports

9.32 Overview

9.32.1 Introduction

NFM-P supports a physical topology view that allows you to create a fiber connection by
selecting two ports on the displayed shelves. The connection can be between two ports
on the same shelf or different shelves.

Note: You can create a fiber connection only with ports that are not already part of a
fiber connection.

For an interface (that is, a shelf, slot, or port), you can specify that the interface is:

• connected to another interface on the network element

• connected to an external interface within or outside of the 1830 PSS network

• unconnected

To define the network topology, you first configure the fiber topology on each network
element in the network. You can then connect the external interfaces on each of the
network elements to create the network.

9.33 OCS ports

9.33.1 Introduction

NFM-P supports the following for a port on 1830 PSS-36 and 1830 PSS-64 devices:

• configure port group

• configure the pluggable module type

• assign a rate

• configure TCA and alarm profiles

• view ODUk cross-connects, optical transport services, and APG groups associated
with a port

9.33.2 Port groups

Port groups are automatically configured when cards are configured on the OCS
shelves, with PWRSV or UNIVTRM as the default port group mode. Each port group is
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identified by the first port in the group, and each group has a specific mode that is
mapped to a specific signal type.

The value of the port group mode must be changed before any port in the group is
configured. The mapping of port group modes to signal types is as follows:

• OTH—OTU2, OTU2e, OTU3, OTU3e2, and OTU4

• ETHSTH—10GbE LAN, STM64, and STM256

• STH—STM1, STM4, STM16, and STM64

• UNIVTRM—100 GbE LAN and OTU4

• PWRSV—power save mode does not have a rate associated with it. It is used to
change the port mode, if required.

Table 9, “Port groups” (p. 147) lists the cards and the corresponding port groups.

Table 9 Port groups

Card name Port group modes Port group ID Ports in the group

1AN100G UNIVTRM 1 1

2AN40G ETHSTH

OTH

PWRSV

1 1

2 1

4AN10G ETHSTH

OTH

PWRSV

1 1, 2

3 3, 4

8ET1GB ETHSTH

PWRSV

1 1 to 8

10AN10G ETHSTH

OTH

PWRSV

1 1, 2

3 3, 4

5 5, 6

7 7, 8

9 9, 10

10ET10G ETHSTH

PWRSV

1 1, 2

3 3, 4

5 5, 6

7 7, 8

9 9, 10
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Table 9 Port groups (continued)

Card name Port group modes Port group ID Ports in the group

10OTH10G ETHSTH

OTH

PWRSV

1 1, 2

3 3, 4

5 5, 6

7 7, 8

9 9, 10

10SD10G STH

PWRSV

1 1,2

3 3,4

5 5,6

7 7,8

9 9,10

11QCUP OTH

PWRSV

1 1, 2

3 3, 4

11QCUPC OTH

PWRSV

1 1, 2

3 3, 4

24ANM ETHSTH

PWRSV

STH

1 1 to 8

9 9 to 16

17 17 to 24

24ET1GB ETHSTH

PWRSV

1 1 to 8

9 9 to 16

17 17 to 24

24ET1G ETHSTH

PWRSV

1 1 to 8

9 9 to 16

17 17 to 24

24SDM STH

PWRSV

1 1 to 8

9 9 to 16

17 17 to 24

43SCUP OTH

PWRSV

1 1

130SCUP OTH 1 1
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Table 9 Port groups (continued)

Card name Port group modes Port group ID Ports in the group

130SCUPB OTH 1 1

130SCUPC OTH 1 1

9.33.3 LAN ports

LAN ports are used for management network connections and debug purposes. The
1830 PSS OCS devices have the following LAN ports:

• CIT port on the FLC card

• OAMP port on the FLC card

• ES1 and ES2 ports on the matrix cards

See the Nokia 1830 Photonic Service Switch Product Information and Planning Guide for
more information about external communication through LAN port interfaces.

9.34 To configure a port on a WDM device

9.34.1 Steps

1

On the equipment tree, expand Network→NE→Shelf→Card→Port.

2

Right-click on the port object and choose Properties. The Physical Port (Edit) form
opens.

3

Configure the required parameters on the General and Port Specifics tabs.
Configure the Transmit Frequency parameter as required in the OT panel. Ensure
that the administrative state of the port is down before configuring the transmit
frequency.

Note: If the transmit frequencies are already configured on the ports, the
Receive Frequency parameter is updated automatically, when a bidirectional
service is created between two devices.

4

Click on the States tab and configure the Administrative State parameter.
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5

Save your changes and close the form.

END OF STEPS

9.35 To configure a port on an OCS device

9.35.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card→Port.

2

Right-click on the port you want to configure, and choose Properties. The Physical
Port (Edit) form opens.

3

Click on the Port Specifics tab.

4

Click Properties beside the Port Group Mode parameter. The Port Group (Edit) form
opens.

5

Configure the Mode parameter as required.

6

Save your changes and close the form.

7

Configure the required parameters in the Physical Port (Edit) form.

Note: The Assigned Rate parameter can only be configured after configuring
the Pluggable Module Type parameter.
The Pluggable Module Type parameter is not applicable for uplink cards.

8

Click on the States tab and configure the Administrative State parameter, if required.

NFM-P To configure a port on an OCS device

Release 17.3
April 2017
Issue 2 1513HE-12002-AAAA-TQZZA



9

Save your changes and close the form.

END OF STEPS

9.36 To enable interworking between different generations of
coherent 100G OTU4 cards

9.36.1 When to use

Perform the following procedure to enable interworking between second-generation
100G OTU4 cards, such as the 130SCA1, 130SCX10, and legacy 100G OTU4 cards,
such as the 112SCX10 and 112SNX10 cards. You can create an optical trail or service
between these cards only when the second-generation cards are in the AFEC mode and
asymmetric interworking is enabled on all the cards.

9.36.2 Steps

1

On the equipment tree, expand to the required line port level of the 130SCA1 or
130SCX10 card.

2

Right-click on the line port and choose Properties. The Physical Port (Edit) form
opens.

3

Click on the Port Specifics tab.

4

Configure the FEC Mode parameter as AFEC.

Note: By default, the value of the FEC Mode parameter is AFEC for the legacy
100G cards, such as 112SX10 and 112SNX10.

5

Select the Asymmetric Interworking Enabled check box.

6

Save your changes and close the form.

END OF STEPS
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9.37 To auto-disable a CIT port on an EC card

9.37.1 Steps

Note: The CIT port can be set to auto-disabled after the 1830 PSS is installed. See the
Nokia 1830 Photonic Service Switch User Provisioning Guide for more information.

1

On the equipment tree, expand Network→NE→Shelf→Card Slot (EC: Equipment
Controller Card)→Port CIT (Local Ethernet Port).

2

Right-click on the CIT port and choose Properties. The Physical Port (Edit) form
opens.

3

Click on the Port Specifics tab.

4

Configure NFM-P server IP in the Source IP field in the Auto-Disable port Status
panel and click Apply. The Disable Port Automatically check box is enabled.

5

Save your changes and close the form.

Note: As long as the 1830 PSS can reach NFM-P server, the CIT port remains
in the disabled state. The 1830 PSS checks the communication link between
NFM-P server every 30 s. If the server is unreachable, the NE waits for 300 s
before the CIT port is enabled for local access.

END OF STEPS
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Managing LAGs

9.38 LAGs

9.38.1 Introduction

Link aggregation combines one or more links to form a Link Aggregation Group (LAG),
such that a MAC client can consider the LAG as if it were a single link. NFM-P supports
LAG through LACP on the following supported ports and cards, where all the member
ports have the same signal rate. LAGs are used for link protection of Ethernet services
on UNIs, specifically with a signal rate of 10 GbE. The LAGs can also be used as a form
of linear protection for NNI ports. A maximum of four ports can be aggregated to form
one LAG.

9.38.2 Supported cards and ports

NFM-P supports the configuration of LAGs in the following cards and ports:

Table 10 Supported cards and ports

Card Ports

11DPE12A C(1-12)

11OPE8 X(1-6), C(1-2), M(1-4)

11QCE12X X(1-4), C(1-22), M(1-4)

11QPE24 X(1-4), C(1-22)

9.39 To configure LAG on 11OPE8, 11QCE12X, and 11QPE24
cards

9.39.1 Steps

1

On the equipment tree, expand Network→NE→Shelf→Card Slot→LAGs.

2

Right-click on the LAGs object and choose Create LAG. The Create LAG step form
appears.
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3

Configure the required parameters:

• LAG ID
• Auto Assign ID
• Description
• Configured Address

• L2Uplink
• Role
• Encap Type
• Administrative State

4

Select a split horizon group, if required. See 14.8 “To configure an SHG” (p. 267) for
more information about configuring a split horizon group

5

Click Next. The Configure LAG Parameters step appears.

6

Configure the Port Threshold parameter and click Next. The Configure LACP step
appears.

7

Configure the required parameters:

• LACP Enabled

• LACP Mode

• LACP Transmit Interval

• LACP Transmit Standby

• Hold Time Down (100s of milliseconds)

Note: Ensure that LACP is enabled before configuring Force Status.

8

Configure the required parameters in the Selection Criteria panel:

• Active Sub-Group Selection Criteria

• Slave to Partner

9

Click Next. The Configure LAG Members step appears.

10

Click Create to add client ports to the LAG. The Create LAG Member step form with
the Only show compatible ports step appears.
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11

Configure the required parameters:

• Show only Compatible Ports

• Class

12

Click Next. The Select Ports step appears with the list of ports.

Note: If you configure the Show only Compatible Ports and Class parameters
in Step 11 , only the ports that are compatible with the selected class appear in
the Select Ports form. Only those LAGs with compatible ports can be used
during service configuration.

13

Choose the compatible ports from the list and click Next. The Specify the Member
Properties step appears.

14

Configure the required parameters:

• Priority

• Sub-Group ID

15

Click Finish. A list of the selected ports appears in the Configure LAG Members step
of the Create LAG step form.

The Specify Member Properties form closes and the Configure LAG Members step
reappears. A dialog box appears.

16

Click OK and then click Finish. The Configure LAG Members form closes and the
Create LAG form reappears.

17

Save your changes and close the forms.

18

On the equipment tree, expand Network→NE→Shelf→Card Slot→LAGs→LAG.
Right-click on a LAG and perform one of the following to force an active or standby
status on LAG subgroups, as required.

a. Choose Force Status→Subgroup 1 or Subgroup 2→Force Active to force the
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chosen subgroup to active state.

b. Choose Force Status→Subgroup 1 or Subgroup 2→Force Standby to force the
chosen subgroup to standby state.

c. Choose Force Status→Subgroup 1 or Subgroup 2→Clear Forced Status to clear
the Force Switch Status for the chosen subgroup.

Note: You can also choose to perform the Force Status task in a similar way
from the LAG (Edit) form.
Forcing a status on a subgroup to a value that is the same as the Force Switch
Status of another subgroup resets the Force Switch Status of the latter
subgroup.

Result: Expand the LAG object in the equipment tree to view the created LAG
and the LAG members. Right-click on the LAG member and choose Properties.
The LAG Member (Edit) form opens and Forced Switch Status displays the forced
status.

END OF STEPS

9.40 To create a LAG on an 11DPE12A card

9.40.1 Steps

1

On the equipment tree, expand Network→NE→Shelf→Card Slot→LAGs.

2

Right-click on the LAGs object and choose Create LAG. The Create LAG step form
appears.

3

Configure the required parameters:

• LAG ID

• Auto Assign ID

• Description

• Administrative State

• MTU (bytes)

4

Click Next. The Configure LAG Parameters step appears.
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5

Configure the required parameters:
• Size

• SVLAN Tag Protocol ID

• LOS Propagation

• LPT Consequent Action

6

Click Next. The Configure LACP step appears.

7

Configure the required parameters:

• Actor Administration Key

• Actor System Priority

8

Click Next. The Configure LAG Members step appears.

9

Click Create to add client ports to the LAG. The Create LAG Member step form with
Select Ports step appears.

10

Choose the ports from the list and click Next. The Specify the Member Properties
step appears.

11

Configure the required parameters:

• Priority

• Admin State

12

Click Finish. A list of the selected ports appears in the Configure LAG members
panel of the Create LAG step form.

The Specify Member Properties form closes and the Configure LAG Members form
reappears. A dialog box appears.

13

Click OK.
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14

Click Finish. The Configure LAG Members form closes and the Create LAG form
reappears.

15

Click Close.

16

Select View the newly created Interface check box and click Close. The LAG (Edit)
form opens.
• The General tab displays the LAG ID, description, and the configured MAC

address.

• The Link Aggregation Group tab displays the parameters selected during LAG
creation, including Number of selected ports, Number of attached ports, size,
SVLAN Protocol ID, LOS propagation, LPT Consequent action and Bandwidth
Attributes.

• The States tab displays the administrative state, which is the LAG enabled or
disabled state on the node.

• The LACP tab displays the LACP parameters such as LACP mode, Actor
Administration Key, Actor Operational Key, Partner Operational Key, Actor System
ID, Partner System ID, Actor System Priority and Partner System Priority.

• The LAG Members tab allows you to add the LAG member ports.

• The VTS map tab displays the VTS map parameters such as VTS Map Number,
VTS Direction, Classification Mode, CE-VLAN ID, and SVLAN ID.

• Statistics, terminations, and fault information is available from the appropriate
tabs.

END OF STEPS
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Managing optical links

9.41 WDM optical links

9.41.1 Introduction

NFM-P supports configuration of the following topological links for WDM devices:

• bidirectional internal topological link

• bidirectional external topological link

• unidirectional internal topological link

• unidirectional external topological link

See 9.44 “To configure an optical link between ports” (p. 163) for more information about
configuring WDM topological links.

9.42 OCS optical links

9.42.1 Introduction

NFM-P supports configuration of the following topological links for OCS devices:

• bidirectional internal topological link

• bidirectional external topological link

• bidirectional compound topological link

See 9.47 “To configure an OCS topological link” (p. 165) for more information about
configuring an OCS topological link.

9.42.2 Bidirectional internal topological link

The bidirectional internal topological link is configured between the ports within an OCS
device. The ports that are not already part of an optical link are available for creating a
new link. The link is configured between two ports on the same shelf or on different
shelves.

Note: Unidirectional internal topological links are not supported in NFM-P for OCS
devices.

9.42.3 Bidirectional external topological link

The bidirectional external topological link is configured from a port within an OCS device
to a port in another OCS or WDM device. The ports that are not already part of an optical
link are available for creating a new link.
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9.42.4 Inter-compound topological link

The inter-compound topological link is configured from an OCH port of the WDM device
to a port in an OCS uplink card. The OCS and WDM devices interwork as partners
where the OCS uplink ports and optical channels are integrated into the WDM domain
using virtual OCONNs and PXCs. The cross-connect provisioned for the configuration
terminates on the SFD or CWR port, because the uplink card is not managed by the
WDM device.

Note: Inter-compound topological links are always bidirectional.

WDM-OCS partner pairing

The WDM-OCS partner pairing is configured in NFM-P as follows:

• On the OCS device—configure the Partner NE parameter, that is, the IP address of
the participating WDM device, before configuring the inter-compound topological link.
The parameter can be viewed on the NE Specifics tab of the Network Element (Edit)
form.

• On the WDM device—configure the OCS IP parameter, that is, the IP address of the
participating OCS device, before configuring the inter-compound topological link. The
parameter can be viewed on the NE Specifics tab of the Network Element (Edit) form.

Compound node object

NFM-P automatically creates a compound node object named Compound_OCS node
name on the navigation tree and on the physical topology map after the WDM-OCS
partner pair is configured. The characteristics of the compound node object are:

• created automatically after WDM-OCS partner pair configuration

• consists of the participating OCS and WDM nodes

• only the compound node object can have the prefix Compound_. NFM-P does not
allow the configuration of a new group in the equipment view of the navigation tree
and on the appropriate topology maps with the object name prefixed by Compound_.

• you cannot delete the compound node object and it is automatically deleted when the
WDM-OCS partner pairing is de-provisioned or modified

• you cannot move the elements out of the compound node object or add elements into
the compound node object

De-provisioning the inter-compound topological link

The WDM-OCS partner pairing is de-provisioned by deleting the inter-compound
topological link and configuring the Partner NE and OCS IP parameters with the value
0.0.0.0 or any other IP address. The WDM-OCS partner pairing can also be configured
using the WebUI. See the Nokia Photonic Service Switch User Provisioning Guide for
more information about connecting an OCS application to WDM application from the
WebUI.
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Note: Ensure that the inter-compound topological link is deleted before modifying the
partner IP from the node.

Supported cards and ports

The UCM is the WDM module responsible for WDM to OCS communication, and for
integrating OCS uplink data into the WDM system. The WDM UCM interface supports
the following OCS uplink cards:

• 11QCUP
• 11QCUPC
• 43SCUP

• 130SCUP
• 130SCUPB
• 130SCUPC

Table 11, “Supported cards and ports” (p. 162) lists the cards and ports that support
inter-compound topological links between a WDM compound and an OCS uplink card.
See 9.47 “To configure an OCS topological link” (p. 165) for more information about
configuring OCS topological links.

Table 11 Supported cards and ports

Card type Ports

CWR8 CLS 1 to 8

CWR8-88 CLS 1 to 8

OPSA SIG

PSC1-6 A to E (1 to 6)

SFD5x channel ports

SFD8x channel ports

SFD40 channel ports

SFD40B channel ports

SFD44 channel ports

SFD44B channel ports

9.43 1830 PSS and generic NE optical links

9.43.1 1830 PSS and generic NE optical links

NFM-P supports establishing an optical link between an 1830 PSS WDM or OCS device
and a non-Nokia transport device or generic NE. See 9.48 “To create a physical link
between an 1830 PSS device and a GNE” (p. 166) for more information about how to
configure an optical link between an 1830 PSS device and a generic NE.
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9.44 To configure an optical link between ports

9.44.1 Steps

1

Perform one of the following to create an optical link between two ports on the same
shelf:

a. From NFM-P main menu.

1. Choose Create→OTN→Optical Link (OTS/OS) from NFM-P main menu. The
Optical Link (Create) form opens.

2. Configure the Endpoint A Type or Endpoint B Type parameters as Unmanaged
NE, if required.

b. On the equipment tree, expand Network→NE→Shelf→Card.

1. Choose two ports, one from each device.

2. Right-click on the selected ports and choose Create Optical Link. The Optical
Link (Create) form opens.

Note:

When you choose two ports from the equipment tree, the port properties are
automatically populated for endpoint A and B.

2

Perform the following steps if the value of Endpoint A Type and Endpoint B Type
parameters are configured to Port:

1. Select a port in the Endpoint A - Port panel.

2. If a rate is not assigned to the endpoint A port, click Properties on the Endpoint A
- Port panel. The Physical Port (Edit) form opens.

3. Click on the Port Specifics→General tab and configure the Assigned Rate
parameter.

4. Perform steps 1 to 3 for Endpoint B - Port panel.

Note: It is optional to configure the rate for ports that support single rate before
configuring an optical link, as NFM-P configures the rates automatically.

3

Perform one of the following if either Endpoint A Type or Endpoint B Type parameter
is configured to Unmanaged NE:

a. Configure Unmanaged NE Identifier in the Endpoint A - UnManaged NE panel.

b. Configure Unmanaged NE Identifier in the Endpoint B - UnManaged NE panel.
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Note: The Unmanaged NE Identifier parameter can be configured as Site
ID Shelf/Slot/Port or Site Name Shelf/Slot/Port. For example,
123.45.56.78 1/2/3 or SiteA 1/2/3.

4

Save your changes and close the form.

Note: You can set the transmit frequency on the ports, even after you create an
optical link, if the administrative state of the port is down. See 9.34 “To
configure a port on a WDM device” (p. 150) for more information.

END OF STEPS

9.45 To delete an optical link

9.45.1 Steps

1

Perform one of the following to list the optical links:

a. List the optical links to be deleted from NFM-P main menu:

1. Choose Manage→Equipment→Equipment. The Manage Equipment form
opens.

2. Choose Optical Link (Optical Management) from the object type drop-down
menu.

3. Go to Step 2 .

b. Double-click on an optical link in the Physical Topology - Network view. The
Physical Link Group List form opens

2

Choose the optical link to be deleted and click Delete.

3

Close the form.

END OF STEPS
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9.46 To view an invalid or stale optical link

9.46.1 Steps

1

Double-click on the optical link that links to the Unmanaged NEs icon on the Physical
Topology map. The Physical Link Group List form opens with a list of invalid or stale
optical link; for example, optical links from a managed NE to an Unmanaged NE in
NFM-P

2

Choose an invalid or stale optical link and click Properties. The Optical Link (Edit)
form opens. Information about the Managed and Unmanaged NE is displayed. The
Unmanaged NE Identifier parameter displays the link that leads to the unmanaged
NE.

END OF STEPS

9.47 To configure an OCS topological link

9.47.1 Before you begin

Ensure that the following parameters are configured before configuring the inter-
compound topological link:

• the Partner NE parameter, that is, the IP address of the participating WDM device, is
configured on the NE Specifics tab of the Network Element (Edit) form of the OCS
compound

• the OCS IP parameter, that is, the IP address of the participating OCS device, is
configured on the NE Specifics tab of the Network Element (Edit) form of the WDM
compound

9.47.2 Steps

1

Perform one of the following:

a. From NFM-P main menu:

1. Choose Create→OTN→Optical Link (OTS/OS). The Optical Link (Create) form
opens.

2. Configure the required parameters.

3. Select a port in the Endpoint A - Port panel.

4. If a rate is not assigned to the endpoint A port, click Properties on the Endpoint
A - Port panel. The Physical Port (Edit) form opens.
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5. Click on the Port Specifics→General tab and configure the Assigned Rate
parameter.

6. Perform 1 to 5 for the Endpoint B - Port panel.

b. From the equipment tree:

1. Choose a port and press CTRL to choose the second port. The two
participating ports are selected.

2. Right-click and choose Create Optical Link. The Optical Link (Create) form
opens with the parameters automatically populated.

2

Save your changes and close the form.

The Notes Parameter on the Optical Link (Edit) form displays the type of topological
link.

The inter-compound topological link configuration results in the creation of a
compound node object named as Compound_OCS node name, on the equipment
tree and consists of the participating WMD and OCS device objects.

END OF STEPS

9.48 To create a physical link between an 1830 PSS device and
a GNE

9.48.1 Steps

1

Right-click on the Physical Topology map and choose Equipment→Create Optical
Link. The Optical Link (Create) form opens.

2

Configure the required parameters.

3

Configure the Endpoint A Type parameter as Port.

4

Configure the Endpoint B Type parameter as Generic NE Interface.

5

Select a port in the Endpoint A - Port panel.
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6

Select a GNE in the Endpoint B - Generic NE Interface panel.

7

Save your changes and close the form.

END OF STEPS
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Managing dry contact

9.49 Dry contact

9.49.1 Introduction

A dry contact is a contact of a relay that does not make or break a current. Usually
another relay or device starts or stops the current. For example, a reed relay matrix
switch is usually switched with all contacts dry. After the contacts are connected, a wire
spring relay connects a supervisory scan point through which the current flows.

9.50 To configure 1830 PSS dry contact sensors

9.50.1 Steps

1

On the equipment tree, expand Network→NE→Shelf→Card Slot (USRPNL - User
Interface Panel)

2

Right-click on the card slot and choose Properties. The Card Slot (User Interface
Panel) (Edit) form opens.

3

Click on the External Control tab. The dry contacts are listed.

4

Choose an entry and click Properties. The DryContact (Edit) form opens.

5

Configure the required parameters.

6

Click Apply to save the changes and close the form.

END OF STEPS
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Managing inventory

9.51 Workflow to manage inventory

9.51.1 Workflow

You can use NFM-P GUI to inventory the managed network equipment. The inventory
information is available to GUI clients on equipment list, properties, and management
forms. For information about performing inventory management, see the NSP NFM-P
User Guide.

Figure 5 Inventory data
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Managing connections

9.52 ROADM OADM and mesh connections (degree 2+)

9.52.1 Overview

The ROADM OADM (degree 2) faces the east and west directions. Some traffic from the
optical lines may be added or dropped and at least one single wavelength passes
through transparently. The configuration can be used as an optical add or drop
multiplexer in linear networks.

The WR8-88A supports up to degree 5 mesh connections without the need for additional
mesh cards. For the connectivity, the mesh output port (MESHOUT(1-3)) of a WR8-88A
card is connected directly to the add input port (ADDIN(1-8)) of another WR8-88A. Three
mesh outputs are required for degree 5 connectivity. See Table 12, “ROADM–2 Degree
8 ROADM connectivity” (p. 170) for more information.

The ROADM OADM mesh (degree 3 to 8) faces more than two line directions. Individual
channels enter from one line and may be added or dropped or transit transparently to
any one of the other lines.

Note: If the 1830 PSS-32 network contains WR8-88A and CWR cards, use the
Exclusion option in the Path Constraints tab to accelerate the path search and transport
service creation. See 15.22 “To configure an optical transport service” (p. 311) for more
information.

See the Nokia 1830 Photonic Service Switch Product Information and Planning Guide for
more information.

Table 12 ROADM–2 Degree 8 ROADM connectivity

From port To port From To

WR1 DROPOUT – – ITLU+SFD

WR1 THRU Out – – WR2 THRU In

WR1 MESHOUT1 – – WR3 ADDIN3

WR1 MESHOUT2 – – WR4 ADDIN3

WR1 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR5 ADDIN3

WR1 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR6 ADDIN3

WR1 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN3

WR1 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN3

WR2 DROPOUT – – ITLU+SFD
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Table 12 ROADM–2 Degree 8 ROADM connectivity (continued)

From port To port From To

WR2 THRU Out – – WR1 THRU In

WR2 MESHOUT1 – – WR3 ADDIN4

WR2 MESHOUT2 – – WR4 ADDIN4

WR2 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR5 ADDIN4

WR2 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR6 ADDIN4

WR2 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN4

WR2 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN4

WR3 DROPOUT – – ITLU+SFD

WR3 THRU Out – – WR4 THRU In

WR3 MESHOUT1 – – WR1 ADDIN3

WR3 MESHOUT2 – – WR2 ADDIN3

WR3 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR5 ADDIN5

WR3 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR6 ADDIN5

WR3 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN5

WR3 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN5

WR4 DROPOUT – – ITLU+SFD

WR4 THRU Out – – WR3 THRU In

WR4 MESHOUT1 – – WR1 ADDIN4

WR4 MESHOUT2 – – WR2 ADDIN4

WR4 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR5 ADDIN6

WR4 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR6 ADDIN6

WR4 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN6

WR4 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN6

WR5 DROPOUT – – ITLU+SFD

WR5 THRU Out – – WR6 THRU In

WR5 MESHOUT1 – – WR1 ADDIN5

WR5 MESHOUT2 – – WR2 ADDIN5

WR5 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR3 ADDIN5

WR5 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR4 ADDIN5
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Table 12 ROADM–2 Degree 8 ROADM connectivity (continued)

From port To port From To

WR5 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN7

WR5 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN7

WR6 DROPOUT – – ITLU+SFD

WR6 THRU Out – – WR5 THRU In

WR6 MESHOUT1 – – WR1 ADDIN6

WR6 MESHOUT2 – – WR2 ADDIN6

WR6 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR3 ADDIN6

WR6 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR4 ADDIN6

WR6 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN8

WR6 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN8

WR7 DROPOUT – – ITLU+SFD

WR7 THRU Out – – WR8 THRU In

WR7 MESHOUT1 – – WR1 ADDIN7

WR7 MESHOUT2 – – WR2 ADDIN7

WR7 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR3 ADDIN7

WR7 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR4 ADDIN7

WR7 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR5 ADDIN7

WR7 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR6 ADDIN7

WR8 DROPOUT – – ITLU+SFD

WR8 THRU Out – – WR7 THRU In

WR8 MESHOUT1 – – WR1 ADDIN8

WR8 MESHOUT2 – – WR2 ADDIN8

WR8 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR3 ADDIN8

WR8 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR4 ADDIN8

WR8 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR5 ADDIN8

WR8 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR6 ADDIN8
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9.53 One-device Anydirection and Two-device Anydirection
configuration connections

9.53.1 Overview

You can manage the following configuration connections:

• One-device Anydirection

• Two device Anydirection

Note: Service provisioning, discovery and topological views are supported for protected
and unprotected services for One-device Anydirection and Two-device Anydirection
configurations. See 15.22 “To configure an optical transport service” (p. 311) for more
information.

9.53.2 One-device Anydirection configuration

For one-device anydirection configuration, the Add drop block and the connection block
are on the same device. The configuration that can be used is the Mesh card (optional)
with WR8, WR8-88A and CWR8-88 cards.

9.53.3 Two-device Anydirection configuration

Two-device Anydirection configuration is supported on two devices for Add and Drop
blocks at the terminal on one device and connection blocks on the other device. The
following configurations are supported in the Add and Drop blocks and the connection
blocks. Figure 6, “Two-device Anydirection connectivity” (p. 172) shows the Two-device
Anydirection configuration.
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Note: Regeneration is possible inside the Add and Drop blocks.

Two devices with no MESH4 card in Add path

Figure 7, “Two devices with no MESH4 card support” (p. 175) shows two devices with
no MESH4 card in Add path.

With this configuration, the limitations in degrees are:

• N<=5 with configuration not allowing in–service upgrade to higher degrees

• N<=4 with configuration allowing in–service upgrade to higher degrees

Figure 6 Two-device Anydirection connectivity
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Two devices with one MESH4 card in Add path

The Add and Drop block allows a configuration up to degree 8+2 as shown in Figure 8,
“Two devices with one MESH4 card support” (p. 176).

Figure 7 Two devices with no MESH4 card support
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Figure 8 Two devices with one MESH4 card support
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1830 PSS synchronization

9.54 WDM and OCS synchronization

9.54.1 Introduction

An 1830 PSS device synchronizes various signals using a single timing source. The
synchronization can be performed using external line references. See “SDH line timing
synchronization” (p. 203) for more information about external line timing and SDH line
timing reference synchronization on an 1830 PSS OCS device.

9.54.2 WDM synchronization

You can configure synchronization on the following cards installed on the 1830 PSS-4,
1830 PSS-16, or 1830 PSS-32 devices:

• 11DPE12A

• 11DPE12E

• 11QPE24

• 11OPE8

• 11QCE12X

9.55 To configure synchronization on an 1830 PSS WDM device

9.55.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card.

2

Right-click on the card and choose Properties. The Card Slot (Edit) form opens.

3

Click on the Card Specifics tab and configure the SyncE Support parameter as
Enable. The Line Timing, Sync Alarm Profile, and Performance sub-tabs appear.

Assign a port to the line references

4

Click on the Line Timing tab.
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5

Choose a Line Reference, and click Properties. The LineReference (Edit) form
opens.

6

Configure the Assigned Port parameter and other line timing parameters as required.
Table 13, “Line references and ports” (p. 177) lists the ports and line references for
the cards supporting synchronization.

Table 13 Line references and ports

Cards Ports Line reference

11DPE12A C(1-12) Line Ref 0

C(1-12) Line Ref 1

L1 Line Ref 2

L2 Line Ref 3

11DPE12E C(1-4, 9-12) Line Ref 0

C(5-8) Line Ref 1

L1 Line Ref 2

L2 Line Ref 3

11QPE24 X(1-4) and C(1-22) Line Ref 0

X(1-6), C(1-2), and M(1-4) Line Ref 1

11OPE8 X(1-6), C(1-2), and M(1-4) Line Ref 0 and Line Ref 1

11QCE12X X(1-4), C(1-22), and M(1-4) Line Ref 0 and Line Ref 1

7

Click OK to save the changes. The LineReference (Edit) form closes.

Switch timing reference

8

Click on the General tab and configure the Switch To Timing Reference and Switch
Request parameters as required in the Sync0 Settings panel.

9

Click Apply to save the changes and close the form.

END OF STEPS
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9.56 NTP server

9.56.1 Procedures to manage an NTP server

NFM-P provides a list of NTP servers configured on the 1830 PSS. The NTP servers are
used for time of day synchronization when the NTP is enabled. NFM-P supports the
creation and deletion of an NTP server. Up to three NTP servers are supported on the
1830 PSS.

9.57 To configure an NTP server

9.57.1 Steps

1

On the equipment tree, expand Network→1830 PSS.

2

Right-click on the 1830 PSS device object and choose Properties. The Network
Element (Edit) form opens.

3

Click on the NTP tab and on the Server sub-tab.

4

Click Create. The NTP Server (Create) form opens.

5

Configure the required parameters and click OK.

Note: The options for the Index parameter are 1, 2, and 3. The value
represents the number of NTP servers that can be added.

6

Click on the General tab and select the NTP Enabled check box for WDM devices.

Note: There must be at least one NTP server added to select the NTP Enabled
check box.

7

To request the WDM devices to authenticate NTP packets arriving from an NTP
server:

1. Click on the Authentication tab and click Create.

NFM-P NTP server
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2. Configure the required parameters.

3. Click OK.

8

Save your changes and close the form.

END OF STEPS

9.58 To delete an NTP server

9.58.1 Steps

1

On the equipment tree, expand Network→1830 PSS.

2

Right-click on an 1830 PSS and choose Properties. The Network Element (Edit)
form opens.

3

Click on the NTP tab and on the Server tab. The configured NTP servers are listed.

4

Choose the NTP server to be deleted and click Delete.

Note: If all of the NTP servers are deleted, the NTP Enabled check box in the
General tab is automatically deselected, which means the NTP is automatically
disabled.

5

Close the form.

END OF STEPS

9.59 Precision time protocol

9.59.1 Overview

PTP is used to distribute time of day and a common epoch or frequency. PTP maintains
synchronization between master and slave clocks, distributes the time to slaves using
multicast.
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NFM-P supports IEEE 1588 PTP clocks for packet-based timing synchronization from a
master clock to one or more slave clocks in a network. You can configure IEEE 1588
PTP clocks on the 1830 PSS device with an ordinary master, an ordinary slave, or a
boundary clock.

The following cards support PTP on the 1830 PSS:

• PTPCTL, which implements the physical layer clock (syncE) to distribute frequency
and the PTP clock to distribute time or phase across the network

• PTPIO, which provides adaptation for transport of PTP over WDM links

• IEEE 1588 PTP-capable OTs (currently only 11DPE12A)

9.60 To configure TOD on the PTPCTL cards

9.60.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→PTPCTL→TOD port.

2

Right-click on the TOD port and choose Properties. The Physical Port (Edit) form
opens.

3

Click on the Port Specifics tab configure the required parameters in the TOD
Attributes panel.

4

Save your changes and close the form.

END OF STEPS

9.61 To configure an IEEE 1588 PTP clock

9.61.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→PTPCTL or
11DPE12A card.

2

Right-click on the card object and choose Properties. The Card Slot (Edit) form
opens.
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3

Click on the PTP tab. The General tab appears.

4

Configure the required parameters and click OK to save the changes.

5

Click on the Clock tab, choose an entry, and click Properties. The IEEE 1588 PTP
Clock (Edit) form opens.

Note: A PTP clock is automatically created when the Clock Mode is changed
from PTP Disabled to any other mode.

6

Configure the required parameters in the General tab.

7

Click on the Port tab and click Create. The IEEE 1588 PTP Port (Create) form
opens.

8

Select an associated physical port.

9

Select a PTP IO timing port.

Note: For an 11DPE12A card, if the Clock Mode is Ordinary Clock – Master or
Ordinary Clock – Slave, only one PTP port can be configured. If the Clock
Mode is Boundary Clock, up to 14 PTP ports can be configured.
For a PTPCTL card, if the Clock Mode is Boundary Clock, up to 6 PTP ports
can be created.

10

Configure the Associated VLAN ID parameter.

11

Save your changes and close the forms.

END OF STEPS
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9.62 BITS

9.62.1 Overview

The BITS input and output ports provide external input and output station clock
interfaces.

9.62.2 WDM BITS

NFM-P provides BITS input and output ports on the PTPCTL and 11DPE12A cards. The
BITS ports are automatically created and deleted with the card. See 9.63 “To configure
BITS attributes on an 1830 PSS WDM device” (p. 182) for more information about
configuring the BITS attributes.

9.62.3 OCS BITS

NFM-P provides two BITS ports on the PSFC card on the 1830 PSS-36 device and the
PSF3T8 card on the 1830 PSS-64 device. The BITS ports can be viewed and configured
on these cards only on the main shelf of the 1830 PSS OCS devices.

9.63 To configure BITS attributes on an 1830 PSS WDM device

9.63.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→PTPCTL or
11DPE12A card→ BITS1 or BITS2 port.

2

Right-click on the BITS1 or BITS2 port object and choose Properties. The Physical
Port (Edit) form opens.

3

Click on the Port Specifics tab and configure the required parameters in the BITS
Attributes panel.

The Signal Type parameter is configured to 2 MHz for the PTPCTL card and cannot
be configured if the SONET/SDH Mode parameter is configured to SONET on the
1830 PSS device. For the 11DPE12A card, if the SONET/SDH Mode parameter is
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configured to SONET on the 1830 PSS device, the Signal Type parameter can be
configured as DS1 SF or DS1 ESF.

If the SONET/SDH Mode parameter is configured to SDH on the 1830 PSS device,
the Signal Type parameter can be configured as follows for the PTPCTL and the
11DPE12A cards:

• 2 MHz

• Unframed E1

• Framed E1

• Framed E1 with SSM

The Line Impedance parameter can be configured as 75 ohms or 120 ohms for the
PTPCTL card in SONET or SDH mode.

For the 11DPE12A card, the Line Impedance parameter is configured to 100 ohms
and cannot be configured in SONET mode. The parameter can be configured as 75
ohms or 120 ohms in SDH mode.

The SA Bit parameter can be configured when the Signal Type parameter is
configured to Framed E1 with SSM in SDH mode.

The Transmitted SSM and AIS Mode parameters can be configured on the BITS1
port of the PTPCTL card when the Signal Type parameter is set to Framed E1 with
SSM in SDH mode.

The Transmitted SSM and AIS Mode parameters can be configured on the BITS1
port of the 11DPE12A card, when the Signal Type parameter is configured to DS1
ESF in SONET mode or Framed E1 with SSM in SDH mode.

The Line Code parameter can be configured only for the 11DPE12A card when the
Signal Type parameter is configured to DS1 ESF or DS1 SF in SONET mode.

The LBO parameter can be configured only on the BITS1 port of the 11DPE12A card
when the Signal Type parameter is configured to DS1 ESF or DS1 SF in SONET
mode.

4

Save your changes and close the form.

END OF STEPS

9.64 To configure BITS attributes on an 1830 PSS OCS device

9.64.1 BIT ports

The two BITS ports supported on the 1830 PSS OCS devices are:

• BITS 0—PSFC card in card slot 44 of the 1830 PSS-36 shelf and PSF3T8 card in card
slot 91 of the 1830 PSS-64 shelf
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• BITS 1—PSFC card in card slot 45 of the 1830 PSS-36 shelf and PSF3T8 card in card
slot 94 of the 1830 PSS-64 shelf

You can view BITS ports only on the main shelf and not on the extension shelves.

9.64.2 Steps

1

On the equipment tree, expand Network→NE→Shelf→PSFC or PSF3T8
card→PSFC or PSF3T8 BITS port.

2

Right-click on the PSFC or PSF3T8 BITS port and choose Properties. The Physical
Port (Edit) form opens.

3

Click on the Port Specifics tab and perform one of the following:

a. Configure the required parameters on the BITS Attributes panel for the 1830 PSS
OCS device in SDH mode:

Note: The SA Bit parameter can be configured when the Signal Type
parameter is set as 2MBIT SSM.

b. Configure the required parameters on the BITS Attributes panel for the 1830 PSS
OCS device in SONET mode:

Note: The Line Code parameter can be configured when the Signal Type
parameter is set as DS1 ESF or DS1 ESF no SSM.

4

Save your changes and close the forms.

END OF STEPS
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10 NFM-P application — Equipment view

10.1 Overview

10.1.1 Purpose

This chapter describes NFM-P application for equipment view.

10.1.2 Contents

10.1 Overview 187

10.2 Equipment view 187

10.3 To start the equipment view application on a specific web browser 187

10.2 Equipment view

10.2.1 Overview

The equipment view is NFM-P application that provides a graphical representation of the
1830 PSS shelves, cards, ports and the interconnections.

You can launch NFM-P equipment view from NFM-P GUI. See 10.3 “To start the
equipment view application on a specific web browser” (p. 187) for information about
launching NFM-P equipment view from NFM-P GUI.

10.3 To start the equipment view application on a specific web
browser

10.3.1 Steps

1

To specify the web browser for the equipment view:

1. Choose Application→User Preferences. The User Preferences form opens.

2. Click Browse beside the Browser Path parameter. The Browser Path form opens.

3. Choose the exe file from the appropriate folder and click Open.

4. Close the forms.

Note:
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Perform Step 1 to set the web browser path when the client is used for the first
time.

See NSP NFM-P Planning Guide for a list of supported browsers.

2

Perform one of the following:

a. Choose equipment from NFM-P navigation tree view selector. The navigation tree
displays the navigation tree objects.

b. Choose an 1830 PSS object in the Physical topology map.

3

Right-click on the 1830 PSS object and choose Equipment View. NFM-P equipment
view appears in the specified web browser.

END OF STEPS
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Part IV: 1830 PSS SDH trails and services

Overview

Purpose

This part provides information about the SDH trails and services.

Contents

Chapter 11, SDH trails and services 191
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11 SDH trails and services

11.1 Overview

11.1.1 Purpose

This chapter provides information about the SDH trails and services.

11.1.2 Contents

11.1 Overview 191

SDH networks 192

11.2 Workflow to configure a VC4 service 192

11.3 VC4 sub-structures 193

11.4 To bind and collapse VC4 sub-structures 194

11.5 VCn cross-connects 194

11.6 To configure a VCn XC and protect/unprotect the VCn XC 195

11.7 To configure an unprotected STM trail 197

11.8 To configure a VC4 service 198

1+1 MSP group 201

11.9 Overview 201

11.10 To configure a 1+1 MSP group 202

SDH line timing synchronization 203

11.11 Overview 203

11.12 To configure an SDH line timing synchronization 203
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SDH networks

11.2 Workflow to configure a VC4 service

11.2.1 Workflow

The 10SD10G and 24SDM cards support STH port group mode, which provides STM
line interfaces and a VC4 based interface toward the backplane. SDH switching and
transport over OTN is achieved by using an optical fiber connection between the TDM
client and optical client/line cards.

11.2.2 Stages

1

Configure TDM cards on an 1830 PSS OCS device by choosing TDM cards as the
assigned card type. See 9.26 “To configure a card on an OCS shelf” (p. 140) .

2

Configure VC4 sub-structures. For example, if you need to create a VC4-4C or a
VC4-16C service, configure the sub-structures appropriately. See 11.4 “To bind and
collapse VC4 sub-structures” (p. 194) .

3

Configure the VC4 service in a bottom-up or top-down approach.

a. Configure the VC4 service in a bottom-up approach.

1. Configure 1+1 MSP groups on the ports involved in the service hops, if
required. See 11.10 “To configure a 1+1 MSP group” (p. 202) .

Note:

After the service is created, click on the APS Groups tabs of the Optical
Transport Service (Edit) form to view the VCn APS groups and 1+1 MSPs
involved in the service.

2. If required, configure the VC4 cross-connects. See 11.5 “VCn cross-connects”
(p. 194) .

3. Configure an STM trail before configuring a VC4 service with underlying
asymmetric ODU trails. See 11.7 “To configure an unprotected STM trail”
(p. 197) .

4. Configure the VC4 service. See 11.8 “To configure a VC4 service” (p. 198) .

b. Configure the VC4 service in a top-down approach.

1. Configure an HO-ODU trail between optical client/line cards on the termination
sites of the service. See 12.5 “To configure an ODU trail” (p. 219).

2. Configure the VC4 service. See 11.8 “To configure a VC4 service” (p. 198) .
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Note:

The underlying trails are created automatically.

11.3 VC4 sub-structures

11.3.1 Overview

The ports with STM rates are further subdivided into administrative units or AUs. These
administrative units can be bound together to form virtual containers. See 11.4 “To bind
and collapse VC4 sub-structures” (p. 194).

Table 14 VC4 sub-structures

STM rate AU-n Number of AU-n Maximum
possible number
of VC4-4C

Maximum
possible
number of
VC4-16C

STM-1 STM1AU4 1 0 0

Figure 9 VC4 sub-structures
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Table 14 VC4 sub-structures (continued)

STM rate AU-n Number of AU-n Maximum
possible number
of VC4-4C

Maximum
possible
number of
VC4-16C

STM-4 STM4AU4 4 1 0

STM-16 STM16AU4 16 4 1

STM-64 STM64AU4 64 16 4

11.4 To bind and collapse VC4 sub-structures

11.4.1 Steps

1

On the equipment tree, expand Network→Shelf→Card(10SD10G or 24SDM)→Port.

2

Right-click on the port and choose Properties. The Physical Port (Edit) form opens.

3

Click on the Show All Tabs, then on the AUn tab.

4

Choose the required port, click Bind Timeslots, and choose either Bind Timeslots to
VC4-4C or Bind Timeslots to VC4-16C. See Table 14, “VC4 sub-structures” (p. 193)
.

5

Choose a bound timeslot and click Collapse Timeslots to retrieve the initial
STMnAU4.

END OF STEPS

11.5 VCn cross-connects

11.5.1 Overview

NFM-P allows you to configure VCn cross-connects using the VC4 sub-structures. You
can also add protection or remove protection from the cross-connects. See 11.7 “To
configure an unprotected STM trail” (p. 197) .
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11.6 To configure a VCn XC and protect/unprotect the VCn XC

11.6.1 Before you begin

Before you configure a VCn XC with a rate of VC4-4c or VC4-16c, ensure that you have
created the VC4 sub-structures, as required. See 11.4 “To bind and collapse VC4 sub-
structures” (p. 194) .

11.6.2 Steps

Configure a VCn XC

1

On the navigation tree, expand Network→1830 PSS.

2

Right-click on the 1830 PSS device and choose Properties. The Network Element
(Edit) form opens.

Figure 10 VCn cross-connects
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3

Click on the VCn Cross Connects tab.

4

Click Create. The VC Cross Connect (Create) form opens.

5

Configure the parameters in the Cross Connect Information panel.

6

Select the source and destination VC4 sub-structures in the Source and Destination
panels respectively.

7

Click OK. The VCn XC is listed in the VCn Cross Connects tab of the Network
Element (Edit) form.

Protect a VCn XC

8

Choose the VCn XC and click Protect. The TDM Facility Protection Group form
opens.

9

Select the VC4 sub-structure in the Protection panel.

10

Configure the parameters as required in the VCnXC Protection Configuration and
Protection Management panels.

11

Click OK. The Working and Protection XCs are listed in the VCn Cross Connects
tab.

12

Click on the APS Groups tab to view the TDM facility protection group created.

Unprotect of a VCn XC

13

Choose a TDM facility protection group in the APS Groups tab and click Unprotect.

To configure a VCn XC and protect/unprotect the VCn XC NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

196 Issue 2



14

Click Yes to confirm. The Unprotect form opens.

15

Choose the path you need to remove and click OK. The TDM facility protection
group is removed from the list in the APS group.

16

Click on the VCn Cross Connects tab. The unprotected VCn XC is displayed.

17

Close the form.

END OF STEPS

11.7 To configure an unprotected STM trail

11.7.1 When to use

An STM trail is created between STM ports of TDM cards.

11.7.2 Before you begin

Before you create an STM trail between two ports with STM rates, perform the following:

• Create an optical link between the STM port of the TDM card and the STM port of an
optical client/line card on both Site A and Site Z ends.

• Create an HO-ODU trail between the two sites from one ODUPOOL to the other.

11.7.3 Steps

1

Choose Create→STM Trail from NFM-P main menu. The STM Trail (Create) form
opens.

2

Configure the required parameters under the General tab.

3

Right-click on the Sites object on the navigation tree and choose Create Trail Site.
The Select Network Elements form opens.
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4

Choose two network elements and click OK. The Site A End and Site Z End objects
are listed in the navigation tree.

5

Right-click on the Site A End object and choose Create Trail Termination Point. The
Select Termination Point form opens.

6

Choose the required termination point from the list and click OK. The termination
point is listed under the Site A End object on the navigation tree.

Note: Confirm the pre-requisites as indicated at the beginning of this procedure
to have the possible termination points listed in the Select Termination Point
form.

7

Perform Step 5 to Step 6 to configure the Site Z end termination point.

8

Click Apply to save the changes.

9

Expand Trail Paths to view the underlying STM, LO-ODU, HO-ODU, and OTU trails.

10

Close the form.

END OF STEPS

11.8 To configure a VC4 service

11.8.1 When to use

You can create a VC4 service in a top-down or bottom-up approach. In a top-down
scenario, configure an HO-ODU trail between the sites, and configure the service
between the TDM cards. The underlying STM and LO-ODU trails are created
automatically. In a bottom-up scenario, create the LO-ODU, STM, and HO_ODU trails,
and then configure a VC4 service using these trails.
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11.8.2 Steps

1

Configure VC4 sub-structures as required. See 11.4 “To bind and collapse VC4 sub-
structures” (p. 194) .

2

Perform one of the following.

a. To configure an unprotected VC4 service, perform 15.22 “To configure an optical
transport service” (p. 311) with the Rate parameter configured as VC4, VC-4C, or
VC-16C, as required.

b. To configure a protected VC4 service, configure the Protection Type as ESNCP
Protected and configure the working and protection path constraints, as required.
See 15.27 “To configure path constraints for a service” (p. 320) for more
information about configuring path constraints.

Note: The VCn cross-connects, STM trail, and VCn APS groups are created
automatically when the VC4 service is created in a top-down approach.

Figure 11 VC4 service
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3

Configure the Protection Type parameter to convert an unprotected VC4 service to a
protected VC4 service, or the converse. While converting a protected VC4 service to
an unprotected VC4 service, configure the Path Preference parameter, as required.

END OF STEPS
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1+1 MSP group

11.9 Overview

11.9.1 Introduction

You can configure 1+1 multiplex section protection group on 10SD10G or 24SDM card
ports configured with rates STM-1, STM-4, STM-16, or STM-64. Each of the paired ports
in the group must have the same STM rate.

The ports can be on the same card or on different cards on the same device. The
protection group supports unidirectional and non-revertive switching. See 11.10 “To
configure a 1+1 MSP group” (p. 202) . See Nokia 1830 PSS Product Information and
Planning Guide for more information about 1+1 MSP groups.

Figure 12 1+1 MSP group
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11.10 To configure a 1+1 MSP group

11.10.1 Steps

1

On the equipment tree, expand Network→1830 PSS.

2

Right-click on the 1830 PSS device object and choose Properties. The Network
Element (Edit) form opens.

3

Click on the APS Groups tab, click Create, then choose STM APS Group. The 1+1
MSP Protection Group form opens.

4

Configure the Rate parameter.

5

Select the working and protection ports in the Working and Protections panels.

6

Click Apply to save the changes.

7

Configure the parameters in the FFP Configuration panel, as required.

8

Save your changes and close the forms.

END OF STEPS
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SDH line timing synchronization

11.11 Overview

11.11.1 Introduction

The capability to synchronize the system to line timing reference transmission ports is
restricted to STM-64 ports of the 10SD10G card with SDH termination capability. By
default, the synchronization is set to the internal time reference that is provided by the
oscillators on the matrix cards of the 1830 PSS OCS devices.

NFM-P allows you to perform the following on an 1830 PSS OCS device:

• configure the attributes on the BITS ports of the power filter cards

• assign these ports to the external time references

• use one of these external time references for the purpose of synchronization

11.12 To configure an SDH line timing synchronization

11.12.1 Steps

1

On the equipment tree, expand Network→NE→Shelf.

2

Right-click on the shelf object and choose Properties. The Shelf (Edit) form opens.

3

Click on the Synchronization tab and set the Sync Messaging parameter to Enable
on the System Timing Reference panel to enable synchronization.

4

Select an alarm profile.

Assign a port to an external or line timing reference

5

Choose an external or line timing reference in the External/Line Timing Reference
panel and click Properties. The LineReference (Edit) form opens.

6

Select a port in the Assigned Port panel.
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Note: You can assign only ports with STM -64 rates of the 10SD10G cards to
the Line Ref 0 through 5.
You cannot assign more than one external or line timing reference to a port.

Table 15 External or line timing references and ports

Cards Ports External or line reference

PSF3T8 (1830 PSS-64)
and PSFC (1830
PSS-36)

BITS0 and BITS1 External Line Ref 0 and
External Line Ref 1

10SD10G H1 to H10 with rate assigned Line Ref 0 to Line Ref 5

7

Configure the required line timing parameters on the General tab.

Note: If the Signal Type parameter is set to 2MBIT SSM or DS1 ESF in
9.55 “To configure synchronization on an 1830 PSS WDM device” (p. 177) ,
synchronization is based on the value of the Provisioned Quality Level
parameter of the external timing reference.
If the Signal Type parameter is set to 2MBIT No SSM or DS1 ESF No SSM in
9.55 “To configure synchronization on an 1830 PSS WDM device” (p. 177) ,
synchronization is based on the value of the Priority parameter of the external
timing reference.

8

Click OK. The LineReference (Edit) form closes and the Shelf (Edit) form reappears.

9

Click Apply. The assigned port is listed in the External/Line Timing Reference panel.

10

Repeat Step 5 to Step 9 for External Line Ref 1, if required.

Switch timing reference

11

Configure the Switch To Timing Reference and Switch Request parameters as
required.

Note: By default, the Switch to Timing Reference parameter is set to Sync0
/Internal. You can configure it to the required external or line timing reference
after assigning ports as described in Step 5 to Step 10 .
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If the Switch Request parameter for an external or line timing reference is
configured as Lockout, you cannot set the Switch Request to Force Switch.
Configure the Switch Request parameter as Clear, click Apply, then configure
the Switch Request parameter as Force Switch to switch to the external or line
timing reference.

12

Click Apply to save the changes. The Active Line Reference parameter displays the
external or line timing reference.

13

Close the form.

END OF STEPS
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Part V: 1830 PSS OTN layer management

Overview

Purpose

This chapter describes the OTN layer and OTH facility management from NFM-P.
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12 1830 PSS optical trail management

12.1 Overview

12.1.1 Purpose

This chapter describes the OTN layer management from NFM-P.

12.1.2 Contents

12.1 Overview 209

OTN — Introduction 210

12.2 Overview 210

OTN trail management 212

12.3 Workflow to manage OTN trails from NFM-P 212

12.4 Manage OTN trails from NFM-P 213

Optical trail configuration procedures 219
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12.7 To configure path constraints for ODU trails 221

12.8 To modify the protection and route of an ODU trail 223

12.9 To configure an ODUCTP 225

12.10 To configure an OTU trail 226

12.11 To auto-discover an OTU trail 228

12.12 To discover client trails from an OTU trail 229

12.13 To configure an OCH trail 230

12.14 To auto-configure an OMS trail 232

12.15 To view an OTS trail 233

12.16 To discover optical trails 233

12.17 To view the optical channel usage 234
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OTN — Introduction

12.2 Overview

12.2.1 OTN

OTN is an ITU-T standard (G.709) that describes a method for wrapping signals of
different protocols for transport across an optical network. OTN provides transport,
multiplexing, routing, management, supervision, and survivability functions for optical
channels that carry client signals.

OTN has the following advantages over SDH and SONET:

• stronger forward error correction mechanisms

• more levels of tandem connection monitoring

• transparent transport of client signals

• switching scalability

12.2.2 Forward error correction

Forward error correction is a method to lower the BER of an optical line signal by adding
redundant information, which can be used to correct bit errors that occur when the signal
is transmitted over long distances.

NFM-P allows the following forward error correction options for 1830 PSS devices:

• SDFEC
• AFEC
• UFEC

• RSFEC
• EFEC
• EFEC2

SDFEC provides higher error correction when compared to AFEC. The 130SCX10 OT
card supports configuration of SDFEC on the line port.

The latency on the 11DPE12A, 11OPE8, 11QCE12X, and 11QPE24 cards is optimized
by setting the FEC Mode parameter to No FEC under the Port Specifics tab of the
respective Physical Port (Edit) forms.

12.2.3 OTN layers

The following layers are defined in OTN.

• OPU—information structure that is used to encapsulate client information for transport
over an optical channel.

• ODU—consists of the OPU information payload and the ODU-specific overhead.

• OTU—information structure that is required to transport an ODU over an optical
channel.
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• OCH—an optical channel that transports a digital client signal between
re-amplification, re-shaping, and re-timing (3R) regeneration points.

• OMS—provides multiplexing of several wavelengths.

• OTS—provides transmission of optical signals across various types of optical media.
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OTN trail management

12.3 Workflow to manage OTN trails from NFM-P

12.3.1 Workflow

The workflow to manage the OTN trails is described in this topic.

12.3.2 Stages

1

Configure the ODU trails; see 12.5 “To configure an ODU trail” (p. 219) .

If required:

• discover the services associated with the ODU trails; see 12.6 “To discover
services associated with ODU trails” (p. 221) .

• configure the path constraints for ODU trails; see 12.7 “To configure path
constraints for ODU trails” (p. 221) .

• change the protection type of the ODU trails; see 12.8 “To modify the protection
and route of an ODU trail” (p. 223) .

• configure the ODUCTPs; see 12.9 “To configure an ODUCTP” (p. 225) .

2

Configure the OTU trails; see 12.10 “To configure an OTU trail” (p. 226) .

If required:

• auto-discover the OTU trails; see 12.11 “To auto-discover an OTU trail” (p. 228) .

• discover the client trails from the OTU trails; see 12.12 “To discover client trails
from an OTU trail” (p. 229) .

3

Configure the OCH trails; see 12.13 “To configure an OCH trail” (p. 230) .

4

Auto-configure the OMS trails; see 12.14 “To auto-configure an OMS trail” (p. 232) .

5

View the OTS trails; see 12.15 “To view an OTS trail” (p. 233) .

6

If required, discover the optical trails; see 12.16 “To discover optical trails” (p. 233) .
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7

If required, view the optical channel usage; see 12.17 “To view the optical channel
usage” (p. 234) .

12.4 Manage OTN trails from NFM-P

12.4.1 OTN layer navigation using NFM-P

The optical trail configuration forms allow you to create optical trails in NFM-P. You can
access the optical trail configuration forms from the Create menu or the Manage menu.
Figures Figure 13, “Optical trail configuration form navigation from Create menu”
(p. 212) and Figure 14, “Optical trail configuration form navigation from Manage menu”
(p. 214)show both methods of accessing optical trail configuration forms.

Figure 13 Optical trail configuration form navigation from Create menu
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The navigation tree of an optical trail configuration form lists the sites, termination points,
and trail paths that are configured for the optical trail.

Table 16, “Navigation tree objects” (p. 214) describes the objects on the navigation tree
of the optical trail configuration form, which NFM-P allows you to create and manage.

Table 16 Navigation tree objects

Object Description

Sites Contains the Site A and Site Z attribute information

Site A End

Site Z End

Child objects of the Sites object

Termination Point Located under the Site A End and Site Z End objects.

Contains the termination point attribute information.

Termination Point Working Child objects of the Termination Point object.

Trail Paths Contains the optical trail path attribute information.

Figure 14 Optical trail configuration form navigation from Manage menu
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Table 16 Navigation tree objects (continued)

Object Description

<ODU/OTU/OCH> Trail Path, Mode: Working

<ODU/OTU/OCH> Trail Path, Mode: Protection

Child object of the Trail Paths object.

Figure 15, “Optical trail navigation tree objects” (p. 215) shows the navigation tree
objects that you can manage in the optical trail configuration forms.

NFM-P allows you to navigate to the underlying OTN layers from the Service or Trail
Paths of the Optical Transport Service, Multipoint Transport Service, ODU Trail, and
OTU Trail configuration forms. Figure 16, “OTN layer navigation from Optical Transport
Service form” (p. 216) shows the trail hierarchy on the navigation tree of the Optical
Transport Service form and Figure 17, “OTN layer navigation from trail ODU Trail form”
(p. 217) shows the trail hierarchy on the navigation tree of the ODU Trail form.

Figure 15 Optical trail navigation tree objects
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Figure 16 OTN layer navigation from Optical Transport Service form
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12.4.2 Force XC creation

NFM-P allows you to create OCH XCs even while the power commissioning is in
progress. This option is available during the configuration of:

• OTU trails

• ODU trails

• OCH trails

• optical transport service

• multipoint transport service

During a service or trail configuration, you can enable the Force Create OCH XC check
box on the configuration forms and bypass the check to ensure that the OCH XCs are
successfully power commissioned.

Note: NFM-P displays a deployment error if you attempt to configure a service or an
optical trail when the power commissioning is in progress. The deployment error will not
halt service or trail creation.

After a service or trail configuration, you can enable the Force Create OCH XC check
box on the configuration forms and click Complete service or Complete Trail to complete
the service or trail configuration.

Figure 17 OTN layer navigation from trail ODU Trail form
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12.4.3 Delay measurement for OTH path

NFM-P allows you to initiate an on-demand delay measurement for an ODU trail. The
following OTs can perform an on-demand delay measurement of ODU trails:

• 11QPA4
• 11QPEN4
• 112SDX11

• 130SCX10
• 130SNX10
• 260SCX2

To initiate a delay measurement, click More Actions on the ODU Trail (Edit) form and
choose Delay Measurement→Start. Upon retrieval of the delay measurement values, the
DM Current Status and the DM Current Value (us) parameters are updated in the ODU
Trail (Edit) form.

To stop the delay measurement, click More Actions on the ODU Trail (Edit) form and
choose Delay Measurement→Stop.

The line ports also display the following delay measurement parameters on the General
tab of the Physical Port (Edit) form:

• Connection Monitoring End Point Mode

• DM Current Status

• DM Current Value (us)

The Connection Monitoring End Point Mode parameter can be set to ByPass, Source, or
Destination. The value is set to ByPass by default.
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Optical trail configuration procedures

12.5 To configure an ODU trail

12.5.1 Before you begin

Ensure that the rate and transmit frequency are configured before creating the ODU trail.

12.5.2 Steps

1

Choose Create→OTN→ODU Trail from NFM-P main menu. The ODU Trail (Create)
form opens.

2

Select a customer in the Customer panel and configure the required parameters.

Note: The Trail ID parameter is configurable when the Auto-Assign ID
parameter is disabled.
If you configure the Protection Type parameter as Segment Protected, the Path
Search Option parameter is set to User Defined by default and cannot be
configured.
If you configure the Protection Type parameter as Segment Protected, the path
constraints need to be configured. See Step 13 .

3

Configure the Protection Path Finding Options parameter if the Protection Type
parameter is configured as SNCN Protected, SNCNC Protected, or SNCI Protected.

4

Configure the parameters in the OTU/OCH Details panel.

1. Configure the Spectral Width parameter for the CDC-F configuration with D5X500
cards.

2. If you have configured the Wave Key Assign mode as Manual Keying, configure
the parameters in the Wavekey Attributes panel.

3. If you need to reuse the wave keys, configure the Wave Key Preference
parameter as Duplicates Allowed.

Note: Rekey with duplicates may or may not allow reuse of wave keys that are
already used by a channel. The specific channel number is marked as "Allow
duplicate wave keys" for an 1830 PSS device.
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4. If you need to create OCH XCs even while the power commissioning is in
progress, configure the Force Create OCh XC parameter.

5

Configure the required parameters in the ODUk Attributes panel.

6

Configure the required parameters in the TTI Attributes panel.

Note: Configure the A-Z Source Tx TTI, Z-A Source Tx TTI, A-Z Destination Tx
TTI, and Z-A Destination Tx TTI parameters for OCS nodes.
Configure the A-Z Transmitted TTI, Z-A Transmitted TTI, A-Z Expected TTI, and
Z-A Expected TTI parameters for WDM nodes.

7

Configure the Administrative State parameter in the States panel.

8

Right-click on the Sites object on the navigation tree and choose Create Trail Site.
The Select Network Elements - ODU Trail form opens with a list of 1830 PSS WDM
and OCS devices.

9

Select two sites and click OK. The site objects appear on the navigation tree.

10

Right-click on the Site A End object on the navigation tree and choose Create Trail
Termination Point. The Select Termination Point - ODU Trail form opens.

11

Choose the termination point and click OK. The termination point objects appear on
the navigation tree.

12

Repeat Step 10 to Step 11 to configure the Site Z End.

13

Configure the path constraints, if required. See 12.7 “To configure path constraints
for ODU trails” (p. 221) .

14

Click Apply. The form name changes to ODU Trail (Edit) form.

To configure an ODU trail NFM-P
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15

Expand the Trail Paths object on the navigation tree and click on the ODU Trail Path
object to view the properties of the ODU trail.

16

Close the ODU Trail (Edit) form.

END OF STEPS

12.6 To discover services associated with ODU trails

12.6.1 Steps

1

Choose Manage→OTN→OTN Trails from NFM-P main menu. The Manage OTN
Trails form opens.

2

Choose ODU Trail (Optical Management) from the object drop-down menu. A list of
ODU trails appears.

3

Choose an ODU trail and click Properties. The ODU Trail (Edit) form opens.

4

Click on the Transported Services tab and click Discover Services. The service is
listed in the ODU Trail (Edit) form and the Used By a Service check box of the
Manage OTN Trails Form is selected.

5

Close the Manage OTN Trails form.

END OF STEPS

12.7 To configure path constraints for ODU trails

12.7.1 Steps

1

Perform one of the following:
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a. To configure path constraints during an optical trail configuration:

1. Configure an ODU trail. See 12.5 “To configure an ODU trail” (p. 219) .

2. Click on the Path Constraints tab on the ODU Trail (Create) form.

b. To configure path constraints for an existing ODU trail:

1. Choose Manage→OTN→OTN Trails from NFM-P main menu. The Manage
OTN Trails form opens.

2. Choose ODU Trail (Optical Management) from the object drop-down menu.
The OTU trails are listed.

3. Choose an ODU trail and click Properties. The OTU/ODU/OCH Trail (Edit)
form opens.

4. Click on the Path Constraints tab.

2

Click Create. The Optical Path Constraint (Create) form opens.

3

Configure the required parameters.

Choose Exclusion to exclude the constraint element from the trail path and choose
Inclusion to include the constraint element in the trail path.

ODUk Rate is applicable only when the Constraint Element is ODUk Timeslot.

To apply the direction for a path constraint, configure the Direction parameter.

4

Configure the Service Path Type parameter for the Protected ODU trail.

5

Perform one of the following:

a. If the constraint element is a port:

1. Select a site on the Site panel.

2. Select a port on the Port panel.

b. If the constraint element is a site, select a site on the Site panel.

Note: Configure the Regeneration Option parameter, if the Constraint Type
is configured as Inclusion and the Constraint Element as Site, before
selecting the site.

c. If the constraint element is a trail, select a trail on the Trail panel.

d. If the constraint element is an ODUk timeslot:

1. Configure the ODUk Rate parameter.

To configure path constraints for ODU trails NFM-P
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2. Select a site on the Site panel.

3. Select an ODUk Timeslot on the ODUk Timeslot panel.

e. If the constraint element is an optical link:

1. Select a site on the Site panel.

2. Select an optical link on the Optical Link panel.

6

Click OK. The Optical Path Constraint (Create) form closes and the ODU Trail (Edit)
form reappears.

7

Click Apply to save the changes.

8

Expand the Trail Paths object on the navigation tree and expand the ODU Trail Path
object.

9

Click on the Hops A to Z tab to verify the inclusion or exclusion of the path constraint.

10

Close the form.

END OF STEPS

12.8 To modify the protection and route of an ODU trail

Note:

NFM-P supports the following modifications of protection and route of the HO-ODU and
LO-ODU trails:

• unprotected to SNCN protected

• SNCN protected to unprotected

• unprotected to SNCNC protected

• SNCNC protected to unprotected

• unprotected to segment protected

• segment protected to unprotected

• route modification for HO-ODU (OCS to OCS and OCS to 1830 PSS-32 in the
intermediate nodes only)

• route modification for LO-ODU (OCS to OCS and OCS to 1830 PSS-32)
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12.8.1 Steps

1

Choose Manage→OTN→OTN Trails from NFM-P main menu. The Manage OTN
Trails form opens.

2

Choose ODU Trail (Optical Management) from the object drop-down menu.

3

Choose an ODU trail and click Properties. The ODU Trail (Edit) form opens.

4

Configure the required parameters.

5

Configure the Protection Type parameter depending on the conversion from
protected to unprotected or unprotected to protected.

Note: The modification of the Protection Type parameter results in the deletion
of the APS groups.

6

Perform one of the following.

a. Convert a segment protected, SNCN protected, or SNCNC protected ODU trail to
an unprotected ODU trail, configure the Path Preference parameter to indicate the
path that needs to be retained as the unprotected path.

b. Convert an unprotected ODU trail to an segment protected, SNCN protected, or
SNCNC protected ODU trail:

1. Right click on the Site A End and choose Create Trail Termination Point. The
Select Termination Point - ODU Trail form with a list of termination points
opens.

2. Choose a termination point from the list and click OK. The Select Termination
Point - ODU Trail form closes and the termination point is added to the ODU
Trail navigation tree.

3. Perform 1 and 2 on Site Z End and add termination point, as required.

7

Configure path constraints, as required. See 12.7 “To configure path constraints for
ODU trails” (p. 221) for more information about configuring the path constraints.
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8

Click Apply.

9

Expand the Trail Paths object on the navigation tree to view the trail path attributes.

When you convert a protected ODU trail to an unprotected ODU trail, only the
unprotected path object appears instead of the working and protection path objects

END OF STEPS

12.9 To configure an ODUCTP

12.9.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card→Line
Port→ODU.

2

Right-click on the ODU object and choose Properties. The Odu Ctp (Edit) form
opens.

3

Configure the required parameters in the ODUk Attributes panel.

4

Configure the required parameters in the TTI Attributes panel.

Note: You can enter the Transmitted TTI and Expected TTI values up to 15
characters for 1830 PSS devices and up to 64 characters for other devices.

5

Save your changes and close the form.

END OF STEPS
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12.10 To configure an OTU trail

12.10.1 Before you begin

Perform the following before creating an OTU trail:

• Configure the rate and frequency of the terminating sites.

• Create optical links between the terminating sites.

Note:

The OTU trail is created automatically, when you configure an optical link between
two OT line ports.

12.10.2 Steps

1

Choose Create→OTN→OTU Trail from NFM-P main menu. The OTU Trail (Create)
form opens.

2

Select a customer in the Customer panel and configure the required parameters.

Note: The Trail ID parameter is configurable when the Auto-Assign ID
parameter is disabled.

3

Configure the parameters in the OCH panel.

1. Enable the Show Flex Grid Channels check box and configure the Channel
parameter for OTU trail configuration.

2. Configure the Spectral Width parameter for the CDC-F configuration with D5X500
cards.

3. If you have configure the Wave Key Assign mode as Manual Keying, configure
the parameters in the Wavekey Attributes panel

Note: Rekey with duplicates may or may not reuse wave keys which are already
used by a channel. The specific channel number is marked as "Allow duplicate
wave keys" for an 1830 PSS device.

4. If you need to reuse the wave keys, configure the Wave Key Preference
parameter as Duplicates Allowed.

5. If you need to create OCH XCs even while the power commissioning is in
progress, configure the Force Create OCh XC parameter.
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4

Configure the Protection Path Finding Options parameter, if the Protection Type
parameter is configured as OPS Protected.

5

Configure the parameters on the Wavekey Attributes panel, as required, if the Wave
Key Assign Mode parameter is set to Manual Keying.

Note: A service created with manual wave keying cannot be re-keyed.

6

Configure the required parameters in the TTI Attributes panel.

Note: Configure the A-Z Source Tx TTI, Z-A Source Tx TTI, A-Z Destination
TTI, and Z-A Destination TTI parameters for OCS nodes.
Configure the A-Z Transmitted TTI, Z-A Transmitted TTI, A-Z Expected TTI, and
Z-A Expected TTI parameters for WDM nodes.

7

Configure the Administrative State parameter in the States panel.

8

Right-click on the Sites object on the navigation tree and choose Create Trail Site.
The Select Network Elements - OTU Trail form opens with a list of 1830 PSS
devices.

9

Choose two sites from the list and click OK. The site objects appear on the
navigation tree.

10

Right-click on the Site A End object and choose Create Trail Termination Point. The
Select Termination Point form opens.

11

Choose the termination point and click OK. The Termination Point object appears on
the navigation tree below the Site A End object.

12

Repeat Step 10 to Step 11 to configure the Site Z End.
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13

Expand the Site A End and Site Z End objects on the navigation tree, to view the
termination points added on the navigation tree.

14

Click Apply to save the changes. The form name changes to OTU Trail (Edit) form.

15

Expand the Trail Paths object on the navigation tree and click on the OTU Trail Path
object to view the properties of the OTU trail.

16

Close the OTU Trail (Edit) form.

Note: See 12.7 “To configure path constraints for ODU trails” (p. 221) for more
information about configuring path constraints. ODUk Timeslot is not supported
as a constraint element for OTU trail.

END OF STEPS

12.11 To auto-discover an OTU trail

12.11.1 Steps

1

Configure internal topological links between the line port of a hybrid card (OCS) or
OT card (WDM) and an SFC channel port. See 9.47 “To configure an OCS
topological link” (p. 165) for more information about configuring topological links.

2

Configure an external topological link between the OMD ports of the participating
OCS SFC cards. See 9.47 “To configure an OCS topological link” (p. 165) for more
information about configuring topological links.

3

Choose Manage→OTN→OTN Trails from NFM-P main menu. The Manage OTN
Trails form opens.

4

Click Discover Optical Trails. The Discover Optical Trails form opens with a list of
equipment groups.
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5

Choose a equipment group and click OK. The OTN trails are listed in the Manage
OTN Trails form.

6

Close the Manage OTN Trails form.

END OF STEPS

12.12 To discover client trails from an OTU trail

Note: When an OTU trail exists between the client port of a 130SCX10 card and a line
port of a 11DPM12 card on the same device, you can discover the client trail from the
OTU Trail (Edit) form.

12.12.1 Steps

1

Choose Manage→OTN→OTN Trails from NFM-P main menu. The Manage OTN
Trails form opens.

2

Choose OTU Trail (Optical Management) from the object drop-down list. A list of
OTU trails appears.

3

Choose the required OTU trail and click Properties. The OTU Trail (Edit) form opens.

4

Click on the OTU Trail object on the navigation tree of the OTU Trail (Edit) form.

5

Click Discover Client Trails and click on the HO-ODU Trails tab. The discovered
ODU trail is listed on the HO-ODU Trails tab.

6

Close the OTU Trail (Edit) form. The Manage OTN Trails form reappears.

7

Choose ODU Trail (Optical Management) from the object drop-down list. A list of
ODU trails appears. The ODU trail discovered on the OTU Trail form is displayed in
the list.
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8

Close the Manage OTN Trails form.

END OF STEPS

12.13 To configure an OCH trail

12.13.1 Before you begin

The following points should be considered before creating the OCH trail:

• Configure the rate, transmit frequency, and receive frequency of the terminating sites.

• Create optical links between the terminating sites.

12.13.2 Steps

1

Choose Create→OTN→OCH Trail from NFM-P main menu. The OCH Trail (Create)
form opens.

2

Select a customer in the Customer panel and configure the required parameters.

Note: The Trail ID parameter is configurable when the Auto-Assign ID
parameter is disabled.

3

If you need to create OCH XCs even while the power commissioning is in progress,
configure the Force Create OCh XC parameter.

4

Configure the Protection Path Finding Options parameter, if the Protection Type
parameter is configured as OPS Protected.

5

Configure the parameters in the OCH panel.

1. Enable the Show Flex Grid Channels check box and configure the Channel
parameter for OCH trail configuration.

2. Configure the Spectral Width parameter for the CDC-F configuration with D5X500
cards.

3. If you have configured the Wave Key Assign mode as Manual Keying, configure
the parameters in the Wavekey Attributes panel.
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4. If you need to reuse the wave keys, configure the Wave Key Preference
parameter as Duplicates Allowed.

Note: Rekey with duplicates may or may not allow reuse of wave keys that are
already used by a channel. The specific channel number is marked as "Allow
duplicate wave keys" for an 1830 PSS device.

Note: If the Wave Key Assign Mode parameter is set to Manual Keying,
configure the parameters on the Wavekey Attributes panel, as required. A
service created with manual wave keying cannot be re-keyed.

6

Configure the Administrative State parameter in the States panel.

7

Right-click on the Sites object on the navigation tree and choose Create Trail Site.
The Select Network Elements - OCH Trail form opens.

8

Choose two sites from the list and click OK. The site objects are added on the
navigation tree.

9

Right-click on the Site A End object on the navigation tree and choose Create Trail
Termination Point. The Select Termination Point - OCH Trail form opens.

10

Choose the termination point and click OK. The termination point objects appear on
the navigation tree.

11

Repeat Step 9 to Step 10 to configure the Site Z End.

12

Click Apply. The form name changes to OCH Trail (Edit) form.

13

Expand the Trail Paths object on the navigation tree and click on the OCH Trail Path
object to view the properties of the OCH trail.

14

Close the OCH Trail (Edit) form.
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Note: See 12.7 “To configure path constraints for ODU trails” (p. 221) for more
information on configuring path constraints. ODUk Timeslot is not supported as
a constraint element for OCH trail.

END OF STEPS

12.14 To auto-configure an OMS trail

12.14.1 Steps

1

Configure an internal topological link between the line port of a hybrid card in the
OCS device and an SFC channel port in the same OCS device. See 9.47 “To
configure an OCS topological link” (p. 165) for more information about configuring
topological links.

2

Configure one of the following to auto-configure an OMS trail:

a. an external topological link from the OMD port of the participating SFC card in the
OCS device to the OMD port of an SFC card in another OCS device. See
9.47 “To configure an OCS topological link” (p. 165) for more information about
configuring topological links.

b. an external topological link from the OMD port of the participating SFC card in the
OCS device to the OMD port of an SFC card in a WDM device. See 9.47 “To
configure an OCS topological link” (p. 165) for more information about configuring
topological links.

3

To view the auto-configured OMS trail, choose Manage→OTN→OTN Trails from
NFM-P main menu. The Manage OTN Trails form opens.

4

Choose OMS Trail (Optical Management) from the object drop-down menu. The
auto-created OMS trail is listed.

Note: The OMS trails are deleted when the external topological links
configured in Step 2 are deleted.

5

Close the Manage OTN Trails form.

END OF STEPS

To auto-configure an OMS trail NFM-P
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12.15 To view an OTS trail

12.15.1 Steps

1

Choose Manage→OTN→OTN Trails from NFM-P main menu. The Manage OTN
Trails form opens.

2

Choose OTS Trail (Optical Management) from the object drop-down menu. A list of
OTS trails appears.

3

Choose an OTS trail and click Properties. The OTS Trail (Edit) form opens.

END OF STEPS

12.16 To discover optical trails

12.16.1 Steps

1

Choose Manage→OTN→OTN Trails from NFM-P main menu. The Manage OTN
Trails form opens.

2

Click Discover Optical Trails. The Discover Optical Trails form opens with a list of
equipment groups.

3

Choose a equipment group and click OK. A list of optical trails in the group appears.

4

Close the Manage OTN Trails form.

END OF STEPS
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12.17 To view the optical channel usage

12.17.1 Steps

1

Choose Manage→OTN→OTN Trails from NFM-P main menu. The Manage OTN
Trails form opens.

2

Choose Optical Channel Usage (Optical Management) from the object drop-down
menu. The optical channel usage list appears.

3

Choose a channel and click Properties. The Optical Channel Usage (View) form
opens.

END OF STEPS

To view the optical channel usage NFM-P
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13 1830 PSS OTH facility management

13.1 Overview

13.1.1 Purpose

This chapter provide information about the OTH facilities.

13.1.2 Contents

13.1 Overview 235

OTH facility 236

13.2 Overview 236

13.3 ODU facility types 238

ODUk cross-connections 244

13.4 ODUk cross-connection 244

13.5 To configure ODUk cross-connects 244

13.6 To sub-structure ODUk timeslots 245

Virtual OCH cross-connection 247

13.7 Virtual OCH cross-connections 247

ODUk protection groups 248

13.8 Overview 248

13.9 To configure ingress path overhead monitoring 249

13.10 To configure ODUk protection groups 249

13.11 To configure 1:N ODUk protection groups 252

13.12 To configure protection switching 254
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OTH facility

13.2 Overview

13.2.1 Autoconfigured OTH facilites

NFM-P supports auto-configuration of the following OTH facilities:

• OTUk • ODUPTF

• ODUk • OMS

• OCH • OMSOCH

• GBE • OMSOCHIF

• OCN • OTS

13.2.2 Transmitted trail trace identifier

NFM-P supports configuration of the following TTI parameters for the OTH facilities.

• Transmit SAPI—transmit source access point identifier, valid for terminated TCM only.

• Expected SAPI—expected incoming source access point identifier, valid for
termination and non-intrusive monitoring.

• Transmit DAPI—transmit destination access point identifier, valid for terminated TCM
only.

• Expected DAPI—expected incoming destination access point identifier, valid for
termination and non-intrusive-monitoring.

Note: The NIM facility objects only have Expected SAPI and Expected DAPI.

The configurations of the TTI parameters can be performed using hexadecimal string
format or quoted ASCII string format.

• Hexadecimal string format consists of 31 ASCII characters, that is, X followed by 30
hexadecimal characters. The 15 byte TTI encodes into 30 half-byte characters in
hexadecimal format. The string starts after the all-zero header byte generated by the
device.

• Quoted ASCII string format consists of 0-15 ASCII valid input characters. If the value
consists of all ASCII NULLs, then 15 "." characters is displayed. See Nokia 1830
Photonic Service Switch TL1 Commands and Messages Guide for more information.

When the Region parameter on the Network Element (Edit) form is set to ETSI, the TTI
parameters can be configured without any restrictions.
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When the Region Parameter is set to ANSI and the Command Mode parameter is set to
Normal on the Network Element (Edit) form, the TTI parameters cannot be configured.
The Command Mode parameter needs to be set to Forced to configure the TTI
parameters.

The STMN (STM1, STM4, STM16, STM64) facilities can be configured for the ETSI
region nodes. The OCN facilities can be configured for the ANSI region nodes.

13.2.3 OTUk facility

NFM-P auto-configures the OTUk facility object when the OTUk signal rate is configured
on the line or client ports.

13.2.4 ODUk and NIM facilities

An ODUk entity is used for non-intrusive monitoring (NIM). NIM is a method for reporting
defects and performance monitoring for an intermediate path on non-terminated add-
drop and through connections.

NFM-P supports the following ODUk facility objects in the physical and virtual planes of
the WDM and OCS device as listed in Table 17, “ODU facility objects on the 1830 PSS
device” (p. 236). The facilities in the physical plane are associated with an OT or client
/line card. The facilities in the virtual plane are associated with the internal shelf matrix.
The object IDs for these facilities have slot number as 71.

Table 17 ODU facility objects on the 1830 PSS device

ODU facility object GUI naming convention Example

Non-terminated HO-ODUs in the physical
plane

OTUODUk-<shelf>/<slot>/<port> OTUODU2-3/3/H1

Non-terminated LO-ODUs in the virtual plane ODUmODUn-<shelf>/71/<HO-ODU#>-<LO-
ODU#>

ODU4ODU1-1/71/1-3

Client-transparent ODUs ODUk-<shelf>/<slot>/<client port> ODU1-1/2/C1

Terminated HO-ODUs in the virtual plane ODUk-<shelf>/71/<ODU#> ODU4-2/71/1

13.2.5 ODUPTF facility

NFM-P auto-configures the ODUPTF when a cross-connect is configured between a
non-terminated ODUn and an ODUPOOL.

NFM-P auto-configures the ODUPTF facility when a transparently transported GBE10,
STM-64, OC-192, STM-16, OC-48, GBE is created.
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13.2.6 OMS, OTS, OMSOCH, and OMSOCHIF facilities

NFM-P auto-configures the OMSOCHIF on the SFC8 channel port when an internal
bidirectional optical link is configured from a 10AN10G or a 4AN10G line port to the
SFC8 channel port.

NFM-P auto-configures the OMS, OTS, and OMSOCH facilities on the OMD port of the
SFC8 OMD port when an internal bidirectional optical link is configured from a 10AN10G
or a 4AN10G port to an SFC8 channel port and an external optical link is configured from
the OMD port of the same SFC card to an SFC8 OMD port of a WDM or an OCS node.

13.2.7 OCH, GBE, and OCN facilities

NFM-P auto-configures the OCH facility when the OCH signal rate is configured on the
line or client ports.

NFM-P auto-configures the GBE facility when 1, 10, or 100 GbE signal rates are
configured on the line or client ports.

NFM-P auto-configures the OCN facility when OC3, OC12, OC48, or OC192 signal rates
are configured on the line or client ports.

13.3 ODU facility types

13.3.1 Non-terminated ODUs (ODUNIM)

NFM-P supports the following types of non-terminated ODU facilities:

• “HO-ODU” (p. 238) in the physical plane—OTUODUn

• “LO-ODU” (p. 239)

• “LO-ODU in the virtual plane” (p. 240)—ODUmODUn-(1-xx)-(1-xx)

• “LO-ODU in the PSS-8 and PSS-16II virtual plane” (p. 240)

NFM-P supports auto-configuration of the following NIM facilities when the signal rates of
the I/O card ports are configured:

• 130SCUP, 130SCUPB, or 130SCUPC—OTU4 with an unterminated higher order
ODU4 (higher order ODU4 NIM)

• 11QCUPC—OTU2 with an unterminated higher order ODU2 (higher order ODU2 NIM)

• 43SCUP—OTU3e2 with an unterminated higher order ODU3e2 (higher order ODU3e2
NIM)

• 10AN10G—OTU2 with an unterminated higher order ODU2 (higher order ODU2 NIM)

• 4AN10G—OTU2 with an unterminated higher order ODU2 (higher order ODU2 NIM).

HO-ODU

NFM-P auto-configures the HO-ODU facility object as a child object of the OTU facility
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object on the navigation tree, when the port is configured.

NFM-P supports non-terminated HO-ODU facilities for the cards and ports listed in
Table 18, “Non-terminated HO-ODU facilities ” (p. 238).

Table 18 Non-terminated HO-ODU facilities

Card Port Parent on
Tree

Label on Tree

112SDX11 C{1-10} OTU1f OTUODU1f

112SDX11 C{1-10} OTU2 OTUODU2

112SDX11 C{1-10} OTU2e OTUODU2e

11DPM12 C{1-12} OTU1 OTUODU1

1UD200 L1 CH1-OTU4 OTUODU4

CH2-OTU4

20P200 {1-20} OTU2 OTUODU2

20P200 {1-20} OTU2e OTUODU2e

260SCX2 L1 CH1-OTU4 OTUODU4

CH2-OTU4

260SCX2 C1 OTU4 OTUODU4

4QPA8 L{1-4} OTU1 OTUODU1

D5X500 L{1-2} OTU4-{1-5} OTUODU4

LO-ODU

NFM-P auto-configures the LO-ODU when the LO-ODUk structure is defined for the
parent-terminated HO-ODU.

NFM-P supports non-terminated LO-ODU facilities for the cards and ports listed in Table
19, “LO-ODU” (p. 239).

Table 19 LO-ODU

Card Port Parent on
Tree

Label on Tree

11DPM12 L{1-2} ODU2 ODU2ODU0-{1-8}

11DPM12 L{1-2} ODU2 ODU2ODU1-{1-8}

11DPM12 L{1-2} ODU2 ODU2ODUFlex-{1-8}
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Table 19 LO-ODU (continued)

Card Port Parent on
Tree

Label on Tree

11DPM4M L{1-2} ODU2 ODU2ODU0-{1-8}

11DPM8

11DPM4M L{1-2} ODU2 ODU2ODU1-{1-8}

11DPM8

20P200 BP{1,2} ODU4 ODU4ODU2-{1-80}

20P200 BP{1,2} ODU4 ODU4ODU2e-{1-80}

4QPA8 L{1-4} ODU1 ODU1ODU0-{1-2}

LO-ODU in the virtual plane

NFM-P auto-configures the ODU facility when the terminated HO-ODU is auto-
configured as a result of a cross-connect between a non-terminated HO-ODU and an
ODUPOOL.

LO-ODU in the PSS-8 and PSS-16II virtual plane

NFM-P supports non-terminated LO-ODU facilities in the virtual plane. These facilities
are initially created when the terminated HO-ODU is created. They are also created or
deleted when the sub-structure of the parent HO-ODU is modified.

Table 20 LO-ODU in the PSS-8 and PSS-16II virtual plane

Parent on Tree Label on Tree

ODU2-<HO-ODU ID> ODU2ODU0-{1-8}

ODU2-<HO-ODU ID> ODU2ODU1-{1-8}

13.3.2 Terminated ODUs

NFM-P supports the following types of terminated ODU facilities:

• “Client transparent ODU” (p. 241)—ODUk

• “HO-ODU” (p. 242)

• “HO-ODU in the virtual plane” (p. 243)—ODUk-(1-xx)

• “HO-ODU in the PSS-8/PSS-16II virtual plane” (p. 243)

ODU facility types NFM-P
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Client transparent ODU

NFM-P auto-configures the ODU facility in the physical plane when a non-OTN port is
configured.

NFM-P supports client transparent ODU facilities for the cards and ports listed in Table
21, “Client transparent ODU” (p. 240).

Table 21 Client transparent ODU

Card Port Parent on
Tree

Label on
Equipment
Tree

When Created

112SDX11 C{1-10} C{1-10} ODU2e Signal Rate =
CBR10G3

112SDX11 C{1-10} C{1-10} ODU2e Signal Rate =
10GBE

112SDX11 C{1-10} C{1-10} ODUFlex Signal Rate =
DDR, FC400,
FC800, FC1200,
FC1600

112SDX11 C11 C11 ODUFlex Signal Rate =
40GBE MLD

11DPM12 C{1-12} C{1-12} ODU0 Container = ODU0

11DPM12 C{1-12} C{1-12} ODU1 Container = ODU1

11DPM12 C{1-12} C{1-12} ODUFlex Container =
ODUFlex

11DPM12 C{1-12} C{1-12} OPTSG Container =
OPTSG

[No provisioning,
alarm or PM]

11DPM4M C{1-8} C{1-8} ODU0 Container = ODU0

11DPM8

11DPM4M C{1-8} C{1-8} ODU1 Container = ODU1

11DPM8

20P200 {1-20} {1-20} ODU2 Signal Rate =
OC192/STM64 or

Signal Rate =
10GbE & ODU
Rate = ODU2
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Table 21 Client transparent ODU (continued)

Card Port Parent on
Tree

Label on
Equipment
Tree

When Created

20P200 {1-20} {1-20} ODU2e Signal Rate =
10GbE & ODU
Rate = ODU2e

260SCX2 C{1-2} C{1-2} ODU4 Signal Rate =
100GbE

4QPA8 C{1-8} C{1-8} ODU0 Container = ODU0

4QPA8 C{1-8) C{1-8} OPTSG Container =
OPTSG

[No provisioning,
alarm or PM]

D5X500 C{1-5} C{1-5} ODU4 Signal Rate =
100GbE

HO-ODU

NFM-P auto-configures the ODU facility when the line port is configured.

NFM-P supports HO-ODU facilities for the ports listed in Table 22, “HO-ODU” (p. 242).

Table 22 HO-ODU

Card Port Parent on
Tree

Label on
Equip-
ment
Tree

112SDX11 L1 OTU4 ODU4

11DPM12 L{1,2} OTU2 ODU2

11DPM4M L{1,2} OTU2 ODU2

11DPM8

20P200 BP{1,2}
with
Signal
Rate =
OTL4.10

BP{1,2} ODU4

4QPA8 L{1-4} OTU1 ODU1
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HO-ODU in the virtual plane

NFM-P auto-configures the ODU facility in the virtual plane when a cross-connect is
configured between a non-terminated HO-ODU and an ODUPOOL.

HO-ODU in the PSS-8/PSS-16II virtual plane

NFM-P supports HO-ODU facilities in the PSS-8/PSS-16II virtual plane (slot 71). The
facilities are automatically created in the virtual plane (slot 71) when an ODU XC is
created between a non-terminated HO-ODU and ODUPOOL. The Equipment tree parent
for these facilities is the virtual card (slot 71). The supported facility includes: ODU2-
<HO-ODU ID> where PSS-8/PSS-16II virtual plane HO-ODU ID = {1001-1080}.
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ODUk cross-connections

13.4 ODUk cross-connection

13.4.1 Overview

NFM-P allows you configure the ODUk cross-connect from:

• manage menu—parameter values are not inherited

• shelf object—the site and shelf parameter values are inherited from the current device

See 13.5 “To configure ODUk cross-connects” (p. 244) for more information about
configuring an ODUk cross-connects.

13.4.2 Virtual plane

NFM-P auto-configures the HO-ODUs in the virtual plane when the cross-connects are
configured between the non-terminated HO-ODUs and ODUPOOLs. The ODUs are
listed in the Virtual Plane tab of the Shelf (Edit) form.

13.4.3 ODU sub-structure

NFM-P supports sub-structuring of the ODUs. See 13.6 “To sub-structure ODUk
timeslots” (p. 245) for more information about sub-structuring the ODUs.

13.5 To configure ODUk cross-connects

13.5.1 Steps

1

Perform one of the following to open the ODUk Cross Connect (Create) form:

a. From NFM-P main menu:

1. Choose Manage→OTN→ODUk Cross Connects. The Manage ODUk Cross
Connects form opens.

2. Click Create. The ODUk Cross Connect (Create) form opens.

3. Go to Step 2 .

b. From the Shelf object on the navigation tree.

1. On the equipment tree, expand Network→NE→Shelf.

2. Right-click on the Shelf object and choose Properties. The Shelf (Edit) form
opens.

3. Click on the ODUk Cross Connects tab.

4. Click Create. The ODUk Cross Connect (Create) form opens.

ODUk cross-connection NFM-P
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5. Go to Step 4 .

2

Select a site for the ODUk cross connect in the Site panel.

3

Select a shelf for the ODUk cross connect in the Shelf panel.

4

Configure the required parameters.

5

If A or Z end needs to terminate on the ODU pool, configure the Termination on
ODUPOOL parameter for A or Z end.

6

Select an HO-ODU facility in the A-End and Z-End panels.

7

Save your changes and close the forms.

END OF STEPS

13.6 To sub-structure ODUk timeslots

13.6.1 Steps

1

On the equipment tree, expand Network→NE→Shelf.

2

Right-click on the Shelf object and choose Properties. The Shelf (Edit) form opens.

3

Click on the Virtual Plane tab. The HO-ODUks are listed.

Note: The HO-ODUk is auto-configured in the virtual plane when a cross-
connect is configured between an ODUPOOL and a non-terminated HO-ODU.
See 13.5 “To configure ODUk cross-connects” (p. 244) for more information
about configuring ODUk cross-connects.

4
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Choose an HO-ODUk from the list and click Properties. The ODU Path Termination
(Edit) form opens.

5

Click on the ODU Structure tab.

6

Choose the LO-ODUs based on the timeslot mapping in Table 23, “ODUk timeslot
mapping” (p. 245), and click Bind Timeslots. The LO-ODUk Configuration form
opens.

Table 23 ODUk timeslot mapping

Auto-configured
HO-ODUk

Rate No of
LO-ODUs to
bind
timeslots

Size of the tributary slot

ODU2/ODU2e ODU0 8 1.25G

ODU1 4 1.25G

ODU3/ODU3e2 ODU0 32 1.25G

ODU1 16 1.25G

ODU2/ODU2e 4 1.25G

ODU4 ODU0 80 1.25G

ODU1 40 1.25G

ODU2/ODU2e 10 1.25G

ODU3/ODU3e2 2 1.25G

7

Configure the required parameters and click OK.

8

Scroll to the bottom of the list to view the newly created timeslot.

9

Choose a bound timeslot and click Collapse Timeslots to retrieve the initial timeslots.

10

Save your changes and close the forms.

END OF STEPS
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Virtual OCH cross-connection

13.7 Virtual OCH cross-connections

13.7.1 Overview

NFM-P auto-configures a virtual OCH cross-connection when an internal topological link
is configured from a line port of the client-line card to a channel port of an SFC8 card.
The virtual cross-connections that are auto-configured for an OCS node are listed on the
OCH Cross-Connects tab on the Network Element (Edit) form. You can choose an entry
and click Properties to open the Virtual Cross Connect (Edit) form.

NFM-P auto-configures working and protection virtual OCH cross-connections during
trail (OCH, OTU, or ODU) or service configuration or discovery, involving:

• OPSA card that is configured with the OCHP mode and located in one node with the
OPSA A and B ports connected to the filter card in an another node

• OPSA card that is configured with the OMSP mode and located in one node with the
OPSA A and B ports connected to the OPSA A and B ports on another node.
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ODUk protection groups

13.8 Overview

13.8.1 Introduction

NFM-P supports the configuration of the ODUk protection groups. The ODUk protection
group represents a path protected cross-connection in NFM-P. The ODUk protection
group can be configured for the rate facilities:

• ODUPOOL

• ODUk NIM

• client transparent ODUk

The ODUPOOL path terminated entity is configured as the client facility of the ODUk
protection group.

The protected and protecting ingress POMs (Path Overhead Monitoring) needs to be
enabled when the ODUk protection group is configured using the ODUk NIM entities.
See 13.9 “To configure ingress path overhead monitoring” (p. 249) for more information
about configuring the POMs.

The working and protecting facilities must be configured as the client transparent ODUk
facilities, to configure an SNCNC protection type of ODUk protection group. The client
transparent facilities can be configured as working and protecting, if they are configured
with the SDH or SONET signals rates.

NFM-P allows you configure the ODUk protection groups from the:

• manage menu

• OCS device object

• shelf object (by choosing the unprotected cross-connect)

• port object

• ODU facility object

For more information about configuring a protection group, see 13.10 “To configure
ODUk protection groups” (p. 249) .

NFM-P supports configuration of protection switching to configure either the working or
protection path as active or standby. See 13.12 “To configure protection switching”
(p. 254) for more information about configuring a protection switch.
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13.9 To configure ingress path overhead monitoring

13.9.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Port.

2

Right-click on the port object and choose Properties. The Physical Port (Edit) form
opens.

3

Click on the OTUODUk tab, then on the NIM tab. The OTUODU2 source and sink
entries are listed.

4

Choose the sink and click Properties. The ODU NIM Point (Edit) form opens.

5

Select the Path Overhead Monitoring check-box and click OK.

6

Save your changes and close the forms.

END OF STEPS

13.10 To configure ODUk protection groups

13.10.1 Steps

1

Perform one of the following to open the ODUk Protection Group (Create) form.

a. From NFM-P main menu.

1. Choose Manage→OTN→ODUk Protection Groups. The Manage ODUk
Protection Groups form opens.

2. Click Create. The ODUk Protection Group (Create) form opens.

3. Go to Step 2 .

b. From the equipment tree.

1. On the equipment tree, expand Network→1830 PSS.
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2. Right-click on the 1830 PSS object and choose Properties. The Network
Element (Edit) form opens.

3. Click on the APS Groups tab.

4. Click Create and choose ODUk APS Group. The ODUk Protection Group
(Create) form opens.

5. Go to Step 3 .

c. From the list of ODUk cross-connects on a shelf object or an ODU facility object.

1. On the equipment tree, expand Network→NE→Shelf object or
Network→NE→Shelf→Card→Port→ODU facility object.

2. Perform one of the following:

• Right-click on the Shelf object and choose Properties. The Shelf (Edit) form
opens.

• Right-click on the ODUk object and choose Properties. The ODU Path
Termination (Edit) form opens.

• Right-click on the OTUODUk object and choose Properties. The ODU NIM
(Edit) form opens.

3. Click on the ODUk Cross Connects tab.

4. Choose an unprotected ODUk cross-connect and click Protect. The ODUk
Protection Group (Create) form opens.

5. Go to Step 6 .

d. From the port object on the navigation tree.

1. On the equipment tree, expand Network→1830 PSS→Shelf→Port.

2. Right-click on the port object and choose Properties. The Physical Port (Edit)
form opens.

3. Click on the APS Groups tab.

4. Click Create and choose ODUk APS Group. The ODUk Protection Group
(Create) form opens.

e. From the ODU facility object on the navigation tree.

1. On the equipment tree, expand Network→NE→Shelf→Card→Port→ODU
object.

2. Perform one of the following:

• Right-click on the ODUk object and choose Properties. The ODU Path
Termination (Edit) form opens.

Note:

Ensure that the selected facilities are SONET or SDH rates, if you are
configuring client transparent facilities for the working and protection
parameters.

• Right-click on the OTUODUk object and choose Properties. The ODU NIM
(Edit) form opens.

To configure ODUk protection groups NFM-P
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Note:

Ensure that the ingress POM is configured before configuring the ODUk
protection group for the ODUk NIM entities. See 13.9 “To configure ingress
path overhead monitoring” (p. 249) for more information about configuring
the ingress POM.

3. Click on the APS Group tab.

4. Click Create. The ODUk Protection Group (Create) form opens.

2

Select a site in the Site panel.

3

Select a shelf in the Shelf panel.

4

Perform one of the following:

a. Configure the Client on ODUPOOL parameter. Go to Step 5 .

b. Select a client in the Client panel.

5

Select a facility object in the Working panel.

Note: Configure the working facility as HO-ODU NIM, if the Client on
ODUPOOL parameter is configured.

6

Select a facility object in the Protection panel.

Note: Configure the protection facility as HO-ODU NIM, if the Client on
ODUPOOL parameter is configured.

7

Configure the Protection Method parameter in the Working and Protection panels, as
required.

Note: Configure the Protection Method parameter as PNIM if the protection
type is SNCN or SNCNC.
Configure the Protection Method parameter as PADAPT for SNCI protection
type.

8

Configure the required parameters in the APS Configuration panel.
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Note: Configure the Protection Type parameter as SNCNC, if client transparent
ODU facilities are configured as working and protection facilities.

9

Save your changes and close the form.

END OF STEPS

13.11 To configure 1:N ODUk protection groups

13.11.1 1:N ODUk protection groups

NFM-P supports the configuration of 1:N ODUk protection groups on the ODUk facility
objects of the following cards with ODU2 or ODU2e rates:

• 4AN10G

• 10AN10G

• 10OTH10G

Bidirectional and revertive protection switching is supported. The Extra Traffic parameter
is disabled by default.

13.11.2 Before you begin

Before configuring a 1:N ODUk protection group, configure a TCM entity on the required
ODUk facility object on the 1830 PSS OCS device. See the Nokia 1830 PSS User
Provisioning Guide for more information about provisioning a TCM entity.

When Path Overhead Monitoring is enabled on an ODUk protection facility and the Extra
Traffic parameter is disabled, you cannot configure a 1:N ODUk protection group.

When an external command is active on a 1:N ODUk protection group, you cannot
delete the 1:N ODUk protection group.

13.11.3 Steps

1

Perform one of the following:

• Open the 1:N ODUk Protection Group form from the equipment tree.

1. On the equipment tree, expand Network→1830 PSS.

2. Right-click on the OCS device object and choose Properties. The Network
Element (Edit) form opens.

3. Click on the 1:N ODUk Protection Group tab and click Create. The 1:N ODUk
Protection Group (Create) form opens.

To configure 1:N ODUk protection groups NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

252 Issue 2



• Right-click on the required OCS device object on the physical topology map and
choose Add 1:N ODUk Protection Group. The 1:N ODUk Protection Group
(Create) form opens.

2

Select the required shelf in the Shelf panel.

3

Configure the Rate parameter.

4

Configure ODUk working and protection members on the Oduk Protection Members
panel.

1. Click Create. The ODUk Protection Member (Create) form opens.

2. Select the ODUk facility object in the Odu Facility Pointer panel.

3. Configure the required parameters.

You can configure a maximum of 14 working group members and one protection
group member.

The value of the ID parameter for the working group members must be unique for
an ODUk protection group.

4. Click OK. The ODUk working and protection members are listed in the Oduk
Protection Members panel.

5. Click Apply on the 1:N ODUk Protection Group (Create) form.

5

Configure protection switching.

1. Configure the Protection Switch parameter on the Protection Management panel.
See the Nokia 1830 PSS Product Information and Planning Guide for more
information about the options available for the Protection Switch parameter.

2. Select the source ODUk facility in the Source panel.

6

Save your changes and close the forms.

The status of the source and protection ports is displayed in the Source Port Status
and Protection Port Status panels.

END OF STEPS
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13.12 To configure protection switching

13.12.1 Steps

1

Perform one of the following to open the ODUk Protection Group (Edit) form.

a. From NFM-P main menu.

1. Choose Manage→OTN→ODUk Protection Groups. The Manage ODUk
Protection Groups form opens.

2. Choose a protection group and click Properties. The ODUk Protection Group
(Edit) form opens.

b. From the 1830 PSS device object on the equipment tree.

1. On the equipment tree, expand Network→1830 PSS.

2. Right-click on the 1830 PSS object and choose Properties. The Network
Element (Edit) form opens.

3. Click on the APS Groups tab.

4. Choose an entry and click Properties. The ODUk Protection Group (Edit) form
opens.

c. From the port object on the equipment tree.

1. On the equipment tree, expand Network→1830 PSS→Shelf→Port.

2. Right-click on the port and choose Properties. The Physical Port (Edit) form
opens.

3. Click on the APS Groups tab.

4. Choose an entry and click Properties. The ODUk Protection Group (Edit) form
opens.

d. From the ODU facility object on the equipment tree.

1. On the equipment tree, expand Network→NE→Shelf→Card→Port→ODU
object.

2. Perform one of the following:

• Right-click on the ODUk object and choose Properties. The ODU Path
Termination (Edit) form opens.

• Right-click on the OTUODUk object and choose Properties. The ODU NIM
(Edit) form opens.

3. Click on the APS Group tab.

4. Choose an entry and click Properties. The ODUk Protection Group (Edit) form
opens.

2

Configure the required parameters in the Protection Management panel.

To configure protection switching NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

254 Issue 2



Note: Configure the Request For parameter to specify the path that needs to
be switched.

3

Save your changes and close the form.

END OF STEPS
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Part VI: 1830 PSS service management

Overview

Purpose

This part provides information about optical transport services, VPLS, and mirror
services.

Contents

Chapter 14, 1830 PSS VPLS management 259

Chapter 15, 1830 PSS optical transport service management 273

Chapter 16, 1830 PSS mirror service management 367
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14 1830 PSS VPLS management

14.1 Overview

14.1.1 Purpose

This chapter describes VPLS, SHG, E-tree services and IGMP snooping. It also contains
the procedures to configure a VPLS service and SHG.

14.1.2 Contents

14.1 Overview 259

VPLS management 260

14.2 VPLS 260

14.3 To configure a VPLS 261

14.4 VLAN ranges 264

14.5 To configure an 1830 PSS connection profile 265

14.6 To configure VPLS VLAN range SAPs 266

14.7 Split horizon group 267

14.8 To configure an SHG 267

14.9 To add ports to an SHG 268

14.10 E-Tree services 268

14.11 IGMP snooping 270

14.12 MAC move 270

NFM-P 1830 PSS VPLS management

Release 17.3
April 2017
Issue 2 2593HE-12002-AAAA-TQZZA



VPLS management

14.2 VPLS

14.2.1 Introduction

VPLS is a class of virtual private network multipoint L2 service that provides connections
to multiple customer sites in a single bridged domain contained within the service
provider-managed IP/MPLS network. A VPLS service provides connectivity between two
or more SAPs. Customer sites in the VPLS appear to be on the same LAN, even when
the sites are geographically dispersed. See 14.3 “To configure a VPLS” (p. 261) for
more information about how to configure a VPLS.

NFM-P supports configuration of VPLS service on the following cards:

• 11OPE8

• 11QCE12X

• 11QPE24

The following conditions apply for the VPLS service configured using the L2 cards:

• VPLS is configured at the card level (and not at the NE level).

• A VLAN ID is only applicable when the SAP type is dot1q-preserve.

• A VPLS cannot be deleted if SAPs are defined for the service.

14.2.2 SAP

Each subscriber service type is configured with a minimum of one service access point
(SAP). A SAP identifies the customer interface point for a service.

NFM-P supports SAPs for the following cards:

• 11OPE8

• 11QCE12X

• 11QPE24

The SAP configuration requires that slot and port information be specified. The slot and
port parameters must be configured prior to provisioning a service. A SAP is a local
entity to the cards and is uniquely identified by:
• physical Ethernet port or LAG

• encapsulation identifier (ID)

Depending on the port encapsulation, a physical port can have one or more SAPs
associated with it. The SAPs are created on ports designated as access or uplink.
NFM-P supports the following port encapsulations on access Ethernet ports:
• Null—supports a single service on the port

• Dot1Q—supports multiple services for one or more customers.
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• Q in Q—adds an IEEE 802.1ad or 802.1Q tag to the 802.1Q tagged packets entering
the access port to expand the VLAN space, producing a double-tagged frame.

NFM-P supports only Q in Q encapsulation on the uplink ports.

14.2.3 Service SAP types

VPLS service requires a service SAP type that specifies the SAPs configured in the
service.

The following SAP types are supported by NFM-P and configure if:

• null-star—the SAP in the service can be Null, Dot1Q or Q in Q.

• dot1q-preserve—the SAP in the service is Dot1Q. The Dot1Q ID is retained after
packets match the SAP.

• any—if the system processes and forwards only packets with no VLAN tag. All other
packets with one or more VLAN tags are not processed are dropped.

• dot1q-range—the VPLS VLAN range SAPs need to be configured.

14.3 To configure a VPLS

14.3.1 Steps

Note:

The following needs to be configured for a basic VPLS service:

• Customer ID

• two SAPs specifying access port, uplink port, and encapsulation values.

1

Choose Create→Service→VPLS from NFM-P main menu. The VPLS Service
(Create) form opens.

2

Select a customer to associate with the VPLS.

3

Configure the required general service parameters.

4

On the equipment tree, right-click on the Sites object and choose Create VPLS Site.
The Select Network Elements - VPLS Service form opens with a list of available
sites.
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5

Choose a site and click OK. The Select ELAN Elements form opens with a list of
supported cards.

6

Choose a card and click OK. The VPLS Site (Create) form opens and the VPLS site
information is updated in the Network Element panel.

7

Configure the required general VPLS site parameters.

8

Perform one of the following

a. Configure the SAP Type parameter to dot1q-range for the VLAN range SAP
configuration.

b. Configure the SAP Type parameter to dot1q-preserve and configure the Customer
VID parameter.

9

If you need to configure MC LAG, select the Enable MC LAG Binding check box in
the MC-LAG configuration panel.

10

If you need to configure E-Tree, select the ETree Enabled check box in the ETree
panel.

11

Configure the parameters in the MAC Move panel to protect the network against
loops.

12

Click OK. The VPLS Site (Create) form closes and the VPLS Service (Create) form
opens.

13

Click Apply to save the changes.

14

Click on the newly created Site object on the equipment tree to view the following:
• The Forwarding Control tab displays the MFIB, FIB, and L2 Access Interface FIB

information.
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• The Multicast tab displays the IGMP Snooping parameters.

• Statistics, scripts, and fault information is available from the appropriate tabs.

15

Right-click on the VPLS Service→Sites→Site→L2 Access Interfaces object on the
VPLS service tree and choose Create VPLS L2 Access Interface. The VPLS L2
Access Interface (Create) form opens.

16

Configure the required general VPLS L2 access interface parameters.

17

Select a SAP TCA profile.

18

Click on the Port tab.

19

Select a terminating port for the L2 access interface.

20

Configure the VLAN range SAP.

1. Configure the VLAN Range SAP parameter.

2. Select an 1830 PSS connection profile in the Connection Profile panel.

21

Select an Ethernet ring for the L2 access interface.

22

Configure the Enable Split Horizon parameter, if required.

Note: Enabling the split horizon parameter creates a split horizon group for the
VPLS instance.
Ensure that the Enable Split Horizon parameter is configured for the
interconnect site during the manual configuration of a control service for a
virtual sub-ring.

23

Click on the IGMP Snooping tab and then on the General sub-tab and configure the
required parameters.
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24

Click on the Static Mcast Group sub-tab and click Create. The Access Interface Igmp
Snooping Mcast Group Display (Create) form opens.

25

Configure the parameters, save the changes and close the forms.

26

Click on the newly created VPLS L2 Access Interface object on the navigation tree to
view the following:
• The Forwarding Control tab displays the FIB information.

• The IGMP Snooping tab displays the IGMP Snooping parameters

• The port tab displays the terminating port, encapsulation type, Ethernet ring, and
LLF values.

• The QoS tab displays the QoS policy information.

• Statistics, scripts, and fault information is available from the appropriate tabs.

END OF STEPS

14.4 VLAN ranges

14.4.1 Introduction

A VLAN range allows you to group a range of VLAN IDs as a single entity. This allows
you to provide a VPLS configuration, for example, forwarding, ACL, QoS, PM, and so on,
to the group of VLAN IDs.

14.4.2 Benefits of VLAN ranges

When the VLAN range is not configured, an ERP ring configuration requires a group of
VLANs, where each VLAN uses a VPLS and a minimum of three SAPs: one access SAP
and two network (uplink) SAPs.

When the VLAN range is configured, an ERP ring configuration requires a VLAN range,
where the range uses one VPLS and a minimum of three SAPs: one access SAP and
two network (uplink) SAPs. See 14.6 “To configure VPLS VLAN range SAPs” (p. 266)
for more information.

14.4.3 1830 PSS connection profile

You can use the 1830 PSS connection profile to configure either a range of VLAN IDs or
individual VLANs to be grouped together in a single SAP. The connection profiles that
are associated with a SAP cannot be modified unless the connection profile is removed
from all SAPs that are using it. A maximum of Up to eight VLAN ranges are allowed per
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connection profile. See 14.5 “To configure an 1830 PSS connection profile” (p. 264) for
more information about configuring connection profiles.

14.4.4 Restrictions

The following restrictions apply for VPLS VLAN range SAPs:

• You can configure only one VLAN range SAP in a VPLS service.

• VLAN range SAPs are configured only on Dot1Q-encapsulated access ports or LAGs
with Dot1Q encapsulation and in a VPLS service where the SAP Type parameter is
set to dot1q-range.

• You can configure multiple connection profiles for each port or LAG, as long as the
VLAN values that are specified in each profile do not overlap.

• IGMP snooping is not supported on VLAN range SAP.

14.5 To configure an 1830 PSS connection profile

14.5.1 Steps

1

Choose Policies→Ethernet→PSS Connection Profile from NFM-P main menu. The
Manage PSS Connection Profiles form opens.

2

Perform one of the following:

a. Click Create. The Connection Profile Global Policy (Create) form opens.

b. Click Search, and choose a connection profile to modify, and click Properties. The
Connection Profile (Edit) form opens.

3

Configure the parameters, click on the VLAN Range tab, and click Create. The
VLAN Range, Connection Profile, Global Policy (Create) form opens.

4

Configure the range and click OK.

Result: The VLAN Range, Connection Profile, Global Policy (Create) form closes
and the Connection Profile (Edit) form refreshes with the new range information.

5

Click Apply, click on the General tab, click switch mode, and then click Switch
Distribution Mode. The Switch Distribution Mode form opens.
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6

Choose the 1830 PSS devices that you need to distribute, move them to the
Selected Local Policies panel, and click Local Edit Only.

7

Save your changes and close the forms.

END OF STEPS

14.6 To configure VPLS VLAN range SAPs

14.6.1 Steps

1

Set the Encapsulation Type parameter on the port and LAG properties form to Dot1
Q.

2

Configure an 1830 PSS connection profile. See 14.5 “To configure an 1830 PSS
connection profile” (p. 265).

3

Configure a VPLS service. See 14.3 “To configure a VPLS” (p. 261).

Ensure that:

1. The SAP Type parameter in the site properties form is set to dot1q-range.

2. The VLAN Range SAP check box in the VPLS L2 Access Interface (Create) form
is selected.

3. The 1830 PSS connection profile in the Connection Profile panel of the VPLS L2
Access Interface (Create) form is selected.

4

Save your changes and close the forms.

END OF STEPS
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14.7 Split horizon group

14.7.1 Overview

An SHG prevents loops in the network by not allowing traffic in one SAP to be forwarded
to other members of the group in the same service.

NFM-P supports the configuration of SHGs on the following cards:

• 11QPE24

• 11OPE8

• 11QCE12X

You can add ports and LAGs to an SHG. A LAG member cannot be added to the group
and the ports in a group cannot become a LAG member. A port and a LAG can only be in
one SHG. See 14.8 “To configure an SHG” (p. 266) and 14.9 “To add ports to an SHG”
(p. 268) for more information about configuring SHGs.

14.8 To configure an SHG

14.8.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card.

2

Right-click on the Card object and choose Properties. The Card Slot (Edit) form
opens.

3

Click on the Split Horizon Groups tab, then click Create. The Split Horizon Group
(Create) form opens.

4

Configure the required parameters.

5

Save your changes and close the forms.

END OF STEPS
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14.9 To add ports to an SHG

14.9.1 Before you begin

The following conditions must be met before you add a port to an SHG:

• The Assigned Rate parameter must be configured on the port.

• The port must not be used in a service.

• The port must be in the Shut Down state.

14.9.2 Steps

1

On the navigation tree, expand Network→1830 PSS→Shelf→Card→Port.

2

Right-click on a port where the SHG is configured and choose Properties. The
Physical Port (Edit) form opens.

3

Select an SHG in the Split Horizon Group panel and click OK. The Select Split
Horizon Group form closes and the Physical Port (Edit) form reappears.

4

Repeat Step 2 to Step 3 for each additional port that you need to assign to the
SHG.

5

Save your changes and close the form.

END OF STEPS

14.10 E-Tree services

14.10.1 Overview

An E-Tree service is a type of Ethernet service that is based on a rooted-multipoint
Ethernet virtual connection. An E-Tree service provides a single root for multiple leaf
UNIs. Each leaf UNI exchanges data with only the root UNI. A service frame sent from
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one leaf UNI with a destination address for another leaf UNI is not delivered. The E-Tree
service is used for Internet access or video over IP applications, such as multicast or
broadcast packet video.

NFM-P supports E-Tree configurations consisting of:

• roots—VPLS service with SAPs not in an SHG

• leaves—VPLS service with SAPs in an SHG

See 14.3 “To configure a VPLS” (p. 261) for more information about configuring a VPLS
service and 14.8 “To configure an SHG” (p. 267) for more information about configuring
an SHG.

NFM-P supports the following E-Tree services:

• EP-Tree—Ethernet private tree service on the ports that are null-encapsulated

• EVP-Tree—Ethernet virtual private tree service on ports that support other services
such as EVPL or EVP-LAN

An E-Tree root can be on the same card as the leaves, or on a different card. There can
be more than one root in the network for redundancy. The leaves of the E-Tree are
configured on one card in the network to provide the required isolation. The leaf ports
are in the same SHG and leaf SAPs are in the same service as that of the leaves and
roots.

Table 24 E-Tree functions

Function Description

E-Tree with ERP The E-Tree is configured over ERP with leaf ports on one node
and roots on one or more other nodes.

E-Tree with LAG The E-Tree leaves are LAGs, or individual ports, or both. The
roots are individual ports or LAGs.

The roots can be members of an MC LAG.

E-Tree with CFM Monitoring of an E-Tree is performed using up-MEPs on each
root and leaf SAPs in the same association.

On the card with the leaves, the CFM association has only the
roots listed as remote MEPs.

On a card with a root, the association has the leaves and other
roots listed as remote MEPs.

CFM monitoring is not required when roots and leaves are in the
same card.

E-Tree with IGMP
snooping

IGMP snooping is used on E-Tree leaves to further optimize the
tree for specific multicast groups.
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14.11 IGMP snooping

14.11.1 Overview

NFM-P supports the configuration of the IGMP Snooping parameters for a VPLS service.
See 14.3 “To configure a VPLS” (p. 261) for more information about configuring a VPLS
service.

14.11.2 IGMPv2

IGMP is a multicast protocol that service providers can use to establish multicast group
memberships on a LAN. Within the LAN, end users use IGMP to communicate with a
local multicast router, which then uses PIM to distribute the IGMP messages to other
local and remote multicast routers. Multicast routers send regular membership queries to
IGMP hosts which respond with membership reports. Multicast routers can use the
reports to determine which hosts are interested in receiving specific multicast messages.
The IGMP operates above the network layer on IPv4 networks. See the “ IGMP
configuration workflow and procedures” section in the NSP NFM-P User Guide for more
information about how to configure IGMP.

14.12 MAC move

14.12.1 MAC move

The MAC move function protects against undetected loops in a VPLS topology and the
presence of duplicate MAC addresses s in a VPLS service. NFM-P supports
configuration of the MAC move parameters for a VPLS. See 14.3 “To configure a VPLS”
(p. 261) for more information about configuring the MAC move parameters during VPLS
configuration.

When the MAC Move Enabled check box is selected, MAC move monitors the re-learn
rate of each MAC address. If two clients in the VPLS have the same MAC address, the
VPLS has a high re-learn rate for the MAC address.

If the rate exceeds the value set for the Frequency parameter in the MAC Move panel, it
disables the SAP on which the source MAC address last arrived.

Configure the Retry Timeout parameter in the MAC Move panel to specify the time in
seconds that elapses before a SAP that is disabled after exceeding the maximum
relearn rate is re-enabled.

Configure the Retries parameter in the MAC Move panel to specify the number of retries
that can be performed for re-enabling the SAP.
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When the MAC Move Enabled check box is not selected, the SAP is marked as non-
blockable, which means that when the re-learn rate exceeds the limit, another SAP—one
that is blockable—is disabled instead.
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15 1830 PSS optical transport service
management

15.1 Overview

15.1.1 Purpose

This chapter provides information on optical transport services, types of optical transport
service, and procedures to configure optical transport service, VTS maps and VTS XCs.

15.1.2 Contents

15.1 Overview 273

Overview 276

15.2 General information 276

Optical protection 278

15.3 Protection types and protection levels 278

15.4 Diverse route 279

15.5 ESNCP 279

15.6 OPS protection 280

15.7 Y-cable protection 284

15.8 Client protection 287

Types of optical transport services 288

15.9 Dual-stage multiplexing 288

15.10 Regeneration services 288

15.11 CDC-F ROADM service 291

15.12 Symmetric and asymmetric interworking services 292

15.13 Client/line ADM services 293

15.14 ADM ring and linear configurations 294

15.15 Multipoint services 296

Operations on optical transport services 298

15.16 Path search for optical transport services and trails 298
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15.17 Viewing optical services on NFM-P GUI 299

15.18 Deleting optical transport services and trails 301

15.19 Administrative state transitions for service and trail 303

15.20 Administrative and operational states determined by NFM-P 305

15.21 AINS parameters for ports and facility objects 309

Procedures to configure optical transport services 311

15.22 To configure an optical transport service 311

15.23 To configure a multipoint transport service 314

15.24 To discover optical transport services 317

15.25 To unmanage an optical transport service 319

15.26 To remanage an unmanaged optical transport service 319

15.27 To configure path constraints for a service 320

15.28 To convert an unprotected service to an ESNCP service on a 4DPA4
FlexMux card

322

15.29 To convert an ESNCP service to an unprotected service on a 4DPA4
FlexMux card

323

15.30 To display services riding on external or internal optical links 324

15.31 To view the service hops 325

Procedures to configure protected services 326

15.32 To configure an ESNCP protected service 326

15.33 To configure a Y-cable protected service 328

15.34 To configure a client-side OPS protected service 330

15.35 To configure an OMSP protected service 331

15.36 To configure an OCHP protected service 331

15.37 To configure an optical transport service with underlying cascaded
OCHP and OMSP protected trails

332

15.38 To configure an OLP protected service 334

15.39 To configure a client protected service on OCS devices 334

15.40 To configure a client protected service with double add-drop 336

15.41 To configure a diverse route protected service 336
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Procedures to configure service using 11DPM12, 11DPM8, and
11DPM4M cards

339

15.42 To configure an unprotected service routing through an SNCN
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Overview

15.2 General information

15.2.1 Introduction

An optical transport service is a wavelength that traverses the network between two
endpoints, which can be tandem wavelengths in some cases. The path that the service
takes through the network is defined by NFM-P using shortest path algorithm and the NE
adjacencies.

An XC is the path that the service takes through an NE. A cross-connect is defined by
the ingress and egress points for the service on the NE. The NE physical topology
defines the internal path that the service takes through the NE.

NFM-P supports the following:

• identification of adjoining XCs and management of linked XCs as an optical transport
service

• creation, deletion, and discovery of optical transport services, when there are no XCs

• discovery of optical transport service between OTs of the vendor network

Each service is assigned a trail identifier and a pair of Wavelength Tracker wave keys.
The trail identifier and ITU channel number (wavelength) and wave key pair, are unique
in the network. See Tables Table 44, “L-band channel wave keys” (p. 434) , Table 45,
“C-band channel wave keys” (p. 436) , and Table 46, “S-band channel wave keys”
(p. 438) for wave key information.

Because optical transport services create transport connectivity between router ports,
they must be created before IP services. Services are created by selecting the
endpoints. See 15.22 “To configure an optical transport service” (p. 311) and 15.23 “To
configure a multipoint transport service” (p. 314) to create services.

NFM-P supports optical transport services between:

• two 1830 PSS devices

• two non-1830 PSS devices, that is, 7750 SR, 7450 ESS, 7705 SAR, 7210 SAS, and
7950 XRS

• an 1830 PSS device and a non-1830 PSS device, that is, 7750 SR, 7450 ESS, 7705
SAR, 7210 SAS, and 7950 XRS

15.2.2 Connection between WDM and OCS device

NFM-P supports the configuration of a WDM node with an OCS uplink card. The
configuration is supported with DWDM FOADM, ROADM, and TOADM nodes. The
following OCS card types are supported:
• 11QCUP—One-degree FOADM
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• 11QCUPC—FOADM, ROADM, and TOADM

• 130SCUP—FOADM, ROADM, and TOADM

The connection between a DWDM node and an uplink card is supported on the following
port types:
• SFD channel ports (FOADM, ROADM, and TOADM configurations)

• CWR8 and CWR8-88 CLS ports (TOADM configurations)

The cross-connect provisioned for this configuration terminates on the SFD or CWR port,
because the uplink card is not managed by the WDM system.

15.2.3 SR-SR optical transport service and trail

During the SR-SR ODU and OTU trail configurations, the TTI attributes are available for
configuration only for the OTU-enabled SR ports. The TTI attributes configured during
the trail configuration can also be viewed on the Optical Transport Channel Unit tab of
the Physical Port (Edit) form for the OTU-enabled SR ports.

15.2.4 Highlight services and trails on physical topology map

NFM-P allows you to highlight the service, trail, or path on the physical topology map to
indicate working, protection, nominal, actual and alarm status. Click Navigate on the trail
or service configuration form and choose Physical View : Highlight Path to open the
physical topology map with the highlights. Click Legend and choose Highlight Sessions
to view the highlight sessions for the current map. See the NSP NFM-P User Guide for
more information about the highlight function in NFM-P.
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Optical protection

15.3 Protection types and protection levels

15.3.1 Protection types

NFM-P supports the following protection types:
• Diverse route protection. See 15.4 “Diverse route” (p. 279)

• ESNCP protection. See 15.5 “ESNCP” (p. 279)

• OPS protection. See 15.6 “OPS protection” (p. 280)

• Y-Cable protection. See 15.7 “Y-cable protection” (p. 284)

• Client protection. See 15.8 “Client protection” (p. 287)

The following table lists the optical transport services and trails and the corresponding
protection types that can be configured using NFM-P.

Table 25 Protection types supported for services and trails

Services/trails Supported protection types

Optical Transport Service Client Protected

Diverse Route

ESNCP Protected

OPS Protected

Y-Cable Protected

Multipoint Optical Transport
Service

ESNCP Protected

Multicast Optical Transport
Service

ESNCP Protected

OTU trail OPS Protected

OCH trail OPS Protected

ODU trail SNCN Protected

SNCNC Protected

SNCI Protected

Segment Protected

15.3.2 Protection level

Protection Level provides information about the existence of protection in the server
layers of a connection object. NFM-P displays the protection levels for services, LO ODU
trails, HO ODU trails, OCH trails and OTU trails.
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If the full path of the server layers are protected then the protection level is displayed as
Protected. If only a part of the server layers are protected then the protection level is
displayed as segment protected. If none of the server layers are protected then the
protection level is displayed as unprotected.

15.4 Diverse route

15.4.1 Introduction

NFM-P allows you to create diverse services pertaining to an existing unprotected optical
transport service. The two services can have the same or distinct termination points.
However, the service paths are fully divergent.

Diverse route services can only be created by using NFM-P and the services are not part
of the service discovery operation.

If you unmanage a diverse route and run the discover transport services operation,
NFM-P discovers two unprotected services instead of a diverse route service.

See 15.41 “To configure a diverse route protected service” (p. 336) for more information
about configuring a diverse route protected service.

15.5 ESNCP

15.5.1 Introduction

ESNCP is a line side (network side) protection mechanism which protects against loss of
the line signal due to an OTM failure, fiber interruption, or a malfunction of an
intermediate NE node.

NFM-P supports ESNCP protection on the following OTs:

• 4DPA2
• 4DPA4
• 10SD10G
• 11DPE12
• 11DPE12A

• 11DPE12E
• 11DPM12
• 11QPA4
• 11QPEN4
• 24SDM

ESNCP protection is implemented by permanent head-end bridging and dynamic tail-
end selection.

NFM-P supports ESNCP across mate 11DPE12A cards. LAG is available on a single
card and cannot be used in conjunction with ESNCP across cards.

See 15.32 “To configure an ESNCP protected service” (p. 326) for more information
about configuring an ESNCP protected service.
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15.6 OPS protection

15.6.1 Introduction

The OPS cards provide photonic protection switching in DWDM configurations for
channels supported in the C-band, allowing users to provide 1+1 APS protection.

There are two types of OPS cards:

• OPSA

• OPSB

The following are the protection modes for the OPSA card:

• 15.6.2 “OLP” (p. 280)

• 15.6.3 “OCHP” (p. 281)

• 15.6.4 “OMSP” (p. 281)

For OPS protected service provisioning, you can only specify the following ports as
termination points:

• 11STAR1 client port
• 11STAR1A client port
• 11STGE12 client port
• 11STMM10 client port
• 11QPA4 client port
• 11QPEN4 client port
• 112SNX10 client port

• 112SNA1 client port
• 112SCA1 client port
• 112SCX10 client port
• 112SNA1 client port
• 112SCA1 client port
• 260SCX2 client port
• OPSA SIG

15.6.2 OLP

The Protection Mode parameter on the Card Specifics form of the OPSA card is set to
OLP. The Assigned Rate parameter for the SIG, A, and B ports is OTS. The OLP is a 1+1
protection type that provides two separate fiber connections between adjacent network
elements. The OLP provides optical bridging at the source end and switch selection of
one of the two signals at the receiving end. NFM-P supports OLP as the protection type
for 1830 PSS-32 and 1830 PSS-16 in the ROADM configuration using WR2-88, WR8-
88A, and WR8-88AF. The OLP is supported with manual power management.

The following OT cards support OLP protection:

• 112SNA1
• 112SNX10
• 11STAR1A
• 11DPM12

• 11DPE12A
• 11DPE12E
• 11QPA4

See 15.38 “To configure an OLP protected service” (p. 334) for more information about
configuring OLP protected service.
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15.6.3 OCHP

The Protection Mode parameter on the Card Specifics form of the OPSA card is OCHP
by default. The Assigned Rate parameter for the SIG, A, and B ports is OCH. See
15.36 “To configure an OCHP protected service” (p. 331) to configure an OCHP
protected service.

The following OT cards support OCHP protection:

• 112SCA1
• 112SNA1
• 112SCX10
• 112SNX10

• 130SCX10
• 130SNX10
• 260SCX2

OCHP on OCS devices

You can configure OCHP protected service between optical client/line cards configured
on the 1830 PSS OCS devices. You first need to connect the line ports of two uplink
cards on the OCS devices with the SIG ports of two OPSA cards that are configured on
two 1830 PSS WDM devices. The A port of the OPSA card must be connected to the
corresponding channel on an SFD card on the same 1830 PSS WDM device.

Before configuring the service, create an OPS protected OTU trail between the line ports
of the uplink cards. Then create an HO-ODU trail between the two OCS devices on
which the uplink cards are configured. Finally, create an unprotected service of
appropriate rate between the client ports of two client/line cards on the OCS devices.
The LO-ODU trail is created automatically. The protection level of the service is
configured as protected after service creation and the OPS protected OTU trail is used
as the underlying trail.

Note: Alternatively, if the service configuration does not require an HO-ODU trail
between the ODUPOOLs, top-down provisioning is allowed.

NFM-P uses the following uplink cards to set up the configuration for OCHP protection
on OCS devices:

• 130SCUP

• 130SCUPB

• 130SCUPC

• 43SCUP

• 11QCUPC

15.6.4 OMSP

The Protection Mode parameter on the Card Specifics form of the OPSA card is set to
OMSP. The Assigned Rate parameter for the SIG, A, and B ports is OTS. When the
OPSA card is used in OMSP protection mode, in the transmit direction, the SFD and
ITLB total output channels are separated into two optical multiplex sections routed to
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different DWDM lines. In the receive direction, the OPSA selector selects one of the two
lines as the active path based on power monitoring or manual selection.

You can configure an OMSP protection service for FOADM configuration by positioning
the OPSA card between the SFD or ITLB and LD.

You can configure an OMSP protection service for ROADM configuration by positioning
the OPSA card between the WR card and LD.

NFM-P support for OMSP protection includes:

• configuration of OMSP protection on the OPSA cards. See 9.23 “To configure an
OPSA card” (p. 137) for information about configuring OMSP protection on the OPSA
card.

• creation of OMSP protected service for FOADM or ROADM configuration.

See 15.35 “To configure an OMSP protected service” (p. 331) for information about
configuring an optical transport service.

See 15.49 “To configure an OMSP protection service using 112SDX11” (p. 347) for
information about configuring an optical transport service using 112SDX11 card.

Table 26 Supported cards

Configuration Supported LD cards Supported
SFDs, ITLB,
and ITLU
cards

Supported
WR cards

Supported
OTs

Supported
uplink cards

Ingress Egress

FOADM ALPHG

AHPHG

AHPLG

None

ALPHG

AHPHG

AHPLG

A2325A

SFD5

SFD8

SFD40

SFD40B

SFD44B

SFD44

ITLB

- 112SCX10

11QPA4

11STAR1

112SDX11

11STMM10

11DPM12

11QPEN4

-

ROADM AHPHG

AHPLG

None

AHPHG

AHPLG

A2325A

ITLB

ITLU

WR2-88

WR8-88A

WR8-88A

11STAR1

11STAR1A

112SNX10

112SNA1

11QPA4

11DPE12E

11DPE12A

43SCA1

11DPM12

130SCUP

11QCUPC
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Note: See 15.35 “To configure an OMSP protected service” (p. 331) for more
information about service configuration and OTN layer management of the 112SDX11
card.

15.6.5 OPSB

OPSB is an optical protection switch card supporting client-side OPS protection. The
OPSB card uses non-latching switch, which means that upon power failure, the OPSB
automatically switches back to the default path. The protection mode for the OPSB card
is OTUP.

When a pair of transponder cards are part of a client-side OPS protection configuration,
the following rules apply.

• The assigned rate, frequency, and OPR mode parameters need to be the same at the
client ports of the working and protection OTs.

• The LOS propagation mode is set to LASER OFF.

• The encapsulation mode can be the same or different at the client ports of the working
and protection OTs.

• The frequencies supported at the client port that connects to OPSB A and B ports are
1310 nm and 1550 nm.

• When the pair of OTs are 112SCA1 or 112SNA1 cards, and the clients are provisioned
for 100 GbE, the errored frame drop mode and LOS propagation parameters need to
be the same for both cards.

• When the pair of OTs are 112SCA1 or 112SNA1 cards, and the clients are provisioned
for OTU4 signal rate, the FEC Mode and TTI (at both the OTU4 and ODU4 layers)
parameters need to be the same for both cards.

NFM-P support for client-side OPS protection includes:

• configuration of client-side OPS protection on the OPSB cards. See 9.24 “To
configure an OPSB card” (p. 138) for information about configuring client-side OPS
protection on the OPSB cards.

• creation of client-side OPS protection service using the OPSB cards. See 15.34 “To
configure a client-side OPS protected service” (p. 330) for information about creating
the client-side OPS protected optical transport service.

• creation of client-side OPS protection service using the OPSB card linked to an OT of
an 1830 PSS device and another OT of a third-party device. The OT of the 1830 PSS
device is linked to the A port of the OPSB card and the OT of the third-party device is
linked to the B port of the OPSB card.

Note:

The third-party device is transparent to NFM-P. Hence an optical link needs to be
created from the B port of OPSB card of an 1830 PSS device to the B port of the
OPSB card of another 1830 PSS device.
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The following OT cards support client-side OPS protection:

• 11QPA4
• 11STAR1
• 11STAR1A
• 11STMM10

• 112SNA1
• 112SCA1
• 130SCA1
• 260SCX2

The following combinations of OTs as working and protection are supported in the client-
side OPS protection:

• 11STAR1 with 11STAR1
• 11STAR1A with 11STAR1
• 11STAR1A with 11STAR1A
• 130SCA1 with 130SCA1
• 130SCA1 with 112SNA1
• 130SCA1 with 112SCA1
• 130SCA1 with 260SCX2

• 11STMM10 with 11STMM10
• 112SNA1 with 112SNA1
• 112SCA1 with 112SCA1
• 11QPA4 with 11QPA4
• 11QPA4 with 11STAR1
• 11QPA4 with 11STAR1A
• 260SCX2 with 260SCX2

15.7 Y-cable protection

15.7.1 Introduction

Y-cable protection is a network-side protection mechanism that protects the line card,
client-side laser, network-side laser, and network-side fibers.

15.7.2 Configuration

Connect a Y-cable splitter/joiner to a pair of client ports on redundant optical transponder
packs (OTs) at one end of the network. Repeat the configuration at the other end of a

Figure 18 Y-cable protection
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point-to-point link across the network. Connect the OT line ports to diversely routed
working and protection lines across the network (with no shared risk groups in common).

Connect the near-end working OT to the far-end working OT and the near-end protection
OT to the far-end protection OT.

Ensure that the:

• working and protection OTs are of the same type

• two half-height OTs are positioned in vertically adjacent slots and full-height OTs are
positioned in horizontally adjacent slots

• port numbers for Y-cable protection match

For example, port #1 is paired in a Y-cable protection arrangement with port #1 on the
adjacent card and port #2 is paired with port #2 on the adjacent card.

For more information about the Y-cable configurations, refer to the 1830 PSS Product
Information and Planning Guide.

See 15.33 “To configure a Y-cable protected service” (p. 328) for more information about
configuring a Y-cable protected service.

15.7.3 Supported OTs

NFM-P supports the configuration of Y-cable protected services using the following OT
cards:

• 11DPM12
• 11DPE12A
• 11QPA4
• 11QPEN4
• 11STAR1

• 11STAR1A
• 11STMM10
• 43SCX4
• 43SCX4E
• 112SCX10

• 112SNX10
• 130SCX10
• 130SNX10
• 11QPA4

15.7.4 Y-cable support on 11QPEN4 card

The Y-cable protection is supported on the 11QPEN4 OT card. The working and
protection OTs must be the same type at the near and far end. For example, there must
be an 11QPEN4 card at each end, and near-end port C1 must be connected to the far-
end port C1. The same applies to port C2. Unidirectional Y-cable is supported with CBR
client mapping, but is not supported with GFP-F client mapping. Up to two protection
groups can be created on the 11QPEN4 card. A protection group consists of two line
ports and one client port. Each protection group operates independently of the other
group, with its protection state.

The 11QPEN4 and the 11QPA4 cards are channels in the Y-cable protection group and
are independent channels on working and protection boards. The channel numbering at
one end may not be the same as the channel numbering at the other end. For example,
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channel C1 and L1 in the near-end working and protection pairs can connect to channel
L2 and C2 at the far-end working. The protection pairs form an end-to-end protected
service.

An 11QPEN4 OTU2 client port (OT A) can be connected to 11DPE12 and 11DPE12E
line ports (OT B). Up to four 11DPE12 and 11DPE12E OTs can be connected to one
11QPEN4 card. The configuration is encrypted for GbE services.

An 11QPEN4 OTU2 client port (OT A) can be connected to an 11DPM12 line port (OT
B). Up to four 11DPM12 OTs can be connected to one 11QPEN4 card. The configuration
is encrypted for GbE, FC100, FC200, and FC400 services.

Note: The operational mode on the 11QPEN4 line port is add-drop only.

The client ports on the 11QPEN4 card cannot be assigned to the OC192/STM64 rate.

The E-SNCP and Y-cable must not coexist on the 11QPEN4 card. For example, if at
least one E-SNCP protection group is created on a board, the Y-cable protection must
not be on the board and vice versa.

See 15.33 “To configure a Y-cable protected service” (p. 328) for more information about
configuring a Y-cable protected service.

15.7.5 Y-cable protection with signal degrade

Y-cable protection switching does not occur by default in case of a signal degrade. The
switching is triggered by default, due to various signal failure conditions. However, a
service can be impaired or lost before signal failure conditions occur. Therefore, it is
recommended to have signal degrade conditions as a trigger for the Y-cable protection
switching. You can select the signal degrade option to enable Y-cable protection
switching in the service creation form. See 15.33 “To configure a Y-cable protected
service” (p. 328) for more information about configuring a Y-cable protected service.

The option for Y-cable protection with signal degrade is available for the following cards:

• 11DPM12

• 130SCX10

• 130SNX10

• 43SCX4

When the signal degrade option is enabled at the Y-cable protected optical transport
service level, the signal degrade is enabled on all the client ports, line ports, and
ODUCTPs of the working and protection paths and on the APS groups. When a Y-cable
protection switching occurs due to signal degrade after the option is enabled, the Switch
Status is displayed as Signal Degrade in the Protection Management panel of the APS
Group (Edit) form.

In addition to enabling signal degrade and configuring burst interval and burst threshold
at the service level, you can also set the degrade interval and degrade threshold for
ODU trails with ODU0 or ODU1 rate.
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15.8 Client protection

15.8.1 Introduction

You can configure a client protected optical transport service between I/O cards with OC
or STM rates over SNCNC protected lower-order ODU trails, which are configured
between I/O cards with OTU rates on OCS devices. See 15.39 “To configure a client
protected service on OCS devices” (p. 334) to configure a client protected service with
double add-drop cross-connects, select working and protection ports, or trails, or ODUk
timeslots as constraints for each of the termination points of the service. See 15.40 “To
configure a client protected service with double add-drop” (p. 336) .

NFM-P allows configuration of an SNCNC protected trail or a client protected optical
service with three termination points. In such a configuration, if Site A has one
termination point, Site Z has two termination points; or if Site A has two termination
points, Site Z has one termination point. In case of a unidirectional SNCNC protected
trail with three termination points, the source site must have two termination points and
destination site must have one termination point.

If you configure two termination points on each of the sites (A and Z), four paths created
after a trail or service is configured; namely, A1Z1, A1Z2, A2Z1, and A2Z2. Only one of
these paths is active at a time. You can modify the active path by modifying the
Protection Switch parameter of the APS group. See 15.56 “To modify the protection
switch for an APS group” (p. 357).
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Types of optical transport services

15.9 Dual-stage multiplexing

15.9.1 Introduction

Dual-stage multiplexing is supported on the 1830 PSS-16 and 1830 PSS-32 shelves. A
signal is added to an OT client port and multiplexed on a line port with a larger
bandwidth. The signal is added a second time at a higher rate OT and multiplexed to the
line port. The reverse path occurs if the signal is dropped. See 15.53 “To configure dual-
stage multiplexing services on an 1830 PSS for keyed and unkeyed services” (p. 352)
and the Nokia 1830 Photonic Service Switch User Provisioning Guide for more
information.

15.10 Regeneration services

15.10.1 Introduction

The 1830 PSS supports provisioning, discovery, and a topological view of the following
regeneration services.

• DWDM–DWDM

• DWDM–CWDM

• CWDM–B&W

• DWDM–B&W

To provision the services, see 15.22 “To configure an optical transport service” (p. 311).
To discover the services, see 15.24 “To discover optical transport services” (p. 317). To
view the services in the topological view, see the NSP NFM-P User Guide. The Regen
check box is automatically selected when a regen service is created. You can view the
Regen parameter on the General tab of the Service Path form.

Note: You need to set frequency on all OTs before configuring a colorless direction less
uni-directional regen trail or service.

15.10.2 DWDM–DWDM

DWDM–DWDM single channel OEO regeneration is supported with back-to-back OTs
connected through the client ports. Keyed and unkeyed services are supported on the
configuration.

The following OTs are supported:

• 11STAR1
• 11STAR1A
• 260SCX2

• 43STA1P
• 43STX4P
• 43STX4
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Note: For regeneration on the 43STA1P, the client port rate must be OC768 or STM256.
Do not use OTU3.

The regeneration is supported with two single port OTs that have line port operational
modes configured for regeneration. Client ports are not used in the configuration.

The following OTs are supported:

• 112SA1L (drop shelf only)
• 112SCA1
• 112SNA1
• 112SCX10
• 112SNX10
• 112SX10L (drop shelf only)

• 260SCX2
• 43SCA1
• 43SCGE1
• 43SCX4
• 43SCX4E
• 43SCX4L (drop shelf only)

Note: For this configuration, the channels can be different on each SFD or CWR port.

15.10.3 DWDM–CWDM

The 1830 PSS-32 supports single channel regeneration for CWDM and DWDM
connections and configurations for CWDM bidirectional transmission with DWDM-
CWDM (dual-fiber) regeneration, when regeneration OTs are supported. The rate
supported for the service is FC200. Keyed and unkeyed services are supported on the
configuration.

The following OTs are supported:

• 11STAR1 and 11STAR1A OT—line port is connected to the DWDM signal and the
client port is connected to the CWDM signal

• 4DPA4 OT (FlexMux only)—one line and an eVOA port are connected to the DWDM
signal; the other line and eVOA port are connected to the CWDM signal. The line ports
are configured for CrossRegen mode.

• 11QPA4 OT—a line and an eVOA port are connected to the DWDM signal and the
associated client port is connected to the CWDM signal

Note:

11QPEN4 supports regeneration services with the 11QPA4 as the A end and Z end of
the service.
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15.10.4 CWDM–B&W

The CWDM-B&W single channel OEO regeneration is supported when the 1830 PSS-32
and 1830 PSS-1 GBEH devices are operational. The rate supported for the service is
1Gbe. Unkeyed service is supported on the configuration and no cross-connects are
created.

The following OTs are supported:

• 4DPA4 OT (FlexMux only)—one line and an eVOA port are connected to the CWDM
signal and the other line port is connected to the B&W signal. The line ports are
configured for CrossRegen mode.

• 11QPA4 OT—a line port is connected to the CWDM signal and the associated client
port is connected to the B&W signal.

Note:

The 11QPEN4 card supports regeneration services with the 11QPA4 as the A end and
Z end of the service.

15.10.5 CWDM–FOADM

Degree-2 CWDM-FOADM is supported on the 1830 PSS. Any symmetrical combination
of OMD-based end terminal configuration is supported.

The following configurations are supported:

• SFC-2—SFC-2

• SFC-4—SFC-4

• SFC-8—SFC-8

The following OTs are supported:

• 4DPA4

• 11DPE12

15.10.6 DWDM–B&W

The DWDM-B&W single channel OEO regeneration is supported when the 1830 PSS-
32, and 1830 PSS-1 GBEH devices are operational. The rate supported for the service is
1 GbE.

The following OTs are supported:

• 11STAR1 and 11STAR1A OT—the line port is connected to the DWDM signal and the
client port is connected to the B&W signal. Regeneration occurs from client to line.

• 4DPA4 OT (FlexMux only)—one line and an eVOA port is connected to the DWDM
signal and the other line port is connected to the B&W signal. The line ports are
configured for CrossRegen mode

• 11QPA4 OT—a line and an eVOA port are connected to the DWDM signal and the
associated client port is connected to the B&W signal
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Note:

The 11QPEN4 card supports regeneration services with the 11QPA4 as the A end and
Z end of the service.

15.11 CDC-F ROADM service

15.11.1 Introduction

NFM-P supports the configuration of colorless, directionless, and contentionless flexible
grid ROADM service that provides:

• optical channel add-drop for up to 88 channels with spectral widths 50 GHz or 62.5
GHz per degree to the add-drop section of the node

• contentionless add-drop using multicast switches in each add-drop block

• coherent optical demultiplexing at the OT and uplink receivers

• support for eight degree configurations

• support for 12 MCS add-drop blocks

• support for 16 add-drop channels per add-drop block for a maximum of 192 add-drop
channels for the node

• hardware readiness for transmission spectrum of 96 50 GHz spaced channels per
degree

• hardware readiness for flexible grid operation

• hardware readiness for expansion to add up to 20 additional add-drop blocks

NFM-P supports the following cards in the CDC-F configuration:

• WR20 TFM
• MCS8-16
• AAR-8A
• OTDR
• 260SCX2
• 130SCUPB

• MSH8-FSM
• A4PSWG
• ASWG
• 130SNX10
• 130SCUPC
• MVAC8B

See the Nokia 1830 PSS Product Information and Planning Guide for more information
about the CDC-F architecture.

NFM-P supports the configuration of the CDC-F service and the underlying trails.

For more information see:

• 12.13 “To configure an OCH trail” (p. 230) — OCH trail configuration

• 12.10 “To configure an OTU trail” (p. 226) — OTU trail configuration

• 12.5 “To configure an ODU trail” (p. 219) — ODU trail configuration

• 15.22 “To configure an optical transport service” (p. 311) — Optical transport service
configuration
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15.11.2 Path search limitations for CDC network

The CDC network supports up to eight degree configurations, that may result in the
timing out of NFM-P system-defined path search function.

To avoid path search timeout:

• configure path constraints with the Constraint Type parameter set to Exclusion during
the trail configuration. See 12.7 “To configure path constraints for ODU trails” (p. 221)
for more information about configuring path constraints for trails.

• configure the Path Search Option parameter on the Optical Transport Service form to
User Defined and configure path constraints with the Constraint Type parameter set to
Exclusion during service configuration. See 15.22 “To configure an optical transport
service” (p. 311) and 15.27 “To configure path constraints for a service” (p. 320) for
more information about service configuration and path constraints configuration for
services.

15.11.3 100 GigE and 200 GigE card limitations

The CDC-F service configuration with a 100 GigE or 200 GigE card used for the
unidirectional regen configuration in the middle node has certain limitations. Nokia
recommends that you follow the bottom-up method: configure the OTU trails, then the
ODU trails, and then configure the service.

15.12 Symmetric and asymmetric interworking services

15.12.1 Introduction

NFM-P supports the configuration of symmetric and asymmetric interworking optical
transport services. WDM devices configured with OTH supported cards or OCS devices
can interwork with WDM devices configured with non-OTH cards.

15.12.2 Symmetric

The interworking is symmetric when both the OTH and non-OTH ends are configured
with the same rates (for example, ODU0).

15.12.3 Asymmetric

The interworking is asymmetric when the OTH end is configured with a lower rate (for
example, ODU0) and the non-OTH end is configured with a higher rate (for example,
ODU2). The Asymmetric Interworking parameter is configured on the ODU trail (Create)
form during the ODU trail configuration of an asymmetric interworking service.

Symmetric and asymmetric interworking services NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

292 Issue 2



15.13 Client/line ADM services

15.13.1 Client/line

The client/line configurations consist of a combination of 20P200 and 1UD200 cards
interconnected through multiple backplane connections to the 1830 PSS-8 or 1830 PSS-
16II shelves.

15.13.2 Client/line ADM configuration

NFM-P supports the configuration of 100 GigE ADM and 200 GigE ADM services. Any
client port can be flexibly assigned to any time-slot and can route any client port at the A
end to any client port at the Z end.

A client/line ADM is a 3-card configuration (100 GigE ADM configuration) or 4-card
configuration (200 GigE ADM configuration) that can add and drop or pass-through lower
rate signals from the optical channels terminating on the line cards.

100 GigE ADM configuration

The 100 GigE ADM configuration consists of one 20P200 card and two 1UD200 cards
connected over the backplane. The 20P200 card is connected to each 1UD200 card with
100 GigE capacity (throughput). The maximum capacity (throughput) of a 3-card
configuration is 200 GigE and depends on the capacity (throughput) of the 20P200 card.

NFM-P supports the following functions using the 20P200 card:

• 10 x10 GigE client service add/drop function

• ODU2/ODU2e pass-thru functions between the 100 GigE uplinks

NFM-P supports the 100 GigE uplink function using the 1UD200 card.

The client ports are configured with the following assigned rates:

• 10 GigE LAN with pluggable module CBR11.096 for ODU2e rates

• 10 GigE LAN with pluggable module GFP-F/P for ODU2 rates

• OTU2, OTU2e

• OC192/STM64

Client port SFP+ can be B&W, CWDM, or DWDM.

200 GigE ADM configuration

The 200 GigE ADM configuration consists on two 20P200 cards and two 1UD200 cards
connected over the backplane. Each 20P200 card is connected to both 1UD200 cards
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with 100 GigE capacity each. The maximum capacity of a 4-card configuration is 400
GigE and depends on the capacity of the 1UD200 card.

The client ports are configured with the following assigned rates:

• 10GbE LAN

• OTU2, OTU2e

• OC192/STM64

Client port SFP+ can be B&W, CWDM, or DWDM.

15.14 ADM ring and linear configurations

15.14.1 Introduction

NFM-P supports the following client/line ADM configurations:

• 100 GigE ADM ring

• 200 GigE ADM ring

• 100 GigE ADM linear chain

• 200 GigE ADM linear chain

15.14.2 ADM ring

A client/line ADM ring is the group of OCH trails that are interconnected at client/line
ADMs.

A 3-node client/line ADM ring is shown in the following figure.
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15.14.3 Linear chain

A client/line linear chain is a group of OCH trails that are interconnected at client/line
ADMs, but do not form a closed ring. The two ends are made of client/line muxponders
and the intermediate nodes are client/line ADMs. A linear chain that does not have any
intermediate client/line ADMs is also known as a point-to-point client/line muxponder
configuration.

A 4-node client/line linear chain is shown in the following figure. There are two
intermediate client/line ADM nodes, two client/line muxponder nodes, and three OCH
trails in this client/line linear chain.

Figure 19 ADM ring
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15.15 Multipoint services

15.15.1 Introduction

Multipoint transport service is primarily used to transmit video signals to multiple
destinations. The client signals to be transmitted are added at the Add site.

The multipoint transport service is categorized in one of the following types:

• drop and continue

• multicast

15.15.2 Drop and continue

In drop and continue multipoint transport service, some signals are dropped at the
intermediate drop and continue sites. The remaining signals are dropped at the drop site.

You can discover or configure a segment protected drop and continue service using dual
stage multiplexing of the 4DPA4 card with the 11DPM12 card. You must create the
segment protected unidirectional LO-ODU trail over the required HO-ODU trail, before
creating the drop and continue service with the 4DPA4 client port at the Add Site.

The 1830 PSS OCS devices are not used as Add, Drop and Continue, and Drop sites.
The 1830 PSS OCS devices are used as the intermediate devices through which
regeneration services are created. See 15.23 “To configure a multipoint transport
service” (p. 314) for information about creating a multipoint optical transport service.

Figure 20 Linear chain
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15.15.3 Multicast

In the multicast multipoint transport service, intermediate drop and continue sites do not
exist.

15.15.4 Multipoint service on an 1830 PSS OCS device

NFM-P supports the creation of multipoint transport services using 11QPA4 cards
interworking with 1830 PSS OCS devices by creating HO-ODU trails where required and
creating a multipoint service on top of the HO-ODU trails. The LO-ODU trails are created
automatically after the service is created. However, Extend Drop Site and Delete Drop
Site is not supported.

NFM-P Multipoint services

Release 17.3
April 2017
Issue 2 2973HE-12002-AAAA-TQZZA



Operations on optical transport services

15.16 Path search for optical transport services and trails

15.16.1 Path search options

NFM-P supports the following types of options for searching a protection path while
configuring a protected optical transport service or trail:

• Site divergence — The protection path that traverses distinct sites with respect to the
working path is searched.

• Link divergence — The protection path that has distinct links with respect to the
working path is searched.

• Best effort — The protection path that is the most close to a fully divergent path is
selected. In this case, there are common sites and links.

By default, the Protection Path Finding Option parameter is configured as Site
Divergence while configuring a protected optical transport service or trail. However, for a
discovered protected optical transport service or trail, the Protection Path Finding Option
parameter is configured as Best Effort, by default.

The following protected optical transport services support the configuration of the
Protection Path Finding Option parameter in the Optical Transport Service (Create) form:

• Client Protected

• ESNCP Protected

• OPS Protected

• Y-Cable Protected

The following protected ODU trails support the configuration of the Protection Path
Finding Option parameter in the ODU Trail (Create) form:

• SNCN Protected

• SNCNC Protected

• SNCI Protected

The OPS Protected OTU and OCH trails also support the configuration of the Protection
Path Finding Option parameter in the OTU Trail (Create) and OCH Trail (Create) form,
respectively.

If creation of a protected optical service or trail fails when the Protection Path Finding
Option parameter is configured as Site Divergence or Link Divergence, a corresponding
error is listed in the Problems Encountered window.

A site divergent path search fails if a protection path with distinct sites compared to the
working path is not found. A link divergent path search fails if a protection path with
distinct links compared to the working path is not found.
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If a site divergent path search option fails, configure the Protection Path Finding Option
parameter as Link Divergence or Best Effort and retry. If a link divergent path search
option fails, configure the Protection Path Finding Option parameter as Best Effort and
retry.

If a divergent service or trail configuration fails, the error description displays the best
working and protection path found and the common sites and common hops.

See the following procedures for more information about configuring trails and services.

• 12.5 “To configure an ODU trail” (p. 219)

• 12.10 “To configure an OTU trail” (p. 226)

• 12.13 “To configure an OCH trail” (p. 230)

• 15.22 “To configure an optical transport service” (p. 311)

15.16.2 Regeneration options for path constraints

While configuring a site inclusion path constraint, you can set the following regeneration
options:

• 3R Regeneration Site — NFM-P selects the path in which 3R Regeneration
(re-amplification, reshaping, and re-timing) occurs at the specified site. If there is no
such path, an error stating "Path Not Found" appears in the Problems Encountered
form.

• Pass Through Site — NFM-P selects the path in which 3R regeneration does not
happen at the specified site. If there is no such path, an error stating "Path Not Found"
appears in the Problems Encountered form.

• Unspecified — NFM-P selects any of the paths on the selected site. However, the path
contains the specified site.

See the following procedures for more information about configuring the regeneration
options while configuring a site inclusion path constraint:

• 15.27 “To configure path constraints for a service” (p. 320) for optical transport
service.

• 12.7 “To configure path constraints for ODU trails” (p. 221) for ODU trail.

• 12.10 “To configure an OTU trail” (p. 226) for OTU trail.

• 12.13 “To configure an OCH trail” (p. 230) for OCH trail.

15.17 Viewing optical services on NFM-P GUI

15.17.1 Overview

NFM-P client GUI provides multiple ways of viewing optical transport services.
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Table 27 Multiple ways of viewing optical transport services

Method Steps

From NEs on the physical topology map Right-click on one, or a pair of the NEs and choose Show Services→Optical
Transport Services or Optical Multipoint Transport Services 1 2 6

From NEs on the navigation tree Right-click on one, or a pair of the NEs and choose Show Services→Optical
Transport Services or Optical Multipoint Transport Services 1 2 6

From NEs in the compound node on the
physical topology map or the navigation
tree

Right-click on one, or a pair of compound nodes, or on one, or pair of the
WDM or OCS nodes in a compound node and choose Show
Services→Optical Transport Services or Optical Multipoint Transport
Services 3 4 5 6

From the NE properties form • Right-click on an NE on the navigation tree or the physical topology map
and choose Properties

• Click on the Services tab on the Card Slot (Edit) form
• Click on the Optical Transport Services tab or the Optical Multipoint

Transport Services tab

From the card properties form • Expand the equipment navigation tree to the card level
• Right-click on a card and choose Properties
• Click on the Services tab on the Card Slot (Edit) form
• Click on the Optical Transport Services tab or the Optical Multipoint

Transport Services tab

From NFM-P main menu • Choose Manage→Service→Services from NFM-P main menu. The
Manage Services form opens.

• Choose the Optical Transport Service (Optical Management) option from
the drop-down menu and click Search. A list of optical transport services
appears.

Notes:

1. If the chosen NE is a starting or terminating site of an optical transport service or an add site of an optical
multipoint transport service, the services are displayed. If the chosen NE is a pass-through site, drop, or drop
and continue site, the services are not listed.

2. If two NEs are chosen, the services starting or terminating on the NEs are listed. If the NEs are starting or
terminating sites of other services, those services are not listed if both the NEs are chosen together.

3. If only a WDM or an OCS NE is chosen from within a compound node, the services starting or terminating on
the NE are listed.

4. If both the WDM and OCS NEs are chosen from within a compound node, the services starting or
terminating on the NEs are listed.

5. If one or two compound nodes are chosen, the services starting or terminating on any of the two or four NEs
are displayed.

6. If two NEs are selected, the Optical Multipoint Transport Services option is disabled. If you select more than
two NEs, both Optical Transport Services and Optical Multipoint Transport Services are disabled.
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In a list of optical transport services or trails, properties like site name, site ID, and
endpoint names are listed. You can filter the list using these properties to search optical
transport services or trails on a particular site or endpoint.

15.18 Deleting optical transport services and trails

15.18.1 Optical transport services

When you choose to delete an optical transport service from the Manage Services form,
the following check boxes are available. You can select either both check boxes or only
the second check box.

• Also delete unused server trails from the network

• I understand the implications of this action

15.18.2 OTH and non-OTH rates

While deleting an optical transport service between two 1830 PSS WDM devices with
non-OTH rate cards, if you select both of the preceding check boxes, the optical
transport service, underlying ODU and OTU trails, and cross-connects are all deleted.
However, if you select only the I understand the implications of this action check box,
only the optical transport service is deleted, and the underlying trails and cross-connects
are retained. This optical transport service can be rediscovered. If you delete an optical
transport service with SubGigE rate or an optical transport service that involves LAG, the
VTS XCs are deleted, so the services cannot be rediscovered.

While deleting an optical transport service between two 1830 PSS WDM devices with
OTH rate cards, if you select both of the preceding check boxes, the optical transport
service, underlying LO-ODU and HO-ODU trails, and cross-connects are all deleted.
However, if you select only the I understand the implications of this action check box,
only the optical transport service and the LO-ODU trail are deleted, and the HO-ODU
trail and cross-connects are retained. If you delete an optical transport service involving
11DPM12 OPTSG service with an LO-ODU trail that is also used by another optical
transport service, deletion of the service does not delete the LO-ODU trail. You cannot
rediscover the optical transport service in this case.

While deleting an optical transport service between two 1830 PSS OCS devices,
irrespective of either selecting both the options or only the second option, the HO-ODU
trail is never deleted.

15.18.3 Optical trails

While deleting an ODU trail between two 1830 PSS WDM devices with non-OTH rate
cards, if you select both of the preceding check boxes, the ODU trail, underlying OTU
trail, and cross-connects are all deleted. However, if you select only the I understand the
implications of this action check box, only the ODU trail is deleted, and the underlying
OTU trail and cross-connects are retained.
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While deleting an LO-ODU trail between two 1830 PSS WDM devices with OTH rate
cards, if you select both of the preceding check boxes, the LO-ODU trail, underlying HO-
ODU trail, and cross-connects are all deleted. However, if you select only the I
understand the implications of this action check box, only the LO-ODU trail is deleted,
and the HO-ODU trail and cross-connects are retained.

While deleting an LO-ODU trail between two 1830 PSS OCS devices, irrespective of
either selecting both the options or only the second option, the HO-ODU trail is never
deleted.

15.18.4 Service priority

Services can be protected against accidental removal by raising their Service Priority.

Medium

While deleting an optical transport service with a service priority set as medium, the
following warning message is displayed:

This service can be deleted by entering the string medium in the “Highest protection
level of selected service(s)” field.

High

While deleting an optical transport service with a service priority set as high, the
following warning message is displayed:

Figure 21 Service priority set as Medium
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This service can only be deleted by an administrator by entering the string high in the
“Highest protection level of selected service(s)” field.

15.19 Administrative state transitions for service and trail

15.19.1 Overview

This topic describes the administrative state transitions for services and trails.

Table 28 Administrative state transitions for service and trail

Transitions Termination points Intermediate 1830
PSS OT ports
(client, line, VA,
and MVAC G)

OCH XC VTS XC 8

Service state changed to
Maintenance

Maintenance 1 Maintenance Down Down

ODU trail state changed to
Maintenance

Maintenance 1 Maintenance Down -

Service state changed from
Maintenance to Up 2

Up Up Up Up

Figure 22 Service priority set as High
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Table 28 Administrative state transitions for service and trail (continued)

Transitions Termination points Intermediate 1830
PSS OT ports
(client, line, VA,
and MVAC G)

OCH XC VTS XC 8

ODU trail state changed from
Maintenance to Up 2

Up Up Up -

Service state changed to
AINS

Up with Port AINS
enabled 3

Up with Port AINS
enabled 4

Up Up

ODU trail state changed to
AINS

Up with Port AINS
enabled 3

Up with Port AINS
enabled 4

Up -

Service state changed from
AINS to Up

Up 5 Up 5 - Up

ODU trail state changed from
AINS to Up

Up 5 Up 5 - -

Service state changed from
AINS to Down

Down 6 Up 5 - Down

ODU trail state changed from
AINS to Down

Down Up 5 - -

Service state changed from
Down to Up

Up - - Up

ODU trail state changed from
Down to Up 7

Up Up - -

Service state changed from
Up to Down

Down - - Down

ODU trail state changed from
Up to Down

Down - - -

Notes:

1. When the termination point is an 1830 PSS port.

2. When a service or ODU trail administrative state is changed from maintenance state to Up or AINS state,
NFM-P checks if a loopback is configured on any of the OT or MVAC G ports involved in the service or ODU
trail. If a loopback is detected on any of the ports, the administrative state change is unsuccessful.

3. Port AINS can be enabled only when the termination ports are 1830 PSS ports and the Administrative State
parameter is not set to Up.

4. Port AINS can be enabled only when the Administrative State parameter is not set to Up.

5. Port AINS is disabled.

6. The administrative state of the termination points of a SubGigE service is unchanged.
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7. When the ODU trail state is changed from Down to Up, then the states of intermediate 1830 PSS non-OT
ports change to Up.

8. The administrative state of a VTS XC cannot be changed when the VTS XC is a part of a protection group.
Hence, the administrative state of the ESNCP SubGigE service does not affect the administrative state of the
VTS XC.

Note: NFM-P does not support service administrative state transition from Maintenance
state to Down state.

The Port AINS state of a physical port is indicated on the hop objects.

15.20 Administrative and operational states determined by
NFM-P

15.20.1 Overview

This topic explains how NFM-P determines the administrative state and operational state
of a service or ODU trail during the service discovery.

15.20.2 Administrative states for service and ODU trails

Table 29 Administrative states for service and ODU trails

Service or ODU trail Termination point A Termination point Z

Up Up Up

Down Down Down

Down Down Up

Down Up Down

Note: If the administrative state of the OT or MVAC G ports that are part of a service
path, is changed to maintenance, the service administrative state is changed to
maintenance with an inconsistency message in the Optical Transport Service (Edit) form.

If the administrative state of the OT or MVAC G ports that are part of an ODU trail, is
changed to maintenance, the administrative state of the ODU trail and all associated
services is changed to maintenance with an inconsistency message in the Optical
Transport Service (Edit) form of all the associated services.

If none of the OT or MVAC G ports that are part of a service path, is in maintenance
state and Port AINS is enabled on one of the ports, the service administrative state is
changed to AINS with an inconsistency message in the Optical Transport Service (Edit)
form.

If none of the OT or MVAC G ports that are part of an ODU trail, is in maintenance state
and Port AINS is enabled one of the ports, the administrative state of the ODU trail and
all associated services is changed to AINS with an inconsistency message in the Optical
Transport Service (Edit) form of all the associated services.
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15.20.3 Administrative states for multipoint service

Table 30 Administrative states for multipoint service

Service Add site Drop site A Drop site B

Up Up Up Down

Up Up Down Up

Down Up Down Down

Down Down Down Down

15.20.4 Administrative states for unprotected SubGigE services

Table 31 Administrative states for unprotected SubGigE services

Service 1 Source termination
point

Destination
termination point

Source VTS XC Destination VTS XC

Up Up Up Up Up

Down Up Up Up Down

Down Up Up Down Up

Down Up Up Down Down

Down Up Down Up Up

Down Up Down Up Down

Down Up Down Down Up

Down Up Down Up Up

Down Up Down Down Down

Down Down Up Up Up

Down Down Up Up Down

Down Down Up Down Up

Down Down Up Down Down

Down Down Down Up Up

Down Down Down Up Down

Down Down Down Down Up

Down Down Down Down Down

Administrative and operational states determined by NFM-P NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

306 Issue 2



Notes:

1. The administrative state of a VTS XC cannot be changed when the VTS XC is a part of a protection group.
The administrative state of the ESNCP SubGigE service does not affect the administrative state of the VTS
XC.

15.20.5 Administrative states for Y-cable and OPSB protected services

Table 32 Administrative states for Y-cable and OPSB protected services

Service Working path source Protection path
source

Working path
destination

Protection path
destination

Up Up Up Up Up

Up Up Up Up Down

Up Up Up Down Up

Up Up Down Up Up

Up Down Up Up Up

Up Up Down Up Down

Up Down Up Down Up

Down Up Up Down Down

Down Up Down Down Up

Down Down Up Up Down

Down Down Down Down Up

Down Down Down Up Down

Down Down Up Down Down

Down Up Down Down Down

Down Down Down Down Down

15.20.6 Operational states for service and trails

Table 33 Operational states for service and ODU trail

Service Termination point A Termination point Z

Up Up Up

Up Maintenance Maintenance

Up Up Maintenance

Up Maintenance Up
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Table 33 Operational states for service and ODU trail (continued)

Service Termination point A Termination point Z

Down Down Down

Down Down Maintenance

Down Maintenance Down

Down Down Up

Down Up Down

Table 34 Operational states for protected multipoint service

Service Working path Protection path

Up Up Up

Down Down Down

Up Down Up

Up Up Down

Table 35 Operational states for Y-cable and OPSB protected services

Service Working path source Protection path
source

Working path
destination

Protection path
destination

Up Up (maintenance) Up (maintenance) Up (maintenance) Up (maintenance)

Up Up (maintenance) Up (maintenance) Up (maintenance) Down

Up Up (maintenance) Up (maintenance) Down Up (maintenance)

Up Up (maintenance) Down Up (maintenance) Up (maintenance)

Up Down Up (maintenance) Up (maintenance) Up (maintenance)

Up Up (maintenance) Down Up (maintenance) Down

Up Down Up (maintenance) Down Up (maintenance)

Down Up (maintenance) Up (maintenance) Down Down

Down Up (maintenance) Down Down Up (maintenance)

Down Down Up (maintenance) Up (maintenance) Down

Down Down Down Down Up (maintenance)

Down Down Down Up (maintenance) Down

Down Down Up (maintenance) Down Down

Down Up (maintenance) Down Down Down
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Table 35 Operational states for Y-cable and OPSB protected services (continued)

Service Working path source Protection path
source

Working path
destination

Protection path
destination

Down Down Down Down Down

The transport service operational state and additional information are assigned
separately for working paths and for protection paths. The operational state of a path can
be Down as a result of many reasons such as:
• Cross Connect Down—at least one of the cross-connections on the path has an

operational state set to Down

• Missing Cross Connect—there is a missing cross-connect on the path

• Wavekey Mode Mismatch—there is a wavekey mismatch on the path

• Port (that is not part of CrossConnect) Down—a port that is not part of the
cross-connect is operationally Down

• VTS Connection is Down

• Missing VTS Connection

• Missing ODUk Connection

You can click Complete Transport Service to re-create the cross-connections and APS
groups if entries are missing and to complete the creation of the service.

Note: You can view the administrative state and operational state information on the
hops tab in the protection or working paths in the service.

When you set the administrative state to Down, NFM-P does not generate transport
service down or ODU trail down alarms.

If the administrative state of the ODU trail is set to Up from NFM-P, then the
administrative states of all the hops are set to Up.

If the administrative states of the termination points of an OPSB service is set to Up or
Down, then the administrative states of the client and SIG ports of the OPSB card is also
set to Up or Down respectively.

15.21 AINS parameters for ports and facility objects

15.21.1 Overview

You can configure AINS parameters using the Turn Up/AINS option on the equipment
tree port object for ports and facility object for OTU or ODU facility objects.

15.21.2 OCS ports

The Port Specifics→General tab of the Physical Port (Edit) form displays the facility and
the equipment AINS parameters. The ports of the uplink cards do not have the
equipment AINS parameters. The Turn Up/AINS button is also available on the Physical
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Port (Edit) form. The Administrative State parameter is automatically set to Up when the
Turn Up/AINS option is chosen of the equipment tree port object. The AINS mode is
disabled when the Turn Up option is chosen from contextual menu of the equipment tree
port object.

15.21.3 OCS facility objects

You can configure AINS parameters using the Turn Up/AINS option on the equipment
tree facility object. The States tab of the facility object form displays the facility AINS
parameters. The Administrative State parameter is automatically set to Up when the Turn
Up/AINS option is chosen of the equipment tree facility object. The AINS mode is
disabled when the Turn Up option is chosen from the contextual menu of the equipment
tree facility object.

15.21.4 WDM ports

You can configure AINS parameters using the Turn Up/AINS option on the equipment
tree port object. The Port Specifics→General tab of the Physical Port (Edit) form displays
the facility AINS parameters. The Turn Up/AINS button is also available on the Physical
Port (Edit) form. The Turn Up/AINS parameter is dimmed when the Administrative State
parameter is set to Up.

15.21.5 WDM facility objects

You can configure AINS parameters using the Turn Up/AINS option on the equipment
tree facility object. The States tab of the facility object form displays the facility AINS
parameters. The Turn Up/AINS parameter is dimmed when the Administrative State
parameter is set to Up.
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Procedures to configure optical transport services

15.22 To configure an optical transport service

15.22.1 Before you begin

The following points should be considered before creating the service:

• Configure the rate, transmit frequency, and receive frequency of the terminating sites.

• Configure optical links between the terminating sites.

• Configure ODU trails before configuring the optical transport service for OCS devices.

15.22.2 Steps

1

Choose Create→Service→Optical→Transport Service from NFM-P main menu. The
Optical Transport Service (Create) form opens.

2

Select a customer in the Customer panel.

Note: You can create a template for the service at every stage by using the
Apply or OK button before you specify the optical sites and termination points.
You can use the service template to create a service by adding optical sites
and termination points. See Step 7 to Step 10 to create an optical site.

3

Configure the required parameters.

Note:

• If you select the Bidirectional check box, bidirectional cross-connects are
created and hops from A to Z and Z to A are displayed after service creation.

• If you deselect the Bidirectional check box, unidirectional cross-connects are
created and hops from A to Z are displayed after service creation

4

Configure the parameters in the VLAN Configuration Details panel, if you have
configured the Assigned Rate parameter as SubGigE, for Sub GigE services.

Note:

• For a line SVID configuration with a QinQ Service Stack-VLAN Tagging
Configuration of Push-Pop, the value of CE-VLANID - AZ and CE-VLANID -
ZA must be the same.
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• For a line SVID configuration, the value of Stack-VLANID - AZ and
Stack-VLANID - ZA must be the same.

5

Perform one of the following:

a. Configure the Protection Type parameter as Unprotected.

b. See “Procedures to configure protected services” (p. 326) to configure protected
services.

6

Configure the parameters in the ODU/OTU/OCH Details panel.

1. Configure the Spectral Width parameter for optical transport service configuration
using D5X500 cards.

2. If you have configured the Wave Key Assign mode as Manual Keying, configure
the parameters in the Wavekey Attributes panel.

3. If you need to reuse the wave keys, configure the Wave Key Preference
parameter as Duplicates Allowed.

Note: Rekey with duplicates may or may not reuse wave keys that are already
used by a channel. The specific channel number is marked as "Allow duplicate
wave keys" for an 1830 PSS device.

4. If you need to create OCH XCs even while the power commissioning is in
progress, configure the Force Create OCh XC parameter.

7

Right-click on the Sites object in the optical transport service tree and choose Create
Optical Site. The Select Network Elements - Optical Transport Service form opens.

8

Choose two sites and click OK. The Site A End and Site Z End objects appear on the
optical transport service tree below the Sites object.

Note: You can also create an optical transport service by selecting one or more
sites from the physical topology map or the equipment tree. With this method,
you do not configure the end site for the chosen site. However, you must
configure the termination point for the chosen site. See Step 7 to Step 10 for
information about configuring the termination point for the chosen site.

9

Right-click on the Site A End object and choose Create Termination Point. The
Select Termination point form opens.
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10

Choose a port and click OK.

Note:

• In this form, only the termination points that can be configured with the
specified service rates are displayed.

• If a termination point is used in another service, the termination point is not
displayed (except for SubGigE services).

• If a termination point is configured with another valid rate, the termination
point is not displayed.

11

Repeat Step 9 to Step 10 to configure the Site Z End.

12

Expand the Site A End and Site Z End objects on the optical transport service tree to
view the termination points created.

13

Perform 15.27 “To configure path constraints for a service” (p. 320) to configure a
path constraint for the service, if required.

14

To configure the preview of the optical transport service:

1. Configure the Service Deployment Mode parameter on the General tab of the
Optical Transport Service (Create) form as Preview, and click Apply. The preview
of the path that NFM-P will take when the service is deployed is displayed.

2. To select the option to include or exclude a path, click on the Service
Paths→Preview Path object on the navigation tree and click on the Hops A-Z or
Hops Z-A tab.

3. Choose an entry and click Include Constraint or Exclude Constraint, as required,
to add a new path or to exclude an existing path, and perform the path search
again.

Note:

• The service preview information is lost when the form is closed.

• When the underlying trails are not configured, only the physical hops are
displayed in the preview path and not the logical hops.

• The APS groups are not displayed in the preview.

• The underlying trails are listed in the Server Trails tab only if the trails are
configured before the service configuration.
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• For the optical services that require the configuration of ODU trails as a
prerequisite for service configuration, the preview can only be generated if the
trails are configured.

4. Configure the Service Deployment Mode parameter on the General tab of the
Optical Transport Service (Create) form as Deploy, to deploy the service on the
network.

15

Save the changes and close the forms.

Note: Up to two sites can be specified to create an optical transport service.
The sites are named Site A End and Site Z End by NFM-P.

END OF STEPS

15.23 To configure a multipoint transport service

15.23.1 Before you begin

The following are the prerequisites for 11QPA4 multipoint drop and continue service
creation:

• For unprotected multipoint drop and continue service, the termination points must
have their administrative state set to down.

• Create the APS group on the 1830 PSS. See 15.55 “To configure an APS group”
(p. 356).

• The APS group must be created manually on the drop and continue and drop sites for
configuring 11QPA4 ESNCP protected service. The working port must be assigned a
rate and the protection port must be unassigned.

• Set the Operational Mode parameter to Drop Continue on the line port when you
create a drop and continue multipoint service.

• Set the Operational Mode parameter to Add Only on the line ports of the Add site and
to Drop And Continue on the Drop and Continue sites.

• Configure the rate, transmit frequency, and receive frequency of the terminating sites.

• Create optical links between the terminating sites.

Before configuring a multipoint drop and continue service, create bidirectional HO-ODU
trails on the service path to be used, as required.

15.23.2 Steps

1

Choose Create→Service→Optical→Multipoint Transport Service from NFM-P main
menu. The Multipoint Transport Service (Create) form opens.
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2

Select a customer in the Customer panel.

Note: You can create a template for the service at operational state by using
the Apply or OK button before you specify the optical sites and termination
points. You can use the service template to create a service by adding optical
sites and termination points. See “ Template management” in the NSP NFM-P
Scripts and Templates Developer Guide for the procedure to create a service
from a template.

3

Configure the required parameters.

Note: You cannot configure the Administrative State parameter for a protected
service.

4

Configure the Rate parameter. Table 36, “Rate supported on OT cards” (p. 314) lists
the rates supported on 11PDM12 and 11QPA4 cards.

Table 36 Rate supported on OT cards

Card Service type Rate supported

11DPM8 Drop and Continue 1GbE

11DPM12 Drop and Continue 1 GbE

HDSDI

SDSDI

11QPA4 Drop and Continue 10GbE LAN

Multicast 10GbE LAN

4DPA4 Drop and Continue 1 GbE

HDSDI

SDSDI

5

Configure the parameters in the ODU/OTU/OCH Details panel.

1. Configure the Spectral Width parameter for the CDC-F configuration with D5X500
cards.

2. If you have configured the Wave Key Assign mode as Manual Keying, configure
the parameters in the Wavekey Attributes panel.
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3. If you need to reuse the wave keys, configure the Wave Key Preference
parameter as Duplicates Allowed.

Note: Rekey with duplicates may or may not reuse wave keys that are already
used by a channel. The specific channel number is marked as "Allow duplicate
wave keys" for an 1830 PSS device.

4. If you need to create OCH XCs even while the power commissioning is in
progress, configure the Force Create OCh XC parameter.

6

Right-click on the Sites object in the navigation tree and choose Create Add Site.
The Select Network Elements - Multipoint Transport Service form opens.

7

Choose a site and click OK.

8

Right-click on the Site Add object in the multipoint transport service tree and choose
Create Termination Point. The Select Termination Point form opens.

9

Choose a port and click OK.

Note: The Select Termination Point form lists only the termination points that
can be configured for the Rate parameter value configured in Step 4.

10

Repeat Step 6 to Step 9 to configure drop and continue and drop sites.

Note: Configure two drop sites for an ESNCP service.

11

Go to Step 12 for ESNCP service and Step 14 for unprotected service.

12

Configure one of the drop sites as working and the other as protection. Click on the
Site Drop object on the multipoint transport service tree. The properties of the drop
site appear in the right panel.

13

Configure the required parameters for the drop sites.
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14

To create path constraints, click on the Multipoint Transport Service object on the
multipoint transport service tree.

15

Click on the Path Constraints tab and click Create. The Optical Path Constraint
(Create) form opens.

16

Select the drop and continue sites as the sites in the Site panel.

17

Select the port in the Port panel.

18

Choose the port as path constraints.

19

Save your changes and close the forms.

Note:

• If the termination points are not added for any of the drop and continue sites
during service creation, repeat Step 6 to Step 9 to add the termination
points after the service is created. The path constraints are updated
automatically.

• If you need to delete any of the termination points in a drop and continue
site, right-click on the termination point and choose Delete. The path
constraints are updated automatically.

END OF STEPS

15.24 To discover optical transport services

15.24.1 When to use

The optical transport services are not discovered automatically during NE discovery. The
discovery of an optical transport service includes sub-tasks such as discovery of ODU
trails, OTU trails, and OCH trails. The status of an optical transport service discovery is
displayed as In Progress in the Task Manager form, until all the sub-tasks are completed
successfully. The status also displays the number of new optical transport services, ODU
trails, OTU trails, and OCH trails discovered. See the NSP NFM-P User Guide for more
information about monitoring NFM-P task manager.
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Perform this procedure after all of the 1830 PSS devices are synchronized in NFM-P.

15.24.2 Steps

1

Perform one of the following:

a. From the Manage menu for services:

1. Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form opens.

2. Click Optical Transport Service and select Discover Transport Services. The
Discover Transport Services form opens.

3. Choose a physical equipment group and click OK. The Manage Services form
reappears with a list of discovered optical transport services within the
specified group.

b. From the Manage menu for trails:

1. Choose Manage→OTN→OTN Trails from NFM-P main menu. The Manage
OTN Trails form opens.

2. Choose ODU Trail (Optical Management) from the object drop-down menu. A
list of ODU trails appears.

3. Choose an ODU trail from the list and click Discover Transport Services. The
discovered service is listed in the Manage Services form.

c. From the physical topology map:

1. If the physical topology map is not open, choose Application→Physical
Topology from NFM-P main menu. The physical topology map opens.

2. Right-click on an NE or on the empty space in the map and choose Discover
Transport Services in Group. The Manage Services form opens with a list of
discovered optical transport services within the group to which the NE belongs.

d. On the equipment tree, right-click on the equipment group object, NE object, or
multiple NE objects, and choose Discover Transport Services in Group. The
Manage Services form opens with a list of discovered optical transport services
within the group to which the NE belongs.

2

Close the form.

Note: You can perform the same procedure to discover services created in
1354 PhM.

END OF STEPS
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15.25 To unmanage an optical transport service

15.25.1 Steps

1

Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form appears.

2

Choose Optical Transport Service (Optical Management) option.

3

Choose the optical transport service that you need to unmanage and click Optical
Transport Service, then choose Unmanage Service.

4

Save your changes. The optical transport service is unmanaged. The optical
transport service appears on the Manage Services form with the Managed check
box deselected.

The deselected Managed check box indicates the following:
• The APS groups and VTS XCs are disassociated from the service.

• The service paths are removed.

• The sites with the termination points are retained.

• The information on the General tab of the Optical Transport Service (Edit) form is
retained.

END OF STEPS

15.26 To remanage an unmanaged optical transport service

15.26.1 Steps

1

Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form appears.

2

Choose Optical Transport Service (Optical Management) option and click Search. A
list optical transport services on the 1830 PSS appears on the Manage Services
form.
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3

Perform one of the following:

a. From the Manage Services form:

1. Choose the unmanaged service and click Optical Transport Service.

2. Choose Complete Transport Service.

b. From the Optical Transport Service (Edit) form:

1. Choose the unmanaged optical transport service from the Manage Services
form and click Properties. The Optical Transport Service (Edit) form opens.

2. Click Complete Transport Service.

4

Save your changes and close the form.

END OF STEPS

15.27 To configure path constraints for a service

15.27.1 Steps

1

Configure an optical transport service or a multipoint transport service. See
15.22 “To configure an optical transport service” (p. 311) or 15.23 “To configure a
multipoint transport service” (p. 314) .

2

Click on the Path Constraints tab in the Optical or Multipoint transport Service
(Create) form.

3

Click Create. The Optical Path Constraint (Create) form opens.

4

Configure the required parameters.

Note: Configure the Constraint Type parameter as Exclusion to exclude the
constraint element from the service path, and as Inclusion to include the
constraint element in the service path.
To apply a direction for a path constraint, configure the Direction parameter.

5

Perform one of the following:
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a. The constraint element is a port:

1. Select a site on the Site panel.

2. Select a port on the Port panel.

b. Select a site on the Site panel, if the constraint element is a site.

Note: Configure the Regeneration Option parameter, if the Constraint Type
is configured as Inclusion and the Constraint Element as Site, before
selecting the site.

c. Select a trail on the Trail panel, if the constraint element is a trail.

d. The constraint element is an ODUk timeslot:

Ensure that you have configured the ODUk timeslots. See 15.44 “To configure an
ODU timeslot assignment for 11DPM12 cards” (p. 340).

The constraint element, ODUk timeslot, is available for configuration only on the
1830 PSS, Release 5.5 and later.

1. Configure the ODUk Rate parameter.

2. Select a site on the Site panel.

3. Select an ODUk Timeslot on the ODUk Timeslot panel.

e. The constraint element is an OPTSG timeslot:

Ensure that you have configured the OPTSG timeslots. See 15.46 “To configure
OPTSG” (p. 343).

This option is applicable only for an optical transport service.

The constraint element, OPTSG timeslot, is available for configuration only on the
1830 PSS Release 5.5 and later.

1. Select a site in the Site panel.

2. Select an OPTSG timeslot in the OPTSG Timeslot panel.

f. The constraint element is a TDM timeslot:

Ensure that you have configured the TDM timeslots as required.

1. Select a site in the Site panel.

2. Select a TDM timeslot in the TDM Facility panel.

g. The constraint element is an optical link:

1. Select a site on the Site panel.

2. Select an optical link on the Optical Link panel.

6

Click OK to save your changes and go to Step 8 .
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7

Perform the following for 4DPA4 card:

1. On the optical transport service tree, expand Sites→Site A End→Termination
Point→TerminationPoint Working. The TP form opens.

2. Click Properties. The Physical Port (Edit) form opens.

3. Click Configure Time Slots. The Configure Time Slots for: 4DPA4 form opens.

4. Configure the Select Line Port parameter and choose the L1 or L2 timeslots
based on the configured line port.

5. Click OK. The Configure Time Slots for: 4DPA4 form closes and the Physical Port
(Edit) form reappears.

6. Click OK to save your changes.

8

On the optical transport service tree, expand Service Paths→Service Path and click
on the Hops A to Z tab to view the changes in the path hops due to the path
constraints modifications.

9

Close the form.

END OF STEPS

15.28 To convert an unprotected service to an ESNCP service on
a 4DPA4 FlexMux card

15.28.1 Steps

1

Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form opens.

2

Choose Optical Transport Service from the drop-down menu and click Search.

3

Choose an unprotected optical transport service and click Properties. The Optical
Transport Service (Edit) form opens.

4

Configure the Protection Type parameter to ESNCP Protected.
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5

Save your changes.

6

On the optical transport service tree, expand Service Paths. The protection path is
added as a service path.

Note: If no protection path is available, the conversion is unsuccessful and an
error message appears.

7

Close the forms.

END OF STEPS

15.29 To convert an ESNCP service to an unprotected service on
a 4DPA4 FlexMux card

15.29.1 Steps

1

Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form opens.

2

Choose Optical Transport Service and click Search.

3

Choose an ESNCP Protected optical transport service and click Properties. The
Optical Transport Service (Edit) form opens.

4

Perform one of the following to convert an ESNCP service to an unprotected service.

a. Convert an ESNCP Protected service to an Unprotected service and retain the
working path:

1. Configure the Protection Type parameter to Unprotected.

2. Configure the Path Preference parameter to Retain Working Path.

3. Click Apply.
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b. Convert an ESNCP Protected service to an Unprotected service and retain the
protection path:

1. Configure the Protection Type parameter to Unprotected.

2. Configure the Path Preference parameter to Retain Protection Path.

3. Click Apply to save the changes.

4. Perform Step 7 of 15.27 “To configure path constraints for a service” (p. 320)
to configure the timeslots manually.

5

Close the forms.

END OF STEPS

15.30 To display services riding on external or internal optical
links

15.30.1 Steps

1

From the Physical Topology - Network view, double-click on an external or internal
optical link. The Physical Link Group List form opens.

2

Choose an external or internal optical link and click Properties. The Optical Link
(Edit) form opens.

3

Choose the Optical Transport Services option and click Search.

4

Choose a service and click Properties. The Optical Transport Service (Edit) form
opens.

Note: You can view optical services on an OCH cross-connect. Choose
NE→Properties→OCH CrossConnects→Choose a cross connect→Properties.
The OCH Cross Connect (Edit) form opens. Click on the Optical Transport
Services tab to view the optical services on the selected cross-connect.
You can also view optical services on ports from the Physical Port (Edit) form
by clicking on the Optical Transport Services tab.
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The services must be discovered in NFM-P in order to view services on the
external and internal optical links, the OCH cross-connect, and the ports.

END OF STEPS

15.31 To view the service hops

15.31.1 Steps

1

Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form opens.

2

Choose Optical Transport Service and click Search.

3

Choose an optical transport service and click Properties. The Optical Transport
Service (Edit) form opens.

4

On the optical transport service tree, expand Service Paths→Service Path. The
Service Path form opens.

5

Click on the Hops A to Z, Hops Z to A, ODU Hops A to Z, and ODU Hops Z to A tabs,
as required, to view the hops in a service along the service path and ODU trail.

END OF STEPS
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Procedures to configure protected services

15.32 To configure an ESNCP protected service

15.32.1 Steps

1

Choose Create→Service→Optical→Transport Service from NFM-P main menu. The
Optical Transport Service (Create) form opens.

2

Select a customer in the Customer panel.

3

Configure the required parameters.

Note: If you select the Bidirectional check box, bidirectional cross-connects are
created and hops from A to Z and Z to A are displayed after service creation
If you deselect the Bidirectional check box, unidirectional cross-connects are
created and hops from A to Z are displayed after service creation

4

Configure the Protection Type parameter as ESNCP Protected.

5

Configure the Protection Path Finding Option parameter.

6

Configure the parameters in the APS Group panel.

7

Configure the parameters in the ODU/OTU/OCH Details panel.

1. If you have configured the Wave Key Assign mode as Manual Keying, configure
the parameters in the Wavekey Attributes panel.

2. If you need to reuse the wave keys, configure the Wave Key Preference
parameter as Duplicates Allowed.

Note: Rekey with duplicates can or cannot reuse wave keys that are already
used by a channel. The specific channel number is marked as "Allow duplicate
wave keys" for an 1830 PSS device.
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3. If you need to create OCH XCs even while the power commissioning is in
progress, configure the Force Create OCh XC parameter.

4. Set the Spectral Width parameter to 62.5 GHz for the CDC-F configuration with
D5X500 cards.

8

Right-click on the Sites object in the optical transport service tree and choose Create
Optical Site. The Select Network Elements - Optical Transport Service form opens.

9

Choose two sites and click OK. The Site A End and Site Z End objects appear on the
optical transport service tree below the Sites object.

10

Right-click on the Site A End object and choose Create Termination Point. The
Select Termination point form opens.

11

Choose a port and click OK.

12

Repeat Step 10 to Step 11 to configure the Site Z End.

13

Expand the Site A End and Site Z End objects on the optical transport service tree to
view the termination points created.

14

Click Apply.

Result: The working and protection service path objects appear on the navigation
tree.

15

Click on the Service Path Working or Service Path Protection object to view the
hops.

16

Save your changes and close the forms.

END OF STEPS
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15.33 To configure a Y-cable protected service

15.33.1 Steps

1

Choose Create→Service→Optical→Transport Service from NFM-P main menu. The
Optical Transport Service (Create) form opens.

2

Select a customer in the Customer panel.

3

Configure the general parameters.

4

Configure the Protection Type parameter as Y-Cable Protected.

5

Configure the Protection Path Finding Option parameter.

6

Configure the parameters in the APS Group panel.

7

Perform the following to enable switching on signal degrade:

1. Select the Switch on Signal Degrade check box.

2. Configure the parameters in the Line Port Parameters panel.

3. Configure the parameters in the Client Port Parameters panel

Note: The Line Port Parameters panel is not displayed if the Rate parameter is
configured as 1GbE for the Y-cable protected optical transport service.

8

Configure the parameters in the ODU/OTU/OCH Details panel.

1. If you have configured the Wave Key Assign mode as Manual Keying, configure
the parameters in the Wavekey Attributes panel.

2. If you need to reuse the wave keys, configure the Wave Key Preference
parameter as Duplicates Allowed.
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Note: Rekey with duplicates can or cannot reuse wave keys that are already
used by a channel. The specific channel number is marked as "Allow duplicate
wave keys" for an 1830 PSS device.

3. If you need to create OCH XCs even while the power commissioning is in
progress, configure the Force Create OCh XC parameter.

4. Set the Spectral Width parameter to 62.5 GHz for the CDC-F configuration with
D5X500 cards.

9

Right-click on the Sites object in the optical transport service tree and choose Create
Optical Site. The Select Network Elements - Optical Transport Service form opens.

10

Choose two sites and click OK.

Result: The Site A End and Site Z End objects appear on the optical transport
service navigation tree below the Sites object.

11

Right-click on the Site A End object and choose Create Termination Point. The
Select Termination point form opens.

12

Choose a port and click OK.

Result: The TerminationPoint Working object appears on the optical transport
service navigation tree below the Site A End object.

13

Repeat Step 11 to Step 12 for the protection port.

Result: The TerminationPoint Protection object appears on the optical transport
service navigation tree below the Site A End object.

14

Repeat Step 11 to Step 13 to configure the Site Z End.

15

Expand the Site A End and Site Z End objects on the optical transport service tree to
view the termination points.

16

Click Apply.
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Result: The working and protection service path objects appear on the navigation
tree.

17

Click on the Service Path Working or Service Path Protection object to view the
hops.

18

Save your changes and close the forms.

END OF STEPS

15.34 To configure a client-side OPS protected service

15.34.1 Steps

1

Configure an OPSB card. See 9.24 “To configure an OPSB card” (p. 138).

2

Configure a protected optical transport service. See 15.22 “To configure an optical
transport service” (p. 311) for more information about configuring an optical transport
service.

3

Choose OPS Protected as the Protection Type parameter option on the Optical
Transport Service (Create) form in Step 5 of 15.22 “To configure an optical
transport service” (p. 311).

4

Upon completion of service creation, the Optical Translator Unit Protection check
box is automatically enabled on the Optical Transport Service (Edit) form.

Note: If NFM-P detects a port configuration mismatch during optical transport
service creation, an error message appears and the service creation is
unsuccessful.
When the mismatch is corrected, the service creation is successful.
If the mismatch is detected during service discovery, the mismatch is indicated
on the General tab of the Optical Transport Service form and cleared when the
mismatch is corrected.

END OF STEPS
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15.35 To configure an OMSP protected service

15.35.1 Steps

1

Configure the OPSA cards as described in 9.23 “To configure an OPSA card”
(p. 137).

2

Configure the Protection Mode parameter as OMSP on the Card Specifics tab of the
OPSA cards.

3

Configure the optical links for the following as described in 9.44 “To configure an
optical link between ports” (p. 163).

OT (line port)←→SFD (Channel port): SFD (OMD)←→OPSA (SIG port): OPSA (A
port)←→AMP1 (SIG port): AMP1 (LINE port)←→AMP1 (LINE port): AMP1 (SIG
port) ←→OPSA (A port): OPSA (SIG port)←→SFD (OMD): SFD (Channel
port)←→OT (line port)

OT (line port)←→SFD (Channel port): SFD (OMD)←→OPSA (SIG port): OPSA (B
port)←→AMP2 (SIG port): AMP2 (LINE port)←→AMP2 (LINE port): AMP2 (SIG
port) ←→OPSA (B port): OPSA (SIG port)←→SFD (OMD): SFD (Channel
port)←→OT (line port)

4

Configure an unprotected optical transport service as described in 15.22 “To
configure an optical transport service” (p. 311) between the client ports of the OTs
used in the configuration in Step 3.

Note: The OPS Protected OTU trail is created automatically by NFM-P.

END OF STEPS

15.36 To configure an OCHP protected service

15.36.1 Steps

1

Configure the OPSA cards as described in 9.23 “To configure an OPSA card”
(p. 137).
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2

Configure the Protection Mode parameter as OCHP on the Card Specifics tab of the
OPSA cards.

3

Configure the optical links for the following as described in 9.44 “To configure an
optical link between ports” (p. 163):

OT (line port)←→OPSA (SIG port): OPSA (A port)←→SFD1 (Channel port): SFD1
(OMD port)←→AMP1 (SIG port): AMP1 (LINE port)←→AMP1 (LINE port): AMP1
(SIG port)←→SFD1 (OMD port): SFD1 (Channel port)←→OPSA (A port): OPSA
(SIG port)←→OT (line port)

OT (line port)←→OPSA (SIG port): OPSA (B port)←→SFD2 (Channel port): SFD2
(OMD port)←→AMP2 (SIG port): AMP2 (LINE port)←→AMP2 (LINE port): AMP2
(SIG port)←→SFD2 (OMD port): SFD2 (Channel port)←→OPSA (B port): OPSA
(SIG port)←→OT (line port)

4

Configure an unprotected optical transport service as described in 15.22 “To
configure an optical transport service” (p. 311) between the client ports of the OTs
used in the configuration in Step 3.

Note: The OPS Protected OTU trail is created automatically by NFM-P.

END OF STEPS

15.37 To configure an optical transport service with underlying
cascaded OCHP and OMSP protected trails

15.37.1 OCHP and OMSP cascaded protection

You can configure OPS protected (OMSP or OCHP) trails and configure a service over
the trails. Figure 23, “Example configuration for OCHP and OMSP cascaded protection”
(p. 333) represents an example configuration.
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15.37.2 Steps

1

Configure the OPSA cards with appropriate protection mode, as required. See
9.23 “To configure an OPSA card” (p. 137) for more information.

2

Configure an OPS (OMSP or OCHP) protected OCH trail between the required
devices. See 12.13 “To configure an OCH trail” (p. 230) for more information.

3

Configure an unprotected optical transport service between the required devices
over the OPS protected trail. See 15.22 “To configure an optical transport service”
(p. 311) for more information. The underlying OTU and ODU trails are created
automatically.

Before creating a configuration as shown in Figure 23, “Example configuration for
OCHP and OMSP cascaded protection” (p. 333), create an external link from the OT
to the OPSA card using the 1830 PSS WebUI.

END OF STEPS

Figure 23 Example configuration for OCHP and OMSP cascaded protection
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15.38 To configure an OLP protected service

15.38.1 Steps

1

Configure the OPSA cards as described in 9.23 “To configure an OPSA card”
(p. 137).

2

Configure optical links for the following as described in 9.44 “To configure an optical
link between ports” (p. 163):

OT→SFD→AMP (line port)→OPSA (A port)→OPSA (A port)→AMP (line
port)→SFD→OT

OT→SFD→AMP (line port)→OPSA (B port)→OPSA (B port)→AMP (line
port)→SFD→OT

Note: The OTS trail is automatically created when the optical link is configured
from OPSA (A port) to OPSA (A port) and OPSA (B port) to OPSA (B port). The
OTS trail cannot be deleted.

3

Configure an unprotected optical transport service as described in 15.22 “To
configure an optical transport service” (p. 311), routing through the OTU trails
automatically created in Step 2 .

Note: You can route the service through the OTU trails by choosing the client
port of the OTs used for creating optical links in Step 2 as termination points.

END OF STEPS

15.39 To configure a client protected service on OCS devices

15.39.1 Before you begin

Before performing this procedure, ensure that you configure the I/O cards with the OTU
rates in card slots 33 to 48 on an 1830 PSS-64 device, or in any I/O card slots of an
1830 PSS-36 device.
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15.39.2 Steps

1

Perform 12.10 “To configure an OTU trail” (p. 226) to configure an unprotected
higher-order OTU trail between two I/O cards, with the Rate parameter configured as
OTU2.

2

Perform 12.5 “To configure an ODU trail” (p. 219) to configure an unprotected
higher-order ODU trail between the sites containing the I/O cards used in Step 1,
with the Rate parameter configured as ODU2 and termination points as the
ODUPOOLS of the sites.

3

Configure the required I/O cards with OC or STM rates on the sites used in Step 1
and Step 2.

4

Perform one of the following:

a. Configure the lower-order ODU trail and discover the client protected service:

1. Perform 12.5 “To configure an ODU trail” (p. 219) to configure an SNCNC
protected lower-order ODU trail between the two client ports of I/O cards
configured in Step 3 , with the Rate parameter configured as ODU0.

2. Perform 15.24 “To discover optical transport services” (p. 317) to discover the
service between the termination points used in sub-step 1 . Before discovering
the optical service, ensure that the necessary optical links are configured as
required.

b.

1. Ensure that the necessary optical links are configured as required. The lower-
order ODU trail between the two client ports of I/O cards configured in Step 3
is created automatically.

2. Perform 15.22 “To configure an optical transport service” (p. 311) to configure
a client protected service between the two client ports of I/O cards configured
in Step 3 , with the Rate parameter set to an OC or STM rate, as required.

3. Configure the Protection Type parameter as Client Protected.

END OF STEPS
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15.40 To configure a client protected service with double add-
drop

15.40.1 Before you begin

Before performing this procedure, ensure that you configure the I/O cards with the OTU
rates in card slots 33 to 48 on an 1830 PSS-64 device, or in any of the I/O card slots of
an 1830 PSS-36 device.

15.40.2 Steps

1

Perform Step 1 and Step 2 of 15.39 “To configure a client protected service on
OCS devices” (p. 334), twice, to create two unprotected OTU and ODU trails.

2

Perform Step 3 and Step 4 of 15.39 “To configure a client protected service on
OCS devices” (p. 334).

3

Click on the Path Constraints tab and configure one of the OTU trails as the Working
constraint and the other as Protection constraint.

4

Save your changes and close the form.

END OF STEPS

15.41 To configure a diverse route protected service

15.41.1 Before you begin

Before configuring a diverse route protected service, configure an unprotected optical
transport service, as required.

15.41.2 Steps

1

Choose Create→Service→Optical→Transport Service from NFM-P main menu. The
Optical Transport Service (Create) form opens.
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2

Select a customer in the Customer panel.

3

Configure the required parameters.

Note: If you select the Bidirectional check box, bidirectional cross-connects are
created and hops from A to Z and Z to A are displayed after service creation.
If you deselect the Bidirectional check box, unidirectional cross-connects are
created and hops from A to Z are displayed after service creation.

4

Configure the Protection Type parameter as Diverse Route.

5

Configure the parameters in the ODU/OTU/OCH Details panel.

1. If you have configured the Wave Key Assign mode as Manual Keying, configure
the parameters in the Wavekey Attributes panel.

Note: Rekey with duplicates can or cannot reuse wave keys that are already
used by a channel. The specific channel number is marked as "Allow duplicate
wave keys" for an 1830 PSS device.

2. If you need to reuse the wave keys, configure the Wave Key Preference
parameter as Duplicates Allowed.

3. If you need to create OCH XCs even while the power commissioning is in
progress, configure the Force Create OCh XC parameter.

4. Set the Spectral Width parameter to 62.5 GHz for the CDC-F configuration with
D5X500 cards.

6

Select a diverse service in the Diverse Route Details panel.

Note: Only unprotected optical transport service are available for selection.

7

Right-click on the Sites object in the optical transport service tree and choose Create
Optical Site. The Select Network Elements - Optical Transport Service form opens.

8

Choose two termination sites and click OK. The Site A End and Site Z End objects
appear on the optical transport service tree below the Sites object.
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9

Right-click on the Site A End object and choose Create Termination Point. The
Select Termination point form opens.

10

Choose a port and click OK.

11

Repeat Step 9 and Step 10 to configure the Site Z End.

12

Expand the Site A End and Site Z End objects on the optical transport service tree to
view the termination points created.

13

Click Apply and view the hops in the Hops A to Z and Hops Z to A tabs.

14

Choose Manage→Service→Services from the main menu. The Manage Services
form opens. The services that are combined with a diverse route are listed with the
same Service Group ID.

15

Perform one of the following to convert a diverse route service to or from an
unprotected service.

a. To convert an unprotected service, configure the Protection Type parameter as
Unprotected and click Apply on the Optical Transport Service (Edit) form. The two
diverse route services with the same Service Group ID are disjoined and listed as
two distinct services in the Manage Services form.

b. To convert a diverse route service, configure the Protection Type parameter as
Diverse Route, and select a service in the Diverse Route Details panel, as
required, and click Apply on the Optical Transport Service (Edit) form. The diverse
services are re-created with the same Service Group ID in the Manage Services
form.

16

Save your changes and close the forms.

Note: Before performing a software upgrade, unmanage and delete all diverse
services from the Manage Services form.

END OF STEPS
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Procedures to configure service using 11DPM12, 11DPM8,
and 11DPM4M cards

15.42 To configure an unprotected service routing through an
SNCN protected ODU trail on 11DPM12, 11DPM8, and
11DPM4M cards

15.42.1 Steps

1

Perform 12.5 “To configure an ODU trail” (p. 219) to configure an SNCN protected
LO-ODU trail. Choose SNCN Protected as the option for the Protection Type
parameter.

Note: You can configure an unprotected OPTSG service through the SNCN
protected ODU1PTF LO-ODU trails by choosing ODU1 as the value for the
Assigned Rate parameter and ODU1PTFs as termination points on the
11DPM12 card.

2

Perform 15.22 “To configure an optical transport service” (p. 311) and configure an
unprotected optical transport service routing through the LO-ODU trail configured in
Step 1 .

Note: You can route the service through the LO-ODU trail by choosing the
client ports used in the ODU trail configuration as the termination points.
You can configure an unprotected OPTSG service through the SNCN protected
ODU1PTF LO-ODU trails. Choose the OC3 or OC12 as the value for the
Assigned rate parameter and client ports used in the ODU trail configuration as
the termination points on the 11DPM12 card.

END OF STEPS

15.43 To extend a drop site on an unprotected multipoint service

15.43.1 When to use

You can extend a drop site by adding a new site as a drop site for an existing
unprotected multipoint optical transport service. The site on which you choose to extend
the drop site is converted to a drop and continue site. Extending a drop site is supported
on 11DPM8 and 11DPM12 cards.
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15.43.2 Steps

1

Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form opens.

2

Choose Optical Transport Service from the drop-down menu.

3

Choose an unprotected multipoint service from the list and click Properties. The
Multipoint Transport Service (Edit) form opens.

4

On the navigation tree, right-click on the Site Drop object and choose Extend Drop
Site. The Extend Drop Site form opens.

5

Select the new drop site. The new drop site object is added on the navigation tree.

6

Right-click on the newly created Site Drop object and choose Create Termination
Point. The Select Termination Point form opens.

7

Choose a termination point and click OK. The Termination Point object appears on
the navigation tree.

8

Click Apply. The extended drop site changes into a drop and continue site.

END OF STEPS

15.44 To configure an ODU timeslot assignment for 11DPM12
cards

15.44.1 Steps

1

On the equipment tree, expand Network→NE→Shelf→Card→Line Port.
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2

Right-click on the line port and choose Properties. The Physical Port (Edit) form
opens.

3

Click Configure Timeslots. The Timeslot Assignments form opens.

4

Specify the required timeslot configuration. Table 37, “12xANY timeslot mapping”
(p. 340) lists the timeslot mapping.

Table 37 12xANY timeslot mapping

Client signal type ODU0 XC
(default)

ODU1 XC
(TS)

ODUFlex XC
(TS)

OPTSG XC
(TS)

FC100 1 — — —

OC3/STM1 1 — — 1

OC12/STM4 1 — — 4

GbE 1 — — —

SDSDI 1 — — —

FE 1 — — —

OTU1 — 2 — —

OC48/STM64 — 2 — —

HDSDI — 2 — —

FC200 — 2 — —

FC400 — — 4 —

3GSDI — — 3 —

5

Save your changes and close the forms.

END OF STEPS
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15.45 To associate a line-side LO-ODUk on the 11DPM12 card

15.45.1 Steps

1

Configure the timeslots as described in 15.44 “To configure an ODU timeslot
assignment for 11DPM12 cards” (p. 340).

2

Perform one of the following:

a. 1830 PSS Release 5.5 and later.

1. On the equipment tree, expand Network→1830
PSS→Shelf→Card→ODUPTF.

2. Right-click on the ODUPTF Object and choose Associate Line Side LO-ODUk
Facility. The ODU1Ptf Association with Line side LO-ODUk (Create) form
opens.

b. Earlier releases of the 1830 PSS device.

1. On the equipment tree, expand Network→1830 PSS→Shelf→Card.

2. Right-click on the Card object and select Properties. The Card Slot (Edit) form
opens.

3. Click on the ODU1PTF Objects tab, choose an ODU1PTF and click Properties.
The ODU1PTF (Edit) form opens.

4. Click Associate Line Side LO-ODUk Facility. The ODU1Ptf Association with
Line side LO-ODUk (Create) form opens.

3

Select a line-side LO-ODUk facility in the Line Side LO-ODUk Facility panel.

Note: You can sub-structure the ODU1PTF object to create OPTSG objects
only when ODU1PTF is associated with Line side LO-ODUk.

4

Click OK to confirm, save your changes, and close the forms.

END OF STEPS

To associate a line-side LO-ODUk on the 11DPM12 card NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

342 Issue 2



15.46 To configure OPTSG

15.46.1 Steps

1

Configure the ODU1 timeslots as described in 15.44 “To configure an ODU timeslot
assignment for 11DPM12 cards” (p. 340) .

2

Associate an ODU1PTF object with the line port ODUk facility object to create the
cross-connect as described in 15.45 “To associate a line-side LO-ODUk on the
11DPM12 card” (p. 342) . The ODU1PTF can be associated only with the ODU1
container (with two timeslots) on a line port.

3

On the equipment tree, expand Network→1830 PSS→Shelf→Card→ODUPTF

4

Right-click on the ODUPTF object and choose Configure ODU1PTF Timeslots. The
Timeslot Assignments form opens.

5

Configure the timeslots and click OK.

Note: OPTSG configuration is applicable for keyed and unkeyed services.

END OF STEPS

15.47 To delete an ODUk XC on the 11DPM12 card

Note: You cannot delete an ODUk XC when it is associated with a service or an APS
Group.

15.47.1 Steps

1

On the equipment tree, expand Network→1830 PSS

2

Right-click on the 1830 PSS object and choose Properties. The Network Element
(Edit) form opens.
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3

Click on the ODUk Cross Connects tab, choose the cross-connect to be deleted,
and click Delete. A Warning dialog box appears.

4

Select the check box on the Warning dialog box and click Yes. The ODUk XC
deleted and disassociates the client port from the line port.

END OF STEPS
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OTN layer management and service configuration using
112SDX11 card

15.48 112SDX11 card

15.48.1 Overview

The 112SDX11 card has an OTM-0.4v4 interface carrying a four-lane optical signal
containing one OTU4. The L1 port of the 112SDX11 card is configured with the signal
rate of OTL4.4. The OTL4.4 signal is mapped to four optical transport lane carriers or
OTLC physical ports, L1 to L4. The four OTLC signals are multiplexed into one OTLC
group, identified as OTLCG. The L1 to L4 ports belong to one OTLCG and the optical
attributes of the ports are provisioned only on the first port. The frequency and primary
state of the L2, L3, and L4 port are determined by the parameters provisioned on the L1
port.

The OTLCG signal is mapped to an OPSMnk. The OPSMnk is a physical optical signal
consisting of four multilanes using wavelength division multiplexing for n = 4 and
containing one OTU4 signal.The OPSMnk signal is sent to the OTM-0.4v4 interface.

NFM-P supports configuration of the OCH cross-connect groups on the 112SDX11 card.
The OCH cross-connect groups are automatically created during a service configuration
and the OCH cross-connect group comprises the OCH cross-connects. See 15.50 “To
view the OCH cross-connect group from the NE” (p. 349) for more information about
viewing the OCH cross-connect groups for an 1830 PSS device.

NFM-P automatically creates the underlying optical trails during service configuration.
One LO-ODU trail, one HO-ODU trail, one OTU trail, and four OCH trails—one each
from the L1 to L4 ports—are created during the service configuration and can be viewed
from NFM-P.

The first OCH trail (associated with the L1 port) is called the primary OCH trail and the
remaining three OCH trails (associated with the L2 to L4 ports) are called sibling OCH
trails. You can view the OCH cross-connect groups from the primary OCH trail. The
sibling OCH trails display only the OCH cross-connects. See 15.51 “To view the OCH
cross-connect group from the primary OCH trail” (p. 349) for more information about
viewing the OCH cross-connect groups from the primary OCH trail.

15.48.2 Dual-rate support

The 112SDX11 card supports the configuration of dual-rate (default 100GbE and OTU4)
100GBASE-LR4 CFP in the OTU4 mode on the L1 port to interconnect with the external
OTN networks. The Pluggable Module Type parameter of the L1 port is set to C113G4Cd
on the Port Specifics→General tab of the Physical Port (Edit) form. When the 112SDX11
card is configured with the CFP module on a line port, the device be connected to the
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external OTN network with another device configured with the same 100GBASE-LR4
CFP. The external OTN network provides an unterminated ODU4 connection between
the 112SDX11 cards.

15.48.3 ISL trunking

NFM-P supports ISL trunking through client ports assigned with rates FC400, FC800, or
FC1600 on the 112SDX11 card. To establish ISL trunking using NFM-P:
• Configure the same Link Group ID on the client ports with rates FC400, FC800, or

FC1600 on the 112SDX11 cards of two 1830 PSS devices.

• Configure an optical transport service with one of the client ports from each of the
1830 PSS devices as termination points.

15.48.4 SR-SR optical transport service using fan-out cable

NFM-P allows you to discover an optical transport service between two 7750 SR devices
that are connected to two 1830 PSS devices using a fan-out cable. One end of the fan-
out cable is connected to a 100GbE port on a 7750 SR device and the other ten ends
are connected to ten client ports, each with the CBR10G3 rate of the 112SDX11 card
configured on an 1830 PSS device. You must first configure an optical transport service
between the two 1830 PSS devices, then discover the service on the 7750 SR devices.
• Before configuring the optical transport service between the two 1830 PSS devices,

set the Link Group ID parameter to the same value on all ten client ports of the
112SDX11 card connected to the fan-out cable on each of the 1830 PSS devices. The
Link Group ID parameter is on the OT panel of the General sub-tab of the Port
Specifics tab of the physical port properties form.

• Before creating the service, delete the optical links between the client ports of
112SDX11 cards on the 1830 PSS devices and the 100GbE cards on the 7750 SR
devices. Create an optical transport service, with a rate of CBR10G3, between two
client ports of the two 112SDX11 cards on the 1830 PSS devices. NFM-P
automatically creates nine more optical transport services.

• After configuring the optical transport service between the two client ports of the
112SDX11 cards, recreate the optical link between the client ports of the 112SDX11
cards, used to create the optical transport service, and the ports of the 100GbE cards
on the 7750 SR devices. Choose Optical Transport Service→Discover Transport
Services on the Manage Services form. The services from the remaining client ports of
the 112SDX11 cards are discovered by NFM-P. All the client ports are extended to the
7750 SR device and one of the termination points of all the ten services is the same
port of the 100GbE card on the 7750 SR device.

Note: You can also discover optical transport services in the same way, when one end of
the fan-cable is connected to a 40GbE port on a 7750 SR device and the other four ends
are connected to four client ports, each with the CBR10G3 rate of the 112SDX11 card
configured on an 1830 PSS device.
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15.49 To configure an OMSP protection service using 112SDX11

15.49.1 Steps

1

Configure the OPSA cards as described in 9.23 “To configure an OPSA card”
(p. 137) .

2

Configure the Protection Mode parameter as OMSP on the Card Specifics tab for the
OPSA cards.

3

Configure the optical links for the following as described in 9.44 “To configure an
optical link between ports” (p. 163) :

OT (L1 to L4)←→MVAC8B (C1 to C4): MVAC8B (L1 to L4)←→SFD (Channel port):
SFD (OMD)←→OPSA (SIG port): OPSA (A port)←→AMP1 (SIG port): AMP1 (LINE
port)←→AMP1(LINE port): AMP1 (SIG port) ←→OPSA (A port): OPSA (SIG
port)←→SFD (OMD): SFD (Channel port)←→MVAC8B (C1 to C4): MVAC8B (L1 to
L4)←→OT (L1 to L4)

OT (L1 to L4)←→MVAC8B (C1 to C4): MVAC8B (L1 to L4)←→SFD (Channel port):
SFD (OMD)←→OPSA (SIG port): OPSA (B port)←→AMP2 (SIG port): AMP2 (LINE
port)←→AMP2 (LINE port): AMP2 (SIG port) ←→OPSA (B port): OPSA (SIG
port)←→SFD (OMD): SFD (Channel port)←→MVAC8B (C1 to C4): MVAC8B (L1 to
L4)←→OT (L1 to L4)

See Step 4 and Step 5 for more information about the sequence of configuring the
optical links for unkeyed and keyed services respectively.

Unkeyed service

4

To configure the optical links between 112SDX11 L(1 to 4) ports to the SFD channel
ports for an unkeyed service:

1. Configure four optical links, from the 112SDX11 card line ports L1 to L4 to the
SFD channel ports.

If the L1 port does not have the frequency set, the 1830 PSS creates a
connection and automatically sets the port frequency to the SFD channel
frequency value.

2. Configure L1 optical links before L2 to L4 links because only the wavelength of
L1 can be configured. The L1 optical link must be deleted after L2 to L4 links are
deleted.
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If the L1 to L4 ports are configured with a frequency that is different from the SFD
channel, the 1830 PSS does not create a connection.

Keyed service

5

Perform one of the following for a keyed service.

a. To configure the optical links between the 112SDX11 L(1 to 4) ports to the
MVAC8B C(1 to 8) ports and the SFD channel ports:

• The optical link from the MVAC8B line to the SFD must be created before the
optical link from the OT line to the MVAC8B client is created.

• The optical link from the OT line to the MVAC8B client must be deleted before
the optical link from the MVAC8B line to the SFD channel is created.

• If the L1 to L4 ports have the frequency set to a different value than the
MVAC8B line frequency, the 1830 PSS does not create the connection.

• If the L1 port does not have the frequency set, the 1830 PSS creates a
connection and automatically sets the port frequency to the SFD or MVAC8B
line frequency value.

b. To configure the optical links between the 112SDX11 L(1 to 4) ports to the MVAC
G(1 to 8) ports and the SFD channel ports:

• The optical link from the MVAC G port to the SFD must be created before the
optical link from the 112SDX11 line to the MVAC G port is created.

• The optical link from the 112SDX11 line to the MVAC G port must be deleted
before the optical link from the MVAC G port to the SFD channel is created.

• If the 112SDX11 L1 to L4 ports have the frequency set to a different value than
the MVAC G frequency, the 1830 PSS does not create the connection.

• If the L1 port does not have the frequency set, the 1830 PSS creates a
connection and automatically sets the port frequency to the SFD or MVAC G
frequency value.

6

Configure an unprotected optical transport service as described in 15.22 “To
configure an optical transport service” (p. 311) between the client ports of the OTs
used in the configuration in Step 3 .

Note: The OPS Protected OTU trail is created automatically by NFM-P.

END OF STEPS

To configure an OMSP protection service using 112SDX11 NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

348 Issue 2



15.50 To view the OCH cross-connect group from the NE

15.50.1 Steps

1

On the equipment tree, expand Network→1830 PSS.

2

Right-click on the 1830 PSS object and choose Properties. The Network Element
(Edit) form opens.

3

Click on the OCH Cross-Connect Groups tab, choose an OCH cross-connect group,
and click properties. The OCH Cross Connect Group (Edit) form opens.

4

Click on the OCH Cross-Connects tab. The OCH cross-connects are listed.

END OF STEPS

15.51 To view the OCH cross-connect group from the primary
OCH trail

15.51.1 Steps

1

Choose Manage→OTN→OTN Trails from NFM-P main menu.

2

Choose OCH Trail (Optical Management) from the object drop-down menu. The
OCH trails are listed.

3

Choose the primary OCH trail and click Properties. The OCH Trail (Edit) form opens.

4

Click on the Trail Paths and on the OCH Trail Path object on the OCH trail tree. The
OCH trail path attributes appear on the right panel.
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5

Click on the OCH CrossConnect tab, choose an OCH cross-connect group, and click
Properties. The OCH Cross Connect Group (Edit) form opens.

6

Click on the OCH CrossConnects tab. The OCH cross-connects are listed.

END OF STEPS

15.52 To bind and collapse HO-ODUk timeslots

15.52.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card→Port→ODU.

2

Perform one of the following:

a. To open the ODU NIM (Edit) form, right-click on the OTUODUk object and choose
Properties.

b. To open the ODU Path Termination (Edit) form, right-click on the ODUk object and
choose Properties.

3

Click on the ODU Structure tab.

4

Choose two ODU0s, eight ODU0s, or four ODU1s, and click Bind Timeslots. The
LO-ODUk Configuration form opens.

Note: Bind timeslots as follows:
• Two ODU0s to form one ODU1.

• Four ODU1s or eight ODU0s to form one ODU2.

5

Configure the required parameters and click OK.

6

Scroll to the bottom of the list to view the newly created timeslot.
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7

Choose a bound timeslot and click Collapse Timeslots to retrieve the initial timeslots.

END OF STEPS
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Procedures to configure dual-stage muxing services

15.53 To configure dual-stage multiplexing services on an 1830
PSS for keyed and unkeyed services

15.53.1 Related information

Dual-stage multiplexing service support is provided on the 1830 PSS 16/32 shelves for
the following cards:

• 11DPM12 OTU1 client port (OT A) connected to a 4DPA4 line port (OT B). Up to four
4DPA4 OTs can be connected to one 11DPM12.

• 11QPEN4 client port (OT A) connected to an 11DPE12A line port (OT B). Up to four
11DPE12A OTs can be connected to one 11QPEN4.

• 11QPEN4 client port (OT A) connected to an 11OPE8 line port (OT B). Up to four
11OPE8 OTs can be connected to one 11QPEN4.

• 11QPEN4 client port (OT A) connected to an 11QPE24 line port (OT B). Up to four
11QPE24 OTs can be connected to one 11QPEN4.

• 11STMM10 OTU1 client port (OT A) connected to a 4DPA4 line port (OT B). Up to four
4DPA4 OTs can be connected to one 11STMM10.

• 43SCX4 and 43SCX4E OTU2 client port (OT A) connected to an 11DPM12 line port
(OT B). Up to four 11DPM12 OTs can be connected to one 43SCX4 or 43SCX4E.

• 43SCX4E client port (OT A) connected to an 11DPE12A line port (OT B). Up to four
11DPE12A OTs can be connected to one 43SCX4E.

• 43SCX4E client port (OT A) connected to an 11OPE8 line port (OT B). Up to four
11OPE8 OTs can be connected to one 43SCX4E.

• 43SCX4E client port (OT A) connected to an 11QPE24 line port (OT B). Up to four
11QPE24 OTs can be connected to one 43SCX4E.

• 43STX4P OTU2 client port (OT A) connected to an 11DPM12 line port (OT B). Up to
four 11DPM12 OTs can be connected to one 43STX4P.

• 112SCX10 OTU2 client port (OT A) connected to an 11DPM12 line port (OT B). Up to
ten 11DPM12 OTs can be connected to one 112SCX10.

• 112SCX10 OTU2 client port (OT A) connected to an 11DPE12A line port (OT B) with
symmetric port rates on either side. Up to ten 11DPE12A OTs can be connected to
one 112SCX10.

• 112SCX10 OTU2 client port (OT A) connected to an 11QPEN4 line port (OT B). Up to
ten 11QPEN4 OTs can be connected to one 112SCX10.

• 112SDX11 OTU2 client port (OT A) connected to an 11DPM12 line port (OT B). Up to
ten 11DPM12 OTs can be connected to one 112SDX11.

• 112SNX10 OTU2 client port (OT A) connected to an 11DPM12 line port (OT B). Up to
ten 11DPM12 OTs can be connected to one 112SNX10.

• 112SNX10 OTU2 client port (OT A) connected to an 11QPEN4 line port (OT B). Up to
ten 11QPEN4 OTs can be connected to one 112SNX10.
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• 112SNX10 client port (OT A) connected to an 11DPE12A line port (OT B) with
symmetric port rates on either side. Up to ten 11DPE12A OTs can be connected to
one 112SNX10.

• 112SNX10 client port (OT A) connected to an 11OPE8 line port (OT B). Up to ten
11OPE8 OTs can be connected to one 112SNX10.

• 112SNX10 client port (OT A) connected to an 11QPE24 line port (OT B). Up to ten
11QPE24 OTs can be connected to one 112SNX10.

• 130SCX10 OTU2 client port (OT A) connected to an 11QPEN4 line port (OT B). Up to
ten 11QPEN4 OTs can be connected to one 130SCX10.

• 130SCX10 OTU2 client port (OT A) connected to an 11DPM12 line port (OT B). Up to
ten 11DPM12 OTs can be connected to one 130SCX10.

• 130SCX10 client port (OT A) connected to an 11DPE12A line port (OT B) with
symmetric port rates on either side. Up to ten 11DPE12A OTs can be connected to
one 130SCX10.

• 130SCX10 client port (OT A) connected to an 11OPE8 line port (OT B). Up to ten
11OPE8 OTs can be connected to one 130SCX10.

• 130SCX10 client port (OT A) connected to an 11QPE24 line port (OT B). Up to ten
11QPE24 OTs can be connected to one 130SCX10.

• 130SNX10 client port (OT A) connected to an 11DPE12A line port (OT B) with
symmetric port rates on either side. Up to ten 11DPE12A OTs can be connected to
one 130SNX10.

• 260SCX2–OTU4 client port (OT A) connected to an 112SDX11 line port (OT B). One
112SDX11 OT can be connected to one 260SCX2–OTU4.

• 260SCX2–OTU4 client port (OT A) connected to an 130SCA1 line port (OT B). One
130SCA1 OT can be connected to one 260SCX2–OTU4.

• 260SCX2–OTU4 client port (OT A) connected to an 1AN100G line port (OT B). One
1AN100G OT can be connected to one 260SCX2–OTU4.

15.53.2 Before you begin

Before configuring dual-stage multiplexing services ensure that:

• An internal topological link is provisioned between the OT A client port and the OT B
line port.

• The cross-connect terminates on the OT A line port. The OT B is not included in the
cross-connect.

• Because there is no wave key encoding on OT B, the eVOA port is not used.

• There is no alarm correlation between OT A and OT B.

Note: Dual Trans mode and Flex Mux mode are supported on the 4DPA4 card.

Keyed and unkeyed services are supported in the Wave key Assign mode.

NFM-P To configure dual-stage multiplexing services on an 1830 PSS for keyed and unkeyed services

Release 17.3
April 2017
Issue 2 3533HE-12002-AAAA-TQZZA



15.53.3 Steps

1

Perform one of the following:

• See 15.22 “To configure an optical transport service” (p. 311) to create an optical
service.

• See 14.3 “To configure a VPLS” (p. 261) to create a VPLS service.

• See 24.4 “To configure an Ethernet ring” (p. 567) to create an Ethernet ring.

END OF STEPS

15.54 To configure CWDM and DWDM single fiber bidirectional
service

15.54.1 Before you begin

You can configure single fiber, bidirectional service on NFM-P by creating two
unidirectional trails between the same client ports using SFDs or SFCs. Each
bidirectional transmission requires different CWDM or DWDM wavelengths in each
direction. This is accomplished with two fiber connections in the transmit and receive
directions from the OT to two adjacent wavelengths connections on the MUX (in) side of
the filter.

Figure 24 Dual-stage multiplexing

CWR or SFD
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Line
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Client

Client

22756
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The CWDM single fiber, bidirectional unkeyed service support on the 1830 PSS-4/16/32
is provided for the following fiber and OT cards:

• SFC-2
• SFC-4
• SFC-8
• 4DPA4

• 11STAR1
• 11STAR1A
• 11STMM10
• 11DPE12(E)

The DWDM single fiber, bidirectional, keyed and unkeyed service support on the 1830
PSS-4/16 is provided for the following fiber and OT cards:

• SFD-4
• SFD-8
• SFD-44 (1830 PSS-16)
• 11QPA4
• 11DPM12

• 112SDX11 (1830 PSS-16)
• 130SCA1 (1830 PSS-16)
• 4DPA4
• AHPHG (keyed service)

Prerequisites
• The SFC must be connected in a OneFiber MuX mode. The default is TwoFiberMux.

You must set the mode before you create an optical link. The mode can be configured
on the Card Specifics tab of the Card (Edit) form. See 9.25 “To configure a card on a
WDM shelf” (p. 138) for more information.

• You can only create unidirectional internal optical links between the OT and filter
channels.

• External optical links are always bidirectional. After the service is created, you can
view the channel, frequency used, and direction in the topology view.

15.54.2 Steps

1

Perform 15.22 “To configure an optical transport service” (p. 311) to configure an
optical service.

For more information about single fiber, bidirectional services, see the Nokia 1830
Photonic Service Switch Product Information and Planning Guide.

END OF STEPS
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Procedures to configure APS groups

15.55 To configure an APS group

15.55.1 Steps

1

On the equipment tree, expand Network→1830 PSS.

2

Right-click on the 1830 PSS object and choose Properties. The Network Element
(Edit) form opens.

3

Click on the APS Groups tab, then click Create. The APS Group (Create) form
opens.

4

Configure the required parameters in the Protection Attributes panel:

5

Select a port in the Port panel, if applicable.

6

Select a working LO-ODUk facility in the Working LO-ODUk facility panel, if
applicable.

7

Select a protection LO-ODUk facility in the Protection LO-ODUk facility panel, if
applicable.

8

Select a working port in the Working Port panel, if applicable.

9

Select a protection port in the Protection Port panel, if applicable.

10

Configure the required parameters as applicable:
• Channel

• Working VTS
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• Protection VTS

11

Click OK. The APS Group (Create) form closes.

END OF STEPS

15.56 To modify the protection switch for an APS group

15.56.1 When to use

You can modify the protection switch from the Network Element (Edit) form or from the
Optical Transport Service (Edit) form.

15.56.2 Steps

1

Perform one of the following to open the APS Group (Edit) form.

a. From the Network Element (Edit) form:

1. Choose Equipment from the navigation tree view selector. The navigation tree
displays the Equipment view.

2. Choose Network→1830 PSS.

3. Right-click on the 1830 PSS device object and choose Properties. The
Network Element (Edit) form opens.

4. Click on the APS Groups tab. A list of APS groups appears.

5. Choose an entry and click Properties. The APS Group (Edit) form opens.

b. From the Optical Transport Service (Edit) form.

1. Choose Manage→Service→Services from NFM-P main menu.

2. Choose Optical Transport Service from the drop-down menu.

3. Click Search and choose the protected optical transport service for which the
protection switch needs to be modified.

4. The Optical Transport Service (Edit) form opens.

5. Click on the APS Groups tab. A list of APS groups appears.

6. Choose an entry and click Properties. The APS Group (Edit) form opens.

2

Choose the protection switch type based on the working or protection path in the
Protection Switch drop-down menu of the Protection Management panel. The
options for Protection Switch parameter are:
• Protection Lockout
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• Forced Switch to Protection

• Forced Switch to Working

• Manual Switch to Protection

• Manual Switch to Working

• No Cmd

Note: The Protection Switch drop-down menu is active only when the card on
which the protection port is present is equipped on the 1830 PSS device.

3

Click OK. The APS Group (Edit) form closes.

END OF STEPS
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Procedures to configure services using LAGs

15.57 To configure 11DPE12A service using LAGs

15.57.1 Steps

1

Create LAGs on SR. See Procedure “To create a LAG” in the NSP NFM-P User
Guide for information about creating LAGs on an SR.

2

Create LAGs on an 11DPE12A card. See 9.40 “To create a LAG on an 11DPE12A
card” (p. 157).

3

Create optical links between the SR and 11DPE12A LAG ports. See 9.44 “To
configure an optical link between ports” (p. 163).

4

Choose Create→Service→Optical→Create Transport Service from NFM-P main
menu. The Optical Transport Service (Create) form opens.

5

Click Select in the Customer panel to choose a customer to associate with the
optical transport service. The Select Customer - Optical Transport Service form
opens.

6

Choose a customer for the optical transport service and click OK. The Select
Customer - Optical Transport Service form closes and the Optical Transport Service
(Create) form reappears with the customer information displayed on the General tab.

7

Configure the required parameters:
• Service Name

• Description

• Service ID

8

Set the Rate parameter to SubGigE.
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9

Configure the required parameters in the VLAN Configuration Details panel:
• Is SubGigE Service QinQ

• CE-VLANID-AZ

• CE-VLANID-ZA

• Stack-VLANID-AZ

• Stack-VLANID-ZA

10

Click on the Service Sites tab and click Create. The Select Network Elements -
Optical Transport Service form opens with a list of sites.

11

Choose the SR sites and click OK. The A and Z sites are displayed in the navigation
tree.

12

Choose A End in the Service Sites tab and click Properties. The Optical Site (Create)
form opens.

13

Click on the Termination Point tab and click Create on the right panel. The
Termination Point (Create) form opens

14

Click Select. The Select Termination Point form opens.

15

Choose the one of the LAG ports and click OK. The Select Termination Point form
closes and the Termination Point (Create) form reappears.

16

Configure the required parameters in the Optical Access Port Virtual Time Slot panel:
• Ingress VTS Number

• Egress VTS Number

17

Configure the required parameters in the Optical Working Network Port Virtual Time
Slot panel:
• Line Port
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Click Select. The Select Line Port - Termination Point form opens with a list of line
ports. Choose the line port.

• Ingress VTS Number

• Egress VTS Number

18

Click Apply. The Termination Point (Create) form closes and the Optical Transport
Service (Create) form reappears.

19

Perform Step 12 to Step 18 to add the termination point for Site B.

20

Click OK to complete the service configuration.

END OF STEPS
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Procedures to configure timeslots

15.58 To configure a port-timeslot assignment on channelized
cards

15.58.1 Steps

1

Right-click on a channelized port and choose Properties. The Physical Port (Edit)
form opens.

2

Click on the Port Specifics tab.

3

Configure the Assigned Rate parameter.

4

Click Configure Timeslots. The Timeslot Assignments form opens.

5

Choose the required timeslot configuration and click OK. The Timeslot Assignments
form closes.

6

Click OK. The Physical Port (Edit) form closes.

END OF STEPS
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Procedures to configure VTS maps and XCs

15.59 To configure VTS maps on 11DPE12/E/A cards

15.59.1 Steps

1

Choose Equipment from the navigation tree view selector. The navigation tree
displays the Equipment view.

2

Choose Network→NE→Shelf→Card→Port.

3

Right-click on the port and choose Properties. The Physical Port (Edit) form opens.

4

Click on the Port Specifics tab and click on the VTS Map tab.

Note: You can see the VTS Map tab on the Physical Port (Edit) form of a port
on the 11DPE12 card, only when the Card Rate Mode parameter is set as
QinQ in the Card Slot (Edit) form of the 11DPE12 card.

5

Click Create. The Port Specifics (Create) form opens.

6

Configure the required parameters:
• VTS Map Number

• VTS Direction

• Classification Mode

Note:

If the Classification Mode is configured to Port in case of a client port VTS map
configuration, go to Step 8 .

7

Configure the VTS map information based on the values configured for the VTS
Direction and Classification Mode parameters:

a. VTS Egress CE-VLANID—If the VTS Direction is configured to Egress and
Classification Mode is configured to CE-VLAN Tagged or Untagged
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b. VTS Egress S-VLAN ID—If the VTS Direction is configured to Egress and
Classification Mode is configured to S-VLAN Tagged

c. VTS Ingress CE-VLAN ID—If the VTS Direction is configured to Ingress and
Classification Mode is configured to CE-VLAN Tagged or Untagged

d. VTS Ingress S-VLAN ID—If the VTS Direction is configured to Ingress and
Classification Mode is configured to S-VLAN Tagged

e. CE-VLAN ID—If the VTS Direction is configured to Ingress and Egress and
Classification Mode is configured to CE-VLAN Tagged or Untagged

f. Stack-VLAN ID—If the VTS Direction is configured to Ingress and Egress and
Classification Mode is configured to S-VLAN Tagged

8

Click OK. The Port Specifics (Create) form closes and the VTS map is added to the
list of maps under the VTS Map tab.

9

Click OK. The Physical Port (Edit) form closes.

END OF STEPS

15.60 To configure VTS XCs on 11DPE12/E/A cards

15.60.1 Before you begin

Perform 15.59 “To configure VTS maps on 11DPE12/E/A cards” (p. 363) before
configuring a VTS cross-connect.

15.60.2 Steps

1

Choose Equipment from the navigation tree view selector. The navigation tree
displays the Equipment view.

2

Choose Network→NE.

3

Right-click on the NE and choose Properties. The Network Element (Edit) form
opens.
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4

Click on the VTS Connections tab.

5

Click Create. The VTS Connection (Create) form opens.

6

Configure the VTS Connection Name parameter.

7

Click Select in the VTS Connection Source panel. The Select VTS Connection
Source Port form opens.

8

Choose a port from the list and click OK. The Select VTS Connection Source Port
form closes.

9

Configure the Source VTS Number parameter in the VTS Connection Source panel.

10

Click Select in the VTS Connection Destination panel. The Select VTS Connection
Destination Port form opens.

11

Choose a port from the list and click OK. The Select VTS Connection Destination
Port form closes.

12

Configure the Destination VTS Number parameter in the VTS Connection
Destination panel.

13

Configure the required parameters on the VTS Connection Details panel:
• Committed Information Rate(Mb/s)

• Peak Information Rate(Mb/s)

• Committed Burst Size(kb/s)

• Peak Burst Size(kb/s)
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14

Click OK. The VTS Connection (Create) form closes.

END OF STEPS
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16 1830 PSS mirror service management

16.1 Overview

16.1.1 Purpose

This chapter describes the mirror service management briefly and provides references
for more information about mirror services.

16.1.2 Contents

16.1 Overview 367

16.2 Mirror service management 367

16.2 Mirror service management

16.2.1 Overview

In a mirror service, packets from one or more sources are forwarded to their configured
destinations. A copy of the entire packet, or a specified portion of the packet, is sent to
the mirror destination. The mirrored packet can be viewed using a packet-decoding
device, typically called a sniffer, that is attached to the destination port. NFM-P does not
limit the number of destination and source sites that can be added under a mirror
service. The mirrored packets are transported unidirectionally through the core network
using IP or MPLS tunneling. For more information about mirror services, see NSP
NFM-P User Guide.

Table 38 Mirror service management references

Topics Chapter Document

Mirror service overview Mirror service management NSP NFM-P User Guide

Sample mirror service configuration Mirror service management NSP NFM-P User Guide

Mirror service procedures Mirror service management NSP NFM-P User Guide
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Part VII: 1830 PSS performance management

Overview

Purpose

This part provides information about performance management of 1830 PSS using
NFM-P.

Contents

Chapter 17, 1830 PSS performance management 371

NFM-P

Release 17.3
April 2017
Issue 2 3693HE-12002-AAAA-TQZZA



NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

370 Issue 2



17 1830 PSS performance management

17.1 Overview

17.1.1 Purpose

This chapter provides information about performance management of 1830 PSS using
NFM-P.
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Performance monitoring

17.2 Overview

17.2.1 General information

PM is the in-service, non-intrusive monitoring of transmission quality and equipment
health. The 1830 PSS tracks the signal quality and equipment health through the
continuous collection and analysis of performance data. The user can retrieve current
and past values for an overview of the health of the system. The PM function applies to
optical lines, channels, ports, and equipment. The user can provision threshold
parameters to the required level of performance degradation.

Proactive maintenance refers to following up on a performance degradation before a
failure and alarms are generated. Reactive maintenance refers to following up on a
system alarm. Crossing a performance parameter threshold indicates a potential network
quality or performance degradation when the transported services are not impacted. If
performance degradation continues, alarms are generated to resolve or repair the
problem.

NFM-P supports viewing raw PM data from NFM-P Equipment View application. See
10.3 “To start the equipment view application on a specific web browser” (p. 187) for
more information about launching the application. Right-click on the port icon and
choose View Raw PM data. The data can be refreshed every 60, 90, 120, 150, or 180
seconds. You can export the data to CSV format by clicking on the Export Data to CSV
icon.

17.2.2 PM process

The 1830 PSS provides the following PM processing functions:

• monitor and accumulate digital and analog parameters for a physical or logical access
point

• store and manage historical accumulated data; up to thirty two 15 minute and seven
24 hour accumulation registers can be stored

• validate threshold crossing processing

• assign threshold values to profile port entities

• use free-running counters for monitored points

PM functions are performed on physical and logical points within the 1830 PSS devices
that represent the boundary with other devices or an external system. A user can define
and monitor QoS at individual points in which a local NE interacts with other network
entities.
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17.2.3 PM profile types supported for line ports on amplifier cards

Inter-device management and control information is communicated over the amplifier
cards. The amplifier card line ports support their statistics profiles. The amplifier is a
separate optical channel that operates at the STM-1/OC-3 rate of 155 Mb/s. The
amplifier card transfers management and control information between the ECs of two
adjacent NEs, regardless of whether any of the DWDM payload channels are terminated
between the two NEs. The channel transports IP and OSI PDUs. See the Nokia 1830
Photonic Service Switch Product Information and Planning Guide for more information.

17.3 Performance statistics

17.3.1 Overview

NFM-P can be configured to collect statistics counters from 1830 PSS devices and
NFM-P servers.

NFM-P supports the following for 1830 PSS devices:

• assign the default 1830 PSS Performance Management Policy to the 1830 PSS
device.

• enable the policy by setting the Administrative State to Up.

• configure the protocol for the statistics collection.

• specify a retention period in the Statistics Policy which indicates the period after which
the statistics records are removed from the database.

• collect scheduled (file-based) statistics using TFTP or SFTP to view historical statistics
by selecting the required PM group and clicking Search.

• collect on-demand (MIB-based) statistics using SNMP polling to view historical and
real-time statistics by clicking Collect or Collect All.

17.3.2 Bins and intervals

The performance parameters groups obtained during the parameter processing are
collected in registers over 15 minutes and 24 hours measurement periods. A bin is the
collection of registers associated with a PM group and collection period. The bins can be
cleared by configuring the number of bins to be cleared for each interval. See 17.10 “To
clear the 1830 PSS bins on an EC card” (p. 385) for information about clearing the 1830
PSS bins.

Bins and intervals in a 1830 PSS device

The 15 minute bins collect data at quarterly time intervals (that is, 00, 15, 30, or 45) of
the 1830 PSS clock. The 24 hour bins collect data from midnight to midnight based on
the UTC (not the local time). At the end of each 15 minute time interval, the contents of
the 15 minute bin are transferred to the previous 15 minute bin. The 15 minute bins are
then initialized to zero and a new record is initiated.
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Each PM group consists of thirty two 15 minute bins and seven 24 hour bins. When the
storage capacity of thirty two 15 minute bins is reached, the oldest bin is dropped. The
24-h bins are managed in the same way. 1830 PSS also supports raw bins for the
parameters that can be monitored through raw bins for the supported PM profiles. The
raw bins are 32-bit or 64-bit registers that count the monitored events until it rolls over, or
are reset or cleared by the user.

17.3.3 File-based statistics collection

The file-based statistics are scheduled statistics that are collected from the files on the
1830 PSS devices using TFTP or SFTP. The statistics are available for scheduled
collection and enable viewing of the historical statistics.

The file-based statistics (scheduled statistics) are stored in NFM-P database for a
configurable retention period. See 17.8 “To configure retention time for file-based
statistics” (p. 382) for more information about configuring the retention period. When the
retention period elapses, the statistics are removed from the database.

The file-based statistics collection is applicable for both WDM and OCS devices.

17.3.4 MIB-based statistics collection

The MIB-based statistics are on-demand statistics that are collected from the 1830 PSS
MIBs using SNMP polling. The statistics are available for on-demand collection and
enable viewing of the real-time and historical statistics.

The real-time statistics are collected for real-time display are available only for the
duration of the session and for the operator who initiates the session.

The MIB-based statistics collection is applicable only for WDM devices.

17.3.5 1830 PSS statistics storage on NFM-P server

NFM-P allows you to back up statistics data to another location. See “ NFM-P database
management procedures” in the NSP NFM-P System Administrator Guide for information
about how to back up NFM-P database.

The 1830 PSS statistics are stored in the following directory on NFM-P server:

/opt/nsp/nfmp/server/nms/tftp_home/stats
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The files are retained for 24 h, by default.

You can configure the main server and the auxiliary server path for statistics collection by
configuring the following parameters under the tftp tag of the nms-server.xml file:

• nodeBackupDirectory

Note:

Main server—The path is configured on the main server, and the parameter is
applicable for WDM and OCS devices. The default path is /opt/nsp/nfmp/server/nms/
tftp_home.

Auxiliary server—The path is configured on the auxiliary server and the parameter is
applicable only for WDM. The default path is /opt/nsp/nfmp/auxserver/nms/tftp_home.

• nodeBackupDirectoryAux

Note:

The parameter is applicable only for OCS device and to configure the auxiliary server
path on the main server. The default path is /opt/nsp/nfmp/auxserver/nms/tftp_home.

17.4 Workflow for performance statistics collection

17.4.1 Workflow

See Figure 25, “Performance management workflow - File-based” (p. 375) , Figure 26,
“Performance management workflow - MIB-based” (p. 378), and 17.4.2 “Stages”
(p. 378) for high-level steps to configure 1830 PSS performance statistics collection.
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Figure 25 Performance management workflow - File-based
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17.4.2 Stages

1

Configure 1830 PSS Performance Management Policy to assign 1830 PSS devices
to the policy and enable the policy by setting the Administrative State to Up. See
17.5 “To configure an 1830 PSS WDM performance management policy” (p. 380).

2

Specify the retention time for a statistics record. See 17.8 “To configure retention
time for file-based statistics” (p. 382).

3

Collect and view the statistics values in a current statistics record. See 17.9 “To

Figure 26 Performance management workflow - MIB-based
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collect and display the statistics values” (p. 384).

4

Configure real-time and historical statistics graph. See “ Graphing statistics” in the
NSP NFM-P Statistics Management Guide for information about creating a real-time
and historical statistics graph.

5

Use the XML API interface to retrieve the performance statistics records from NFM-P
for processing by a third-party application. See the NSP NFM-P XML API Developer
Guide for information about using the XML API to transfer statistics records from
NFM-P database to an OSS client application.
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1830 PSS statistics procedures

17.5 To configure an 1830 PSS WDM performance management
policy

17.5.1 Steps

1

Choose Tools→Statistics→Optical Performance Management Policies from NFM-P
main menu. The Optical Performance Management Policies form opens.

2

Click Search, choose the Default TFTP policy, and click Properties. The 1830 PSS
Performance Management Policy - 1 (Edit) form opens.

3

Configure the required parameters.

4

Perform one of the following to configure the Protocol parameter:

a. Choose SFTP from the drop-down menu and configure the parameters in the FTP
Settings panel.

b. Choose TFTP from the drop-down menu.

5

Click on the 1830 PSS Elements tab and click Assign 1830 PSSs. The Assign
“Default TFTP” Filter and Assign “Default TFTP” forms open.

6

Configure the filter criteria in the Assign “Default TFTP” Filter form and use the right
and left arrows to move the 1830 PSS devices between the Unassigned PSS list
and the Assigned PSS list, as required in the Assign “Default TFTP” form.

7

Click Apply to deploy the 1830 PSS performance management policy to the
assigned PSS.

Note: Alternatively, when an 1830 PSS device is discovered, NFM-P assigns
the default 1830 PSS performance management policy to it automatically.
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8

Save your changes and close the forms.

END OF STEPS

17.6 To configure an 1830 PSS OCS performance management
policy

17.6.1 Steps

1

Choose Tools→Statistics→Optical Performance Management Policies from NFM-P
main menu. The Optical Performance Management Policies form opens.

2

Click Search, choose the Default SFTP policy, and click Properties. The 1830 PSS
Performance Management Policy - 2 (Edit) form opens.

3

Configure the required parameters in the 1830 PSS Performance Management
Policy tab.

4

Click on the 1830 PSS Elements tab and click Assign 1830 PSSs. The Assign
“Default SFTP” Filter and Assign “Default SFTP” forms open.

5

Configure the filter criteria in the Assign “Default SFTP” Filter form and use the right
and left arrows to move the 1830 PSS devices between the Unassigned PSS list
and the Assigned PSS list, as required in the Assign “Default SFTP” form.

6

Click Apply to deploy the 1830 PSS performance management policy to the
assigned PSS.

Note: Alternatively, when an 1830 PSS device is discovered, NFM-P assigns
the default 1830 PSS performance management policy to it automatically.

7

Save your changes and close the forms.

END OF STEPS
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17.7 To enable PMON configuration on an 1830 PSS OCS
device

17.7.1 Steps

1

Choose Manage→Equipment→Equipment from NFM-P main menu. The Manage
Equipment form opens.

2

Choose PMON Configuration (Optics Specifics) from the object drop-down menu
and click Search.

3

Choose one or more configurations from the list and click Properties. The PMON
Configuration (Edit) form opens.

4

Select the Enable check box. The selected PMON configurations are enabled.

5

Configure the required parameters.

6

Click Clear PM Counters to clear the counters of the selected PMON counters, if
required.

7

Select the Delete PM Bin History check box, if required.

8

Save your changes and close the forms.

END OF STEPS

17.8 To configure retention time for file-based statistics

17.8.1 Steps

1

On the navigation tree, expand Network→1830 PSS→Shelf→Card Slot→Port.
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Note: Choose the PM-supported ports.

2

Right-click on the Port and choose Properties. The Physical Port (Edit) form opens.

3

Click on the Statistics tab and choose an object type from the Select Object Type
drop-down menu.

4

Click Statistics Policies and choose the Statistics Policy from the drop-down menu.
The Statistics Policy form opens.

5

Configure the required parameters.

Note: The default value of the Retention Time (hours) parameter is 24 from
Release 14.0 R5 onwards. When you upgrade from an earlier release to 14.0
R5, the value of the Retention Time (hours) parameter will be retained as is if it
is less than or equal to the global value, that is, the accounting statistics data
retention value. If the value configured in the previous release is greater than
the global value, then value is changed to match the global retention time. For
example, if the global value is 48 and the individual value is 24, then 24 is
retained even after upgrade. If the global value if 48 and the individual value is
168, then after upgrade the new value will be 48.

6

Click Purge Statistics Records to purge all statistics records.

Note: When you upgrade from an earlier release to NFM-P Release 13.0 R7
and later, the old PM records may or may not be purged. Perform Step 6 to
purge the records. The new PM records collected after the upgrade are purged
as per the retention policy configured in Step 5.

7

Save your changes and close the forms.

END OF STEPS
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17.9 To collect and display the statistics values

17.9.1 Purpose

Perform this procedure to collect and display the statistics values in a current statistics
record.

17.9.2 Steps

1

Open the properties form of the object for which you want to view statistics. The
General tab is displayed.

2

Click on the Statistics tab and perform one of the following.

a. View file-based (scheduled) statistics.

1. Choose a statistics class that is not identified as on-demand from the object
drop-down menu.

2. Specify a filter to create a filtered list of statistics records, if required, and click
Search.

b. View MIB-based (on-demand) statistics.

1. Choose a statistics class identified as on-demand from the object drop-down
menu.

2. Specify a filter to create a filtered list of statistics records, if required, and click
Collect.

Note: The Collect button is not displayed when you choose a statistics class
that does not support on-demand statistics collection.

c. View statistics for all classes.

1. Choose a statistics class identified as on-demand from the object drop-down
menu.

Note: The Collect and Collect All buttons are not displayed when you choose a
statistics class that is not identified as on-demand.

2. Specify a filter to create a filtered list of statistics records, if required.

3. Click Collect All to collect statistics for all classes.

3

Choose a statistics record and perform one of the following.

a. Scroll horizontally to view the statistics counter values for the statistics record.
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b. Open the statistics record to view it.

1. Select the statistics record and click on the Properties button. The Statistics
Record form opens.

2. View the statistics record.

3. Click on the Close button to close the Statistics Record form.

4

Close the object properties form.

END OF STEPS

17.10 To clear the 1830 PSS bins on an EC card

17.10.1 Steps

1

On the navigation tree, expand Network→1830 PSS→Shelf→EC Card.

2

Right-click on the EC card and choose Properties. The Card Slot (Edit) form opens.

3

Click on the Card Specifics tab, then on the Performance tab.

4

Choose either 15-min or 24-h bin, and click Properties. The TCA Profile Assignment
form opens.

5

Configure the Number of Bins parameter.

6

Click Clear PM Counters and perform one of the following actions:

a. Choose Bins to clear the 15-h or 24-h bin

b. Choose Raw Bins to clear the raw bin counters

7

Save your changes and close the form.
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8

Click on the Statistics tab in the Card Slot (Edit) form, choose the profile type for
which the bins are cleared, and click Collect. The new counts are displayed.

9

Close the form.

END OF STEPS

17.11 To clear the 1830 PSS bins on a port

17.11.1 Steps

1

On the navigation tree, expand Network→1830 PSS→Shelf→Card→Port.

2

Right-click on the port and choose Properties. The Physical Port (Edit) form opens.

3

Click on the Port Specifics tab, then on the Performance tab.

Note: For 11QPE24 ports, click on the Port TCA Profile Assignment tab under
the Performance tab.

4

Choose either a 15-min or 24-h bin and click Properties. The TCA Profile Assignment
form opens.

5

Configure the Number of Bins parameter, if required.

6

Click Clear Count and perform one of the following actions:

a. Choose Bins to clear the 15-min or 24-h bin

b. Choose Raw Bins to clear the raw counts

7

Save your changes and close the form.
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8

Click on the Statistics tab under the Physical Port (Edit) form, choose the profile type
for which the bins are cleared, and click Collect. The new counts are displayed.

9

Close the form.

END OF STEPS
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Managing TCA profiles

17.12 Overview

17.12.1 General information

NFM-P supports all of the TCAs that are provided by the NE. The support includes
configuring thresholds, distributing TCA profiles, and reporting, for example, generating
and clearing appropriate alarms. See the Nokia 1830 Photonic Service Switch User
Provisioning Guide for more information about TCA support on the 1830 PSS.

17.12.2 PM thresholds

PM statistics are collected for all service cards and interface ports that perform OEO
conversions or protection switching. The statistics are grouped by functional category.
Each category has several monitored parameters for which you can configure TCAs. A
threshold is the mechanism for generating a notification in response to changes in PM
parameter values. The 1830 PSS allows you to provision performance parameter
thresholds, which can be set by the user to indicate degraded performance. You can
configure how much data is collected and stored, and how and when you are notified if
thresholds levels are crossed. For information about performance management
requirements see the Nokia 1830 Photonic Service Switch User Provisioning Guide and
the Nokia 1830 Photonic Service Switch Product Information and Planning Guide.

17.12.3 TCA profiles

You can configure and assign a profile to an interval to monitor the value of each
parameter in the active bin and generate a log event if a threshold level is reached. If a
specified threshold is crossed, an alarm is generated.

You can configure each PM group with up to eight profiles. Each profile can have
different threshold levels. NFM-P allows you to modify the TCA profiles.

The threshold levels that you configure depend on the following factors:

• interval length—for example, to gather statistics for an interface over 15-min and 24-h
intervals you must define two profiles: one for each interval

• service level of the traffic using the interface

17.13 Workflow to manage TCA profiles

17.13.1 Workflow

The workflow to manage TCA profiles is described in this topic.
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17.13.2 Stages

1

Configure a global or local 1830 PSS TCA profile.

a. Configure a global 1830 PSS card TCA profile, release, and distribute the policy
to an 1830 PSS WDM device, or create a local 1830 PSS card TCA profile at an
L2 card level on an 1830 PSS WDM device, as required. See 17.14 “To configure
an card TCA profile” (p. 390) .

b. Configure a global 1830 PSS OCS TCA profile, release, and distribute the policy
to an 1830 PSS OCS device. See 17.19 “To configure an OCS TCA profile”
(p. 394) .

2

Assign a TCA profile to supporting objects.

a. Assign an Ethernet TCA profile to an L2 card port or a SAP. See 17.15 “To assign
an Ethernet TCA profile to an Ethernet card port” (p. 391) .

b. Assign a TCA profile to an EC card slot or other card ports. See 17.17 “To assign
TCA profiles to an EC card and other card ports” (p. 392) .

c. Assign an OCS TCA profile to the supporting objects of an 1830 PSS OCS
device, as required. See 17.20 “To assign an OCS TCA profile” (p. 395) .

3

Configure the threshold values of a TCA profile, as required.

a. Configure the NE and card TCA profile threshold values, as required. See
17.18 “To configure thresholds for NE and Card TCA profiles” (p. 393) .

b. Configure the OCS TCA profile threshold values, as required. See 17.21 “To
configure thresholds for an OCS TCA profile” (p. 397) .
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Procedures to configure TCA profile

17.14 To configure an card TCA profile

17.14.1 Steps

1

Perform one of the following:

a. Open the 1830 PSS Card TCA Profile, Global Policy (Create) form from NFM-P
main menu.

1. Choose Tools→1830 PSS TCA Profiles from NFM-P main menu. The 1830
PSS TCA Profiles form opens.

2. Choose Card TCA Profiles (NE Threshold Crossing Alerts) from the object
drop-down menu.

3. Click Create and choose Card TCA Profile. The 1830 PSS Card TCA Profile,
Global Policy (Create) form opens.

b. Open the 1830 PSS Card TCA Profile, Local Policy (Create) form from the card
properties form.

1. On the navigation tree, expand Network→NE→Shelf→Card.

2. Right-click on the card and choose Properties. The Card Slot (Edit) form
opens.

3. Click on the Card Specifics tab, then on the Performance tab.

4. Click Create. The 1830 PSS Card TCA Profile, Local Policy (Create) form
opens.

2

Configure the required parameters.

3

Save your changes and close the form.

4

To distribute a global policy:

1. Choose the global policy from the list of policies in the 1830 PSS TCA Profiles
form and click Properties. The 1830 PSS Card TCA Profile, Global Policy (Edit)
form opens.

2. Click Switch Mode. A dialog box appears.

3. Click Yes. The value of the Configuration Mode parameter changes to Released
and the Release - Card TCA Profile form opens.
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4. Choose the nodes from the Available Nodes list and click on the right-arrow
button. The selected nodes move to the Selected Nodes list.

5. Click Distribute.

6. Close the Release - Card TCA Profile form and the 1830 PSS Card TCA Profile,
Global Policy (Edit) form.

5

Close the 1830 PSS TCA Profiles form.

Note: See 17.18 “To configure thresholds for NE and Card TCA profiles”
(p. 393) to configure TCA threshold values.

END OF STEPS

17.15 To assign an Ethernet TCA profile to an Ethernet card port

17.15.1 Steps

1

On the navigation tree, expand Network→NE→Shelf→Card→Port.

2

Right-click on the port and choose Properties. The Physical Port (Edit) form opens.

3

Click on the Port Specifics tab, then on the Performance tab.

4

Select a TCA profile in the Port TCA Profile panel.

5

Save your changes and close the form.

Note: See 17.23 “To enable PM TCA alerts” (p. 398) to generate TCA alerts
after the TCA profile is assigned.

END OF STEPS
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17.16 To assign an Ethernet TCA profile to an Ethernet card SAP

17.16.1 Steps

1

Choose Manage→Service Tunnels from NFM-P main menu. The Manage Service
Tunnels form opens.

2

Choose Service Management→ VPLS in the object drop-down box and click Search.

3

Choose the required VPLS service and click Properties. The VPLS Service (Edit)
form opens.

4

Choose VPLS Service→Sites→Site→L2 Access Interfaces→L2 Access Interface
Port.

5

Select a TCA profile in the SAP TCA Profile panel.

6

Save your changes and close the forms.

Note: See 17.23 “To enable PM TCA alerts” (p. 398) to generate TCA alerts
after the TCA profile is assigned.

END OF STEPS

17.17 To assign TCA profiles to an EC card and other card ports

17.17.1 When to use

You can assign unique profiles for 15-min intervals and 24-h intervals for each EC card
and port.

17.17.2 Steps

1

On the navigation tree, perform one of the following actions:
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a. To assign the TCA profile to EC card slot:

1. On the navigation tree, expand Network→NE→Shelf→ EC Card.

2. Right-click on the card and choose Properties. The Card Slot (Edit) form
opens.

3. Click on the Card Specifics tab, then on the Performance tab. Go to Step 2 .

b. To assign the TCA profile to a port:

1. On the navigation tree, expand Network→NE→Shelf→Card→Port.

2. Right-click on the port and choose Properties. The Physical Port (Edit) form
opens.

3. Click on the Port Specifics tab, then on the Performance tab. Go to Step 2 .

2

Choose a profile and click Properties. The TCA Profile Assignment (Edit) form
opens.

3

Configure the required parameters in the General tab.

4

Select a TCA profile in the Select Profile panel.

5

Save your changes and close the forms.

END OF STEPS

17.18 To configure thresholds for NE and Card TCA profiles

17.18.1 When to use

All NE and Card TCA profiles contain a set of counters and parameters for which
threshold values can be configured. The NE TCA profiles are always on the 1830 PSS
and cannot be deleted. However, the Card TCA profiles can be deleted.

17.18.2 Steps

1

Choose Tools→1830 PSS TCA Profiles from NFM-P main menu. The 1830 PSS
TCA Profiles form opens.
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Note: See Step 4 of 17.14 “To configure an card TCA profile” (p. 390) to
release and distribute a global policy to a specific 1830 PSS. To modify a
specific 1830 PSS policy, modify only the local definitions.

2

Choose a profile type from the list and click Properties. Depending on the profile
chosen, the NE TCA Profiles (Edit) form or the 1830 PSS Card TCA Profile (Edit)
form opens.

3

Click on the TCA Thresholds tab in the NE TCA Profiles (Edit) form or the Card TCA
Thresholds tab in the 1830 PSS Card TCA Profile (Edit) form.

4

Choose a TCA variable name and click Properties. The NE TCA Thresholds (Edit)
form opens.

5

Configure the Threshold Value parameter and click OK.

Note:

• By default, profile ID 7 specifies threshold values that can be applied to the
15-minute interval, and profile ID 8 contains threshold values that can be
applied to the 24-hour interval in case of a NE TCA profile.

• NFM-P does not validate whether you have entered a valid threshold value.
Ensure that you enter a valid threshold value that is supported for the 1830
PSS devices.

6

Save your changes and close the forms.

END OF STEPS

17.19 To configure an OCS TCA profile

17.19.1 Steps

1

Choose Tools→1830 PSS TCA Profiles from NFM-P main menu. The 1830 PSS
TCA Profiles form opens.

To configure an OCS TCA profile NFM-P
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2

Click Create and choose OCS TCA Profile. The OCS NE TCA Profiles, Global Policy
(Create) form opens.

3

Configure the required parameters in the General tab.

4

Click Apply to save your changes.

5

Click Switch Mode. The Release - TCA Profile form opens.

6

Choose the devices from the Available Objects list and click on the right-arrow
button. The selected devices move to the Selected Objects list.

7

Click Distribute and close the form after the policy is distributed successfully.

8

Click on the Local Definitions tab in the OCS NE TCA Profiles, Global Policy (Edit)
form to view the devices to which the policy is distributed.

9

Close the form.

END OF STEPS

17.20 To assign an OCS TCA profile

17.20.1 When to use

By default, all objects that support an OCS TCA profile are assigned the default OCS
TCA profile. However, you can perform this procedure to assign a different OCS TCA
profile to supporting objects.

17.20.2 Steps

1

Perform one of the following on the equipment tree:
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a. Assign an OCS TCA profile to a port with an STM rate.

1. Expand Network→NE→Shelf→Card→Port on the navigation tree.

2. Right-click on the port and choose Properties. The Physical Port (Edit) form
opens.

3. Click on the Port Specifics tab.

4. Go to Step 2 .

b. Assign an OCS TCA profile to an ODUPTF facility object.

1. Expand Network→NE→Shelf→Card→Port on the navigation tree.

2. Right-click on the port and choose Properties. The Physical Port (Edit) form
opens.

3. Click on the ODUPTF tab.

4. Go to Step 2 .

c. Assign an OCS TCA profile to an ODUk object.

1. Expand Network→NE→Shelf→Card→Port→ODUk on the navigation tree.

2. Right-click on the ODUk object and choose Properties. The ODU Path
Termination (Edit) form opens.

3. Go to Step 2 .

d. Assign an OCS TCA profile to an OTUk object.

1. Expand Network→NE→Shelf→Card→Port→OTUk on the navigation tree.

2. Right-click on the OTUk object and choose Properties. The OTUk (Edit) form
opens.

3. Go to Step 2 .

e. Assign an OCS TCA profile to an OTUODUk object.

1. Expand Network→NE→Shelf→Card→Port→OTUk→OTUODUk on the
navigation tree.

2. Right-click on the OTUODUk object and choose Properties. The ODU NIM
(Edit) form opens.

3. Go to Step 2 .

2

Select a TCA profile in the TCA Profile panel and click OK.

3

Save your changes and close the form.

END OF STEPS
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17.21 To configure thresholds for an OCS TCA profile

17.21.1 Steps

1

Choose Tools→1830 PSS TCA Profiles from NFM-P main menu. The 1830 PSS
TCA Profiles form opens.

2

Choose OCS NE TCA Profiles (NE Threshold Crossing Alerts) from the object drop-
down menu. A list of OCS TCA profiles appears.

3

Choose a profile for which the threshold needs to be modified and click Properties.
The OCS NE TCA Profiles (Edit) form opens.

4

Click on the TCA Thresholds tab. A list of parameters for which the thresholds are
monitored appears.

5

Choose the required monitored parameter type and click Properties. The OCS NE
TCA Thresholds, Global Policy (Edit) form opens.

6

Configure the Threshold Value parameter.

Note: NFM-P does not validate whether you have entered a valid threshold
value. Ensure that you enter a valid threshold value that is supported for the
1830 PSS devices.

7

Save your changes and close the forms.

END OF STEPS
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PM data

17.22 Overview

17.22.1 Configuring PM data

The prerequisites to configure PM are:
• Determine the interfaces and cards that you must configure to collect PM data.

• Configure the profiles to specify the threshold levels at which log events are generated
for the PM groups to be monitored on the NE.

• Configure each of the interfaces and cards on the NE for which you must collect PM
statistics.

• Configure the PM statistics to collect, the interval period over which they are collected,
and the profile used for each interval period.

17.22.2 Viewing PM data

PM data is recorded in logs or bins. Logs record all of the TCAs that occur on the NE.
The bins store data collected for a specific card or interface over a specific interval. A
raw bin for each PM group collects data until the data is cleared.

Note: When PM data is not available, PM parameter names are displayed with blank
values.

17.22.3 Displaying PM data for an EC card

You can display PM data only for an EC card.

Note: Card-level PM is not supported for other card types.

17.23 To enable PM TCA alerts

17.23.1 Steps

1

On the navigation tree, expand Network→NE.

2

Right-click on the NE and choose Properties. The Network Element (Edit) form
opens.

3

Click on the NE Specifics tab.
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4

Perform the following in the Performance Management panel.

1. Select the Enable PM TCA Alerts check box in the Performance Management
panel to enable NFM-P to generate all TCA alerts.

Note:

If the check box is disabled, NFM-P does not generate the TCA alerts.

2. Select the default PM policy in the File based PM Policy panel to enable
collection of scheduled statistics.

5

Save your changes and close the form.

END OF STEPS

17.24 To clear PM counters of a TCA profile bin associated with a
port or SAP on L2 card

17.24.1 Before you begin

Ensure that the port or SAP, where the PM counters needs to be cleared, have a TCA
profile assigned to it. See 17.17 “To assign TCA profiles to an EC card and other card
ports” (p. 392) to assign a TCA profile to a card or SAP.

17.24.2 Steps

1

Perform one of the following:

a. To clear PM counters from port properties of L2 card:

1. On the navigation tree, expand Network→NE→Shelf→Card→ Port.

2. Right-click on the port and choose Properties. The Physical Port (Edit) form
opens.

3. Click on the Port Specifics tab, then on the Performance tab.

4. Go to Step 2 .

b. To clear PM counters from NFM-P main menu:

1. Choose Tools→1830 PSS TCA Profiles from NFM-P main menu. The 1830
PSS TCA Profiles form opens.

2. Choose Card TCA Profiles (NE Threshold Crossing Alerts) from the object
drop-down box and click Search.

3. Choose the required TCA Profile from the list and click Properties. The 1830
PSS Card TCA Profile (Edit) form opens.
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4. Click on the Associations tab, then click Search.

Note:

By default,

• for SAP TCA profile type, L2 Access Interfaces tab opens under the
Associations tab.

• for Port TCA profile type, Ports tab opens under the Associations tab.

5. Choose the required ports as SAPs. Go to Step 2 .

2

Click Clear PM Counters.

3

Close the forms.

END OF STEPS
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Cards and ports that support PM data

17.25 Overview

17.25.1 General information

Table 39, “Cards and ports supporting PM data” (p. 401) lists cards and ports that
support PM data.

Note: The 11STMM10 hardware does not support GBE PM statistics in the egress
direction. The transmit side of the PM data is not displayed for the 4DPA2 client or line
ports.

Table 39 Cards and ports supporting PM data

Cards Ports

Card Type - Amplifier and associated cards

A2325A

AHPHG

AHPLG

ALPHG

AM2017B

AM2325B

LINE, LINE- (9170~9605)

OSC

A2P2125

A4PSWG

AM2032A

AM2125A

AM2125B

AM2318A

AM2625A

ASWG

LINEIN, LINEIN- (9170~9605)

LINEOUT, LINEOUT- (9170~9605)

OSCSFP

AA2DONW LINE, OSCSFP, SIG

ALPFGT LINE, OSC, OSCSFP

OSCT LINE, LINE- (9170~9605), OSCSFP

RA2P LINEIN

WTOCM

WTOCMA

IN (1 to 4)-(9170~9605)

Dedicated card
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Table 39 Cards and ports supporting PM data (continued)

Cards Ports

EC No port, PM data collected on the EC card and not on the port level

IROADM cards

IROADM-Fixed OSCSFP

LINEIN (9170 to 9605)

LINEOUT (9170 to 9605)

IROADM-Variable OSCSFP

LINEIN (9170 to 9605)

LINEOUT (9170 to 9605)

Optical Client/Line Cards

1AN100G H1

2AN40G H (1,2)

2ANQ40G H (1,2)

24ANM

24ANMB

24ET1G

24ET1GB

C (1 to 24)

4AN10G H (1 to 4)

8ET1GB C (1 to 8)

10AN10G

10AN10GC

10OTH10G

H (1 to 10)

20P200 H (1 to 20)

10ET10G

10ET10GC

C (1 to 10)

11QCUP

11QCUPC

L (1 to 4)

43SCUP

130SCUP

130SCUPB

130SCUPC

L1

1UD200 L1

Optical Transponder Cards
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Table 39 Cards and ports supporting PM data (continued)

Cards Ports

1DPP24M Master

PSS1P21

C (1 to 21), L1

1DPP24M Slave C (1 to 21)

4DPA2 C (1, 2), L (1, 2)

4DPA4 DualTran C (1, 3), L (1, 2), VA (1, 2)

4DPA4 FlexMux C (1 to 4), L (1, 2), VA (1, 2)

4QPA8

11QPA4

11QPEN4

C (1 to 4), L (1 to 4), VA (1 to 4)

11DPE12

11DPE12A

11DPE12E

11DPM12

C (1 to 12), L (1, 2), VA (1, 2)

11DPM4M C (1 to 4) and L (1, 2) without adjacent 11DPM4E card

C (1 to 8) and L (1, 2) with adjacent 11DPM4E card

11DPM8 C (1 to 8), L (1, 2), VA (1, 2)

11OPE8 C (1,2), M (1 to 4), VA (1 to 4), X (1 to 6)

11QCE12X C (1 to 22), M (1 to 4), VA (1,2), X (1 to 4)

11QPE24 C (1 to 11, 24), VA (1 to 4), X (1 to 4)

11STAR1

11STAR1A

112SA1L

112SCA1

112SNA1

130SCA1

43SCA1

43SCGE1

43STA1P

SVAC

C1, L1
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Table 39 Cards and ports supporting PM data (continued)

Cards Ports

11STGE12

11STMM10

112SCX10

112SNX10

112SX10L

130SCX10

130SNQ10

130SNX10

C (1 to 10), L1

43SCX4

43SCX4E

43SCX4L

43STX4

43STX4P

C (1 to 4), L1

112SDX11 C (1 to 14), L (1 to 4)

260SCX2 C (1,2), L1

MVAC G (1 to 8)

MVAC8B C (1 to 8), L (1 to 8)

PSS1GBE C (1 to 12), L (1, 2)

PSS1MD4

(Card Mode = DualTran)

C (1, 3), L (1, 2)

PSS1MD4

(Card Mode = FlexMux)

C (1 to 4), L (1, 2)

D5X500 C (1 to 5), L (1, 2)

PTP cards

PTPCTL P (1 to 6)

PTPIO TP (1, 2), ITP (1, 2)

TDM Cards

10SD10G H (1 to 10)

24SDM H (1 to 24)

Table 40, “Dedicated cards and ports” (p. 405) lists the dedicated cards that are required
to boot the 1830 PSS.
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Table 40 Dedicated cards and ports

Cards Ports

FAN —

USRPNL OAMP, VOIP, E1, E2

EC CIT (Local Ethernet Port), AUX, ES1, ES2

PFDC50 50A No ports

PFDC60 60A No ports
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Part VIII: 1830 PSS power management

Overview

Purpose

This part contains information about power management of 1830 PSS device using
NFM-P.

Contents

Chapter 18, 1830 PSS power management 409
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18 1830 PSS power management

18.1 Overview

18.1.1 Purpose

This chapter contains information about power management settings, power charts,
wavelength tracker and wave keys, technology types, and procedures on power
management.

18.1.2 Contents

18.1 Overview 409

Power management 411

18.2 Power management settings 411

Power chart 415

18.3 Overview 415

18.4 To view optical power on ports 419

18.5 To display optical power levels along a service path 421

Power adjustment - equipment 424

18.6 Power adjustment 424

18.7 To configure power management type 424

18.8 Automatic power adjustment-Equipment level 425

18.9 To perform an automatic power adjustment on an 1830 PSS 426

Power adjustment - service and trails 428

18.10 Service, OCH trail, and OTU trail - automatic power adjust 428

18.11 To configure automatic power adjustment for a service, an OCH trail, or
an OTU trail

429

18.12 Automatic power adjustment rules 431

18.13 To configure automatic power adjustment rules for a service, an OCH
trail, or an OTU trail

431

Wavelength tracker and wave key 433

18.14 Wavelength tracker and wave key 433
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18.15 Wave keys for the L-band, C-band, and S-band channels 434

18.16 Rekey and reuse wave keys 440

18.17 To rekey wave key values of a service, OCH trail, or OTU trail 442

18.18 To configure a rekey with duplicates allowed on an existing service or
trail

443

Spectral grids for WDM devices 445

18.19 Introduction 445

18.20 Fixed and flexible grid 445

Target power offset 447

18.21 Target power offset 447

18.22 To configure target power offset per direction 447

18.23 To view and configure target power offset per channel 448

OSNR 450

18.24 OSNR measurement 450

18.25 To configure an on-demand OSNR scan 450

OTDR 452

18.26 OTDR 452

18.27 To configure an OTDR scan 452

Technology types 456

18.28 Overview 456

18.29 To create an unreserved technology type 456

18.30 To set the technology type on OCH cross-connects on the 1830 PSS 457

Baseline 459

18.31 To configure baseline types OPT and OPR on ports 459
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Power management

18.2 Power management settings

18.2.1 LD port settings

NFM-P supports viewing and modifying the power management parameters for the
following LD ports:

• A2325A, AA2DONW, AHPHG, AHPLG, ALPHG, AM2318A, and OSCT LINE ports

• AM2032A, A4PSWG, A2P2125, AM2125A, AM2125B, AM2318A, ASWG, and
AM2625A LINEOUT ports

Table 41, “Power management parameters for LD ports” (p. 411) lists the configurable
power management parameters for LD ports. The parameters are configured on the Port
Specifics→General tab on the Network→1830 PSS→Shelf→Card→Port→Physical Port
form.

Table 41 Power management parameters for LD ports

Parameter Card restrictions

Power Management

Power Management Type Read-only for AA2DONW and OSCT

Service Launch Attenuation Offset (dB) Not applicable for AA2DONW and OSCT

Span Loss Tilt (dB) Not applicable for AA2DONW and OSCT

Auto Gain Adjustment Enabled Read-only for OSCT and not applicable for AA2DONW

Auto Tilt Adjustment Enabled Read-only for OSCT and not applicable for AA2DONW

Auto Tilt Maintenance Mode Enabled Read-only for OSCT and not applicable for AA2DONW

Commissioning Completed Not applicable for AA2DONW

Gain Adjustment settings

Time Offset Past Hour (HH:MM:SS) Not applicable for AA2DONW and OSCT

Time Period Between Adjustments (HH:MM:SS) Not applicable for AA2DONW and OSCT

Allocated Adjustment Time (HH:MM:SS) Not applicable for AA2DONW and OSCT

Wavelength Tracker Settings

Wavelength Tracker Decoder Usage Not applicable for AA2DONW and OSCT
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The power management parameters are configurable under the following conditions:

• You can configure the power management parameters only if the Ap Opp Direction
Port Addr parameter on the Port Specifics→General tab of the Network→1830
PSS→Shelf→Card→Port→Physical Port (Edit) form is configured.

• The Power Management Type parameter cannot be set to auto if the shelf where the
card is provisioned has the Wavelength Tracker Enabled parameter deselected for
1830 PSS-32 devices.

• If you configure the Power Management Type parameter as auto, the Service Launch
Attenuation Offset (dB) parameter is available for configuration.

18.2.2 WR port settings

NFM-P supports viewing and modifying the power settings for the following WR ports:

• WR8-88A SIG port

• WR8-88AF SIG port

Table 42, “Power management parameters for WR ports” (p. 411) lists the configurable
power management parameters for WR ports. The parameters are configured on the
Port Specifics→General tab on the Network→1830 PSS→Shelf→Card→Port→Physical
Port form.

Table 42 Power management parameters for WR ports

Parameter Values

Power Management Type Auto

Manual

Commissioning Completed —

The power management parameters are configurable under the following conditions:

• You can configure the power management parameters only if the Level in Optical
Node parameter of the WR8-88A and WR8-88AF Card Specifics tab on the
Network→1830 PSS→Shelf→Card→Card Slot form is set to 1.

• The Power Management Type parameter cannot be configured as Auto if the shelf
where the card is provisioned has Wavelength Tracker Enabled parameter deselected
for 1830 PSS-32 devices.

• If you configure the Power Management Type parameter as Auto, the Service Launch
Attenuation Offset (dB) parameter is available for configuration.

18.2.3 WR20-TFM DGE configuration

The DGE configuration equalizes the power gain on LDs using variable attenuators on a
WR20-TFM card. The DGE configuration consists of two WR20TFM cards. The
DROPOUT port of the first WR20TFM card is connected to the ADDIN port of the second
WR20TFM card in one direction, and the reverse, in the other direction.
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The following cards can be used in a DGE configuration:

• WR20TFM
• ASWG
• A4PSWG

• OTDR
• WTOCM
• WTOCM-F

See Nokia 1830 Photonic Service Switch Product Information and Planning Guide for
more information about DGE configuration.

Note: The DROP2OUT port of the first WR20TFM card must not be connected to
ADD2IN port of the second WR20TFM card for a DGE configuration, as it creates fiber
loops.

18.2.4 WR20–TF port settings

NFM-P supports configuring the WR20-TF card on an 1830 PSS device. The WR20-TF
card includes SIG, ADT, AD, and INV ports. You can configure the following parameters
on the Port Specifics→General tab of the Physical Port (Edit) form for ADT and AD ports:

• Express Channel Target Power (dBm)

• Initial Drop Channel Target Power (dBm)

Consider the following:

• WR20-TF ADT (1 to 8) and AD (9 to 20) ports cannot be connected to the CWR8,
CWR8-88, or WR2-88 THRU port.

• WR20-TF ADT (1 to 8} and AD (9 to 20) ports cannot be connected to the CWR8 or
CWR8-88, ColorLess (1 to 8) ports.

• WR20-TF ADT (1 to 8) and AD (9 to 20) ports cannot be connected to the WR2-88
ADDIN port.

• WR20-TF ADT (1 to 8) and AD (9 to 20) ports cannot be connected to the WR2-88
DROPOUT port.

• WR20-TF ADT (1 to 8) and AD (9 to 20) ports cannot be connected to another ADT (1
to 8) or AD (9 to 20) ports on the same WR20-TF card.

18.2.5 WTOCM, WTOCMA, and WTOCM-F port settings

NFM-P supports configuring the following parameters for the WTOCM, WTOCMA and
WTOCM-F IN ports:

• Ap Wtocm Conn Address

• Monitored Port Connection Loss (dB)

• OSNR Measurement Enabled

(only for WTOCMA)
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The IN ports are automatically configured and deleted with the card. NFM-P allows the
user to select the monitored port.

The supported port types are the LINE and SIG ports for the following LD card types:

• A2325A

• AHPHG

• ALPHG

• LINEOUT

LINEOUT ports for the following LD card types:

• A2P2125
• A4PSWG
• AM2032A
• AM2125A

• AM2318A
• AM2625A
• ASWG
• AM2125B
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Power chart

18.3 Overview

18.3.1 Optical power levels

NFM-P displays the optical power levels on the:

• ports

• OTU and OCH trails

• optical transport services

18.3.2 Port power chart

The port power chart displays the following power values for each wavelength (direction
(IN or OUT) and a port):

• measured power—a measurement that provides the current power level

• expected power—a provisioned value that indicates to the 1830 PSS device the power
level that must be achieved

• expected power deviation—a provisioned value that represents the deviation from the
expected power level that is considered healthy

In automatically powered equipment, the expected power and deviation values are
determined by SCOT. In manually powered equipment, the user can change the values.
See 18.4 “To view optical power on ports” (p. 419) to manage the expected power levels
and deviation at a wavelength tracker detection point.

You can navigate to the optical transport services configured for a specific channel by
choosing Show service on the power chart. The Optical Transport Service edit form
opens, if the channel has only one service configured. The Select Transport Service form
opens with a list of services, if the channel has multiple services configured.

Optical power levels are represented by bars, and the high and low watermarks are
represented by a Z bar. Figure 27, “Port power chart” (p. 416) shows a port optical
power chart.

The color legends used on the port power chart are as follows:

• Green—within range

• Orange—out of range (OoR, but within the chart interval which ranges from –30 to
+10)
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18.3.3 OTU and OCH trails power chart

The power chart can also be displayed from the optical trail. The power chart generated
from the OCH Trail (Edit) form (Manage→OTN→OTN Trails→OTU or OCH Trail (Edit)
form→OTU, or OCH Trail Path→Power A to Z or Power Z to A.

The OCH trail power chart displays:

• received power on all the points along the OCH trail of a keyed service, on a single
channel for the A to Z direction and Z to A direction, except the client ports

• power loss on each power monitored ports calculated as the difference of the
expected power with the actual power value

The color legend for the service power chart (as shown in Figure 28, “Service power
chart” (p. 417)) is as follows:

• Green—within range

• Orange—out of range (OoR, but within the interval which ranges from -30 to + 10

• White—the power levels are -99 and less than -30

• Black—the power levels are -99

Figure 27 Port power chart
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18.3.4 Service power chart

The service power chart displays:

• received power on all of the points along the service path on a single channel for the A
to Z direction and Z to A direction

• power loss on each power monitored ports calculated as the difference of the
expected power with the actual power value

See 18.5 “To display optical power levels along a service path” (p. 421) for more
information about displaying optical power levels along a service path.

The color legend for the service power chart (as shown in Figure 28, “Service power
chart” (p. 416)) is as follows:

• Green—within range

• Orange—out of range (OoR, but within the interval which ranges from -30 to + 10

• White—the power levels are -99 and less than -30

• Black—the power levels are -99

18.3.5 Wavelength Tracker-enabled ports

Table 43, “Wavelength Tracker-enabled ports” (p. 418) lists the wavelength tracker-
enabled ports.

Figure 28 Service power chart
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Table 43 Wavelength Tracker-enabled ports

Card Port Direction

Decoder Ports

A2325A

AHPHG

AHPLG

ALPHG

AM2017B

AM2325B

LINE IN, OUT

SIG OUT

DCM OUT

AM2125A LINEIN IN

LINEOUT OUT

CWR8

CWR8-88

SIG IN, OUT

THRU OUT

OMD IN

CLS (1 to 8) IN, OUT

OPSA, Protection Mode = OCHP or OMSP
only

SIG IN

A IN

B IN

Encoder Ports

112SCA1 L1 OUT

112SCX10 L1 OUT

11DPE12

11DPE12E

VA (1 to 2) OUT

11QPA4 VA (1 to 4) OUT

11STAR1 L1 OUT

11STAR1A L1 OUT

11STGE12 L1 OUT

11STMM10 L1 OUT

43SCX4

43SCX4E

L1 OUT

43STA1P L1 OUT

43STX4

43STX4P

L1 OUT
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Table 43 Wavelength Tracker-enabled ports (continued)

Card Port Direction

4DPA4 VA (1 to 2) OUT

MVAC G (1 to 8) OUT

SVAC L1 OUT

Other Ports

WTOCM IN (1 to 4) IN

18.4 To view optical power on ports

18.4.1 Steps

1

On the navigation tree, expand Network→NE→Shelf→Card→Port.

2

Right-click on a port and choose Properties. The Physical Port (Edit) form opens.
Table 43, “Wavelength Tracker-enabled ports” (p. 418) lists the ports that support
the Wavelength Tracker.

3

Resynchronize all wave keys.

1. Click on the Port Specifics tab of the Physical Port (Edit) form, then on the Wave
Keys tab.

Note: The Wave Keys tab appears only displayed if PPC is enabled.

2. Click Resync All Wave Keys.

4

Perform one of the following:

a. Click Power Management In to view the detection point power levels for the
inbound optical light path. The Port Power Management power chart for the
inbound optical light path opens.

b. Click Power Management Out to view the detection point power levels for the
outbound optical light path. The Port Power Management power chart for the
outbound optical light path opens.
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Configure expected power level

5

Set the expected power level for a channel:

1. Right-click on the power chart and choose Properties. The Wave Keys (Edit) form
opens.

2. Configure the required parameters in the General tab.

3. Save your changes and close the form.

Configure power deviation

6

Right-click on the power chart and choose Set Power Deviation. The Set Power
Deviation for channel form opens.

7

Perform one of the following to set the power deviation.

a. Enter a deviation value between 0 and 5 and click Apply.

b. Drag the slide bar left or right to choose a deviation value and click Apply.

The Set Power Deviation for channel form closes and the size of the Z bar
increases or decreases based on the configured deviation value.

Refresh power chart

8

Perform one of the following to refresh the power measurements:

a. Click Refresh power chart icon to refresh the power measurements manually.
The latest power readings for all of the points are displayed. The optical power
chart is refreshed and the last refresh time is displayed.

b. Perform the following steps to automatically refresh the power measurements:

1. Choose the number of seconds between refreshes from the drop-down menu.

2. Click Auto-refresh power chart icon to automatically refresh the power
measurements. The optical power chart updates at the configured time
interval.

3. Click the Stop icon to stop the power measurements, if required.
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Export power values to CSV

9

Perform the following to save the power values to a file:

1. Click the Export power values to csv file icon .

2. Navigate to the location to which you want to save the file and click Save.

Result: The power values are saved to a comma separated value (CSV) file that
can be opened using Microsoft Excel™.

10

Close the power chart.

END OF STEPS

18.5 To display optical power levels along a service path

18.5.1 Steps

1

Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form opens.

2

Choose Optical Transport Service from the object type drop-down menu and click
Search. A list of managed optical transport services appears.

3

Choose a service and click Properties. The Optical Transport Service (Edit) form
opens.

4

Choose Service Paths→Service Path on the navigation tree. The Service Path
properties form opens.

5

Click on one of the following:

• Power A to Z

• Power Z to A
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If the buttons are not visible, click More Actions and choose the corresponding
option from the drop-down menu.

Result: The optical power level graph opens, displaying all of the points along the
service path for the selected direction.

The power levels that are displayed have the following characteristics:

• When the SR DWDM card has the Port Type parameter set to Fixed on the
Wavelength Tracker tab under the Optical tab of the Physical Port (Edit) form, the
transmitted power from the wavelength tracker is displayed.

• When the SR DWDM card has the SFP VOA Present parameter selected on the
Wavelength Tracker tab under the Optical tab of the Physical Port (Edit) form, the
transmitted power from the wavelength tracker is displayed.

• When the SR DWDM card has the SFP VOA Present parameter deselected on
the Wavelength Tracker tab under the Optical tab of the Physical Port (Edit) form,
the coherent transmitted and received power are displayed for the coherent cards.

• When the SR DWDM card has the SFP VOA Present parameter deselected on
the Wavelength Tracker tab under the Optical tab of the Physical Port (Edit) form
and the Rx Amplifier parameter is set to True on the Optical Amplifier tab under
the Optical tab of the Physical Port (Edit) form, the received power is displayed
from the amplifier.

• For all other configurations of the SR DWDM card, the power from the Lane DDM
or DDM is displayed, depending on the card type.

• The received power of the SR non-DWDM ports in the power graph is from the
Lane DDM or DDM, depending on the card type.

6

Click on the Loss tab. The power chart displays a bar graph representing the power
loss and gain for the power monitored ports along the service path in the specified
direction. NFM-P calculates the power loss or gain of a power monitored port from
the difference in its measured power value and the measured power value of the
previous power monitored port.

The Loss tab also displays a Z bar that indicates the minimum and maximum power
loss or gain values for the following ports:

• Bidirectional Amplifier SIG OUT

• Unidirectional Amplifier LINEOUT

• CWR THRU OUT

• WR SIG OUT

7

Perform one of the following to refresh the power measurements:

a. Click Refresh power chart icon to refresh the power measurements manually.
The latest power readings for all of the points are displayed. The optical power
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chart is refreshed and the last refresh time is displayed.

b. Perform the following steps to automatically refresh the power measurements:

1. Choose the number of seconds between refreshes from the drop-down menu.

2. Click Auto-refresh power chart icon to automatically refresh the power
measurements. The optical power chart updates at the configured time
interval.

3. Click the Stop icon to stop the power measurements, if required.

8

Perform the following to save the power values to a file:

1. Click the Export power values to csv file icon .

2. Navigate to the location in which you want to save the file and click Save.

Result: The power values are saved to a comma separated value (CSV) file
which can be opened using Microsoft Excel™.

END OF STEPS
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Power adjustment - equipment

18.6 Power adjustment

18.6.1 Introduction

NFM-P supports automatic and manual power management of the technology types.
See 18.7 “To configure power management type” (p. 424) for more information about
configuring the power management type. The auto power adjustment is supported for
power adjustment on the LD cards in the ingress and egress direction.

18.6.2 Manual power adjustments

Manual-power managed networks support more flexible topologies, but the power levels
and commissioning can be configured.

In nodal configurations where one or more degrees are OLP protected, the optically
interconnected degrees must be Manually power managed. Manual power managed is
the default state of the1830 PSS device, and configuring degrees to Manual is not
required unless re-configuring a previously configured network element.

18.6.3 Automatic power adjustment

The automatic power adjustment can be done at an equipment, a service, or a trail level.

Auto-power managed networks have restricted topologies, but can be commissioned
and the NE automatically adjusts power levels.

The TOADM and ROADM configurations support auto-power management. The FOADM
configurations support manual-power management. There are FOADM configurations
that support auto-power management. See 18.7 “To configure power management type”
(p. 424) for information about configuring auto-power adjustment at the equipment level
using NFM-P.

18.7 To configure power management type

18.7.1 Steps

1

On the equipment tree, expand Network→1830 PSS object→Shelf object→Card
object (LD card)→Port object (LININ port).
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2

Right-click on the LININ port object and choose Properties. The Physical Port (Edit)
form opens.

3

Configure the Power Management Type parameter.

4

Save the changes and close the form.

END OF STEPS

18.8 Automatic power adjustment-Equipment level

18.8.1 Supported configurations

Power adjustments are supported for the following configurations:

• SR–PSS services (also supports SR DWDM tunable OTs)

• PSS–PSS services when there is a drop shelf OT at the endpoints of the service

• PSS–PSS services when there is an internal 1830 PSS OT that has a manual power
adjustment

18.8.2 Supported cards

NFM-P supports egress and ingress power adjustments for the following cards:

• A2325A
• A2P2125
• A4PSWG
• AHPHG
• AHPLG
• ALPHG
• RA2P
• AM2032A

• AM2125A
• AM2125B
• AM2318A
• AM2625A
• ASWG
• IROADM-V
• IROADM-F

NFM-P supports add and drop power adjustments for the following cards:

• WR8-88A

• WR8-88AF
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18.8.3 Linear power adjustment

The linear power adjustment is supported for linear topologies, and requires forced
cross-connects.

The supported directions are:

• Ingress/Egress for LD cards

• Add/Drop for WR cards

The automatic power adjustment is supported for linear topologies from the power graph.

18.8.4 Ring power adjustment

The ring power adjustment is supported on ring topologies, and is also called ASE
Adjustment.

The ring power adjustment is supported in the Ingress/Egress directions for LD cards.

18.8.5 Dynamic tilt adjustment

The dynamic tilt adjustment is supported on provisioning tilt adjustment attributes.

The dynamic tilt adjustment is supported in the Ingress/Egress directions for LD cards .

18.9 To perform an automatic power adjustment on an 1830
PSS

18.9.1 Steps

1

On the equipment tree, expand Network→1830 PSS object→Shelf object→Card
object (LD card or WR card)

2

Right-click on the card object and choose Properties. The Card Slot (Edit) form
opens.

3

Click on the Card Specifics and then on the Power Adjustment tab. The power
parameters of the ingress and egress ports are listed.
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4

Choose the port for which power adjustment needs to be made and click Properties.
The Ring/Dynamic Tilt/Linear Power Adjustment (Edit) form opens.

5

Perform one of the following

a. Ring Power Adjustment

Configure the parameters in the Power Adjustment panel.

b. Dynamic Tilt Adjustment

Configure the parameters in the Power Adjustment and Dynamic Tilt Attributes
panel.

c. Linear Powert Adjustment

Configure the parameters in the Power Adjustment and Power Attributes panel.

6

Save your changes and close the forms.

END OF STEPS
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Power adjustment - service and trails

18.10 Service, OCH trail, and OTU trail - automatic power adjust

18.10.1 Introduction

NFM-P supports automatic adjustment of power levels for:

• Optical transport services

• OCH trails

• OTU trails

The optical transport service, OCH trails, or OTU trails must originate on an 1830 PSS or
7750 SR that has a DWDM tunable, power control enabled optical transponder card
capable of encoding wavekeys. If no wavekeys are encoded, the SR port must connect
to the 1830 PSS through an SVAC or MVAC, and it is considered as an alien
wavelength. If wavekeys are encoded, the signal from SR can directly come into a
DWDM filter or CWR card. Similar conditions are applicable for services involving
dangling 1830 PSS OTs or internal 1830 PSS OTs with manual power adjustment.

18.10.2 Triggering automatic power adjustment on services and trails

NFM-P supports automatic power adjustment from the power chart for each service,
OCH trail, or OTU trail path for a specified direction. When you click the Auto Power
Adjust button on the service, OCH trail, or OTU trail power chart, an execute operation is
invoked on the corresponding power adjustment rule. This invokes a power adjustment
algorithm based on the type of service configuration; for example, normal, ROADM, or
any direction configured in the rule. See 18.12 “Automatic power adjustment rules”
(p. 431) for more information.

The power adjustment triggered for a service results in the triggering of the power
adjustment for the corresponding OTU or OCH trail, depending on the service type. If the
service has multiple OCH trails, the power adjustment is triggered on all the OCH trails
for the specific service.

See 18.11 “To configure automatic power adjustment for a service, an OCH trail, or an
OTU trail” (p. 429) and 18.13 “To configure automatic power adjustment rules for a
service, an OCH trail, or an OTU trail” (p. 431) for more information.

18.10.3 Check power adjustment status

The Check Status button is available only on the service power chart. When you click
Check Status, the Optical Service Path form opens and the automatic power adjustment
rules appear. You can choose a specific rule and click Properties to check the status of
the power adjustment for a service and the corresponding OTU or OCH trails. See
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18.11 “To configure automatic power adjustment for a service, an OCH trail, or an OTU
trail” (p. 428) for more information.

18.10.4 Supported configurations

Power adjustments are supported for the following configurations:

• SR-PSS-SR FOADM/TOADM services involving SR DWDM tunable, power control
enabled transponders

• PSS-PSS FOADM/TOADM services involving dangling OTs or internal OTs with
manual power adjustment

• SR-PSS-SR ROADM services involving SR DWDM tunable, power control enabled
transponders

• PSS-PSS ROADM services involving dangling OTs or internal OTs with manual power
adjustment

• SR-PSS-SR Anydirection services involving SR DWDM tunable, power control
enabled transponders

• PSS-PSS Anydirection services involving dangling OTs or internal OTs with manual
power adjustment

18.11 To configure automatic power adjustment for a service, an
OCH trail, or an OTU trail

18.11.1 Steps

1

Perform one of the following:

a. Optical transport service form.

1. Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form opens.

2. Choose Optical Transport Service from the object type drop-down menu and
click Search. A list of managed optical transport services is displayed.

3. Choose a service and click Properties. The Optical Transport Service (Edit)
form opens.

4. Choose Service Paths→Service Path. The Service Path properties form
opens.

b. OCH trail form

1. Choose Manage→OTN→OTN trails from NFM-P main menu. The Manage
OTN Trails form opens.

2. Choose OCH Trail (Optical Management) from the object type drop-down
menu and click Search. A list of managed OCH trails is displayed.

3. Choose an OCH trail and click Properties. The OCH Trail (Edit) form opens.
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4. Expand Trail Paths→OCH Trail Path and click OCH Trail Path object. The
OCH Trail Path properties form opens.

c. OTU trail form

1. Choose Manage→OTN→OTN trails from NFM-P main menu. The Manage
OTN Trails form opens.

2. Choose OTU Trail (Optical Management) from the object type drop-down
menu and click Search. A list of managed OTU trails is displayed.

3. Choose a OTU trail and click Properties. The OTU Trail (Edit) form opens.

4. Expand Trail Paths→OTU Trail Patch and click OTU Trail Path object. The
OTU Trail Path properties form opens.

2

Configure auto power adjustment rules. See 18.13 “To configure automatic power
adjustment rules for a service, an OCH trail, or an OTU trail” (p. 431) for more
information.

3

Click Power A to Z or Power Z to A. The Service Power A to Z or Z to A form opens.

4

Click Auto Power Adjust to implement automatic power adjustment. A dialog box
appears.

5

Click Yes. The automatic power adjustment process starts and the status changes
from Not executed to In Progress.

6

If you need to terminate the automatic power adjustment process:

1. Click Abort Power Adjustment. A dialog box appears.

2. Click Yes. The automatic power adjustment process stops. The status changes
from In Progress to Aborted.

7

If you need to check the status of power adjustment:

1. Click Check Status. The Optical Service Path (Edit) form opens.

Note: The Check Status button is only available on the service power chart.

2. Choose the automatic power adjustment rule of the direction for which you need
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to check the status and click Properties in the Power Adjustment Rules panel.
The Auto Power Adjustment Rule (Edit) form opens.

3. View the status of the automatic power adjustment.

8

Save your changes and close the forms.

END OF STEPS

18.12 Automatic power adjustment rules

18.12.1 Introduction

NFM-P supports configuration of automatic power adjustment rules for:

• Optical transport services

• OCH trails

• OTU trails

The rules are automatically created when a service, OCH trail, or OTU trail is
provisioned or discovered. They cannot be manually created or deleted. One rule is
created per service path per direction; so for a protected service, four rules are created:
working A→Z, working Z→A, protection A→Z, and protection Z→A.

The automatic power adjustment rules can be applied to 7750 SR source port, which is
the SR DWDM tunable power control enabled transponder port that can encode wave
keys, and the 1830 PSS target port, which is the cross-connected egress amplifier port
that can decode wave keys for a channel in A→Z or Z→A directions.

18.13 To configure automatic power adjustment rules for a
service, an OCH trail, or an OTU trail

18.13.1 Steps

1

Perform one of the following:

a. Configure the rules from the optical transport service form.

1. Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form opens.

2. Choose Optical Transport Service from the object type drop-down menu and
click Search. A list of managed optical transport services appears.

3. Choose a service and click Properties. The Optical Transport Service (Edit)
form opens.
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4. Expand Service Paths→Service Path and click Service Path object. The
Service Path properties form opens.

b. Configure the rules from the OCH trail form

1. Choose Manage→OTN→OTN trails from NFM-P main menu. The Manage
OTN Trails form opens.

2. Choose OCH Trail (Optical Management) from the object type drop-down
menu and click Search. A list of managed OCH trails appears.

3. Choose an OCH trail and click Properties. The OCH Trail (Edit) form opens.

4. Expand Trail Paths→OCH Trail Path and click OCH Trail Path object. The
OCH Trail Path properties form opens.

c. Configure the rules from the OTU trail form

1. Choose Manage→OTN→OTN trails from NFM-P main menu. The Manage
OTN Trails form opens.

2. Choose OTU Trail (Optical Management) from the object type drop-down
menu and click Search. A list of managed OTU trails appears.

3. Choose an OTU trail and click Properties. The OTU Trail (Edit) form opens.

4. Expand Trail Paths→OTU Trail Path and click OTU Trail Path object. The OTU
Trail Path properties form opens.

2

Choose an automatic power adjustment rule in the Auto Power Adjustment Rules
panel. The Power Adjustment Rule (Edit) form opens.

3

Configure the parameters in the Source Port and Target Port panels.

4

Save your changes and close the forms.

END OF STEPS
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Wavelength tracker and wave key

18.14 Wavelength tracker and wave key

18.14.1 Wavelength Tracker

Wavelength Tracker enables every wavelength to be traced as it passes through the
WDM network. It uses a unique optical signature known as a wave key pair, which is
encoded into each service wavelength at the transmitter of the transponder before it
enters the WDM layer. Combinations of keys that create the signatures can provide up to
113 signatures per OCH frequency supported by the system. Bidirectional services use a
wave key pair per direction. Therefore 56 bidirectional services are possible from the
wave key signature pool per OCH frequency.

18.14.2 Wave keys

NFM-P assigns the wave keys on the SR DWDM ports and on the 1830 PSS cross-
connects to ensure that the encoded wave keys on the SR DWDM ports are the same as
on the 1830 PSS. When you change the wave keys ensure that the same wave keys are
assigned to respective SR source ports in order to view accurate power levels on the
1830 PSS encoder and decoder points. AutoKeying (NMS) is the only wave key assign
mode supported for services originating on the SR and traversing through a network of
1830 PSS.

18.14.3 Wave key assign mode

NFM-P allows you to assign wave keys while service or trail configuration in the following
ways:

• Auto Keying NE

The assignment of wave keys is managed by the 1830 PSS, which maintain a
database of the wave keys used in the network.

• Auto Keying NMS

NFM-P automatically assigns the wave keys.

• Manual Keying

You can configure the wave key attributes during service or trail configuration.

See the following for more information about configuring a service or trail with wave
keying:

• 15.22 “To configure an optical transport service” (p. 311)

• 15.23 “To configure a multipoint transport service” (p. 314)

• 12.5 “To configure an ODU trail” (p. 219)

• 12.10 “To configure an OTU trail” (p. 226)

• 12.13 “To configure an OCH trail” (p. 230)
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18.15 Wave keys for the L-band, C-band, and S-band channels

18.15.1 Introduction

The Table 44, “L-band channel wave keys” (p. 433) , Table 45, “C-band channel wave
keys” (p. 436) , and Table 46, “S-band channel wave keys” (p. 438) list the ITU channel
numbers and corresponding wave keys for the L-band, C-band, and S-band channels.

In addition, the Wavelength Tracker can measure the optical power level at each
detection point for each encoded channel that passes through a port on an 1830 PSS
device. NFM-P power management function uses the Wavelength Tracker feature and
other equipment readings to provide a graphical representation of power levels and a
mechanism to track changes in the network.

For more information about the Wavelength Tracker tool, see the Nokia 1830 Photonic
Service Switch User Provisioning Guide and the Nokia 1830 Photonic Service Switch
Product Information and Planning Guide.

18.15.2 L-band channel wave keys

Table 44 L-band channel wave keys

ITU channel
number (THz)

nm ALU channel
number

ITU channel
number (THz)

nm ALU channel
number

100 GHz grid 50 GHz offset

186.00 1611.79 8600 186.05 1611.35 8605

186.10 1610.92 8610 186.15 1610.49 8615

186.20 1610.06 8620 186.25 1609.62 8625

186.30 1609.19 8630 186.35 1608.76 8635

186.40 1608.33 8640 186.45 1607.90 8645

186.50 1607.47 8650 186.55 1607.04 8655

186.60 1606.60 8660 186.65 1606.17 8665

186.70 1605.74 8670 186.75 1605.31 8675

186.80 1604.88 8680 186.85 1604.46 8685

186.90 1604.03 8690 186.95 1603.60 8695

187.00 1603.17 8700 187.05 1602.74 8705

187.10 1602.31 8710 187.15 1601.88 8715

187.20 1601.46 8720 187.25 1601.03 8725
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Table 44 L-band channel wave keys (continued)

ITU channel
number (THz)

nm ALU channel
number

ITU channel
number (THz)

nm ALU channel
number

100 GHz grid 50 GHz offset

187.30 1600.60 8730 187.35 1600.17 8735

187.40 1599.75 8740 187.45 1599.32 8745

187.50 1598.89 8750 187.55 1598.47 8755

187.60 1598.04 8760 187.65 1597.62 8765

187.70 1597.19 8770 187.75 1596.76 8775

187.80 1596.34 8780 187.85 1595.91 8785

187.90 1595.49 8790 187.95 1595.06 8795

188.00 1594.64 8800 188.05 1594.22 8805

188.10 1593.79 8810 188.15 1593.37 8815

188.20 1592.95 8820 188.25 1592.52 8825

188.30 1592.10 8830 188.35 1591.68 8835

188.40 1591.26 8840 188.45 1590.83 8845

188.50 1590.41 8850 188.55 1589.99 8855

188.60 1589.57 8860 188.65 1589.15 8865

188.70 1588.73 8870 188.75 1588.30 8875

188.80 1587.88 8880 188.85 1587.46 8885

188.90 1587.04 8890 188.95 1586.62 8895

189.00 1586.20 8900 189.05 1585.78 8905

189.10 1585.36 8910 189.15 1584.95 8915

189.20 1584.53 8920 189.25 1584.11 8925

189.30 1583.69 8930 189.35 1583.27 8935

189.40 1582.85 8940 189.45 1582.44 8945

189.50 1582.02 8950 189.55 1581.60 8955

189.60 1581.18 8960 189.65 1580.77 8965

189.70 1580.35 8970 189.75 1579.93 8975

189.80 1579.52 8980 189.85 1579.10 8985

189.90 1578.69 8990 189.95 1578.27 8995
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Table 44 L-band channel wave keys (continued)

ITU channel
number (THz)

nm ALU channel
number

ITU channel
number (THz)

nm ALU channel
number

100 GHz grid 50 GHz offset

190.00 1577.86 9000 190.05 1577.44 9005

190.10 1577.03 9010 190.15 1576.61 9015

190.20 1576.20 9020 190.25 1575.78 9025

190.30 1575.37 9030 190.35 1574.95 9035

190.40 1574.54 9040 190.45 1574.13 9045

190.50 1573.71 9050 190.55 1573.30 9055

190.60 1572.89 9060 190.65 1572.48 9065

190.70 1572.06 9070 190.75 1571.65 9075

190.80 1571.24 9080 190.85 1570.83 9085

190.90 1570.42 9090 190.95 1570.01 9095

18.15.3 C-band channel wave keys

Table 45 C-band channel wave keys

ITU channel
number (THz)

nm ALU channel
number

ITU channel
number (THz)

nm ALU channel
number

100 GHz grid 50 GHz offset

191.00 1569.59 9100 191.05 1569.18 9105

191.10 1568.77 9110 191.15 1568.36 9115

191.20 1567.95 9120 191.25 1567.54 9125

191.30 1567.13 9130 191.35 1566.72 9135

191.40 1566.31 9140 191.45 1565.90 9145

191.50 1565.50 9150 191.55 1565.09 9155

191.60 1564.68 9160 191.65 1564.27 9165

191.70 1563.86 9170 191.75 1563.45 9175

191.80 1563.05 9180 191.85 1562.64 9185

191.90 1562.23 9190 191.95 1561.83 9195

192.00 1561.42 9200 192.05 1561.01 9205
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Table 45 C-band channel wave keys (continued)

ITU channel
number (THz)

nm ALU channel
number

ITU channel
number (THz)

nm ALU channel
number

100 GHz grid 50 GHz offset

192.10 1560.61 9210 192.15 1560.20 9215

192.20 1559.79 9220 192.25 1559.39 9225

192.30 1558.98 9230 192.35 1558.58 9235

192.40 1558.17 9240 192.45 1557.77 9245

192.50 1557.36 9250 192.55 1556.96 9255

192.60 1556.55 9260 192.65 1556.15 9265

192.70 1555.75 9270 192.75 1555.34 9275

192.80 1554.94 9280 192.85 1554.54 9285

192.90 1554.13 9290 192.95 1553.73 9295

193.00 1553.33 9300 193.05 1552.93 9305

193.10 1552.52 9310 193.15 1552.12 9315

193.20 1551.72 9320 193.25 1551.32 9325

193.30 1550.92 9330 193.35 1550.52 9335

193.40 1550.12 9340 193.45 1549.72 9345

193.50 1549.32 9350 193.55 1548.91 9355

193.60 1548.51 9360 193.65 1548.11 9365

193.70 1547.72 9370 193.75 1547.32 9375

193.80 1546.92 9380 193.85 1546.52 9385

193.90 1546.12 9390 193.95 1545.72 9395

194.00 1545.32 9400 194.05 1544.92 9405

194.10 1544.53 9410 194.15 1544.13 9415

194.20 1543.73 9420 194.25 1543.33 9425

194.30 1542.94 9430 194.35 1542.54 9435

194.40 1542.14 9440 194.45 1541.75 9445

194.50 1541.35 9450 194.55 1540.95 9455

194.60 1540.56 9460 194.65 1540.16 9465

194.70 1539.77 9470 194.75 1539.37 9475
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Table 45 C-band channel wave keys (continued)

ITU channel
number (THz)

nm ALU channel
number

ITU channel
number (THz)

nm ALU channel
number

100 GHz grid 50 GHz offset

194.80 1538.98 9480 194.85 1538.58 9485

194.90 1538.19 9490 194.95 1537.79 9495

195.00 1537.40 9500 195.05 1537.00 9505

195.10 1536.61 9510 195.15 1536.22 9515

195.20 1535.82 9520 195.25 1535.43 9525

195.30 1535.04 9530 195.35 1534.64 9535

195.40 1534.25 9540 195.45 1533.86 9545

195.50 1533.47 9550 195.55 1533.07 9555

195.60 1532.68 9560 195.65 1532.29 9565

195.70 1531.90 9570 195.75 1531.51 9575

195.80 1531.12 9580 195.85 1530.72 9585

195.90 1530.33 9590 195.95 1529.94 9595

18.15.4 S-band channel wave keys

Table 46 S-band channel wave keys

ITU channel
number (THz)

nm ALU channel
number

ITU channel
number (THz)

nm ALU channel
number

100 GHz grid 50 GHz offset

196.00 1529.55 9600 196.05 1529.16 9605

196.10 1528.77 9610 196.15 1528.38 9615

196.20 1527.99 9620 196.25 1527.60 9625

196.30 1527.22 9630 196.35 1526.83 9635

196.40 1526.44 9640 196.45 1526.05 9645

196.50 1525.66 9650 196.55 1525.27 9655

196.60 1524.89 9660 196.65 1524.50 9665

196.70 1524.11 9670 196.75 1523.72 9675

196.80 1523.34 9680 196.85 1522.95 9685
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Table 46 S-band channel wave keys (continued)

ITU channel
number (THz)

nm ALU channel
number

ITU channel
number (THz)

nm ALU channel
number

100 GHz grid 50 GHz offset

196.90 1522.56 9690 196.95 1522.18 9695

197.00 1521.79 9700 197.05 1521.40 9705

197.10 1521.02 9710 197.15 1520.63 9715

197.20 1520.25 9720 197.25 1519.86 9725

197.30 1519.48 9730 197.35 1519.09 9735

197.40 1518.71 9740 197.45 1518.32 9745

197.50 1517.94 9750 197.55 1517.55 9755

197.60 1517.17 9760 197.65 1516.78 9765

197.70 1516.40 9770 197.75 1516.02 9775

197.80 1515.63 9780 197.85 1515.25 9785

197.90 1514.87 9790 197.95 1514.49 9795

198.00 1514.10 9800 198.05 1513.72 9805

198.10 1513.34 9810 198.15 1512.96 9815

198.20 1512.58 9820 198.25 1512.19 9825

198.30 1511.81 9830 198.35 1511.43 9835

198.40 1511.05 9840 198.45 1510.67 9845

198.50 1510.29 9850 198.55 1509.91 9855

198.60 1509.53 9860 198.65 1509.15 9865

198.70 1508.77 9870 198.75 1508.39 9875

198.80 1508.01 9880 198.85 1507.63 9885

198.90 1507.25 9890 198.95 1506.87 9895

199.00 1506.49 9900 199.05 1506.12 9905

199.10 1505.74 9910 199.15 1505.36 9915

199.20 1504.98 9920 199.25 1504.60 9925

199.30 1504.23 9930 199.35 1503.85 9935

199.40 1503.47 9940 199.45 1503.10 9945

199.50 1502.72 9950 199.55 1502.34 9955
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Table 46 S-band channel wave keys (continued)

ITU channel
number (THz)

nm ALU channel
number

ITU channel
number (THz)

nm ALU channel
number

100 GHz grid 50 GHz offset

199.60 1501.97 9960 199.65 1501.59 9965

199.70 1501.21 9970 199.75 1500.84 9975

199.80 1500.46 9980 199.85 1500.09 9985

199.90 1499.71 9990 199.95 1499.34 9995

200.00 1498.96 2000 200.05 1498.59 2000

200.10 1498.21 2001 200.15 1497.84 2001

200.20 1497.46 2002 200.25 1497.09 2002

200.30 1496.72 2003 200.35 1496.34 2003

200.40 1495.97 2004 200.45 1495.60 2004

200.50 1495.22 2005 200.55 1494.85 2005

200.60 1494.48 2006 200.65 1494.11 2006

200.70 1493.73 2007 200.75 1493.36 2007

200.80 1492.99 2008 200.85 1492.62 2008

200.90 1492.25 2009 200.95 1491.88 2009

18.16 Rekey and reuse wave keys

18.16.1 Rekeying service and trail

When more than 113 Wavelength Tracker key pairs are needed in a network per optical
channel frequency, key reuse is possible if the network has isolated pockets of NEs. The
isolated NEs can form a separate optical domain, which can be managed as a separate
network. The OAMP port of one of the NEs in this separate network is used to provide
the management interface to the network. The pool of 113 Wave key pairs is then
available again within the separate network. Each separate area can be assigned a
different OSPF area number

NFM-P allows you to rekey wave keys that are associated with an optical transport
service or trail. You can rekey a wave key to resolve duplicate wave key values that are
assigned to a service. See 18.17 “To rekey wave key values of a service, OCH trail, or
OTU trail” (p. 442) for more information about configuring rekey.
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18.16.2 Allow duplicate wave keys

You can reuse wave keys within a single optical network in the same OSPF area. Reuse
of wave keys provides increased flexibility for wavelength tracking in networks that
evolve over time to require more than 56 bidirectional services of the same channel
frequency within a domain. The conflicts caused by wave key pair duplication when two
networks are joined into a single network sharing an OSPF area are resolved by
selectively allowing duplicate keys within a domain.

NFM-P supports the reuse of wave key pairs for services and trails. The capability for the
network to reuse wave key pairs is enabled on a per-OCH frequency basis. Therefore,
you can to allow duplicates usage for some channel frequencies while reserving
exclusivity for other channel frequencies. After the wave key pairs are duplicated per
channel frequency, the process cannot be reversed.

When the Wave Key Mode parameter is set to Auto Keying (NE) in the service or trail
form, and the Wave Key Preference parameter to Duplicates Allowed, the existing wave
keys can or cannot be reused . The specific channel frequency is marked as “Allow
duplicate wave keys” and the 113 pairs of wave keys can be used any number of times.

You can configure the OCH cross-connect to allow duplicate wave keys. In that case, the
OCHKEYDUP and OCHKEYUNAVAIL alarms are not generated when the wave key
pairs are reused. If the OCHKEYDUP or OCHKEYUNAVAIL alarms are generated for
specific wave keys and you need to use those wave keys, configure the OCH cross-
connect to allow duplicate wave keys to clear the alarms. See the Nokia 1830 Photonic
Service Switch (PSS) Release 8.2 Maintenance and Trouble-Clearing Guide for more
information about alarms supporting the wave key scalability enhancements.

You can reuse wave keys by performing one of the following using NFM-P:

• Configuring a service or trail by setting the Wave Key Preference parameter to
Duplicates Allowed.

See the following procedures for more information about configuring services or trails
with wave key reuse:

— 15.22 “To configure an optical transport service” (p. 311)

— 15.23 “To configure a multipoint transport service” (p. 314)

— 12.5 “To configure an ODU trail” (p. 219)

— 12.10 “To configure an OTU trail” (p. 226)

— 12.13 “To configure an OCH trail” (p. 230)

• Configuring the OCH cross-connect of an existing service or trail by setting the Rekey
(Allow Duplicates) parameter to Execute. See 18.18 “To configure a rekey with
duplicates allowed on an existing service or trail” (p. 443) for more information.
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18.17 To rekey wave key values of a service, OCH trail, or OTU
trail

18.17.1 Steps

1

Perform one of the following:

a. Configure the rekey wave key values from the optical transport service form.

1. Choose Manage→Service→Services from NFM-P main menu. The Manage
Services form opens.

2. Choose Optical Transport Service from the object type drop-down menu and
click Search. A list of managed optical transport services is displayed.

3. Choose a service and click Properties. The Optical Transport Service (Edit)
form opens.

b. Configure the rekey wave key values from the OCH trail form

1. Choose Manage→OTN→OTN trails from NFM-P main menu. The Manage
OTN Trails form opens.

2. Choose OCH Trail (Optical Management) from the object type drop-down
menu and click Search. A list of managed OCH trails is displayed.

3. Choose an OCH trail and click Properties. The OCH Trail (Edit) form opens.

c. Configure the rekey wave key values from the OTU trail form

1. Choose Manage→OTN→OTN trails from NFM-P main menu. The Manage
OTN Trails form opens.

2. Choose OTU Trail (Optical Management) from the object type drop-down
menu and click Search. A list of managed OTU trails is displayed.

3. Choose an OTU trail and click Properties. The OTU Trail (Edit) form opens.

2

Click the Rekey Service AZ Path or Rekey Service ZA Path button. Click the More
Actions icon if the button does not appear on the form.

Note: Confirm the deployment status in the Wave Key panel in the OCH Cross
Connects tab of the Optical Transport Service (Edit) form.

3

Save your changes and close the forms.

END OF STEPS

To rekey wave key values of a service, OCH trail, or OTU trail NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

442 Issue 2



18.18 To configure a rekey with duplicates allowed on an
existing service or trail

18.18.1 Steps

1

Perform one of the following:

a. Configure the rekey from the Manage menu

1. Choose Manage→Equipment→Equipment from NFM-P main menu. The
Manage Equipment form opens.

2. Choose Wave Key Encoder (Optical Management) from the object drop-down
menu and click Search. The wave key assigned ports are listed.

3. Choose the port that has the cross-connect for wave key reuse and click
Properties. The Physical Port (Edit) form opens with OCH cross-connects
listed in the OCH Cross Connect tab.

4.Perform one of the following:

• Choose an OCH cross-connect, click Properties and go to Step 2. The OCH
Cross Connect (Edit) form opens.

• Choose an OCH cross-connect, and click Rekey with dup, and go to Step 4.

b. Configure the rekey from the OCH trail form

1. Choose Manage→OTN→OTN trails from NFM-P main menu. The Manage
OTN Trails form opens.

2. Choose OCH Trail (Optical Management) from the object type drop-down
menu and click Search. A list of managed OCH trails is displayed.

3. Choose an OCH trail and click Properties. The OCH Trail (Edit) form opens.

4. Expand Trail Paths→OCH Trail Path and click OCH Trail Path object. The
OCH Trail Path properties form opens.

5. Click on the OCH CrossConnects tab. The OCH cross-connects are listed.

6. Choose an entry and click Properties. The OCH Cross Connect (Edit) form
opens.

c. Configure the rekey from the OTU trail form

1. Choose Manage→OTN→OTN trails from NFM-P main menu. The Manage
OTN Trails form opens.

2. Choose OTU Trail (Optical Management) from the object type drop-down
menu and click Search. A list of managed OTU trails is displayed.

3. Choose a OTU trail and click Properties. The OTU Trail (Edit) form opens.

4. Expand Trail Paths→OTU Trail Path and click OTU Trail Path object. The OTU
Trail Path properties form opens.

5. Click on the OCH CrossConnects tab. The OCH cross-connects are listed.
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6. Choose an entry and click Properties. The OCH Cross Connect (Edit) form
opens.

d. Configure the rekey from the Equipment tree

1. On the equipment tree, expand Network→1830 PSS→Shelf→Card→Port.

2. Right-click on the Port object and choose Properties. The Physical Port (Edit)
form opens.

3. Click on the OCH CrossConnects tab. The OCH cross-connects are listed.

4.Perform one of the following:

• Choose an OCH cross-connect, click Properties and go to Step 2. The OCH
Cross Connect (Edit) form opens.

• Choose an OCH cross-connect, and click Rekey with dup, and go to Step 4.

2

Set the Rekey (Allow Duplicates) parameter to Execute.

3

Note: If you need to reuse the existing wave key pairs, skip Step 3.

Perform one of the following:

a. If the Wave Key Assign Mode parameter is set to Auto Keying (NE), go to Step 4.

Note: When you rekey with “allow duplicate” in the Auto Keying (NE) wave key
assign mode, the existing wave key pairs marked as duplicate may or may not
used. The channel number is marked as "allow duplicate" on the 1830 PSS. The
change is permanent for the specific channel number and it cannot be reversed.

b. If the Wave Key Assign Mode parameter is set to Auto Keying (NMS), and you
need to use a new pair of wave keys, configure the Wave Key 1 and 2 parameters
for AZ and ZA.

4

Save your changes and close the forms.

5

Repeat Step 1 to Step 4 for all of the OCH cross-connects for which the duplicate
wave keys need to be allowed.

END OF STEPS
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Spectral grids for WDM devices

18.19 Introduction

18.19.1 Frequency grid

A frequency grid is a reference set of frequencies used to identify allowed nominal
central frequencies that may be used for defining applications.

18.19.2 Frequency slot

The frequency slot is the frequency range allocated to a slot and unavailable to other
slots within a flexible grid. A frequency slot is defined by its nominal central frequency
and its slot width.

18.19.3 Slot width

The slot width is the full width of a frequency slot in a flexible grid.

18.20 Fixed and flexible grid

18.20.1 Fixed grid channel spacing

The fixed frequency grid supports fixed channel spacings ranging from 12.5 GHz to 100
GHz. The 1830 PSS supports 88 channels at 50 GHz spacing using center frequencies
from 196.05 THz to 191.7 THz. The channel routing is performed using 50 GHz slots for
50 GHz granularity devices, or 100 GHz slots for 100 GHz granularity devices.

18.20.2 Flexible grid

The flexible frequency grid has frequency slots with a nominal central frequency (in THz)
and the width of a channel can be assigned at the time of provisioning. The flexible grid
is supported for both C Band and L Band channels.

NFM-P supports the configuration of a channel width of 50 GHz, 62.5 GHz, and 75 GHz
with D5X500 cards used in the CDC configuration with WR20TFM cards. The default
channel width is 50 GHz.

You can configure the Spectral Width parameter during the configuration of:

• Optical transport service

• Multipoint transport service

• ODU trail

• OTU trail
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• OCH trail

See the following procedures for more information:

• 15.22 “To configure an optical transport service” (p. 311)

• 15.23 “To configure a multipoint transport service” (p. 314)

• 12.5 “To configure an ODU trail” (p. 219)

• 12.10 “To configure an OTU trail” (p. 226)

• 12.13 “To configure an OCH trail” (p. 230)

18.20.3 Flex grid channels

The flex grid channels are represented in the 3 decimal format; for example, “9600.000”
for 196.000 THz.

You can configure the flex grid channels during the configuration of:

• OTU trail

• OCH trail

See the following procedures for more information:

• 12.10 “To configure an OTU trail” (p. 226)

• 12.13 “To configure an OCH trail” (p. 230)

18.20.4 Channel allocation

NFM-P allocates the channel numbers in descending order, starting from 9605, for the
services and trails that are not configured with a channel number and the spectral width
is set to Default.

NFM-P allocates the channel numbers in ascending order, starting from 9170, for the
services and trails that are not configured with a channel number and the spectral width
is set to 62.5 GHz. The channel number 9605 cannot be used with the 62.5 GHz spectral
width due to insufficient bandwidth on the high frequency side in the WR20 wavelength
selective switches.

The channel allocation occurs in two passes. The first pass maintains 250 GHz spectral
spacing between center frequencies of two consecutive OCH cross-connects. If free
channels are not available, in the second pass, the OCH cross-connects are provisioned
at the first encountered free channel in ascending order.
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Target power offset

18.21 Target power offset

18.21.1 Overview

NFM-P supports the configuration of the target power offset for the following ports:

• A2325A, AHPHG, AHPLG and ALPHG LINE ports

• A2P2125, A4PSWG, AM2032A, AM2125A, AM2125B, AM2318A, AM2625A, ASWG,
AWBILA, AWBING, IROADM9M, IROADMF, IROADMV, RA2P and RA5P LINEIN
ports (Ingress only)

• A2P2125, A4PSWG, AM2032A, AM2125A, AM2125B, AM2318A, AM2625A, ASWG,
AWBEGR, AWBILA, IROADM9M, IROADMF and IROADMV LINEOUT ports(Egress
only)

18.22 To configure target power offset per direction

18.22.1 When to use

The target power offset depends on the ingress and egress direction of the port.

See the Nokia 1830 Photonic Service Switch 36/32/16 (PSS-36/PSS-32/PSS-16) User
Provisioning Guide for more information.

18.22.2 Steps

1

On the equipment navigation tree, expand Network→NE→Shelf→Card→Port.

2

Right-click on the port and choose Properties. The Physical Port (Edit) form opens.

3

Click on the Port Specifics tab, then on the Target Power Offset tab.

4

Click Properties. The Power Offset (Edit) form opens.

5

Configure the Target Power Offset (dB) parameter.
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6

Save your changes and close forms.

END OF STEPS

18.23 To view and configure target power offset per channel

18.23.1 When to use

NFM-P allows you to view and configure the ingress and egress target power attributes
per optical channel.

18.23.2 Steps

1

On the navigation tree, expand Network→NE→Shelf→Card.

2

Right-click on the Card Slot and choose Properties. The Card Slot (Edit) form opens.

3

Click on the Card Specifics tab, then on the Channel Target Power Offset tab. A list
of ingress and egress target power attributes per optical channel appears.

The Channel Target Power Offset tab appears on the form under the following
conditions:

• The card is equipped and not pre-provisioned.

• Service is created between the line ports of the two amplifier cards.

• The Power Management Type parameter for the line port of the amplifier card,
which is displayed in the Port Specifics→General form, is set to Auto.

4

Choose an entry for which the Applicable? parameter is set to Yes. Click on the
Properties tab. The Target Power Offset (Edit) form opens.

5

Configure the User Offset (db) parameter.

6

Click OK.
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7

Save your changes and close the form.

END OF STEPS
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OSNR

18.24 OSNR measurement

18.24.1 OSNR measurement

NFM-P supports Optical Signal to Noise Ratio (OSNR) measurement for supported
channels or a specific channel upon activation. The OSNR monitors system aging using
the WTOCMA card. The WTOCMA can monitor up to four optical lines.

The OSNR measurement time for one channel is 30 s. The first scan is performed with
the filter set at the center of the target channel and the second scan is performed with
the filter set slightly de-tuned from center. By comparing the two sets of measurements,
an in-band OSNR measurement is obtained. The OSNR measurement of 40 Gb/s and
100 Gb/s signals requires an inter-leaver for transmission.

NFM-P supports OSNR measurement upon selecting the Port Specifics→On Demand
OSNR→General tab of the WTOCMA Physical Port (Edit) form. The on-demand OSNR
scan can be performed on a specific channel or channels. See 18.25 “To configure an
on-demand OSNR scan” (p. 450) for more information about configuring an on-demand
OSNR scan.

18.25 To configure an on-demand OSNR scan

18.25.1 Steps

1

On the navigation tree, expand Network→NE→Shelf→Card (WTOCMA)→Port.

2

Right-click on the port and choose Properties. The Physical Port (Edit) form opens.

3

Click on the Port Specifics tab, then on the On Demand OSNR Scan tab.

4

Configure the OSNR Measurement Enabled parameter.

Note: The OSNR Scan Status parameter displays the scan status as Not In
Progress.

5

Click on the Channels tab.
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6

Choose a channel or channels to perform the OSNR scan.

7

Click Start OSNR Scan. The OSNR scan begins.

Note: The OSNR Scan Status parameter displays the scan status as Waiting
when the scanning starts and as In Progress during the scanning process.
Click Abort OSNR Scan to abort the scan.

8

Click View results, after the scan completes. The OSNR Scan Results form opens
with a graphical view of the OSNR measurements.

9

Perform one of the following:

a. Manual refresh of OSNR measurement values:

1. Click on the Refresh OSNR Results icon.

2. Choose the refresh time interval: 30 s, 60 s, or 90 s.

b. Automatic refresh of OSNR measurement values:

1. Click on the Auto-refresh OSNR results icon.

2. To stop auto-refresh, click on the Stop auto-refresh icon.

10

Save your changes and close the forms.

END OF STEPS
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OTDR

18.26 OTDR

18.26.1 OTDR scan

An OTDR scan is used to characterize a fiber span before configuring a service,
determine the location of a fiber cut, and monitor the fiber while in-service. The LD cards
that support OTDR scan include A4PSWG and ASWG cards.

External topological links must exist between the ports of the OTDR card and the
OTDRRX or OTDRTX ports of the LD to allow OTDR scans through LINEIN or LINEOUT
ports.

Consider the following while configuring the external topological links to enable OTDR
scans:

• In an ILA, the OTDR scan can be performed through the LINEIN port of the OTDR
card, by connecting the LINEIN port to the OTDRRX port of the amplifier. Similarly, the
OTDR scan can be launched from the LINEOUT port of the OTDR card, by connecting
the LINEOUT port to the OTDRTX port of the amplifier.

• In a ROADM configuration with an ingress LD, the OTDR scan can be performed
through the LINEIN port of the OTDR card by connecting the LINEIN port to the
OTDRRX port of the ingress LD.

• In a ROADM configuration with an egress LD, the OTDR scan can be performed
through the LINEOUT port of the OTDR card by connecting the LINEOUT port to the
OTDRTX port of the egress LD.

See 18.27 “To configure an OTDR scan” (p. 452) for more information about configuring
an OTDR scan.

OTDR scan using MON-OTDR cards

You can perform an OTDR scan on LINEIN, LINEOUT, LINE, or SIG ports of legacy
amplifiers AM2125A, AM2318A, RA2P, AM2625A, AM2032A, AHPHG, AHPLG, A2325A
that are associated with the SIGIN or SIGOUT ports of a MON-OTDR card. The
OTDRRX and OTDRTX must be associated with one of P1 through P8 ports of an
OTDR card.

18.27 To configure an OTDR scan

18.27.1 Introduction

OTDR scans can be configured on the following ports:

• OTDRRX or OTDRTX ports of the A4PSWG or ASWG cards
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• LINEIN or LINEOUT ports of the AM2125A, AM2318A, RA2P, AM2625A, or AM2032A
cards

• SIG or LINE ports of the AHPHG, AHPLG, or A2335A cards

One of the ports P1 through P8 of the OTDR card must be connected to the appropriate
ports in the following way before you start the scan.

• OTDRRX or OTDRTX ports of the A4PSWG or ASWG cards

• SIGIN or SIGOUT ports of the MON-OTDR card to which LINEOUT, LINEIN, LINE, or
SIG port of AM2125A, AM2318A, RA2P, AM2625A, AM2032A, AHPHG, AHPLG, or
A2335A cards is associated

Before performing an out-of-service OTDR scan, ensure that the APR Mode parameter
in the Port Specifics tab of the LINEIN or LINEOUT port is set as Force.

18.27.2 Steps

1

On the equipment tree, expand Network→NE.

2

Right-click on the NE and choose Properties. The Network Element (Edit) form
opens.

3

Click on the NE Specifics tab, then on the OTDR Scan Transfer tab.

4

Configure the required parameters.

Note: Ensure that you configure the File Retrieval Location parameter as Local
or Remote. NFM-P does not display the result of the OTDR scan if the File
Retrieval Location parameter is configured with the default value, Unset.
Configure the File Transfer Protocol parameter as FTP and configure the User
Id and Password parameters.
If the File Retrieval Location parameter is configured as Remote, configure the
File Server IP Address and Retrieval destination Path parameters.

5

Save and close the form.

6

On the equipment tree, expand Network→NE→Shelf→Card→Port.
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7

Right-click on the port and choose Properties. The Physical Port (Edit) form opens.

8

Click on the Port Specifics tab, then on the OTDR Scan Specifics tab.

9

Select the required profile, or click Clear beside the Profile ID parameter to clear a
selected or default profile and if required, configure the required parameters to set a
custom profile.

Note: Before configuring the profile, you must know the required span length of
the configuration, based on which you must select or configure a custom profile
for the OTDR scan. For example, if the network span length is 40 km in one
direction, and the connection is bidirectional, then the total span length is 80
km.

10

Verify the values of the parameters — Associated OTDR Port (in case of all LDs)
and Associated Mon-OTDR Port (in case of legacy LDs). If the values do not reflect
correctly, click Resync.

11

Click Apply, then click Start Scan.

12

Click on the OTDR Scan Results File when the scan is complete.

13

Choose a file and click Retrieve File.

Note: The result is displayed on the JDSU FiberTrace Viewer on the local
machine.
The JDSU FiberTrace Viewer can be installed from the link: http:
//ofs.updatemyunit.net/.
The JDSU FiberTrace Viewer cannot be launched automatically from Firefox or
Internet Explorer 8.
The result file is stored in the following location: /opt/nsp/nfmp/server/nms
/tftp_home/otdrScan/<NE IP address>/
To retrieve all the OTDR scan results from an NE, including the EC card,
choose Retrieve All OTDR Scan Result Files from the More Actions contextual
menu of the Network Element (Edit) form.
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NFM-P purges the result files after seven days.

END OF STEPS
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Technology types

18.28 Overview

18.28.1 Reserved and unreserved technology types

The technology types are:
• reserved types that are discovered on the node

• unreserved types that are discovered on NFM-P

NFM-P allows you to view the reserved technology types. You can create, view, and
modify the unreserved technology types. See 18.29 “To create an unreserved
technology type” (p. 456) for more information about configuring unreserved technology
type.

Note: You cannot create a technology type on NFM-P if a specific Bit Rate Key and the
Encoding Key parameter value is already present.

You cannot modify the Bit Rate Description and the Encoding Description parameters for
the unreserved technology types with Bit Rate Key and Encoding Key parameter values
that are for the reserved technology types. The values range from 1 to 1000 and 9001 to
10000.

You cannot modify the WTOCM/WTOCMA Calibration and the OSNR Calibration
parameters for the unreserved technology types with Bit Rate Key and Encoding Key
parameter values that are for the reserved technology types. The values range from
9001 to 10 000.

You can delete a technology type under the following conditions:

• technology type is not a reserved

• technology type is not associated with a cross-connect. The AZ and ZA configured and
received Bit Rate Key and Encoding Key parameter values do not match on a
cross-connect.

You can set the technology type on OCH cross-connects on the 1830 PSS. See
18.30 “To set the technology type on OCH cross-connects on the 1830 PSS” (p. 457) for
more information about setting the technology type.

18.29 To create an unreserved technology type

18.29.1 Steps

1

On the navigation tree, expand Network→1830 PSS.
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2

Right-click on an 1830 PSS and choose Properties. The Network Element (Edit)
form opens.

3

Click on the NE Specifics tab, then on the Technology Types tab.

4

Click Create. The Technology Type (Create) form opens.

5

Configure the required parameters.

6

Save your changes an close the forms.

END OF STEPS

18.30 To set the technology type on OCH cross-connects on the
1830 PSS

18.30.1 Steps

1

On the navigation tree, expand Network→1830 PSS.

2

Right-click on the 1830 PSS and choose Properties. The Network Element (Edit)
form opens.

3

Click on the OCH CrossConnects tab. A list of OCH cross-connects appears.

4

Choose a cross-connect and click Properties. The OCH Cross Connect (Edit) form
opens.

5

Select the technology type in the User Technology AZ panel or the User Technology
ZA panel and click OK.
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6

Save your changes and close the forms.

Note: The Reserved Technology type is automatically received by the cross-
connect only when the technology type is CWDM or DWDM.

END OF STEPS
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Baseline

18.31 To configure baseline types OPT and OPR on ports

18.31.1 Introduction

NFM-P allows you to create and configure the baseline types OPR (Optical Power
Received on OT and OSC points) and OPT (Optical Power Transmitted on OT and OSC
points).

18.31.2 Steps

1

On the navigation tree, expand Network→NE→Shelf→Card→Port.

2

Right-click on the port and choose Properties. The Physical Port (Edit) form opens.

3

Click on the Port Specifics tab, then on the Performance and the Baseline tabs.

4

Click Create. The Baseline (Create) form opens.

5

Configure the required parameters and click OK.

6

Save your changes and close the forms.

Note: The value of the Reason parameter is modified under the Baseline tab of
the Physical Port (Edit) form.

END OF STEPS
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Part IX: 1830 PSS fault management

Overview

Purpose

This part contains information about fault management in the 1830 PSS device using
NFM-P.

Contents

Chapter 19, 1830 PSS fault management 463
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19 1830 PSS fault management

19.1 Overview

19.1.1 Purpose

This chapter contains information about fault management, RCA audit, alarm and alarm
profile management, and alarm correlation.

19.1.2 Contents

19.1 Overview 463

Fault management 464

19.2 Overview 464

RCA audit 465

19.3 Overview 465

19.4 To configure an RCA audit policy 465

19.5 To perform an RCA audit of an optical link 466

Alarm management 468

19.6 Overview 468

19.7 To configure environmental alarms 469

Alarm profile and severity — WDM devices 471

19.8 Alarm severity 471

19.9 To override an alarm severity at the NE level 472

19.10 To override an alarm severity at the equipment level 474

19.11 To override an alarm severity at the object level 476

Alarm profile and severity — OCS devices 479

19.12 Alarm severity assignment profiles 479

19.13 To configure an OCS alarm profile 480

19.14 To assign an OCS alarm profile to objects 481

Alarm correlation 483

19.15 Alarm correlation in 1830 PSS 483
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Fault management

19.2 Overview

19.2.1 Fault detection and management

The fault management function detects, isolates, and corrects faults in a
telecommunication network. Alarm reporting is the notification sent to external
management systems for internally detected faults. The fault processing and alarm
reporting functions are part of the supervision function of the NE that monitors and
manages the NE transmission resources (for example, logical or physical facilities and
the associated equipment modules).

The 1830 PSS-32 / 1830 PSS-16 is provisioned on a per-port basis to detect faults and
report faults, failures, and performance information. Equipment faults can be diagnosed
down to an FRU or interface.

A system default alarm profile contains all of the alarms or conditions supported in the
system and their severity, that is, Critical, Major, or Minor. The user can change the
severity of alarms on each port or facility independently or point to the system profile.
The system profile can be modified or reset to the original defaults.

NFM-P correlates the events and alarms against the managed equipment and
configured services and policies. NFM-P applies the alarms to the appropriate
equipment and services. A correlated alarm is an alarm that causes fault conditions for
many objects. For example, if an alarm occurs because a port goes down, all services
that use the port receive a notification of the alarm.

You can view the alarm from the service configuration form or from the subscriber
information form that lists the affected service. The object information forms contain a
faults tab, which lists the alarms that affect the object. The alarms appear in the alarm
list. See the 1830 Photonic Service Switch 36/32/16 Product Information and Planning
Guide, the NSP NFM-P User Guide, and the NSP NFM-P Troubleshooting Guide for
more information about fault and alarm management. See the NSP NFM-P Alarm
Reference for a list of the alarms that NFM-P can generate against the 1830 PSS.

19.2.2 User activity logging

NFM-P logs each GUI and OSS user action, such as 1830 PSS object configuration, in
NFM-P database. The User Activity form lists the recent actions; older actions are
purged according to the configured retention limits. For more information about the user
activity log and configuring the log retention, see the NSP NFM-P System Administrator
Guide.
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RCA audit

19.3 Overview

19.3.1 Performing RCA audit

NFM-P allows you to perform RCA audits on optical links for which the MTU of each
endpoint can be determined. The RCA audit policy for physical ports of physical link
needs to be configured before performing an RCA audit. See 19.4 “To configure an RCA
audit policy” (p. 465) for more information about configuring an RCA audit policy and
19.5 “To perform an RCA audit of an optical link” (p. 466) for more information about
performing an RCA audit.

19.4 To configure an RCA audit policy

19.4.1 Steps

1

Choose Policies→RCA Audits from NFM-P main menu. The RCA Audits form opens.

2

Select Audit Policy (RCA) from the object drop down list and click Create. The Audit
Policy (Create) form opens.

3

Configure the required parameters.

4

Select a policy type and click OK. The new RCA audit policy is listed in the RCA
Audits form.

5

Choose the new RCA audit policy and click Properties. The Audit Policy (Edit) form
opens.

6

Configure the required parameters.

7

Save your changes and close the forms.

END OF STEPS

NFM-P Overview

Release 17.3
April 2017
Issue 2 4653HE-12002-AAAA-TQZZA



19.5 To perform an RCA audit of an optical link

19.5.1 Steps

1

Choose Manage→Equipment→Equipment from NFM-P main menu. The Manage
Equipment form opens.

2

Select Optical Link (Optical Management) from the object drop down list and click
Search. A list of optical links appears.

3

Choose an optical link and click Properties. The Optical Link (Edit) form opens.

Note: Ensure that you choose an optical link for which the MTU (bytes)
parameter is configured on the General tab of the Physical Port (Edit) forms for
the endpoints.

4

Click on the RCA Audit button. The Select RCA Policy to run the audit form appears
with a list of configured policies.

5

Choose a the policy that you configured in 19.4 “To configure an RCA audit policy”
(p. 465) and click OK.

NFM-P perform the audit and the Info form opens with the audit results.

6

Click OK. The RCA Result tab appears only if there are any issues found during the
audit.

7

Click on the RCA Result tab. The RCA audit information is displayed on the Related
Problem tab.

8

If required, expand the Optical Link object in the problems tree to view the problems,
the associated severity, and the cause.
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9

Double-click on a problem object on the navigation tree, to display information about
the problem. The Problem (Edit) form opens.

The following information is displayed:

• Last Time Changed

• Probable Cause

• Severity

• Description

• Solution

10

Click on the Related Problem tab to view related problems.

Note: NFM-P does not provide a solution for optical link configuration errors.

11

Click on the Caused By Objects tab to view a list of objects that are causing the
problem.

12

Choose an object and click Properties. The properties form for the object opens.

13

Click on the tabs to view information about the configuration.

14

Configure the parameters, as required.

15

Save your changes and close the forms.

END OF STEPS
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Alarm management

19.6 Overview

19.6.1 Alarm-based fault management system

The alarm-based fault management system provides the following:

• correlation of alarms with equipment- and service-affecting faults

• updates to the managed-object operational status of equipment, services, and
interfaces in near-real-time

• alarm policy control that allows a network administrator to specify how to process
alarms, and how to create and store the alarm logs

• point-and-click alarm management using NFM-P GUI dynamic alarm list and object
properties forms

• ability to log the actions performed to correct the associated fault by adding notes to
the alarm

• alarm history for performing trend analysis

See the NSP NFM-P User Guide, the NSP NFM-P Alarm Reference, and 1830 Photonic
Service Switch 36/32/16 User Provisioning Guide for more information.

19.6.2 Alarm suppression

NFM-P does not generate alarms if several SNMP traps are sent in quick succession for
the same type of event. The alarms are not generated to prevent alarm storms during
intermittent outages in the network caused by bouncing NEs; for example, when links go
up and down rapidly. NFM-P continues to resynchronize the network and, if the 1830
PSS continues to send down state SNMP traps, NFM-P eventually receives the trap and
generates the appropriate alarm.

To indicate how often an alarm is generated, the number of occurrences of each
instance of the alarm is tracked within the alarm record of the initial alarm. Click on the
Statistics tab of an individual Alarm Info form to display how often the alarm was
generated. See the NSP NFM-P User Guide for more information.

Note: NFM-P displays the alarm description and entity type in the additional text field for
the 1830 PSS alarms.

19.6.3 View alarmed object

Alarms generated for network objects allow you to view faults on the 1830 PSS devices
in the network down to the service, path, or port level. NFM-P analyzes incoming alarms
to ensure that the alarms are listed for the appropriate equipment or service. You can
troubleshoot an equipment or service problem using the information. Click on the View
Alarmed Object button in the Alarm Info form to navigate to the properties form of the
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alarmed object. See “ Alarm management workflow and procedures” in the NSP NFM-P
User Guide for more information.

19.6.4 Timestamp

The First Time Detected and Last Time Detected parameters on the Alarm Info form
displays the timestamp of the first and last detections of the alarm on the 1830 PSS
device.

19.6.5 Resynchronization of alarms

NFM-P allows you to resynchronize the active alarms by choosing Resync All Active
Alarms from the Resync contextual menu option at the NE level.

19.6.6 Environmental alarms

NFM-P supports the configuration of the environmental alarm parameters on the User
Interface Panel card for the 1830 PSS-32 or 1830 PSS-16 devices and on the PF card
for 1830 PSS-4 devices.

19.7 To configure environmental alarms

19.7.1 Steps

1

Perform one of the following depending on the 1830 PSS device:

a. On the equipment tree expand, Network→1830 PSS→Shelf→Card Slot (PF)

b. On the equipment tree expand, Network→1830 PSS→Shelf→Card Slot (User
Interface Panel)

Note: Choose the PF card for the 1830 PSS-4 devices.
Choose the USRPNL card for the 1830 PSS-32, 1830 PSS-16, and 1830
PSS-8 devices.

2

Right-click on a Card Slot and choose Properties. The Card Slot (Edit) form opens.

3

Click on the Environmental Alarms tab. The Environmental Alarms Configuration tab
appears with the ports displayed.

Note: The number of ports displayed depends on the device type:
• 1830 PSS-32—eight ports
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• 1830 PSS-16—six ports

• 1830 PSS-8—six ports

• 1830 PSS-4—three ports

4

Choose a port and click Properties. The Control Point Input (Edit) form opens.

5

Configure the required parameters.

Note: The change in the alarm message immediately changes the alarm
description text of the generated alarms.

6

Save your changes and close the forms.

END OF STEPS
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Alarm profile and severity — WDM devices

19.8 Alarm severity

19.8.1 Alarm severity configuration

Alarm status for the network is indicated in the navigation tree, the dynamic alarm list,
and on the topology maps. You can use the navigation tree to view the status of an alarm
generated for a specific object and to view the aggregated alarm status. The status is
also available on the Faults tab of an object property form. Alarm severity profiles can be
configured at the NE, shelf, card slot, and interface level. See “ Alarm status, severity,
and aggregation” in the NSP NFM-P User Guide for more information.

NFM-P displays the severity of an alarm based on the severity on the 1830 PSS device.
The default severity of an alarm is Indeterminate on NFM-P. When the severity of an
alarm changes on the 1830 PSS device, the alarm with the previous severity is cleared
and an alarm is generated on the 1830 PSS device with a new severity. Similarly, NFM-P
also clears the alarm and generates an alarm with the severity that matches the severity
of the alarm displayed on the 1830 PSS device. The alarm severity update occurs
because the Initial Severity Assignment parameter in the Policies tab of the Alarm
Settings form is set to Indeterminate.

The alarms generated on the 1830 PSS device with severity as Not Alarmed have a
severity of Warning on NFM-P. NFM-P allows you to hide and display the alarms raised
on the 1830 PSS device with severity as Not Alarmed. To display the alarms in the alarm
list of NFM-P, select the Enable NA Alarms check box on the Alarm Setting panel of the
NE Specifics tab in the Network Element properties form. To hide the alarms, deselect
the Enable NA Alarms parameter. The Enable NA Alarms parameter does not hide or
display the historical alarms.

You can change the alarm severity on an 1830 PSS device in one of the following ways:

• NE level; see 19.9 “To override an alarm severity at the NE level” (p. 472) .

• Equipment level; see 19.10 “To override an alarm severity at the equipment level”
(p. 474) .

• Object level; see 19.11 “To override an alarm severity at the object level” (p. 476) .

Overriding an alarm severity allows you to have different alarm severities at the NE,
equipment, or the object level. For example, an alarm profile with Category of EQPT and
Condition of mismatch, can have a severity of Critical at the NE level. At the same time,
it can have alarm severity of Major on a shelf instance.
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19.9 To override an alarm severity at the NE level

19.9.1 When to use

19.9.2 Steps

This procedure describes how to override an alarm severity at a NE level and distribute it
to the required local devices.

1

Choose Tools→1830 Alarm Profiles→1830 PSS Alarm Profiles from NFM-P main
menu. The 1830 PSS Alarm Profiles form opens.

2

Click Search. A list of alarm profiles appears.

3

Choose an alarm profile for which you want to override the severity and click
Properties. The Alarm Profile (Edit) form opens.

Figure 29 Override alarm severity at the NE level
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4

Configure the Override Severity parameter click Apply.

5

Click Switch Mode beside the Configuration Mode parameter. The Switch
Distribution Mode form opens.

6

Choose the sites from the Available Local Policies list and click on the right-arrow
button. The sites are listed in the Selected Local Policies list.

7

Click Distribute. The Status field in the Selected Objects list provides the status of
the distribution.

8

Save your changes and close the forms.

END OF STEPS
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19.10 To override an alarm severity at the equipment level

19.10.1 Introduction

You can override the severity of an alarm profile on the following objects:

• shelf

• card

• port

19.10.2 Steps

This procedure describes how to override an alarm severity at the object level.

1

Perform one of the following on the equipment navigation tree:

a. Expand to the required shelf level, right-click on the shelf object, and choose
Properties. The Shelf (Edit) form opens.

Figure 30 Override alarm severity at the equipment level
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b. Expand to the required card level, right-click on the card object, and choose
Properties. The Card Slot (Edit) form opens.

c. Expand to the required port level, right-click on the port object, and choose
Properties. The Physical Port (Edit) form opens.

2

Click on the Alarm Profile tab and click Create. The Select Alarm Category form
opens.

3

Choose a category and click OK. The Equipment Alarm Profile (Create) form opens.

4

Configure the Override Severity parameter and click OK.

5

Save your changes and close the forms.

END OF STEPS
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19.11 To override an alarm severity at the object level

19.11.1 When to use

You can override the severity of an alarm profile on the following objects:

• LAG

• Synchronization

• Line reference

• PTP

• VTS

This procedure describes how to override an alarm severity at the object level.

Figure 31 Override alarm severity at the object level
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19.11.2 Steps

1

Perform one of the following on the equipment navigation tree:

a. Expand to the required 11DPE12A or 11QPE24 card on which a LAG is
configured and perform the following:

1. Choose LAGs→LAG from the navigation tree.

2. Right-click on the LAG object and choose Properties. The LAG (Edit) form
opens.

3. Go to Step 2 .

b. Expand to the 11DPE12A, 11DPE12E, 11QPE24, or PTPCTL card on which
SyncE is enabled and perform the following:

1. Right-click on the card object and choose Properties. The Card Slot (Edit) form
opens.

2. Click on the Card Specifics tab.

3. Click on the Sync Alarm profile tab. A list of alarm profiles appears.

4. Go to Step 3 .

c. Expand to the 11DPE12A, 11DPE12E, 11QPE24, or PTPCTL card on which
SyncE is enabled and perform the following:

1. Right-click on the card and choose Properties. The Card Slot (Edit) form
opens.

2. Click on the Card Specifics tab.

3. Click on the Line Timing tab. A list of line references appears.

4. Choose a line reference from the list and click on Properties. The
LineReference (Edit) form opens.

5. Go to Step 2 .

d. Expand to the 11DPE12A or PTPCTL card on which PTP clock is enabled and
perform the following:

1. Right-click on the card and choose Properties. The Card Slot (Edit) form
opens.

2. Click on the PTP tab.

3. Click on the Clock tab. A list of clocks appears.

4. Choose a clock from the list and click on Properties. The IEEE 1588 PTP
Clock (Edit) form opens.

5. Go to Step 2 .

NFM-P To override an alarm severity at the object level

Release 17.3
April 2017
Issue 2 4773HE-12002-AAAA-TQZZA



e. Expand to the 11DPE12, 11DPE12A, or 11DPE12E card on which VTS map is
configured and perform the following:

1. Right-click on the port and choose Properties. The Physical Port (Edit) form
opens.

2. Click on the Alarm Profile tab.

3. Click on the VTS tab. A list of VTS alarm profiles appears.

4. Go to Step 3 .

2

Click on the Alarm Profile tab. A list of alarm profiles appears.

3

Choose an alarm profile for which you want to override the severity and click
Properties. The Alarm Profile (Edit) form opens.

4

Configure the Override Severity parameter and click OK. The Alarm Profile (Edit)
form closes and the Override Severity column is updated with the configured value in
the object properties form.

5

Save your changes and close the forms.

END OF STEPS
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Alarm profile and severity — OCS devices

19.12 Alarm severity assignment profiles

19.12.1 Conditions and condition severities

A condition is a generic term used to refer to a problem or status that is detected or
exists on a device. When a device declares a condition, the device determines if the
condition is service-effecting, using internal rules. The device provides the corresponding
severity from the provisioning data. There are two types of conditions: alarms and
events. See the Nokia 1830 Photonic Service Switch Product Information and Planning
Guide for more information about alarms and events.

19.12.2 ASAPs

Condition severities are managed by alarm severity assignment profiles (ASAPs).
NFM-P allows you to modify the severity of an alarm profile. However, you cannot modify
the severity of the default alarm profiles that are available on the 1830 PSS-36 and 1830
PSS-64 devices.

NFM-P supports one ASAP type for each entity with configurable severity. Each ASAP
type contains only those conditions that apply to the related entity.

Five system profiles are auto-created per entity type by the 1830 PSS OCS devices. Up
to 251 user-defined profiles can be created and assigned to alarm entities.

The following table lists the system-defined ASAP profiles.

Table 47 System-defined ASAP profiles

Instance Userlabel suffix Contains

0 None All conditions with severity “Not Reported”

1 SYSDFLT Factory default severities

2 NotPrimary Not primary conditions with severity disabled

3 FerfAis FERF and AIS conditions disabled

4 ALL All conditions enabled

NFM-P dynamically changes the ASAP profiles to match the state of the corresponding
service and trails.

If trails or services are created with ... then ASAP will be set to ...

Admin state UP and alarm profile attribute enabled ALL
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If trails or services are created with ... then ASAP will be set to ...

Admin state DOWN and alarm profile attribute
enabled

default values available on ports

Admin state UP and alarm profile attribute disabled default values available on ports

Admin state DOWN and alarm profile attribute
enabled

default values available on ports

19.13 To configure an OCS alarm profile

19.13.1 Steps

Create an OCS alarm profile

1

Choose Tools→1830 Alarm Profiles→1830 OCS Alarm Profiles from NFM-P main
menu. The 1830 OCS Alarm Profiles form opens.

2

Click Create. The OCS Alarm Profile (Create) form opens.

3

Configure the required parameters:

Note: The User Label parameter must not start with the prefix LBL-.
The ASAP Profile ID is not configurable if Auto-Assign ID is selected.

4

Click Apply. The form name changes from OCS Alarm Profile (Create) to OCS Alarm
Profile (Edit). Additional tabs appear on the OCS Alarm Profile (Edit) form depending
on the value configured for the ASAP Entity Type parameter in Step 3 .

Distribute an OCS alarm profile

5

Choose Tools→1830 Alarm Profiles→1830 OCS Alarm Profiles from NFM-P main
menu. The 1830 OCS Alarm Profiles form opens.

6

Choose the newly created alarm profile and click Switch Mode beside the
Configuration Mode parameter. A dialog box appears.
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7

Click Yes. The Release - 1830 OCS Alarm Profile form opens.

8

Choose the sites from the Available Objects list and click on the right-arrow button.
The sites are listed in the Selected Objects list.

9

Click Distribute. The Status field in the Selected Objects list provides the status of
the distribution.

10

Close the Release - 1830 OCS Alarm Profile form. The OCS Alarm Profile (Edit)
form reappears with the Configuration Mode parameter updated as Released.

Configure the alarm severity

11

Click on the OCS ASAP Condition tab. A list of available conditions appears.

12

Choose a condition from the list and click Properties. The OCS ASAP Condition
(Edit) form opens.

13

Configure the Severity parameter.

14

Click OK. The OCS ASAP Condition (Edit) form closes and the OCS Alarm Profile
(Edit) form reappears.

15

Click OK. The OCS Alarm Profile (Edit) form closes.

END OF STEPS

19.14 To assign an OCS alarm profile to objects

19.14.1 Before you begin

Ensure that the OCS alarm profile is configured and distributed to the required device
before assigning the profile to an object on the device. OCS alarm profiles can be
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configured on shelves, cards, ports, facility objects such as OMS, OTS, OMSOCHIF,
OTUODUk, OTUk, and IP interfaces such as ES1 ports. Additionally, you can also
configure the alarm profiles on the OT panels of the Port Specifics tab of the Physical
Port (Edit) form.

19.14.2 Steps

1

Choose Equipment from the navigation tree view selector and expand to the
required object on the navigation tree.

2

Right-click on the object and choose Properties. The properties form of the object
opens.

3

Select an ASAP profile in the Alarm Profile panel.

Note: Depending on the type of object you are configuring the alarm profile on,
the Alarm Profile parameter appears on different tabs or panels on the
properties form.

4

Click OK. The properties form closes.

END OF STEPS
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Alarm correlation

19.15 Alarm correlation in 1830 PSS

19.15.1 Overview

NFM-P fault management application supports viewing the graphical representation of
alarm correlation. Click on the Alarm List, right-click on the specific alarm in the list, and
choose Show Impact from the drop-down menu to display the impact diagram.

The 1830 PSS alarm correlation diagram provides the graphical representation of the
impacted objects in the OTN layer when a fault occurs.

For example, when a port goes out of service due to an optical link failure, the
LossOfSignal alarm is reported to NFM-P on the port and the fault management
application correlates the LossOfSignal alarm to the LinkDown alarm which in-turn
correlates the alarm to the OTN layers above it (that is, OTU, OCH, or OTS). The
process continues up to the transport service layer, if a transport service is configured.

The alarm correlation continues up to the L2 or L3 service if a specific SR port is
involved in both optical transport service and L2 or L3 service.

In the Figure 32, “Alarm correlation in 1830 PSS” (p. 484), one LinkDown alarm is
correlated to multiple OTUTrailDown alarms because all of the OTU trails ride on the
optical link.
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Figure 32 Alarm correlation in 1830 PSS
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Part X: 1830 PSS policy management

Overview

Purpose

This part contains information about QoS and ACL IP filter policies.

Contents

Chapter 20, 1830 PSS QoS policy 487

Chapter 21, 1830 PSS ACL IP filter 499
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20 1830 PSS QoS policy

20.1 Overview

20.1.1 Purpose

This chapter contains information about QoS policy management on the 1830 PSS
device. It also describes the procedures to configure 1830 PSS QoS local policies.

20.1.2 Contents

20.1 Overview 487

QoS policy management on the 1830 PSS 488

20.2 Configuring QoS policies 488

Procedures to configure 1830 PSS QoS local policies 490

20.3 To configure an 1830 PSS access ingress local policy 490

20.4 To configure an 1830 PSS network local policy 492

20.5 To configure an 1830 PSS port access egress local policy 493

20.6 To configure an 1830 PSS port scheduler local policy 495

20.7 To configure an 1830 PSS network queue local policy 495

20.8 To configure an 1830 PSS WRED slope local policy 497

20.9 To associate a slope policy with a port 498
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QoS policy management on the 1830 PSS

20.2 Configuring QoS policies

20.2.1 Overview

You can create, modify, or delete local policies.

You can perform the following configurations for global policies using NFM-P policy
framework:

• create and distribute the global policies to the 1830 PSS devices

• modify and distribute the modified global policies to the 1830 PSS devices

• delete global policies. If a global policy exists as a local policy on an 1830 PSS device,
the local policy is also deleted.

NFM-P supports configuration of QoS policies for the following cards:

• 11OPE8

• 11QCE12X

• 11QPE24

The global policy is distributed to all the supported cards on the 1830 PSS device. You
cannot distribute to a specific card. See “ NE routing and forwarding” and “ QoS policies”
in the NSP NFM-P User Guide for distribution information and QoS policy procedures.

NFM-P supports enabling or disabling ingress and egress frame based accounting on
the Network→NE→Shelf→Card Slot→Card Slot (Edit) form→Policies tab→Frame
Based Accounting tab. When enabled, this feature allows QoS policies to account for the
Ethernet frame overhead. When disabled, the queue rates and egress rates do not
account for the Ethernet frame overhead. By default, frame based accounting is disabled
for both ingress and egress.

20.2.2 QoS policies

NFM-P supports the following types of 1830 PSS QoS policies:

• Access Ingress

• Port Access Egress

• Network

• Network Queue

• Port Scheduler

• Slope

For QoS global policy procedures, see “ QoS policies procedures” in the NSP NFM-P
User Guide.
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Table 48 Policies references

Topics Chapter Document

Policies overview Policies overview NSP NFM-P User Guide

Policies procedures Policies overview NSP NFM-P User Guide

QoS policies overview QoS policies NSP NFM-P User Guide

Table 49 1830 PSS QoS policies

Policy type Applied to Menu option

7210 and 1830 SAP
Access Ingress

Access SAP Policies→QoS→SROS QoS→Access Ingress→7210 and 1830
SAP Access Ingress.

See Procedure “To configure a 7210 and 1830 access ingress
policy” in the NSP NFM-P User Guide for information about how to
configure the global policy.

7210 and 1830 Port
Access Egress

Access port SAP
egress

Policies→QoS→SROS QoS→Access Egress→7210 and 1830
Port Access Egress.

See Procedure “To configure a 7210 and 1830 port access egress
policy” in the NSP NFM-P User Guide for information about how to
configure the global policy.

7210 and 1830 Network Network port Policies→QoS→SROS QoS→Network→7210 and 1830 Network.

See Procedure “To configure a 7210 and 1830 network policy” in
the NSP NFM-P User Guide for information about how to
configure the global policy.

Uplink port

7210 and 1830 Network
Queue

Uplink port Policies→QoS→SROS QoS→Network Queue→7210 and 1830
Network Queue.

See Procedure “To configure a 7210 and 1830 network queue
policy” in the NSP NFM-P User Guide for information about how to
configure the global policy.

7210 and 1830 Port
Scheduler

Access and uplink
ports

Policies→QoS→SROS QoS→Scheduler→7210 and 1830 Port
Scheduler.

See Procedure “To configure a 7210 and 1830 port scheduler
policy” in the NSP NFM-P User Guide for information about how to
configure the global policy.

7210 and 1830 Slope Access and uplink
ports

Policies→QoS→SROS QoS→Slope→7210 and 1830 Slope.

See Procedure “To configure a 7210 and 1830 slope policy” in the
NSP NFM-P User Guide for information about how to configure
the global policy.

NFM-P Configuring QoS policies

Release 17.3
April 2017
Issue 2 4893HE-12002-AAAA-TQZZA



Procedures to configure 1830 PSS QoS local policies

20.3 To configure an 1830 PSS access ingress local policy

20.3.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card.

2

Right-click on the card and choose Properties. The Card Slot (Edit) form opens.

3

Click on the Policies tab, then on the Access Ingress tab.

4

Click Create. The SAP Access Ingress, Local Policy (Create) form opens.

5

Configure the required parameters on the General tab.

Note: If you need to configure the required parameters for the IP match criteria
in Step 8 , set the IP Match Criteria type parameter to Any.

Configure meter

6

Click on the Meter tab.

1. Click Create. The Meter, SAP Access Ingress, Local Policy (Create) form opens.

2. Configure the required parameters on the General tab.

3. Configure the required parameters on the CIR/PIR tab.

Note:

Select the MAX check box to configure the CIR and PIR parameters to MAX.

4. Configure the required parameters on the Burst Size tab.

Note:

Select the MAX check box to configure the Admin Cbs and Admin Mbs
parameters to MAX.

5. Save your changes and close the form.
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Configure forwarding class

7

Click on the Forwarding Classes tab.

1. Click Create. The Forwarding Class, SAP Access Ingress, Local Policy (Create)
form opens.

2. Configure the required parameters and click OK.

3. Save your changes and close the form.

Configure IP, MAC, or IPv6 match criteria

8

Perform one of the following:

a. Click on the IP Match Criteria tab.

1. Click Create. The IP Match, SAP Access Ingress, Local Policy (Create) form
opens.

2. Configure the required parameters.

Note:

If you need to configure the required parameters for the IP match criteria, set
the IP Match Criteria type parameter to Any in Step 5 .

The Protocol parameter must be set to TCP or UDP to configure the required
parameters in the Port Properties panel.

3. Save your changes and close the form.

b. Click on the MAC Match Criteria tab.

1. Click Create. The MAC Match, SAP Access Ingress, Local Policy (Create) form
opens.

2. Configure the required parameters.

3. Save your changes and close the form.

c. Click on the IPv6 Match Criteria tab.

1. Click Create. The IPv6 Match, SAP Access Ingress, Local Policy (Create) form
opens.

2. Configure the required parameters.

Note:

If you want to configure the required parameters for IPv6 Match Criteria, set
the Allow any IPV6 Match parameter to true and the IPV6 Match Criteria type
to Any in Step 5 .

The Protocol parameter must be set to TCP or UDP to configure the required
parameters in the Port Properties panel.
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3. Save your changes and close the form.

9

Save your changes and close the forms.

END OF STEPS

20.4 To configure an 1830 PSS network local policy

20.4.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card.

2

Right-click on the card and choose Properties. The Card Slot (Edit) form opens.

3

Click on the Policies tab, then on the Network tab.

4

Click Create. The Network Policy, Local Policy (Create) form opens.

5

Configure the required parameters on the General tab.

6

Click on the Egress Forwarding Classes tab.

7

Choose a forwarding class and click Properties. The Egress Forwarding Class,
Network Policy (Create) form opens.

8

Configure the required parameters and click OK.

9

Map the dot1p tag of the ingress traffic to the ingress queue ID, if required in the
Network Policy, Local Policy (Create) form.

1. Click on the Ingress Dot1p tab.

2. Click Create. The Network Ingress Dot1p, Network Policy (Create) form opens.
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3. Configure the required parameters and click OK.

4. Repeat Step 9 for each new rule that you need to add. You can configure up to
eight rules.

10

Create network ingress meters in the Network Policy, Local Policy (Create) form.

1. Click on the Ingress Meter tab, then click Create. The Network Ingress Meter
(Create) form opens.

2. Configure the required parameters on the General tab.

Note:

You cannot enter the values 1 and 9 for the ID parameter because they are
created by default and cannot be deleted. Enter any value up to 12 other than 1
and 9.

Set the parameter to true for multicast meters or false for unicast meters.

3. Click on the CIR/PIR tab and configure the required parameters.

4. Click on the Burst Size tab and configure the required parameters.

5. Save your changes and close the form.

6. Repeat 1 to 5 to create additional network ingress meters. You can create up to
nine network ingress meters.

11

Assign the forwarding classes to specific network ingress meters.

1. Click on the Ingress FCMeter tab, then click Create. The Network Ingress
Forwarding Class (Create) form opens.

2. Configure the required parameters and click OK.

3. Save your changes and close the form.

4. Repeat 1 to 3 to assign additional forwarding classes to the network ingress
meters.

12

Save your changes and close the forms.

END OF STEPS

20.5 To configure an 1830 PSS port access egress local policy

20.5.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card.
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2

Right-click on the card and choose Properties. The Card Slot (Edit) form opens.

3

Click on the Policies tab, then on the Port Access Egress tab.

4

Click Create. The Port Access Egress Policy, Local Policy (Create) form opens.

5

Configure the required parameters on the General tab.

6

Click on the Queues tab.

7

Choose a queue and click Properties. The Port Access Egress Queue (Edit) form
opens.

8

Configure the required parameters on the General tab.

9

Click on the CIR/PIR tab and configure the required parameters.

10

Save your changes and close the form.

11

Repeat Step 7 to Step 10 to configure additional queues.

12

Click on the Forwarding Classes tab.

13

Click Create. The Network Egress Forwarding Class (Create) form opens.

14

Configure the required parameters and click OK.
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15

Save your changes and close the forms.

END OF STEPS

20.6 To configure an 1830 PSS port scheduler local policy

20.6.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card.

2

Right-click on the card object and choose Properties. The Card Slot (Edit) form
opens.

3

Click on the Policies tab, then on the Port Scheduler tab.

4

Click Create. The Port Scheduler, Local Policy (Create) form opens.

5

Configure the required parameters on the General tab and click OK.

6

Save your changes and close the forms.

END OF STEPS

20.7 To configure an 1830 PSS network queue local policy

20.7.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card.

2

Right-click on the card and choose Properties. The Card Slot (Edit) form opens.
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3

Click on the Policies tab, then on the Network Queue tab.

4

Click Create. The Network Queue, Local Policy (Create) form opens.

5

Configure the required parameters on the General tab.

6

Click on the Queues tab.

7

Choose a queue and click Properties. The NQueue Entry (Edit) form opens.

8

Configure the required parameters on the General tab.

9

Select a queue management policy in the Queue Management Policy panel.

10

Select a slope policy in the Slope Policy panel.

11

Configure the required parameters in the Port Parent panel.

12

Click on the CIR/PIR tab and configure the required parameters.

13

Click on the Burst Size tab and configure the required parameters.

14

Repeat Step 7 to Step 13 to configure additional queues.

15

Save your changes and close the forms.

END OF STEPS
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20.8 To configure an 1830 PSS WRED slope local policy

20.8.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card.

2

Right-click on the card and choose Properties. The Card Slot (Edit) form opens.

3

Click on the Policies tab, then on the Slope tab.

4

Click Create. The WRED Slope Policy, Local Policy (Create) form opens.

5

Configure the required parameters on the General tab.

6

Click on the Queue Slope tab.

Note: When a slope policy is created, the policy uses the parameters of the
default policy. You can modify the parameters on the new policy.

7

Choose a queue and click Properties. The Queue Slope, Slope Policy (Create) form
opens.

8

Configure the required parameters and click OK.

9

Save your changes and close the forms.

END OF STEPS
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20.9 To associate a slope policy with a port

20.9.1 Before you begin

Before you perform the procedure, ensure that the port is assigned with a rate.

20.9.2 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card→Port.

2

Right-click on the port and choose Properties. The Physical Port (Edit) form opens.

3

Click on the QoS Pool tab. The QoS buffer pools appear on the form.

4

Choose an entry and click Properties. The QoS Pool (Edit) form opens.

5

Select a slope policy in the Slope Policy panel.

6

Save your changes and close the forms.

END OF STEPS
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21 1830 PSS ACL IP filter

21.1 Overview

21.1.1 Purpose

This chapter provides information about 1830 PSS ACL IP filters

21.1.2 Contents

21.1 Overview 499

21.2 1830 PSS ACL IP filter 499

21.3 Workflow to configure 1830 PSS WDM ACL IP filtering 500

21.4 To enable ACL configuration on an 1830 PSS 501

21.5 To create an 1830 PSS ACL IP pattern 501

21.6 To create an 1830 PSS ACL IP filter 502

21.7 To assign an ACL IP filter to a port 503

21.8 To configure an 1830 PSS OCS ACL IP filter 504

21.2 1830 PSS ACL IP filter

21.2.1 Overview

ACL filters are used by routers and switches to allow or deny data into or out of a
network interface. When an ACL is configured on an interface, the network device
analyzes the data that passes through the interface, compares it to the configuration set
in the ACL pattern, and allows or denies the data into or out of the interface.

NFM-P supports the creation and management of the ACL IP filters. The main elements
of the 1830 PSS ACL IP filtering process are patterns, filters, and port-to-ACL-filter
associations. Patterns contain the criteria for traffic filtering, such as source IP, source
port, destination IP, destination port, protocol, and so on. ACL filters are the ordered lists
of ACL patterns. You can assign a maximum of two filters to each ACL-applicable port,
one in the receive direction and one in the transmit direction.
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Table 50 Cards and ports that support ACL IP filtering

Cards Ports 1

OT ports with GCC enabled Ports supporting GCC

A2325A, AHPHG, AHPLG, ALPHG, AM2017B,
AM2325B

OSC

EC (PSS-4) OAMP

MTC1T9, MXEC320H E1, E2, OAMP

USRPNL E1, E2, OAMP, VOIP

Notes:

1. If a port is unassigned, the ACL IP Filters tab does not appear in the Physical Port
(Edit) form.

21.3 Workflow to configure 1830 PSS WDM ACL IP filtering

21.3.1 Workflow

The workflow to configure the WDM ACL IP filter is described in this topic.

21.3.2 Stages

1

Enable ACL configuration on an 1830 PSS device. See 21.4 “To enable ACL
configuration on an 1830 PSS” (p. 501) .

2

Create an ACL IP pattern. See 21.5 “To create an 1830 PSS ACL IP pattern”
(p. 501) .

3

Create an ACL IP filter. See 21.6 “To create an 1830 PSS ACL IP filter” (p. 502) .

4

Assign an ACL IP filter to a port. See 21.7 “To assign an ACL IP filter to a port”
(p. 503) .

Workflow to configure 1830 PSS WDM ACL IP filtering NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

500 Issue 2



21.4 To enable ACL configuration on an 1830 PSS

21.4.1 Steps

1

On the equipment tree, expand Network→1830 PSS.

2

Right-click on the 1830 PSS and choose Properties. The Network Element (Edit)
form opens.

3

Click on the ACL tab.

4

Configure the required parameters in the System Defaults panel.

5

Select the ACL Configuration via SNMP Enabled check box.

6

Save your changes and close the form.

END OF STEPS

21.5 To create an 1830 PSS ACL IP pattern

21.5.1 Steps

1

Choose Policies→Filter→PSS ACL IP Filter from NFM-P main menu. The PSS ACL
Filter Policies form opens.

2

Click Create and choose Create ACL IP Pattern. The ACL Pattern, Global Policy
(Create) form opens.

3

Configure the required parameters on the General tab.
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4

Click Apply to save the changes.

5

Click Switch Mode beside the Configuration Mode parameter. A dialog box appears.

6

Click Yes. The Release - 1830 PSS ACL IP Pattern form appears.

7

Choose the sites from the Available Objects list and click on the right-arrow button.
The sites are listed in the Selected Objects list.

8

Click Distribute. The Status field in the Selected Objects list provides the status of
the distribution.

9

Save your changes and close the forms.

END OF STEPS

21.6 To create an 1830 PSS ACL IP filter

21.6.1 Steps

1

Choose Policies→Filter→PSS ACL IP Filter from NFM-P main menu. The PSS ACL
Filter Policies form opens.

2

Click Create and choose Create ACL IP Filter. The ACL Filter, Global Policy (Create)
form opens.

3

Configure the Filter Name parameter in the General tab and click Apply.

4

Click on the ACL Pattern Binding tab, then click Add Pattern. The ACL Pattern
Binding (Create) form opens.
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5

Select an ACL pattern in the Pattern panel.

6

Configure the Pattern Index parameter and click OK.

7

Click on the General tab.

8

Click Switch Mode beside the Configuration Mode parameter. A dialog box appears.

9

Click Yes. The Release - 1830 PSS ACL IP Filter form opens.

10

Choose sites from the Available Objects list and click on the right-arrow button. The
sites are listed in the Selected Objects list.

11

Click Distribute. The Status field in the Selected Objects list provides the status of
the distribution.

12

Save your changes close the forms.

END OF STEPS

21.7 To assign an ACL IP filter to a port

21.7.1 Before you begin

Ensure that the Administrative State of the port to which an ACL IP filter is assigned is
configured either as Up or Maintenance. Table 50, “Cards and ports that support ACL IP
filtering” (p. 500) lists the cards and ports that support ACL IP filtering.

21.7.2 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card→Port.

2
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Right-click on the port and choose Properties. The Physical Port (Edit) form opens.

3

Click on the ACL IP Filters tab.

Note: Unassigned ports do not display the ACL IP Filters tab.

4

Click Create. The IP Filter Cfg (Create) form opens.

5

Configure the Direction parameter.

6

Select a filter in the Filter ID panel.

7

Select the Filter Enabled check box.

8

Save your changes and close the forms.

END OF STEPS

21.8 To configure an 1830 PSS OCS ACL IP filter

21.8.1 Steps

1

Choose Policies→Filter→PSS ACL IP Filter from NFM-P main menu. The PSS ACL
Filter Policies form opens.

2

Choose OCS ACL IP Filter (Optical Access Control Lists) from the object drop-down
menu and click Search. A list of the default OCS ACL IP filters appears.

3

Choose a filter that you need to modify and click Properties. The OCS ACL IP Filter
(Edit) form opens.
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4

Click on the IP Filter Entries tab. A list of existing entries for the filter appears.

5

Click Create. The IP Filter Entry (Create) form opens.

6

Configure the required parameters.

7

Perform one of the following additional actions depending on the filter chosen in
Step 3 :

a. If you chose ICMP filter in Step 3 , configure the required parameters:

• ICMP Type

• ICMP Code

b. If you chose IP Forwarding filter in Step 3 , configure the required parameters:

• Internet Protocol

• Fragment

• Connection State

Note:

If you configured the Internet Protocol parameter as ICMP, configure the ICMP
Type and ICMP Code parameters.

If you configured the Internet Protocol parameter as TCP or UDP, configure the
Source Port Type and Destination Port Type parameters.

If you configured the Internet Protocol parameter as Others, enter the value in
the text box next to the Internet Protocol parameter.

c. If you chose any other filter in Step 3 , configure the Source Port Type parameter
in the Ports panel.

Note: If the Source Port Type parameter is configured as Others, enter the
value in the text box next to the Source Port Type parameter.

8

Save your changes and close the forms.

END OF STEPS
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Part XI: 1830 PSS network management

Overview

Purpose

This part provides you information about Ethernet OAM, IP routing, service tunnels and
MC LAGs.

Contents

Chapter 22, 1830 PSS Ethernet OAM 509

Chapter 23, 1830 PSS IP routing 543

Chapter 24, 1830 PSS service tunnels 563

Chapter 25, 1830 PSS MC LAG group 577
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22 1830 PSS Ethernet OAM

22.1 Overview

22.1.1 Purpose

This chapter contains information about Ethernet OAM diagnostics tests and Smart
SFP-RMD.

22.1.2 Contents

22.1 Overview 509

Ethernet OAM 511

22.2 Overview 511

Ethernet CFM tests 512

22.3 Overview 512

22.4 Components of Ethernet CFM 513

Ethernet CFM procedures 515

22.5 To configure Ethernet CFM 515

OAM diagnostic tests 519

22.6 Overview 519

OAM diagnostic test procedures 521

22.7 To configure Ethernet OAM fault management mode 521

22.8 To create and run an on-demand CFM loopback test 522

22.9 To create and run an on-demand CFM link trace test 523

22.10 To create and run an on-demand CFM one-way delay test 524

22.11 To create and run an on-demand and proactive CFM two-way delay
test

525

22.12 To create and run an on-demand and proactive CFM two-way SLM test 527

22.13 To create and run an on-demand CFM LM test 528

Smart SFP-RMD 530

22.14 Overview 530
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Procedures to configure RMD 531

22.15 To manually configure an RMD on a card 531

22.16 To automatically configure an RMD on a card 533

22.17 To reset the RMD 534

22.18 To configure the RMD ports 535

22.19 To configure Ethernet CFM for an RMD 536

22.20 To configure TSoP device types 538

MAC swap 540

22.21 Port loopback 540

22.22 To configure port loopback with MAC swap 540
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Ethernet OAM

22.2 Overview

22.2.1 General information

NFM-P supports Ethernet OAM on the following cards on the Ethernet optical transport
services adhering to standards such as 802.1ag, Y.1731, and 802.3ah:

• 11DPE12A

• 11DPE12E

• 11OPE8

• 11QCE12X

• 11QPE24

Ethernet OAM defines the OAM sublayer, which is used for monitoring link operations
such as remote fault indication and remote loopback control. The network operators can
monitor the health of the network and determine the location of failing links or fault
conditions. The EFM OAM provides data link layer mechanisms to complement
applications that may reside in higher layers.

The OAM information is transported in slow protocol frames which are called OAMPDUs.
The OAMPDUs contain the appropriate control and status information to monitor, test
and troubleshoot EFM OAM-enabled links. The OAMPDUs traverse a single link that is
passed between peer OAM entities, and are not forwarded by MAC clients (such as
bridges or switches), unless they are configured.

The following EFM OAM functions are supported on the 11DPE12A, 11DPE12E,
11OPE8, 11QCE12X, and 11QPE24 cards:

• EFM OAM capability discovery
• active and passive modes
• remote failure indication
• local and remote loopbacks

• EFM OAMPDU tunneling
• high-resolution EFM OAM timers (500 ms interval)
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Ethernet CFM tests

22.3 Overview

22.3.1 Ethernet CFM

Ethernet CFM supports end-to-end service management in an L2 network. The CFM
tools provide path discovery and fault detection, isolation and notification.

Table 51 Ethernet CFM test types and test objects in the Ethernet network level

Test type Network object or service component for test

CFM Loopback - 22.8 “To create
and run an on-demand CFM
loopback test” (p. 522)

SAP or Ethernet Ring Path End Point

CFM Link trace - 22.9 “To create
and run an on-demand CFM link
trace test” (p. 523)

CFM One Way Delay - 22.10 “To
create and run an on-demand
CFM one-way delay test” (p. 524)

CFM Two Way Delay - 22.11 “To
create and run an on-demand and
proactive CFM two-way delay test”
(p. 525)

CFM Two Way Synthetic Loss
Measurement (SLM) - 22.12 “To
create and run an on-demand and
proactive CFM two-way SLM test”
(p. 527)

CFM Loss Measurement (LM) -
22.13 “To create and run an
on-demand CFM LM test” (p. 528)

22.3.2 CFM diagnostics tests

The following CFM diagnostic tests detect connectivity failure.

CFM loopback

The CFM loopback messages are sent to a unicast destination MAC address. The MEP
at the destination responds to the loopback message with a loopback reply. A MEP or
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MIP can reply to a loopback message if the destination MAC address matches the MAC
address of the MEP or MIP. The CFM loopback tests verify connectivity to a specific
MEP or MIP.

CFM link trace

The CFM link trace messages that contain a target unicast MAC address are sent to
multicast destination MAC addresses. Each MIP at the same MD level replies with a link
trace response. Messages are forwarded to the next hop until they reach the destination
MAC address. The originating MEP collects the replies to determine the path.

CFM one-way delay

The CFM one-way delay test applies only to Y.1731 MEPs. The test originates on one
MEP and terminates on a target MEP. The results are read from the target MEP. In the
test, frame delay is defined as the time elapsed since the start of transmission of the first
bit of the frame by a source site until the frame is received by the destination site. The
frame delay represents the one-way trip time between the source and destination sites.

CFM two-way delay

The CFM two-way delay test applies only to Y.1731 MEPs. The frame delay is the time
elapsed since the start of transmission of the first bit of the frame by the source site until
the frame is received by the same site after passing through the destination site. The
frame delay represents the round-trip time between the source and destination sites.

CFM two-way SLM

The CFM two-way SLM test measures the synthetic loss which is used to check for
packet loss.

CFM LM

The CFM LM test measures the counter values applicable for ingress and egress service
frames where the counters maintain a count of transmitted and received data frames
between a pair of MEPs.

22.4 Components of Ethernet CFM

22.4.1 Maintenance domain (MD) or maintenance entity (ME)

A maintenance domain or maintenance entity defines the boundaries for connectivity
fault management. NFM-P supports none, DNS, MAC, and string formats for a
maintenance domain. The value of MD value for which varies from 0 to 7. The level of an
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MD distinguishes the administrators involved in monitoring a service and provides a
hierarchy among them. The hierarchy prevents CFM traffic from flowing from a low level
to flow to a high level.

22.4.2 Maintenance association (MA) or maintenance entity group (MEG)

A maintenance association or maintenance entity group includes a set of maintenance
end points. Each MEG in a network is identified by its ID which is composed of the MD
name and the MEG name of a particular format. The name of a MEG is 13 characters
long if the name format is icc-based.

22.4.3 Maintenance end points (MEP)

A maintenance end point initiates, processes, and terminates Ethernet CFM functions. A
MEP has two directions, up or down. The Up-MEP directs the traffic towards the switch
fiber and the Down-MEP directs the traffic towards the SAPs, away from the switch fiber.

NFM-P supports configuration of both Up-MEPs and Down-MEPs using Ethernet cards.
The Up-MEPs are configured on client ports to monitor services. The Up-MEPs supports
the configuration with an interval of one second or longer. Down-MEPs monitor links and
require a short interval like 3.3 ms. A Down-MEP is configured on each path of an
Ethernet ring.

Components of Ethernet CFM NFM-P
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Ethernet CFM procedures

22.5 To configure Ethernet CFM

22.5.1 Before you begin

Configure the Flow Continuity Monitoring parameter as CCM under the Card
Specifics→General tab of the 11DPE12A and 11DPE12E Card Slot (Edit) form, before
configuring the Ethernet CFM using the cards.

22.5.2 Steps

Configure MD and distribute to 1830 PSS

1

Choose Tools→Ethernet CFM→Maintenance Domain Policies from NFM-P main
menu. The Maintenance Domain Policies form opens.

2

Perform one of the following:

a. Modify an existing MD.

1. Configure a filter if required and click Search. A list of MDs appears.

2. Choose an MD and click Properties. The Maintenance Domain Global Policy
(Edit) form opens.

b. Create an MD.

1. Click Create. The Maintenance Domain - Global Policy (Create) form opens.

2. Configure the required parameters.

Note:

Configure Name Type parameter as none for creating a MEG with icc-based
Name Format parameter in Step 9 .

The MD Mgr Object ID and Maintenance Domain ID parameters need not be
configured if the respective Auto-Assign ID check box is selected.

3. Click Apply. The form displays additional tabs, and the form name changes to
Maintenance Domain Global Policy (Edit).

3

Click Switch Mode in the Policy Configuration panel. The Release - Maintenance
Domain form opens with the list of 1830 PSS devices available for distribution in the
Available Objects list.
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4

Choose one or more devices and click on the right arrow button. The device or
devices move to the Selected Objects list on the right side of the form.

5

Click Distribute. The 1830 PSS policy is distributed to the 1830 PSS device or
devices.

6

Close the Release - Maintenance Domain, Maintenance Domain (Edit), and
Maintenance Domain Policies forms. The Maintenance Domain Policies form
reappears with the newly configured MD.

Add global MEG to MD

7

Choose the newly configured MD and click Properties. The Maintenance Domain -
Global Policy (Edit) form opens.

8

Click on the Global Maintenance Entity Group tab and click Create. The Global
Maintenance Entity Group (Create) form opens.

9

Configure the required parameters.

10

Configure the Name Format and Name parameters in the Maintenance Entity Group
panel. If you set the Name Format parameter to icc-based, the associated name
must be 13 characters long.

Note: Configure Name Type parameter in Step 2 as none for creating a MEG
with icc-based Name Format.

11

Configure the required parameters in the Initial MEG Configuration panel.

12

Click OK. The Global Maintenance Entity Group (Create) form closes, and the
Maintenance Domain - Global Policy (Edit) form reappears with the newly configured
global MEG.
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Associate 1830 PSS and service with global MEG

13

Choose a the newly configured global MEG and click Properties. The Global
Maintenance Entity Group (Edit) form opens.

14

Click on the NE Maintenance Entity Group tab and click Create. The NE
Maintenance Entity Group (Create) form opens.

15

Select an 1830 PSS device in the Site panel.

16

Select the supported OT in the Card/RMD panel.

17

Click on the Service tab and then on Create. The MEG Service (Create) form opens.

18

Configure the required parameters.

Note: Only the parameters that are supported on the selected card are
displayed when you open the MEG Service (Create) form.

19

Click OK. The MEG Service (Create) closes, and the service information is displayed
on the NE Maintenance Entity Group (Create) form.

20

Click OK to save the changes. The newly configured NE MEG appears in the NE
Maintenance Entity Group tab of the Global Maintenance Entity Group (Edit) form.

Configure MEP

21

Note: Ensure that you create an optical SubGigE service and associate it to
the MEG before creating a MEP, while using the 11DPE12A card.
Ensure that you create a VPLS service and associate it to the MEG before
creating a MEP, while using the 11QPE24, 11OPE8, and 11QCE12X cards.

Click on the Managed MEP tab and click Create. The MEP (Create) form opens.
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22

Configure the ID parameter.

23

Select the newly configured MD.

24

Configure the required parameters.

The values for the Interface Type parameter are:

• Port and LAG for 11DPE12A card

• SAP and Ethernet Ring Path End Point

25

Configure the port, SAP, LAG, or Ethernet ring path endpoint in the respective
panels based on the value configured for the Interface Type parameter.

26

Choose an entry and click OK. The Select MEP form closes and the MEP (Create)
form reappears.

27

Click OK. The MEP (Create) form closes and the NE Maintenance Entity Group
(Edit) form reappears with the newly configured MEP.

Add remote MEP to NE MEG

28

Click on the Remote MEP tab in the NE Maintenance Entity Group (Edit) form. and
click Create. The Remote MEP (Create) form opens.

29

Configure the MEP ID parameter. The Remote MEP (Create) form closes and the
NE Maintenance Entity Group (Edit) form reappears.

30

Save your changes and close the forms.

END OF STEPS
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OAM diagnostic tests

22.6 Overview

22.6.1 Proactive and on-demand OAM tests

The proper delivery of services requires that a number of operations must occur correctly
at different levels in the service. For example, operations such as the association of
packets to a service, VC labels to a service, and each service to a service tunnel, must
be performed successfully for the service to pass traffic to subscribers according to
SLAs. To verify that a service is operational and that configuration information is correct,
a set of configurable in-band or out-of-band, packet-based OAM tools is available.

You can create and schedule the execution of OAM tests using NFM-P Service Test
Manager, or STM.

The prerequisites for running the CFM tests are:

• Choose CCM option for the Flow Continuity Monitoring parameter on the Card
Specifics→General tab of the Card Slot (Edit) form.

• Configure an Ethernet CFM MD and subordinate objects associated with the MD such
as a Global MEG, MEG, and MEP. See 22.5 “To configure Ethernet CFM” (p. 515) .

Proactive OAM tests are carried out for proactive reporting of fault or performance
results. On-demand OAM tests are initiated by manual intervention for a limited time to
carry out diagnostics. On-demand OAM can result in single or periodic OAM actions
during the diagnostics time interval. The Proactive OAM tests are configured in NFM-P
by enabling the NE Schedulable parameter on the CFM test (Create) forms.

Table 52 Proactive OAM tests and supported cards

CFM tests Supported cards

CFM two-way delay 11DPE12A

11OPE8

11QCE12X

11QPE24

CFM two-way SLM 11DPE12A

11OPE8

11QCE12X

11QPE24
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Table 53 On-demand OAM tests and supported cards

CFM tests Supported cards

CFM loopback 11DPE12A

11OPE8

11QCE12X

11QPE24

CFM link trace 11OPE8

11QCE12X

11QPE24

CFM one way delay 11DPE12A

CFM two way delay 11DPE12A

11OPE8

11QCE12X

11QPE24

CFM two way SLM 11DPE12A

11OPE8

11QCE12X

11QPE24

CFM LM 11DPE12A
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OAM diagnostic test procedures

22.7 To configure Ethernet OAM fault management mode

22.7.1 When to use

Perform the following procedure to configure the Ethernet OAM fault management mode
and the Ethernet CFM redundancy on the following cards:

• 11OPE8

• 11QCE12X

• 11QPE24

22.7.2 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card.

2

Right-click on the card and choose Properties. The Card Slot (Edit) form opens.

3

Click on the OAM tab and configure the required parameters on the Ethernet CFM
Redundancy panel.

4

Configure the Fault Management Mode parameter on the Ethernet OAM Fault
Management panel.

Note: Select IEEE for configuring the IEEE 802.1ag compliant fault
management mode. Select ITU-T for configuring the ITU-T G.8021 compliant
fault management mode.

5

Click OK. The Card Slot (Edit) form closes.

END OF STEPS
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22.8 To create and run an on-demand CFM loopback test

22.8.1 Steps

Note: The maximum number of continuous CFM loopback tests that can be run is 300,
provided that the SAA packet per second rate of 200 pps is not exceeded. The total
number of continuous tests must share this maximum rate of 200 pps.

Perform this procedure to manually create and run a CFM loopback test. You can create
multiple CFM loopback tests for an originating MEP.

1

Choose Tools→Service Test Manager (STM) from NFM-P main menu. The Service
Test Manager form opens.

2

Click Create and choose Ethernet CFM→CFM Loopback. The CFM Loopback Test
(Create) form opens

3

Configure the required parameters.

4

Deselect the NE Schedulable check box.

5

Select a global MEG in the Test Object panel. The MEG information is displayed.

6

Select an originating MEP for the global MEG in the Test Object panel. The MEP
information is displayed.

7

Perform one of the following:

a. Select a MEP as the test destination in the MEP Transmit Information panel.

b. Select a MIP as the test destination in the MEP Transmit Information panel.

c. Select an unmanaged MEP as the test destination in the MEP Transmit
Information panel.

8

Configure the required parameters in the MEP Transmit LBM Information panel.
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9

Click Apply to save the changes.

10

Click Execute and perform the test.

11

Click on the Results tab to view the test results.

END OF STEPS

22.9 To create and run an on-demand CFM link trace test

Note: The maximum number of continuous CFM link trace tests that can be run is 300,
provided that the SAA packet per second rate of 200 pps is not exceeded. The total
number of continuous tests must share this maximum rate of 200 pps.

However, it is recommended that number of continuous CFM link trace tests run should
be kept well below the maximum allowed limit.

22.9.1 Steps

1

Choose Tools→Service Test Manager (STM) from NFM-P main menu. The Service
Test Manager form opens.

2

Click Create and choose Ethernet CFM→CFM Link Trace from the Create contextual
menu. The CFM Link Trace Test (Create) form opens

3

Configure the required parameters.

4

Deselect the NE Schedulable check box.

5

Select a global MEG in the Test Object panel. The MEG information is displayed.

6

Select an originating MEP for the global MEG in the Test Object panel. The MEP
information is displayed.
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7

Perform one of the following:

a. Select a MEP as the test destination in the MEP Transmit Information panel.

b. Select a MIP as the test destination in the MEP Transmit Information panel.

c. Select an unmanaged MEP as the test destination in the MEP Transmit
Information panel.

8

Configure the TTL parameter in the MEP Transmit LTM Information panel.

9

Click Apply to save the changes.

10

Click Execute to perform the test.

11

Click on the Results tab to view the test results.

END OF STEPS

22.10 To create and run an on-demand CFM one-way delay test

22.10.1 Steps

1

Choose Tools→Service Test Manager (STM) from NFM-P main menu. The Service
Test Manager form opens.

2

Click Create and choose Ethernet CFM→CFM One Way Delay Test. The CFM One
Way Delay Test (Create) form opens.

3

Configure the required parameters.

4

Select a global MEG in the Test Object panel. The MEG information is displayed.
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5

Select an originating MEP for the global MEG in the Test Object panel. The MEP
information is displayed.

6

Click Apply. The form displays additional buttons and tabs.

7

Click Execute to run the test.

8

Click on the Results tab to view the test results.

END OF STEPS

22.11 To create and run an on-demand and proactive CFM two-
way delay test

22.11.1 Steps

Note: You can run up to 300 continuous CFM two-way delay tests when you do not
exceed the SAA packet per second rate of 200 pps. The total number of continuous tests
must share this maximum rate of 200 pps.

1

Choose Tools→Service Test Manager (STM) from NFM-P main menu. The Service
Test Manager form opens.

2

Click Create and choose Ethernet CFM→CFM Two Way Delay Test. The CFM Two
Way Delay Test (Create) form opens.

3

Configure the required parameters.

Note: The NE Schedulable parameter is enabled for the proactive CFM two-
way delay test.
When the NE Schedulable parameter is enabled, two additional tabs Test
Parameters and Results Configuration appear in the form.

4

Select a global MEG in the Test Object panel. The MEG information is displayed.
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5

Select an originating MEP for the global MEG in the Test Object panel. The MEP
information is displayed.

6

Perform one of the following:

a. Select a MEP as the test destination in the MEP Transmit Information panel.

b. Select a MIP as the test destination in the MEP Transmit Information panel.

c. Select an unmanaged MEP as the test destination in the MEP Transmit
Information panel.

7

When the NE Schedulable parameter is enabled in Step 3, go to Step 10.
Otherwise, go to Step 8.

8

Configure the required parameters in the MEP Transmit DMM Information panel.

9

Go to Step 12.

10

Click on the Test Parameters tab and configure the required parameters in the
Execution Details panel.

11

Select a card TCA profile in the Card TCA Profile panel.

12

Click Apply to save the changes.

13

Click on the Results tab to view the test results.

END OF STEPS
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22.12 To create and run an on-demand and proactive CFM two-
way SLM test

22.12.1 Steps

Note: You can run up to 300 continuous CFM two-way SLM tests when you do not
exceed the SAA packet per second rate of 200 pps. The total number of continuous tests
must share this maximum rate of 200 pps.

1

Choose Tools→Service Test Manager (STM) from NFM-P main menu. The Service
Test Manager form opens.

2

Click Create.

3

Choose Ethernet CFM→CFM Two Way SLM. The CFM Two Way SLM Test (Create)
form opens.

4

Configure the required parameters.

Note: The NE Schedulable parameter is enabled for the proactive CFM two-
way SLM test.
When the NE Schedulable parameter is enabled, two additional tabs Test
Parameters and Results Configuration appear in the form.

5

Select a global MEG in the Test Object panel. The MEG information is displayed.

6

Select an originating MEP for the global MEG in the Test Object panel. The MEP
information is displayed.

7

Perform one of the following:

a. Select a MEP as the test destination in the MEP Transmit Information panel.

b. Select a MIP as the test destination in the MEP Transmit Information panel.

c. Select an unmanaged MEP as the test destination in the MEP Transmit
Information panel.
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8

When the NE Schedulable parameter is enabled in Step 4, go to Step 11.
Otherwise, go to Step 9.

9

Configure the required parameters in the MEP Transmit SLM Information panel.

10

Go to Step 13.

11

Click on the Test Parameters tab and configure the required parameters in the
Execution Details panel.

12

Select a card TCA profile in the Card TCA Profile panel.

13

Click Apply to save the changes.

14

Click on the Results tab to view the test results.

END OF STEPS

22.13 To create and run an on-demand CFM LM test

22.13.1 Steps

1

Choose Tools→Service Test Manager (STM) from NFM-P main menu. The Service
Test Manager form opens.

2

Click Create and choose Ethernet CFM→CFM LM Test. The CFM LM Test (Create)
form opens.

3

Configure the required parameters.
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4

Deselect the NE Schedulable check box.

5

Select a global MEG in the Test Object panel. The MEG information is displayed.

6

Select an originating MEP for the global MEG in the Test Object panel. The MEP
information is displayed.

7

Perform one of the following:

a. Select a MEP as the test destination in the MEP Transmit Information panel.

b. Select a MIP as the test destination in the MEP Transmit Information panel.

c. Select an unmanaged MEP as the test destination in the MEP Transmit
Information panel.

8

Configure the required parameters in the MEP Transmit LM Information panel.

9

Click Apply to save the changes.

10

Click Execute to run the test.

11

Click on the Results tab to view the test results.

END OF STEPS
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Smart SFP-RMD

22.14 Overview

22.14.1 Types of Smart SFP-RMD

An Ethernet demarcation point is required at the edge of a network to separate the
operator domain from the end user. The demarcation point implemented as an Ethernet
switch, which is known as an NID, supports a network interface and one or more
customer facing ports. The NID provides Ethernet OAM functions to help the operator
monitor, troubleshoot, and localize faults.

An RMD is an NID that is installed in the customer equipment and managed by the OT
cards. NFM-P supports the configuration of the Smart SFP-RMD on the 11QPE24 and
11QCE12X cards.

NFM-P supports configuration of the following device types:

• CFM-capable 1000Base-X SFP

• EFM-capable 1000Base-X SFP

• cEDD NID

• TSoP-OC3

• TSoP-OC12

You can configure an RMD access interface using the C and X ports of the cards for
device types CFM, EFM, and cEDD and using the C ports for device types TSoP-OC3
and TSoP-OC12. Only one access interface can be created per port. The accessible
RMD device with a specific OUI is discovered and a management instance is created for
the discovered device by specifying the device type and MAC address.

See 22.15 “To manually configure an RMD on a card” (p. 531) for more information
about configuring an RMD. See 22.16 “To automatically configure an RMD on a card”
(p. 533) for more information about automatic configuration of an RMD.

Note: NFM-P does not support automatic configuration of RMD for device types TSoP-
OC3 and TSoP-OC12.

NFM-P also supports the configuration of Ethernet CFM on the RMD. The supported
device types are CFM and cEDD. See 22.19 “To configure Ethernet CFM for an RMD”
(p. 536) for more information about configuring Ethernet CFM on RMD.
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Procedures to configure RMD

22.15 To manually configure an RMD on a card

22.15.1 Before you begin

Before you perform the following procedure, ensure that you configure the following:

• set the Assigned Rate parameter on the Port Specifics→General tab of the Physical
Port (Edit) form for the C or X port of the card for device types CFM, EFM, and cEDD

• turn up the port and set the operational state to Up

• configure the SyncE Support parameter on the Card Specifics→General tab of the
Card Slot (Edit) form to Enable for the device types TSoP-OC3 and TSoP-OC12

• configure the Assigned Rate parameter for client ports on the Port Specifics→General
tab of the Physical Port (Edit) form to 1GbE for the device types TSoP-OC3
TSoP-OC12

• configure the Pluggable Module Type parameter for client ports on the Port
Specifics→General tab of the Physical Port (Edit) form to the following for the device
types TSoP-OC3 or TSoP-OC12:

— TSoP-OC3—SG-S-1.1 or SG-L-1.1

— TSoP-OC12—SG-L-4.1 or SG-S-4.1

Note: After the Pluggable Module Type parameter is configured and the RMD device is
configured on a specific port, the pluggable module type of the participating port cannot
be changed to a module type that is not supported by the RMD device type.

22.15.2 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card Slot.

2

Right-click on the Card Slot object and choose Properties. The Card Slot (Edit) form
opens.

3

Click on the RMD tab.

Configure RMD access interface

4

Click on the Access Interface tab and click Create. The RMD Access Interface
(Create) form opens.
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5

Configure the Interface ID parameter. Alternatively, you can select the Auto-Assign
ID check box.

6

Select the port to be used to manage the RMD. You can choose a port that is a
member of a LAG for the EFM and cEDD device types.

7

Click Apply to save your changes.

8

Go to Step 14 if the device types that you need to configure are TSoP-OC3 or
TSoP-OC12.

Assign access interface to RMD

9

Click on the Discovery tab.

10

Configure the OUI parameter.

Note: The OUI parameter is configured to 00-19-3A by default. The OUI
parameter configuration is required only if the RMD has an OUI that differs
from the default value.

11

Select an access interface.

12

Click Initiate to send a request to the 1830 PSS to discover the RMD attached to the
RMD access interface and click OK.

13

After 10 s, click on the Discovered Devices tab. The RMD discovered by the 1830
PSS RMD discovery mechanism appears with the properties displayed.
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Configure RMD

14

To manually configure the RMD, click on the Devices tab and click Create. The
Remote Managed Device (Create) form opens.

15

Select an access interface and click OK.

16

Configure the required parameters.

Note: You can use the device type and MAC address information from the
Discovered Devices tab that displays the RMD properties of the RMD
discovered in Step 13 .

17

Click OK. The Remote Managed Device (Create) form closes and the Devices tab
appears displaying the configured RMD.

18

Save your changes and close the forms.

END OF STEPS

22.16 To automatically configure an RMD on a card

22.16.1 Before you begin

Before you perform the following procedure, ensure that:

• the Assigned Rate parameter on the Port Specifics→General tab of the Physical Port
(Edit) form is configured for the C or X port of the card

• the port is turned up and the operational state is Up

22.16.2 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card Slot.

2

Right-click on the Card Slot and choose Properties. The Card Slot (Edit) form opens.
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3

Click on the Ports tab. The ports are listed.

4

Choose any of the C and X ports to configure an RMD access interface.

5

Click Discover RMD Device to create an RMD access interface to discover the RMD.

6

Click on the RMD tab and click on the Access Interface tab to view the access
interface and Discovered Devices tab to view the discovered RMD.

Note: If the Auto Create Devices check box on the RMD→Discover tab of the
Card Slot (Edit) form is enabled, the RMD devices are automatically created for
the newly discovered devices.
If the Auto Create Devices check box on the RMD→Discover tab of the Card
Slot (Edit) form is not enabled, the RMD device is not created. The automatic
configuration of RMD is possible only for newly discovered devices and not for
pre-existing discovered devices.

END OF STEPS

22.17 To reset the RMD

22.17.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card Slot.

2

Right-click on the Card Slot and choose Properties. The Card Slot (Edit) form opens.

3

Click on the RMD tab. The Discovery tab appears.

4

Click on the Devices tab. The configured RMDs are listed.
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5

Choose a device and click on the Reset Device button and choose one of the
following options:

• Warm1

• Warm 2

• Warm 3

• Cold

A dialog box appears.

6

Click OK.

END OF STEPS

22.18 To configure the RMD ports

22.18.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card Slot.

2

Right-click on the Card Slot and choose Properties. The Card Slot (Edit) form opens.

3

Click on the RMD tab. The Discovery tab appears.

4

Click on the Devices tab. The configured RMD is listed.

5

Choose the RMD and click Properties. The Remote Managed Device (Edit) form
opens.

6

Click on the Ports tab. The RMD ports are listed.

7

Choose and entry and click Properties. The RMD Port (Edit) form opens.
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8

Perform one of the following:

a. Configure the network port (the port facing the service provider) parameters for
EFM, CFM, or cEDD device types.

b. Configure the customer port (the port facing the customer equipment) parameters
for cEDD device type.

Note: When the device type is CFM or EFM, the Auto-Negotiation Fallback
Enabled parameter cannot be modified.
When the device type is cEDD, the Auto-Negotiation Fallback Enabled
parameter cannot be modified on a customer port.
When the device type is TSoP-OC3 or TSoP-OC12, the network port
attributes are not applicable and are not displayed. The Traffic Enabled
parameter is not applicable for customer ports. All other customer port
attributes cannot be modified.

9

Click OK to save the configuration.

END OF STEPS

22.19 To configure Ethernet CFM for an RMD

22.19.1 Steps

1

Perform Step 1 to Step 12 of 22.5 “To configure Ethernet CFM” (p. 515) to:

• configure an MD and distribute it to an 1830 PSS

• add a global MEG to the MD

2

To associate an RMD with the MEG:

1. Choose Tools→Ethernet CFM→Maintenance Domain Policies and choose an MD
in the list.

2. Click Properties. The Maintenance Domain Global Policy (Edit) form opens.

3. Click on the Global Maintenance Entity Group tab and click Search. A list of
global MEGs appears.

4. Choose a global MEG and click Properties. The Global Maintenance Entity Group
(Edit) form opens.

5. Click on the NE Maintenance Entity Group tab.
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6. Click Create. The NE Maintenance Entity Group (Create) form opens.

7. Select an 1830 PSS device in the Site panel.

8. Select a card in the Card/RMD panel.

9. Configure the required parameters:

• When the device type is CFM, configure the CCM Interval parameter.

• When the device type is cEDD, configure:

– CCM Interval (set to 1s)

– MA Format (set to String)

– MD Level (set to 0)

– MD Format (set to String or DNS)

10.Click OK. The NE Maintenance Entity Group (Create) form closes and the The
Global Maintenance Entity Group (Edit) form opens.

3

Perform one of the following to add a managed MEP to the MEG.

a. From Tools→Ethernet CFM→Maintenance Domain Policies:

1. Choose Tools→Ethernet CFM→Maintenance Domain Policies and choose an
MD in the list.

2. Click Properties. The Maintenance Domain - Global Policy (Edit) form opens.

3. Click on the Global Maintenance Entity Group tab.

4. Choose the MEG and click Properties. The Global Maintenance Entity Group
(Edit) form opens.

5. Click on the Managed MEP tab.

6. Click Create. The MEP (Create) form opens.

7. Click on the Select button on the Remote Managed Device panel. The Select
MEP form opens with the list of line ports displayed.

8. Choose an entry and click OK. The Select MEP form closes and the MEP
(Create) form opens.

9. Click OK. The MEP (Create) form closes and the NE Maintenance Entity
Group (Edit) form opens.

b. From Network→NE→Shelf→Card Slot:

1. Choose Network→NE→Shelf→Card Slot.

2. Right-click on the Card Slot and choose Properties. The Card Slot 11G Quad
Port Pluggable GBE Mux (24 Clients) (Edit) form opens.

3. Click on the RMD tab. The Discovery tab appears.

4. Click on the Devices tab.

5. Choose a device and click Properties. The Remote Managed Device (Edit)
form opens.
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6. Click on the Maintenance Domains tab and click Create. The Maintenance
Domain - Local Policy (Create) form opens.

7. Configure the required parameters.

8. Click Apply.

END OF STEPS

22.20 To configure TSoP device types

22.20.1 Steps

1

On the equipment tree, expand Network→1830 PSS→Shelf→Card Slot.

2

Right-click on the Card Slot and choose Properties. The Card Slot (Edit) form opens.

3

Click on the RMD tab. The Discovery tab appears.

4

Click on the Devices tab. The configured RMD is listed.

5

Choose the RMD with the device type configured as TSoP-OC3 or TSoP-OC12, and
click Properties. The Remote Managed Device (Edit) form opens.

6

Click on the TSoP tab. The TSoP parameters are listed.

7

Configure the Loopback Type parameter.

8

Click on the TSoP Channel tab.

9

Configure the required parameters.
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10

Click Apply to save the changes.

END OF STEPS
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MAC swap

22.21 Port loopback

22.21.1 Port loopback with MAC address swap

Port loopback is configurable on a SAP of a VPLS service with MAC address swap. This
allows you to test the packets that pass through the port. When a data packet enters the
loopback port with source and destination MAC addresses the same as the ones
configured in the MAC swap panel of the port properties form, the source and destination
MAC addresses on the packet are swapped, and the packet is looped back to the
source. The packets that do not have the MAC addresses the same as the ones
configured in the MAC swap panel are dropped.

The port loopback with MAC swap can be enabled on the following cards and ports
configured on an 1830 PSS device:

• 11OPE8 — X{1–6}, M{1–4}

• 11QCE12X — X{1-4}, C{1-22}, M{1-4}

• 11QPE24 — X{1-4}, C{1-22}

Before configuring a port loopback with MAC swap, you must configure a port that
cannot be included as a termination point for a service on the same card. See 22.22 “To
configure port loopback with MAC swap” (p. 540) for more information. You cannot
enable loopback on a port with MAC address swap if the port has terminal or facility
loopback enabled.

22.22 To configure port loopback with MAC swap

22.22.1 Steps

1

Configure the VPLS, as required. See 14.3 “To configure a VPLS” (p. 261) for more
information about configuring a VPLS.

Configure non-service port

2

On the equipment tree, expand Network→1830 PSS→Shelf→Card Slot.

3

Right-click on the card object and choose Properties. The Card Slot (Edit) form
opens.
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4

Click on the Card Specifics tab and select a port in the Non-service port MAC Swap
Loopback panel.

Note: You cannot select a port that is a SAP as a non-service port.

5

Save your changes and close the form.

Configure port loopback

6

On the equipment tree, expand Network→1830 PSS→Shelf→Card Slot→Port.

Note: Choose the port that is a SAP for a VPLS, as required.

7

Right-click on the port and choose Properties. The Physical Port (Edit) form opens.

8

Click on the Port Specifics tab and configure the Loopback Enabled parameter as
Internal in the MAC Swap panel.

9

Select a SAP in the SAP panel and configure the source and destination MAC
addresses in the MAC Swap panel.

10

Save your changes and close the form.

END OF STEPS
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23 1830 PSS IP routing

23.1 Overview

23.1.1 Purpose

This chapter provides an overview of IP routing and contains information on how to
configure OSPFv2 on WDM and OCS 1830 PSS devices.

23.1.2 Contents
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Network interfaces and IP routing

23.2 L3 network interfaces

23.2.1 Network interface

An L3 network interface is a logical IP object that is defined on a physical port, such as
an Ethernet port.

An L3 interface:

• associates an IP address and subnet mask with a physical port or channel

• requires QoS policy configuration

• requires routing protocol configuration

The physical connection of one device to another device is through a port or channel.
However, the L3 interface determines its IP connectivity. The L3 interface passes both
routing information and IP traffic.

23.2.2 Embedded communication channels

The 1830 PSS devices support the termination of embedded communication channels
(ECCs) for OTH facilities. The ECC frames are transcoded to Ethernet frames for
transport between the main shelf Equipment Controller (EC) and the line cards, using the
internal LAN infrastructure. The 1830 PSS devices manage edge devices using IP
protocols through GCC.

The WDM optical transponder cards with the OTUk interface support the provision of the
following GCC communication channel types:

• GCC0 (default)

• GCC1

• GCC2

The following table lists the WDM optical transponder cards that support the GCC
channel type provisioning.

Table 54 ECC type supported for the WDM OT cards

Card Port Facility ECC type
supported

112SDX11 L1 OTU GCC0

112SDX11 C{1-10} OTU GCC0
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Table 54 ECC type supported for the WDM OT cards (continued)

Card Port Facility ECC type
supported

11DPE12 L{1-2} OTU GCC0

ODU2 GCC1

GCC2

11DPE12A L{1-2} OTU GCC0

ODU2 GCC1

GCC2

11DPE12E L{1-2} OTU GCC0

ODU2 GCC1

GCC2

11DPM12 L{1-2} OTU GCC0

ODU2 GCC1

GCC2

11DPM8 L{1-2} OTU GCC0

ODU2 GCC1

GCC2

11OPE8 X{1-6} OTU GCC0

ODU2 GCC1

GCC2

11QCE12X X{1-4} OTU GCC0

ODU2 GCC1

GCC2

11QPA4 C{1-4} OTU GCC0

11QPA4 L{1-4} OTU GCC0

OTUODU2 GCC1

GCC2

11QPE24 X{1-4} OTU GCC0

ODU2 GCC1

GCC2

11QPEN4 C{1-4} OTU GCC0
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Table 54 ECC type supported for the WDM OT cards (continued)

Card Port Facility ECC type
supported

11QPEN4 L{1-4} OTU GCC0

ODU2

OTUODU2

GCC1

GCC2

11STAR1 C1 OTU GCC0

11STAR1 L1 OTU GCC0

11STAR1A C1 OTU GCC0

11STAR1A L1 OTU GCC0

11STMM10 C{1-10} OTU GCC0

20P200 {1-10} OTU GCC0

4DPA4 L{1-2} OTU GCC0

4QPA8 L{1-4} OTU GCC0

23.3 To configure a network interface on an 1830 PSS WDM
device

23.3.1 Steps

Note:

Management and control information is carried to and from an 1830 PSS device using
the following interfaces:

• IP interfaces

• network interfacesAn 1830 PSS WDM network interface can only have one associated
facility object.

Perform this procedure to configure a network interface on an 1830 PSS, configure
OSPF parameters, configure GCC type, and associate an ACL IP filter on the network
interface.

1

Choose Routing from the navigation tree view selector.

2

On the navigation tree, expand Network→1830 PSS→Routing Instance.

NFM-P To configure a network interface on an 1830 PSS WDM device

Release 17.3
April 2017
Issue 2 5473HE-12002-AAAA-TQZZA



3

Right-click on the Routing Instance and choose Create Network Interface. The
Select facility for the Network Interface form opens with a list of applicable cards and
facility objects.

4

Choose an object from the list and click OK. The Select facility for the Network
Interface form closes and the Network Interface (Create) form opens.

5

Configure the required parameters.

Note: If the Packet Type parameter is configured as Non-Standard, the MTU
Size parameter is set to 1473.

6

Click Apply. The form name changes to Network Interface (Edit).

7

Click on the OSPF tab.

8

Configure the required parameters.

9

Click on the Facility Binding tab. The associated network interface facility object
appears.

10

Choose the object and click Properties. The Network Interface Facility Binding
(Create) form opens.

11

Configure the Channel Type parameter if the facility object chosen in Step 4
supports GCC1 or GCC2.

Note: If the facility object chosen supports only GCC0, the Channel Type
parameter cannot be configured.

12

Click on the ACL IP Filters tab.
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13

Click Create. The IP Filter Cfg (Create) form opens.

14

Perform Step 5 to Step 8 of 21.7 “To assign an ACL IP filter to a port” (p. 503) to
assign an ACL IP filter to the network interface.

Note: Ensure that you have enabled ACL configuration through SNMP, created
an ACL IP pattern, and created an ACL IP filter before assigning the ACL IP
filter to the network interface. See 21.4 “To enable ACL configuration on an
1830 PSS” (p. 501), 21.5 “To create an 1830 PSS ACL IP pattern” (p. 501),
and 21.6 “To create an 1830 PSS ACL IP filter” (p. 502).

15

Save your changes and close the forms.

END OF STEPS

23.4 To configure a network interface on an 1830 PSS OCS
device

23.4.1 Before you begin

You must configure the loopback IP address on the 1830 PSS device before you can
configure the network interface.

Management and control information is carried to and from an 1830 PSS device using
the following interfaces:

• IP interfaces

• network interfaces

IP interfaces include ports such as CIT and OAMP, which are configured by default. Both
IP interfaces and network interfaces require the loopback address to be defined on the
1830 PSS device. See the Nokia 1830 Photonic Service Switch Installation and System
Turn-up Guide for more information about defining the loopback address on an 1830
PSS device.

An 1830 PSS OCS network interface can have more than one associated facility objects.

23.4.2 Steps

1

Choose Routing from the navigation tree view selector.
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2

On the navigation tree, expand Network→1830 PSS OCS→Routing Instance.

3

Right-click on the Routing Instance and choose Create Network Interface. The
Select facility for the Network Interface form opens with a list of applicable cards and
facility objects.

4

Choose an object from the list and click OK. The Select facility for the Network
Interface form closes and the Network Interface (Create) form opens.

5

Configure the required parameters.

6

Select an alarm profile.

7

Click on the Facility Binding tab. A list of associated facility objects appears.

8

Click Create. The Network Interface Facility Binding (Create) form opens.

9

Select a facility pointer.

10

Save your changes and close the forms.

11

Expand the Network Interface object on the navigation tree to view the facility
objects associated with the interface.

END OF STEPS
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23.5 Types of IP routing

23.5.1 1830 PSS IP routing

The 1830 PSS devices support the following types of IP routing:
• OSPF routing

• IP static routing

The routing is done by selecting a routing protocol that is used for each tunnel. The
options available for the 1830 PSS devices are OSPF or NONE.

When the routing protocol is specified as OSPF, the routes are discovered automatically.

When the routing protocol is specified as NONE, static routes have to be provisioned.
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OSPFv2 on WDM and OCS devices

23.6 OSPF routing

23.6.1 Overview

NFM-P supports the configuration of OSPF parameters for the layer 3 routing.

Three OSPF areas and a backbone can be configured. The OSPF backbone area, that
is, the area with area Id = 0.0.0.0, is always present by default and cannot be deleted.

23.7 Workflow to configure an OSPFv2 routing

23.7.1 Workflow

OSPFv2 is a hierarchical link-state interior gateway protocol that operates within ASs
and is used in IP networks. OSPF packets are routed based on the destination IP
address of the IP packets. NFM-P supports the configuration of the OSPFv2 routing on
the 1830 PSS devices.

23.7.2 Stages

1

Configure a network interface on an 1830 PSS WDM or OCS devices.

See 23.3 “To configure a network interface on an 1830 PSS WDM device” (p. 547)
and 23.4 “To configure a network interface on an 1830 PSS OCS device” (p. 549)
for more information about configuring th network interfaces for WDM and OCS
devices respectively

2

Configure a multi-area OSPFv2. The 1830 PSS devices have a default area that
cannot be deleted.

See 23.8 “To configure a multi-area OSPFv2 for WDM devices” (p. 553) and
23.9 “To configure a multi-area OSPFv2 for OCS devices” (p. 554) for more
information about configuring a multi-area OSPFv2 for WDM and OCS devices
respectively.

See 23.10 “To modify a multi-area OSPFv2 for WDM devices” (p. 555) and
23.11 “To modify a multi-area OSPFv2 for OCS devices” (p. 556) for more
information about modifying a multi-area OSPFv2 for WDM and OCS devices
respectively.
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See 23.12 “To delete a multi-area OSPFv2 for WDM devices” (p. 556) and
23.13 “To delete a multi-area OSPFv2 for OCS devices” (p. 557) for more
information about deleting a multi-area OSPFv2 for WDM and OCS devices
respectively.

3

Configure the OSPFv2 interface.

See 23.14 “To configure a OSPF interface for WDM devices” (p. 557) for more
information about configuring an OSPFv2 interface for WDM devices.

See 23.15 “To modify a OSPF interface for OCS devices” (p. 558) for more
information about modifying an OSPFv2 interface for OCS devices.

4

Configure an OSPFv2 area range. The OSPFv2 area range is used to summarize
and filter out routes between OSPFv2 Areas. If an OSPFv2 area range is not
specified, then all routes are sent out of the area as is. Up to three OSPFv2 area
ranges can be configured per OSPFv2 area.

See 23.16 “To configure an OSPFv2 area range for WDM devices” (p. 558) and
23.17 “To configure an OSPFv2 area range for OCS devices” (p. 559) for more
information about configuring an OSPFv2 area range for WDM and OCS devices
respectively.

23.8 To configure a multi-area OSPFv2 for WDM devices

23.8.1 Steps

Note: You need the 32-bit unique router ID before you can configure OSPF.

The following procedure describes the steps to configure a multi-area OSPF for WDM
devices.

1

Choose Routing from the navigation tree view selector.

2

On the navigation tree, expand Network→1830 PSS→Routing Instance→OSPFv2.

3

Right-click on the OSPFv2 object and choose Create Area. The Area Site (Create)
form opens.
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4

Configure the required parameters.

Note: You can enable the DNS Opaque LSAs Distributed and Wave key
Opaque LSAs Distributed parameters for only one OSPF area on the 1830
PSS WDM devices.
You cannot configure the Type parameter for a backbone area routing instance.
You can create up to three OSPF areas, in addition to the default backbone
area (0.0.0.0).

5

Save your changes and close the forms.

END OF STEPS

23.9 To configure a multi-area OSPFv2 for OCS devices

23.9.1 Steps

Note: You need the 32-bit unique router ID before you can configure OSPF.

The following procedure describes the steps to configure a multi-area OSPF for OCS
devices.

1

Choose Routing from the navigation tree view selector.

2

On the navigation tree, expand Network→1830 PSS OCS→Routing
Instance→OSPFv2.

3

Right-click on the OSPFv2 object and choose Create Area. The Area Site (Create)
form opens.

4

Configure the required parameters.

Note: You can enable the DNS Opaque LSAs Distributed and Wave key
Opaque LSAs Distributed parameters for only one OSPF area on the 1830
PSS WDM devices.
You cannot configure the Type parameter for a backbone area routing instance.
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You can create up to three OSPF areas, in addition to the default backbone
area (0.0.0.0).

5

Depending on the Type parameter value, the parameters in the Stub/NSSA tab are
configurable for OCS devices.

6

Save your changes and close the forms.

END OF STEPS

23.10 To modify a multi-area OSPFv2 for WDM devices

23.10.1 Steps

1

Choose Routing from the navigation tree view selector.

2

On the navigation tree, expand Network→1830 PSS→Routing
Instance→OSPFv2→Area.

3

Right-click on the Area object and choose Properties. The Area Site (Edit) form
opens.

4

Modify the required parameters.

Note: You cannot modify the Type parameter for a backbone area routing
instance.

5

Save the changes and close the form.

END OF STEPS
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23.11 To modify a multi-area OSPFv2 for OCS devices

23.11.1 Steps

1

Choose Routing from the navigation tree view selector.

2

On the navigation tree, expand Network→1830 PSS OCS→Routing
Instance→OSPFv2→Area.

3

Right-click on the Area object and choose Properties. The Area Site (Edit) form
opens.

4

Modify the required parameters.

Note: You cannot modify the Type parameter for a backbone area routing
instance.

5

Save the changes and close the form.

END OF STEPS

23.12 To delete a multi-area OSPFv2 for WDM devices

23.12.1 Steps

1

Choose Routing from the navigation tree view selector.

2

On the navigation tree, expand Network→1830 PSS→Routing
Instance→OSPFv2→Area.

3

Right-click on the selected area and choose Delete. A dialog box appears.
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4

Click Yes. The selected area is deleted.

END OF STEPS

23.13 To delete a multi-area OSPFv2 for OCS devices

23.13.1 Steps

1

Choose Routing from the navigation tree view selector.

2

On the navigation tree, expand Network→1830 PSS OCS→Routing
Instance→OSPFv2→Area.

3

Right-click on the selected area and choose Delete. A dialog box appears.

4

Click Yes. The selected area is deleted.

END OF STEPS

23.14 To configure a OSPF interface for WDM devices

23.14.1 Steps

The following procedure describes the steps to configure a OSPF interface for WDM
devices.

1

Choose Routing from the navigation tree view selector.

2

On the navigation tree, expand Network→1830 PSS OCS→Routing
Instance→OSPFv2→Area.

3

Right-click on the Area object and choose Create Interface. The OSPF Interface
(Create) form opens.

NFM-P To delete a multi-area OSPFv2 for OCS devices

Release 17.3
April 2017
Issue 2 5573HE-12002-AAAA-TQZZA



4

Select the specific interface in the Interface panel.

5

Save your changes and close the forms.

END OF STEPS

23.15 To modify a OSPF interface for OCS devices

23.15.1 Steps

The following procedure describes the steps to configure a OSPF interface for WDM
devices.

1

Choose Routing from the navigation tree view selector.

2

On the navigation tree, expand Network→1830 PSS OCS→Routing
Instance→OSPFv2→Area (Normal).

3

Right-click on the Interface object and choose Properties. The OSPF Interface (Edit)
form opens.

4

Click on the Protocol Properties tab and configure the required parameters.

5

Save your changes and close the forms.

END OF STEPS

23.16 To configure an OSPFv2 area range for WDM devices

23.16.1 Steps

1

Choose Routing from the navigation tree view selector.
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2

On the navigation tree, expand Network→1830 PSS→Routing
Instance→OSPFv2→Area.

3

Right-click on an Area object and choose Create Area Range. The Area Range
(Create) form opens.

4

Configure the required parameters.

5

Save your changes and close the form.

END OF STEPS

23.17 To configure an OSPFv2 area range for OCS devices

23.17.1 Steps

1

Choose Routing from the navigation tree view selector.

2

On the navigation tree, expand Network→1830 PSS OCS→Routing
Instance→OSPFv2→Area.

3

Right-click on an Area object and choose Create Area Range. The Area Range
(Create) form opens.

4

Configure the required parameters.

5

Save your changes and close the form.

END OF STEPS

NFM-P To configure an OSPFv2 area range for OCS devices

Release 17.3
April 2017
Issue 2 5593HE-12002-AAAA-TQZZA



IP static routing

23.18 Overview

23.18.1 Static route configuration

NFM-P supports the configuration of IP static routes.

During creation, NFM-P verifies that another route does not exist with the same
Destination IP, Mask and Next Hop values.

During deletion, NFM-P displays a warning message. Upon continuing with the request,
NFM-P sends the delete request to the 1830 PSS device.

Static routes toward the same destination subnet associated with the same interface, but
with two different next hops are not supported.

NFM-P supports the configuration of multiple static routes to the same destination
subnet using different interfaces. The Metric parameter is used to decide which of the
routes shall be used for forwarding decisions. The route with the lowest metric value
takes precedence.

23.19 To configure a static route

23.19.1 Steps

1

On the routing tree, expand Network→NE→Routing Instance→Static Routes.

2

Right-click on the static routes icon and choose Create Static Route from the menu.
The Static Route (Create) form opens.

3

Configure the general static route parameters.

Note: You cannot specify a Prefix List if either BFD Enabled or Enable CPE
Check parameters are enabled for the static route.

4

If IPv6 is enabled on the routing instance, click on the Select button beside the
Interface Name parameter and select an IPv6 zone index for the static route.

Overview NFM-P

3HE-12002-AAAA-TQZZA

Release 17.3
April 2017

560 Issue 2



5

Configure the parameters in the Destination panel.

6

Configure the parameters in the Other panel.

Note: When you select the Redistribute check-box, the route is only known on
the local 1830 PSS device.
When you de-select the Redistribute check-box, the route is leaked into OSPF
and distributed over the network.

7

Click OK to save the changes.

END OF STEPS
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24 1830 PSS service tunnels

24.1 Overview

24.1.1 Purpose

This chapter contains information about Ethernet ring protection and procedures to
configure an Ethernet ring.

24.1.2 Contents

24.1 Overview 563

Service tunnels 564

24.2 Overview 564

24.3 Ethernet (G.8032) ring protection 564

Procedures for Ethernet ring configuration management 567

24.4 To configure an Ethernet ring 567

24.5 To configure interconnect for Ethernet sub-rings 572

24.6 To configure an Ethernet ring element 574

24.7 To configure an Ethernet ring element path 575
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Service tunnels

24.2 Overview

24.2.1 General information

A service tunnel is an entity that is used to unidirectionally direct traffic from one device
to another device. The service tunnel is provisioned to use a specific encapsulation
method, such as GRE or MPLS, and the services are then mapped to the service tunnel.

On the Optical Transport Service (Edit) form, the Service Tunnels tab lists service tunnel
objects (for example, SDPs, Ethernet rings, Ethernet tunnels, and other services) that
are currently used by the service you are querying. When you click on the associated
Discover Service Tunnels button, any previously discovered service tunnels on the
service are removed and a manual rediscovery of the service tunnel is initiated, based
on direct usage and current service configurations.

Note: The 11OPE8, 11QCE12X, and 11QPE24 cards support ERP. The ODU trails are
added as tunnels for ERP. See 12.5 “To configure an ODU trail” (p. 219) for more
information about configuring ODU trails.

The Flow-through Services tab lists all other services that are currently using the object
you are querying as a service tunnel. When you click on the associated Discover Flow-
through Services button, any previously discovered flow-through services are removed
and a manual rediscovery of the flow-through service is initiated, based on direct usage
and current service configurations.

24.3 Ethernet (G.8032) ring protection

24.3.1 Overview

NFM-P supports ERP for network protection of the Ethernet services using the 11OPE8,
11QCE12X, and 11QPE24 cards on the 1830 PSS-32, 1830 PSS-16, and 1830 PSS-4
devices.

NFM-P also supports:

• interconnection of multiple ERP rings to increase the span of the network

• ERP over LAG to increase link capacity on the ring

ERP switching offers ITU-T G.8032 specification compliance to achieve resiliency for
carrier Ethernet networks. ERP keeps one link in the ring blocked to user traffic. You can
run multiple ring sessions on the same physical ring with different blocked links in
session. ERP enables load balancing on the ring when traffic patterns allow.
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Ethernet rings use the G.8032 standard protocol for control, and participating nodes
exchange protocol messages using Y.1731-defined OAM frames called R-APS. The
R-APS frames are sent by MEPs that belong to an MA not associated with a service, and
are positioned on ring paths. The frames are tagged and must be configured with a
unique VID (that is, not shared with a service or other rings) when the ring port has dot1q
encapsulation, and with a unique outer VID when the ring port has QinQ encapsulation.
Ethernet rings are only on individual NNI ports that use QinQ encapsulation.

VPLS can use ERP. Epipes behave as two-node ERPs. All VPLSs may be protected by
one Ethernet ring instance, or divided among several rings.

24.3.2 ERP on NNI and UNI ports

ERP can be configured on:

• UNI (1 GbE or 10 GbE) (access) ports configured using dot1q or QinQ encapsulation
enabling support for Ethernet R-APS protected services on the service edge towards
the customer site

• NNI (10 GbE) X (access uplink) ports configured using QinQ encapsulation enabling
support for Ethernet R-APS protected services on the service within the Ethernet
backbone

• NNI (1 GbE) C (access uplink) ports configured using QinQ encapsulation enabling
support for Ethernet R-APS protected services on the service within the Ethernet
backbone. The ports can be used to configure sub-rings interconnected with the main
ring on the X ports.

24.3.3 ERP over LAG

LAG is used with ERP to increase link capacity on the ring. LAG ID must exist to add the
endpoints for path A or B. When a sub-group is used on the LAG, only one sub group on
a LAG can be configured for ERP over LAG. Both path A or B must be configured as
LAGs of same signal rate, 1 GbE or 10 GbE. See 24.4 “To configure an Ethernet ring”
(p. 567) for more information about configuring ERP over LAG.

24.3.4 ERP sub-rings

Ethernet sub-rings provide a dual redundant way to interconnect with the main ring. The
Ethernet cards support sub-rings connected to main rings and a sub-ring connected to a
VPLS.

When sub-rings protect a link, the flush messages are propagated to the main ring.
When main rings change topology, the flush messages are propagated around the main
ring and do not continue to any sub-rings. The main rings are completely connected, but
sub-rings are dependent on another ring or network for full connectivity. The topology
changes need to be propagated to the other ring or network. The sub-rings offer the
same capabilities as main rings in terms of control and data so that all link resources
may be used.
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The Ethernet cards support both the virtual channel and non-virtual channel for sub-ring
control communication.

In the virtual channel mode, a dedicated VID, other than the main ring R-APS control
channel is configured as a data instance on the main ring. An SHG needs to be
configured in a virtual sub-ring to ensure that the sub-ring control messages from the
main ring are passed only to the sub-ring control.

In the non-virtual channel mode, the sub-ring is only connected by the R-APS control
channels on the sub-ring. This mode offers less redundancy in the R-APS messaging
than the virtual channel mode because sub-ring R-APS messages are not propagated
across the main ring. When a non-virtual link is configured, the protocol allows RPL
messages over the sub-ring blocked link. See 24.5 “To configure interconnect for
Ethernet sub-rings” (p. 572) for more information about configuring sub-rings.

24.3.5 Automatic Ethernet ring creation

NFM-P automatically unites Ethernet ring elements in the network into Ethernet rings,
and creates path objects to link endpoints within the ring.

For NFM-P to create an Ethernet ring, the following must exist:

• optical links between the participating ports. See 9.44 “To configure an optical link
between ports” (p. 163) for more information about configuring optical links between
ports.

• ODU trails between the participating ports. See 12.5 “To configure an ODU trail”
(p. 219) for more information about configuring ODU trails.

• at least two Ethernet ring elements with path endpoints. See 24.6 “To configure an
Ethernet ring element” (p. 574) for more information about configuring Ethernet ring
elements and 24.7 “To configure an Ethernet ring element path” (p. 575) for more
information about configuring an Ethernet ring element path.

24.3.6 Service provisioning on Ethernet (G.8032) rings

NFM-P accelerates the provisioning of VPLS instances on Ethernet (G.8032) rings by
automatically creating the control and data services on the rings. Services are configured
on Ethernet (G.8032) rings in the same way as service tunnels. You can create Ethernet
(G.8032) rings using NFM-P GUI.
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Procedures for Ethernet ring configuration management

24.4 To configure an Ethernet ring

24.4.1 Before you begin

The following are the prerequisites for configuring an Ethernet ring
• Select the L2Uplink check box on the Physical Port (Edit) form of the participating

ports.

• Configure optical links between the participating ports.

• Configure ODU trails between the participating ports.

• Configure LAGs instead of ports for ERP over LAG.

24.4.2 Steps

1

Choose Manage→Service Tunnels from NFM-P main menu. The Manage Service
Tunnels search form opens.

2

Click Create and choose Ethernet Ring. The Ethernet Ring (Create) form opens.

3

Configure the required parameters:

Note: If you enable the Auto Create Global MEG parameter, the ETH-CFM tab
will display all associated Global MEGs created for this Ethernet Ring.
If path discovery generates Ethernet Ring paths, the Auto Create Global MEG,
Maintenance Domain ID, CCM Interval, and Run CCM on Create parameters
are not propagated to the per-path CFM Continuity Check tab configuration.
Auto-generation of an MEG, or MEPs, or both can be configured on a per-path
basis.
Alternatively, if path discovery is not operational (that is, no Ethernet Ring paths
are populated into the Ethernet Ring), the General tab Path CFM Defaults
parameters are propagated and an MEG, or MEPs, or both are generated upon
manual creation of the Ethernet Ring paths.

4

Configure the Element Type parameter as AOS based.

5

Select an MD in the Path CFM Defaults panel.
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6

Click Apply. The Ethernet Ring (Edit) form opens.

Configure Ethernet ring element

7

Click on the Components tab.

8

Right click on the Ring Elements object on the navigation tree and perform one of
the following options:

a. Create an Ethernet Ring Element

1. Choose Ethernet Ring Element. The Select Network Elements form opens.

2. Select the participating 1830 PSS devices from the list.

3. Click OK. The Select ELAN elements form opens.

4. Select the participating cards from the list.

5. Click OK. The Select ELAN elements form closes and the Ethernet Ring
Element (Create) form opens.

6. Configure the required parameters.

7. Click Apply. The changes are updated and the Ethernet Ring Element (Edit)
form opens.

8. Close the Ethernet Ring Element (Edit) form. The Ethernet Ring (Edit) form
opens with the Ethernet ring element objects on the navigation tree.

b. Select an existing Ethernet ring element.

Configure owner and neighbor

9

Right-click on the Ethernet ring element object that you need to configure as owner
and choose properties. The Ethernet Ring Element (Edit) form opens.

10

Configure the Ring Protection Link Type parameter as Owner.

11

Click OK. The Ethernet Ring Element (Edit) form closes and the Ethernet Ring (Edit)
form reappears.
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12

Right-click on the Ethernet ring element object that you need to configure as
neighbor and choose properties. The Ethernet Ring Element (Edit) form opens.

13

Configure the Ring Protection Link Type parameter as Neighbor.

14

Click OK. The Ethernet Ring Element (Edit) form closes and the Ethernet Ring (Edit)
form reappears.

Configure Ethernet ring path

15

Right-click on the Paths object on the navigation tree and choose Create Ethernet
Ring Path to create a path. The Ethernet Path (Create) form opens.

Note: You must create a path for each element in the ring. Therefore each
element (site) in the ring will have two endpoints (from two different paths)
associated with it.

16

Configure the required parameters.

17

Click on the Endpoints tab to configure the required parameters in the Endpoint A
and Endpoint B panels.

Note: Configure the path of the Ethernet ring elements, configured as owner
and neighbor, as the Ring Protection Link End.
Configure all other paths as Normal.

18

Select the endpoints A and B in the member port panels for Endpoint A and Endpoint
B panels respectively.

19

Configure the Path ID parameter as Path A and Path B in Endpoint A and Endpoint B
panels respectively.

20

Click Apply to save your changes.
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21

Repeat Step 15 to Step 19 to create other required paths.

Configure CFM continuity test

22

Right-click on the Path object on the navigation tree and choose Properties to create
a path. The Ethernet Ring Path (Edit) form opens.

23

Click on the CFM Continuity Check tab.

24

Reconfigure the required parameters in the Global MEG Auto Creation panel, if
required.

25

Click on the Select button. The Select CFM Test form opens.

26

Perform the following steps only if you need to choose the CFM test from the list.

1. Choose the required CFM test.

2. Click OK. The Select CFM Test form closes and the Global ID and ID parameters
for the selected test appear on the CFM Continuity Check tab.

27

Perform this step only if you need to create the required CFM test.

1. Click Create to create the required CFM test. The Global Maintenance Entity
Group (Create) form opens,.

2. Configure the required parameters.

3. Configure the Name Format and Name parameters in the Maintenance Entity
Group panel.

Note:

If you configure the Name Format parameter to icc-based, the associated name
must contain 13 characters.

4. Configure the required parameters in the Initial MEG Configuration panel.

5. Click OK. The Global Maintenance Entity Group (Create) form closes, and the
Select CFM Test form reappears with the new CFM test appearing in the list.

6. Choose the new CFM test.
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7. Click OK. The Select CFM Test form closes and the Global ID and ID parameters
for the selected test appear on the CFM Continuity Check tab.

28

Repeat Step 22 to Step 27 for all the configured paths.

29

Click Apply.

Turn up ring elements

30

Right-click on the Site object on the navigation tree and choose Turn Up. A dialog
box appears.

31

Click Yes. The dialog box closes.

32

Repeat Step 30 to Step 31 for all the configured ring elements and paths.

Create control service

33

Click on the Create Control Service button. The Create Control Service form opens.

Note: See 14.3 “To configure a VPLS” (p. 261) for manual configuration of a
VPLS service.

34

Click on the Select button beside the Customer field and select a customer from the
Select Customer form.

35

Configure the required parameters, if required.

36

Click on the Select button beside the Control Service Template field, if required, and
select a template from the Select Control Service Template form.
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Note: Only use the Control Service Template if you need to customize the
parameter fields associated with the sites or SAPs, such as the description or
name.
If you need to create a Control Service Template, choose Manage→Templates
from NFM-P main menu. Click on the Browse Example button and select the
Ethernet Ring example. For more information about creating service tunnel
templates, see “ Template management” in the NSP NFM-P Scripts and
Templates Developer Guide.
If a template is not specified, all created objects will use their default property
values.

37

Click OK. A dialog box opens.

38

Click Yes. The dialog box closes and the VPLS service (Edit) form opens.

39

Configure the Service Name parameter and click on the Apply button. The VPLS
service is configured.

40

Click on the Topology view to view the topology of the Ethernet ring.

Note: Before deleting an Ethernet ring on an 1830 PSS device, version 8.2.2
and later, ensure that the administrative state of the ring is down and no paths
exist in the ring.

END OF STEPS

24.5 To configure interconnect for Ethernet sub-rings

24.5.1 Steps

1

Configure two Ethernet rings such that the main ring is a closed ring and the sub-ring
is not a closed ring. Perform 24.4 “To configure an Ethernet ring” (p. 567) to
configure the Ethernet rings.

2

Choose Manage→Service Tunnels from NFM-P main menu. The Manage Service
Tunnels search form opens.
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3

Choose Ethernet Ring configured as sub-ring from the object drop-down menu and
click Search.

4

Double-click on the Ethernet ring configured as the sub-ring. The Ethernet Ring
(Edit) form opens.

5

Click on the Components tab.

6

Right-click on Interconnects and choose Create Ethernet Ring Interconnect. The
Ethernet Ring Interconnect (Create) form opens.

7

Configure the required parameters.

8

Select the Ethernet ring element that you need to interconnect at the A end and click
OK. The Select Element - Ethernet Ring Interconnect form closes and the Ethernet
Ring Interconnect (Create) form reappears.

9

Configure the Type parameter.

10

Select the Ethernet ring configured as the main ring and click OK. The Select
Ethernet Ring Element - Ethernet Ring Interconnect form closes and the Ethernet
Ring Interconnect (Create) form reappears.

11

Configure the required parameters, if required.

12

Select the Ethernet ring element that you need to interconnect at the B end and click
OK. The Select Element - Ethernet Ring Interconnect form closes and the Ethernet
Ring Interconnect (Create) form reappears.

13

Configure the Type parameter.
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14

Select the Ethernet ring configured as the main ring and click OK. The Select
Ethernet Ring Element - Ethernet Ring Interconnect form closes and the Ethernet
Ring Interconnect (Create) form reappears.

15

Click OK. The Ethernet Ring Interconnect (Create) form closes. The interconnection
is displayed in the navigation tree of the Ethernet Ring (Edit) form.

16

Click Apply to save the changes.

END OF STEPS

24.6 To configure an Ethernet ring element

24.6.1 Steps

1

Choose Manage→Service Tunnels from NFM-P main menu. The Manage Service
Tunnels search form opens.

2

Click Create and choose Ethernet Ring Element. The Select Network Elements form
opens.

3

Choose the participating 1830 PSS devices from the list.

4

Click OK. The Select ELAN elements form opens.

5

Choose the participating cards from the list.

6

Click OK. The Select ELAN elements form closes and the Ethernet Ring Element
(Create) form opens.

7

Configure the required parameters.
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8

Configure the sub-ring:

1. Configure the Type parameter. The Ethernet Ring ID, VPLS, and Propagate
Topology Change parameters appear if you configure the Type parameter as
Virtual Link or Non Virtual Link.

2. Configure the required parameters, as required.

9

Click Apply. The changes are updated and the Ethernet Ring Element (Edit) form
opens.

10

Close the Ethernet Ring Element (Edit) form.

END OF STEPS

24.7 To configure an Ethernet ring element path

24.7.1 Steps

1

Choose Manage→Service Tunnels from NFM-P main menu. The Manage Service
Tunnels search form opens.

2

Choose Ethernet Ring Element (Ethernet Ring) from the drop-down menu and click
Search. The Ethernet ring elements are listed.

3

Choose the Ethernet ring element for which the path needs to be configured and
click Properties. The Ethernet Ring Element (Edit) form opens.

4

Click on the Path Endpoints tab.

5

Click Create. The Ethernet Ring Path Endpoint (Create) form opens.

6

Configure the required parameters:
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Note: Configure the path of the Ethernet ring elements, configured as owner
and neighbor, as the Ring Protection Link End.
Configure all other paths as Normal.

7

Click on the Port tab.

8

Click on the Select button and choose the port for the specific path (Path A or Path
B).

9

Configure the required parameters.

10

Click OK. The Ethernet Ring Path Endpoint (Create) form closes and the Path
Endpoints tab lists the configured path.

11

Click Apply.

12

Repeat Step 3 to Step 11 to configure the path A and B for all the Ethernet ring
elements.

END OF STEPS
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25 1830 PSS MC LAG group

25.1 Overview

25.1.1 Purpose

This chapter provides information about the 1830 PSS MC LAG group

25.1.2 Contents

25.1 Overview 577

25.2 MC LAG 577

25.3 To configure an MC LAG 578

25.4 To configure an MC LAG source on a card 580

25.5 To configure an MC LAG peer on the card 581

25.2 MC LAG

25.2.1 Overview

A LAG is a group of ports that form one logical link between two NEs to increase
bandwidth, allow load balancing, and provide seamless redundancy. LAG support over
multiple devices provides link and node-level redundancy using a switchover function.

MC LAG is an extension of the LAG concept that provides access link, card, and node
level redundancy. An MC LAG configuration provides redundant L2 access connectivity
that extends beyond link-layer protection by allowing two devices to share a common
LAG endpoint. An MC LAG configuration includes one active member NE and one
standby member NE. The active and standby NEs synchronize the link state information
to facilitate link-layer messaging between an access node and each NE. The active and
standby NE coupling provides a synchronized forwarding plane to and from the access
node. LACP is used to manage the active and standby states of the available LAG links;
only the links of one member NE are active at a time.

NFM-P supports configuration of MC LAG groups on the following cards:

• 11OPE8

• 11QCE12X

• 11QPE24
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MC LAG is supported on C ports with 1 GbE signal rate and on X ports with 10 GbE
signal rate. NFM-P supports configuration of the MC LAG source and the MC LAG peer
at the node level and the card level. Only one MC LAG source can be configured per
card. Four MC LAG peers can be configured per source.

25.3 To configure an MC LAG

25.3.1 Before you begin

Perform the following before you configure an MC LAG group:

• Configure one or more LAGs on the participating cards. See 9.39 “To configure LAG
on 11OPE8, 11QCE12X, and 11QPE24 cards” (p. 154) for more information about
configuring LAGs.

• Configure VPLS service with MC LAG binding on the participating cards. See 14.3 “To
configure a VPLS” (p. 261) for more information about configuring a VPLS service.

25.3.2 Steps

Configure MC LAG peer group

1

Choose Manage→Redundancy→Node Redundancy from NFM-P main menu. The
Manage Node Redundancy form opens.

2

Choose MC PSS Peer Group (Multi-Chassis) from the object drop-down menu.

3

Click Create. The MC PSS Peer Group (Create) form opens.

4

Select an 1830 PSS device in the First Element.

5

Select a card in the Card Slot panel.

6

Select a VPLS service in the Service Site panel.

7

Configure the remaining parameters for the first peer.
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8

Repeat Step 4 to Step 7 for the second peer.

9

Click Apply. The MC PSS Peer Group (Create) form refreshes with additional tabs.

Configure MC LAG group

10

Click on the Associated Groups tab.

11

Right-click on the MC LAG Group object in the navigation tree and choose Create
MC PSS LAG Group. The MC PSS LAG Group (Create) form opens.

12

Configure the required parameters:

13

Select the LAG for the first MC LAG site.

14

Select the LAG for the second MC LAG site

15

Click OK. The MC PSS LAG Group (Create) form closes. The newly created MC
LAG object is displayed below the MC LAG Group object in the navigation tree on
the MC PSS Peer Group (Edit) form.

16

Repeat Step 10 to Step 15 to add more MC LAG groups.

17

Choose Network→NE→Shelf→Card Slot→LAGs→MC LAGs. Right-click on the
newly created MC LAG and choose Properties to view information about the created
MC LAG or to modify MC LAG parameters.

18

Save your changes and close the forms.
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Configure Force Status

19

Right-click on an MC LAG object on the navigation tree, as required, and perform
one of the following to force an active or standby status on an MC LAG group:

a. Choose Force Status→Force Active to force the MC LAG to active state.

b. Choose Force Status→Force Standby to force the MC LAG to standby state.

c. Choose Force Status→Clear Forced Status to clear the Force Switch Status.

Note: You can also choose to perform the Force Status task in a similar way
from the MC LAG (Edit) form.
Forcing a status on an MC LAG to a value that is the same as the status of
another MC LAG resets the status of the latter MC LAG.

Result: Expand MC LAGs→MC LAG on the navigation tree, right-click on an MC
LAG, and choose Properties. The MC LAG (Edit) form opens. The Active/Standby
field in the MC LAG Identifiers panel displays the forced status.

END OF STEPS

25.4 To configure an MC LAG source on a card

25.4.1 Before you begin

Perform the following before you configure an MC LAG group.

• Configure one or more LAGs on the participating card. See 9.39 “To configure LAG
on 11OPE8, 11QCE12X, and 11QPE24 cards” (p. 154) for more information about
configuring LAGs.

• Configure VPLS service with MC LAG binding on the participating cards. See 14.3 “To
configure a VPLS” (p. 261) for more information about configuring a VPLS service.

25.4.2 Steps

1

On the equipment tree, expand Network→NE→Shelf→Card.

2

Right-click on the Card object and choose Properties. The Card Slot (Edit) form
opens.

3

Click on the Redundancy tab and click Create. The MC Source (Create) form opens.
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4

Configure the Source ID parameter.

5

Select a service in the Service Site panel.

6

Save your changes and close the form.

END OF STEPS

25.5 To configure an MC LAG peer on the card

25.5.1 Before you begin

Perform the following before you configure an MC LAG peer:

• Configure one or more LAGs on the participating cards. See 9.39 “To configure LAG
on 11OPE8, 11QCE12X, and 11QPE24 cards” (p. 154) for more information about
configuring LAGs.

• Configure VPLS service with MC LAG binding on the participating cards. See 14.3 “To
configure a VPLS” (p. 261) for more information about configuring a VPLS service.

25.5.2 Steps

Configure MC LAG peer group

1

On the equipment tree, expand Network→NE→Shelf→Card.

2

Right-click on the Card object and choose Properties. The Card Slot (Edit) form
opens.

3

Click on the Redundancy tab, then on the MC Peer tab and click Create. The PSS
MC Peer (Create) form opens.

4

Configure the required parameters:

5

Click on the MC LAG tab and configure the required parameters.
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6

Click on the Members sub-tab and click Create. The MC LAG (Create) form opens.

7

Configure the required parameters:

8

Select a LAG in the LAG panel.

9

Configure the remaining parameters:

10

Save your changes and close the forms.

END OF STEPS
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A MIB entry name and TL1 command mapping

A.1 MIB entry name and TL1 command mapping

A.1.1 MIB entry name and TL1 command mapping

Table 55 TL1 Command Table

TL1Table name TL1Cmd name

AlarmTableEntry RTRV-ALM-ALL

AlmEqptTableEntry RTRV-ALM-EQPT

AlmNetIfTableEntry RTRV-ALM-NETIF

AsapTableEntry RTRV-ASAP-PROF

AU416CTableEntry RTRV-AU416C

AU44CTableEntry RTRV-AU44C

AU4TableEntry RTRV-AU4

BitsTableEntry RTRV-BITS

CardInventoryTableEntry RTRV-RI

CardTableEntry RTRV-EQPT

ConditionTableEntry RTRV-COND-ALL

CpMgrDataTableEntry RTRV-CPMGRDATA

DdmTableEntry RTRV-DDM

DxEqptTableEntry RTRV-DX-EQPT

EqptTableEntry RTRV-EQPT

GBE100FacilityTableEntry RTRV-GBE100

GBE100LpbkTableEntry RTRV-LPBK-GBE100

GBE10FacilityTableEntry RTRV-GBE10

GBE10LpbkTableEntry RTRV-LPBK-GBE10

GBE40FacilityTableEntry RTRV-GBE40

GBEFacilityTableEntry RTRV-GBE

GBELpbkTableEntry RTRV-LPBK-GBE

InventoryTableEntry RTRV-RI
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Table 55 TL1 Command Table (continued)

TL1Table name TL1Cmd name

IpAddrTableEntry RTRV-IP-ADDR

IpFilterTableEntry RTRV-IPACLIST

IpInterfaceTableEntry RTRV-IP-IF

IsuTableEntry RTRV-ISU-STATUS

LanTableEntry RTRV-LAN

NetworkInterfaceTableEntry RTRV-NETIF

NtpAddrTableEntry RTRV-NTP-ADDR

NtpTableEntry RTRV-NTP

OC12LpbkTableEntry RTRV-LPBK-OC12

OC12TableEntry RTRV-OC12

OC192LpbkTableEntry RTRV-LPBK-OC192

OC192TableEntry RTRV-OC192

OC3LpbkTableEntry RTRV-LPBK-OC3

OC3TableEntry RTRV-OC3

OC48LpbkTableEntry RTRV-LPBK-OC48

OC48TableEntry RTRV-OC48

OC768LpbkTableEntry RTRV-LPBK-OC768

OC768TableEntry RTRV-OC768

OchTableEntry RTRV-OCH

OConnTableEntry RTRV-EQPT-OCONN

Odu0CrossConnectTableEntry RTRV-CRS-ODU0

Odu0NimTableEntry RTRV-ODU0

Odu0XcPathProtectionTableEntry RTRV-CRSPROT-ODU0

Odu1CrossConnectTableEntry RTRV-CRS-ODU1

Odu1NimTableEntry RTRV-ODU1

Odu1XcPathProtectionTableEntry RTRV-CRSPROT-ODU1

Odu2CrossConnectTableEntry RTRV-CRS-ODU2

Odu2eCrossConnectTableEntry RTRV-CRS-ODU2E

Odu2eFFPTableEntry RTRV-FFP-ODU2E
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Table 55 TL1 Command Table (continued)

TL1Table name TL1Cmd name

Odu2eNimTableEntry RTRV-ODU2E

Odu2eXcPathProtectionTableEntry RTRV-CRSPROT-ODU2E

Odu2FFPTableEntry RTRV-FFP-ODU2

Odu2NimTableEntry RTRV-ODU2

Odu2XcPathProtectionTableEntry RTRV-CRSPROT-ODU2

Odu3CrossConnectTableEntry RTRV-CRS-ODU3

Odu3e2CrossConnectTableEntry RTRV-CRS-ODU3E2

Odu3e2NimTableEntry RTRV-ODU3E2

Odu3e2XcPathProtectionTableEntry RTRV-CRSPROT-ODU3E2

Odu3NimTableEntry RTRV-ODU3

Odu3XcPathProtectionTableEntry RTRV-CRSPROT-ODU3

Odu4CrossConnectTableEntry RTRV-CRS-ODU4

Odu4NimTableEntry RTRV-ODU4

Odu4XcPathProtectionTableEntry RTRV-CRSPROT-ODU4

OduPtfTableEntry RTRV-ODUPTF

OmsOchIfTableEntry RTRV-OMSOCHIF

OmsOchTableEntry RTRV-OMSOCH

OmsTableEntry RTRV-OMS

OspfAreaTableEntry RTRV-OSPF-AREA

OspfInterfaceTableEntry RTRV-OSPF-IF

OtsTableEntry RTRV-OTS

OtukLpbkTableEntry RTRV-LPBK-OTU

OtukTableEntry RTRV-OTU

PMModeGBE100TableEntry RTRV-PMMODE-GBE100

PMModeGBE10TableEntry RTRV-PMMODE-GBE10

PMModeGBE40TableEntry RTRV-PMMODE-GBE40

PMModeGBETableEntry RTRV-PMMODE-GBE

PMModeOC12TableEntry RTRV-PMMODE-OC12

PMModeOC192TableEntry RTRV-PMMODE-OC192
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Table 55 TL1 Command Table (continued)

TL1Table name TL1Cmd name

PMModeOC3TableEntry RTRV-PMMODE-OC3

PMModeOC48TableEntry RTRV-PMMODE-OC48

PMModeOC768TableEntry RTRV-PMMODE-OC768

PMModeOCHTableEntry RTRV-PMMODE-OCH

PMModeODU0TableEntry RTRV-PMMODE-ODU0

PMModeODU1TableEntry RTRV-PMMODE-ODU1

PMModeODU2ETableEntry RTRV-PMMODE-ODU2E

PMModeODU2TableEntry RTRV-PMMODE-ODU2

PMModeODU3E2TableEntry RTRV-PMMODE-ODU3E2

PMModeODU3TableEntry RTRV-PMMODE-ODU3

PMModeODU4TableEntry RTRV-PMMODE-ODU4

PMModeOTUTableEntry RTRV-PMMODE-OTU

PMModeSTM16TableEntry RTRV-PMMODE-STM16

PMModeSTM1TableEntry RTRV-PMMODE-STM1

PMModeSTM256TableEntry RTRV-PMMODE-STM256

PMModeSTM4TableEntry RTRV-PMMODE-STM4

PMModeSTM64TableEntry RTRV-PMMODE-STM64

PMModeVC416CTableEntry RTRV-PMMODE-VC416C

PMModeVC44CTableEntry RTRV-PMMODE-VC44C

PMModeVC4TableEntry RTRV-PMMODE-VC4

PortGroupTableEntry RTRV-PORTGP

PortInventoryTableEntry RTRV-RI

PortTableEntry RTRV-EQPT

PrmtrNeTableEntry RTRV-PRMTR-NE

ShelfInventoryTableEntry RTRV-RI

ShelfTableEntry RTRV-EQPT

STM16FFPTableEntry RTRV-FFP-STM16

Stm16LpbkTableEntry • RTRV-LPBK-STM16
• RTRV-STM16
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Table 55 TL1 Command Table (continued)

TL1Table name TL1Cmd name

STM1FFPTableEntry RTRV-FFP-STM1

Stm1LpbkTableEntry • RTRV-LPBK-STM1
• RTRV-STM1

Stm256LpbkTableEntry • RTRV-LPBK-STM256
• RTRV-STM256

STM4FFPTableEntry RTRV-FFP-STM4

Stm4LpbkTableEntry • RTRV-LPBK-STM4
• RTRV-STM4

STM64FFPTableEntry RTRV-FFP-STM64

Stm64LpbkTableEntry • RTRV-LPBK-STM64
• RTRV-STM64

SyncNTableEntry RTRV-SYNCN

TCAProfTableEntry RTRV-TH-PROF

TtiTableEntry RTRV-TTI

UserSecurityTableEntry RTRV-DFLT-SECU

UserTableEntry RTRV-USER-SECU

Vc416cCrossConnectTableEntry RTRV-CRS-VC416C

Vc416cXcPathProtectionTableEntry RTRV-CRSPROT-VC416C

Vc44cCrossConnectTableEntry RTRV-CRS-VC44C

Vc44cXcPathProtectionTableEntry RTRV-CRSPROT-VC44C

Vc4CrossConnectTableEntry RTRV-CRS-VC4

Vc4XcPathProtectionTableEntry RTRV-CRSPROT-VC4
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